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8 Chapter 1 Introduction to WinLab32

Welcome to WinLab32!
Important Features of the WinLab32 Software

• This highly usable product was developed by a team of application experts, 
laboratory managers, graphic designers, cognitive psychologists, and users 
from all over the world. Sample analysis, scheduling, and data reporting can be 
handled easily and efficiently.

• Operation is simplified. Based on the familiar Microsoft Windows menus and 
graphics, the software has easy-to-use graphics and familiar pull-down menus.

• Complete system controls and useful online information are at the user's 
fingertips, making procedures simple and routine, even for new operators with 
minimal training in ICP lab procedures. Less training is required and time can 
be saved, hence increasing lab productivity. 

• The automation of many routine tasks not only saves time, but also avoids 
expensive, time-consuming errors.

• Comprehensive data reprocessing and reporting capabilities include: built-in 
QC automation routines; full data reprocessing from stored spectra; methods 
and data stored in a commercial database; and easy generation of customized 
reports using off-the-shelf word processor or spreadsheet programs. 

• The flexibility of WinLab32 should allow you to comply with quality control 
protocols and regulatory procedures associated with Good Laboratory Practice 
(GLP) and Good Automated Laboratory Practice (GALP) requirements.

Related Applications

In addition to the WinLab32 software, PerkinElmerPerkinElmer provides:

• The Data Manager software application lets you archive, copy, delete, and 
rename the data sets created by WinLab32. Within this application, you can 
select a subset of the data from a results data set and save it in a file format that 
can be read by many off-the-shelf applications, including spreadsheet and 
database management programs. In addition, you can create printed reports of 
data where you control the design of and the information included in the report.

• WinLab32 Offline is a second copy of the WinLab32 application that does not 
control the instrument. You can use WinLab32 to edit methods, enter sample 
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information, examine data, build IEC or MSF models, or reprocess data in the 
software without operating the instrument. This is useful when you wish to 
work with methods and data while an analysis is in progress. 

Important Prerequisites

Before you use WinLab32 software, you should:

• Understand ICP principles and practices. If you need background information, 
you should consult one of the many textbooks available.

• Know how to use a personal computer. If you need further information, consult 
your computer manual.

• Understand Windows fundamentals. If you have questions, refer to manuals, 
books or CD-ROM tutorials on Microsoft Windows. 

WinLab32 Software
Organization

The WinLab32 software contains a series of windows, each of which has been 
optimized to help you perform some part of the overall analytical task. This model 
was a refinement of one of our current systems that has been well accepted in the 
analytical community. Each window in the software provides a specialized, task-
oriented view into the system. To perform a task, the analyst displays one or more 
windows that provide the appropriate controls or views of the data.

These windows are grouped in the following functional categories:

Data Analysis and Control:

Editors for 
Parameter Input

Use these windows to create or edit new methods and 
sample information files. These are the Method Editor, 
Periodic Table, Wavelength Table, and Sample 
Information Editor. 
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Controlling the 
Analysis

These windows enable you to select a method, sample 
information file, and make decisions about the analysis, 
whether it is a manual or automated analysis. These are 
the Manual Analysis and Automated Analysis 
windows. In addition, a Data Reprocessing window 
allows you to recalculate data. 

Displaying 
Information and 
Correcting 
Interferences

Windows are available to view calibration and spectral 
and tabular results during an analysis. Take a close look 
at a spectrum with the Examine Spectra/MSF window, 
where you can correct interferences using the MSF 
technique. An IEC Model Builder lets you apply IEC 
correction factors.

Handling Data:
Data Manager 
application

A full range of data management capabilities is 
available using this separate software application. Use 
Data Manager to copy, archive, delete, results data sets. 
You can also export data to other file formats and create 
reports of data. Step-by-step wizards are available.
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Overview of Windows for Data Analysis and Control: 
Specialized Editors for Parameter Input

There are several key windows for entering parameters for the analysis. Here is an 
overview. 

Instrument Control:

Controlling the Plasma, the 
Spectrometer and FIAS

Before, during, and after an analysis, use these 
windows as needed to control hardware 
parameters. These include the Plasma Control, 
the Spectrometer Control, and FIAS Control 
windows.

Adjusting and diagnostics When the instrument requires adjusting or 
diagnosing, check the Diagnostics window. In 
addition, System Monitors keep you informed 
of actions in the spectrometer, plasma and other 
hardware.

Online Assistance:
Finding Information Throughout WinLab32, there are several 

information sources: online help topics, 
messages from the instrument, a tip of the day, 
and tool tips. 

 

Method Editor. In the Method Editor, you enter all of the 
analytical information needed to perform an analysis: 
parameters for instrument settings, directions to convert 
spectral data into intensity data, calibration information and 
autosampler settings. Spike concentrations for matrix check 
samples, location of quality control solutions and 
instructions for performing QC procedures are also included 
here as well as several options for printing and storing data. 
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Periodic Table. The Periodic Table presents a graphical, 
easy-to-use means of selecting elements and their 
recommended wavelengths for your method. The elements 
and wavelengths that you select will be entered automatically 
in the Method Editor: Spectrometer, Define Elements page. 

Wavelength Table. Use the Wavelength Table to search for 
all of the elements that emit a signal at a particular 
wavelength. This window also lets you search for 
wavelengths for your method beyond those that appear in the 
recommended wavelengths list found in the Periodic Table.

Sample Information Editor. Use this window to enter all of 
the information regarding your samples. You enter 
information to describe the samples, information on how the 
samples were prepared, and set up an analysis schedule. In 
addition, you have the flexibility to note parameters that vary 
by sample, such as weight, and those that may be common to 
all samples, such as analyst name.   
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Overview of Windows for Data Analysis and Control: 
Windows for Controlling Analyses

Manual Analysis Control. Use the Manual Analysis 
window to analyze each blank, standard and sample 
manually. You select a method, sample information file, and 
if you choose to save data, a results file. When you analyze 
each item, the current status is reported here as well as in the 
Spectrometer monitor. Performing a manual analysis is 
useful when you wish to analyze only a few samples. 

Automated Analysis Control. For analyses with many 
samples or when an autosampler is used, you can set up an 
automated analysis. On the Set Up page, you select the 
method, sample information file, and if you chose to save 
data, a results data file. On the Analysis page, you start the 
analysis and can then observe the current status of each blank, 
standard and sample as well as the progress of the overall 
analysis. (The Spectrometer and Autosampler Monitors 
report the status of their respective hardware.) The 
Automated Analysis window lets you analyze up to the full 
capacity of your autosampler tray.

Data Reprocessing. Use this window to recalculate existing 
data in a results data set. This is useful if you wish to set 
different analytical conditions than those in the initial 
analysis, select different peak parameters, or change or 
correct method parameters without the need to reanalyze the 
samples. 
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Overview of Windows for Data Analysis and Control: 
Windows for Displaying Information and Correcting Interferences

Spectral Display. Use the Spectral Display window to view 
the spectra as it is generated during an analysis or spectra 
reprocessed from stored data. This graphical window shows 
subarray pixels, background correction points, intensity and 
concentration data. This window can be printed, resized, and, 
if desired, spectral data can be saved to the results data file. 
Color and layout can be adjusted. This window updates as 
each sample is analyzed. 

Results Display. Use the Results Display window to view the 
data generated from the analysis in a tabular form. This 
information can be written to a log file and printed. This data, 
saved in a results data set, can then be manipulated in the Data 
Manager as needed to create reports and to be exported to 
other formats. 

Calibration Display. This window shows the calibration 
curve for the elements being analyzed in each sample. It also 
provides the concentration of elements in the calibration 
standard, the calibration equation being used, and the 
correlation coefficient. (You set up the calibration and select 
the calibration equation in the method.) This window can be 
printed and resized, and color and layout can be adjusted. 
This window updates as the calibration analysis progresses.

Examine Spectra/MSF. The Examine Spectra/MSF window 
has two modes: In Examine Spectra mode, you can take a 
closer look at any spectrum or group of spectra for anomalies. 
Use it to make changes, such as updating the peak wavelength 
or changing background correction points. Should 
interferences be present, the Multicomponent Spectral Fitting 
mode of this window lets you create MSF models (blank, 
analyte, interferent) that you can use to make comparisons 
with your spectrum results to identify and subtract out 
interfering signals. 
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Overview of Windows for Instrument Control:
Windows for Plasma and Spectrometer Control 

IEC Model Builder. Use the IEC Model Builder when you 
suspect interferences that are direct spectral overlaps. This 
window takes you through set up, setting limits, calculating 
and summarizing factors that, when applied, reallocate 
emission intensities to correct for interferences.

Plasma Control. Use this window to modify plasma 
parameters, such as gas flows, radio frequency power and 
pump flow rate. You also use this window to monitor the 
status of major components affecting the plasma and sample 
introduction system, and to ignite the plasma and shut it off. 
In addition, you can override the method parameters with 
those contained in this window. (Recommended settings for 
plasma parameters and for nebulizers are contained in the 
Plasma Control Window section.) 

Spectrometer Control. Use this window to control key 
parameters for the spectrometer. You can adjust the torch 
viewing position, set spectrometer parameters manually 
(such as purge gas and plasma viewing mode) and override 
parameters in the method as well as perform a detector 
calibration. For simultaneous spectrometers, you can also 
perform a system wavelength calibration or a mercury 
realignment using this window. 

FIAS Control. Use the FIAS Control window to view the 
FIAS status and set valves, pumps , and remotes 
independently of any other ICP functions
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Overview of Windows for Instrument Control:  
Windows for Adjusting the Instrument and for Diagnostics

Diagnostics. When a question arises in instrument operation, 
the Diagnostics window can help by providing information 
about system connections (the System page) and about the 
status of the spectrometer, plasma generator and autosampler. 
Each of these component pages also contains a history 
showing the messages between the component and the 
software. In addition, each page contains a reconnect button 
for the associated component.

Status Panels. Several Status Panel windows provide 
updated information on instrument operation. During an 
analysis, these status panels report the position of the 
autosampler probe, the status of the spectrometer and plasma, 
and the status of instrument startup/shutdown. They are 
located at the top of the WinLab32 main screen but can be 
moved to any position on screen as desired.   
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Overview of Windows for Handling Data: 
Data Manager Application

The Data Manager application is a useful tool for maintaining and using data 
generated by the instrument and the WinLab32 software application. See the 
WinLab32 Data Manager Software Guide for further information.

Data Manager window. Use the Data Manager window to 
perform various data handling maintenance tasks. You can 
create, check, rename, copy, delete, and restore results data 
sets as desired. It is important to periodically delete and 
archive data sets to prevent libraries from becoming too large. 
Also, if you are running WinLab32 Enhanced Security use 
the Data Manager utility to view a master event log of all 
significant actions performed by a user as well as the revision 
history on all files and data objects.

Reporting Wizard. Use Data Manager’s Reporting Wizard 
to create printed reports of selected data. This wizard is an 
interview-style series of dialogs to help you easily choose the 
data and the format in your report. 

Export Wizard. Data Manager’s Export Wizard lets you 
select a subset of the data contained in a results data set and 
write it to a file that can be read by many other software 
applications, including spreadsheet and database 
management programs. 



18 Chapter 1 Introduction to WinLab32

Overview of WinLab32 Online Assistance

Help topics. To answer your questions as you operate the 
instrument, WinLab32’s online help file contains step-by-
step procedures, parameter descriptions, graphics, labeled 
screen shots, examples, a glossary and a comprehensive index 
as well as a full text search. You can print an individual topic 
or an entire book. (To do so, open the help contents window, 
click on a book or topic of interest and select Print in the 
bottom right hand corner of the contents window.) 

System Message. When there is an inconsistency in input 
information, WinLab32 alerts you with a system message 
dialog. This identifies the concern and provides an 
appropriate action to enable you to make a correction, or it 
may present you with a choice of actions. These messages can 
be printed for your reference. 

Check method. When an inconsistency in a method occurs, 
a check method dialog appears. This identifies the concern 
and provides an appropriate action to enable you to make a 
correction, or it may present you with a choice of actions. It 
also provides other useful information pertaining to the 
method. These messages can be printed for your reference. If 
you wish to check a method for errors or inconsistencies, in 
the Edit menu, click on Check Method. The active method 
will be checked and problems reported. 
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 Workspaces
Workspaces let you store a group of selected windows for later use. The workspace 
saves all of the entries you have made in the windows for your methods and 
analyses. It also saves the location of each window on the screen. The workspace 
is saved in a workspace file, which has the extension .wsp. Using workspaces, you 
can fill in and arrange windows once, saving time whenever you set up methods or 
perform analyses.

Entries that you can save using a workspace include the names of the method and 
sample information file, information contained in the Automated Analysis window 
(Set Up page), and any information concerning multi-method analysis. It also saves 

Tip of the Day. When you start the WinLab32 application, a 
Tip of the Day message appears with additional information 
that you may find helpful as you operate the instrument.    

Tool tips. Throughout WinLab32, information is available 
for window features such as buttons, entry fields, options, etc. 
When you place the mouse cursor on a feature, a one-line 
description, action, or other useful information relating to the 
feature selected appears. 

Analysis checking and error (warning) messages. When 
you have entered analysis information and begin the analysis, 
WinLab32 checks the entries to make sure that everything is 
set up properly. Depending on the type of error found, the 
software will display an analysis check dialog, which 
provides general information, or an analysis warning dialog, 
which alerts you to the possible collection of invalid data, so 
that you can make corrections. 
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decisions that you have made for your analysis, such as if data is to be saved and 
where, if it is to be printed, and if the method in memory is to be used.

To create a workspace:

1. Open the desired windows, fill in the entries for your methods and analyses and 
arrange the windows on the screen. For example, suppose you have run an 
analysis and arranged the windows as follows:

You can save the entire screen with all of the displayed windows and entries in a 
workspace file to redisplay later. 

2. To save the position of these windows and the entries within them, in the File 
menu, click on Save As... Workspace... In the dialog that appears, type a name 
for the workspace and click on Open. For example, type “analysis1”.

3. When you wish to view (or use) these windows and their entries again, in the 
File menu, click on Open Workspace. In the dialog that appears, select 
analysis1.wsp and click on Open. The windows with the entries appear 
exactly as before.



21Libraries and Files In Data Manager

Libraries and Files In Data Manager
Libraries and Data

The WinLab32 Data Manager application uses database technology to organize 
information in a structured format that is easy to manipulate. This information 
includes: parameters needed to perform analyses; data collected during analyses; 
and parameters used by related WinLab32 applications.

The data generated before, during, and after analyses is stored in libraries. Each 
library is a group of related tables and indices that contain data in a structured 
format. 

Data Manager

The Data Manager is a WinLab32 application that helps you organize and manage 
the data stored in libraries. You can rename, copy, archive, and delete data sets.

Files

Not all WinLab32 information is stored in database libraries. For example, sample 
information is stored in ASCII files, so that you can easily create compatible 
sample information files using off-the-shelf applications such as spreadsheet 
programs. You can use the Windows Explorer to copy, rename, move, or delete 
these files.

Different Libraries

You may want to create separate libraries for each person using the system. You 
can do this by creating new libraries for the methods and results using Data 
Manager. Refer to the Data Manager Help file for information. 

Important
Note

Library maintenance should be done periodically to prevent your Results 
Library from becoming too large. A large Results Library can lead to disk 
problems. Maintenance procedures include archiving, deleting, and 
packing data sets. For additional information, please refer to Data Manager 
Help: What's Important About Managing Data.
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Safety Information and Conventions
This help file contains procedures for setting up and performing analyses using 
WinLab32 and detailed descriptions of the windows in the software. Be advised of 
the following safety information and aware of the conventions used in this help file.

Safety Information

Conventions Used in the online help and software guide

The following special formats are used to set apart important information and 
warnings when dealing with the instrument hardware. 

Before setting up and operating the instrument, carefully read the safety 
precautions described in the Hardware Guide and observe these 
precautions at all times.

A warning indicates an operation that could cause personal injury if 
precautions are not followed.

A caution indicates an operation that could cause instrument damage if 
precautions are not followed.

Note Notes emphasize significant information in a procedure or description. 
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Performing Analyses Overview
This chapter explains the procedures that you will use to operate your instrument 
with WinLab32. It contains eight sections that guide you through setting up and 
optimizing the instrument, setting up the software and performing analyses.

Observe Safety Precautions

To perform analyses

Use sections to select the group of steps required for your analyses.

Before setting up and operating the instrument, carefully read the safety 
precautions described in the Hardware Guide and observe these 
precautions at all times.

Performing Analyses 
Section

Results

Setting up the 
Instrument

• system checked
• major components turned on
• plasma ignited successfully

Optimizing and 
Verifying Performance

• hardware optimized and ready to go

Selecting a Workspace, 
Method, and Sample 
Information File

• workspace created with required windows 
• method or methods designated for your 

analyses
• file created for samples in your analyses

Setting Options in 
Control Window

• results data set named
• such as turning options on or off, automatically 

selected
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For information on the system, installation, maintenance, and troubleshooting, 
refer to the Hardware Guide.

Setting Up the Instrument
To set up the instrument

Setting up the instrument requires these basic steps.

Arranging Samples • solutions prepared
• samples placed in the autosampler 

Analyzing Samples • concentrations of all unknown samples 
determined

Generating Reports • data from analyses collected and then printed 
using WinLab32 Data Manager

Shutting Down the 
Instrument

• plasma extinguished
• instrument shut down or put in an automatic 

shutdown/startup mode

Setup Step What's Required

Checking the System Check these items regularly to make sure that the 
system is set up properly.

Starting the Instrument 
and Accessories 

Switch on power to the various components of the 
system.

Starting the Computer 
and Software 

Start the software and verify instrument 
configuration.

Setting Up and Starting 
the Peristaltic Pump 

Install the pump tubing so the pump is ready to 
start automatically once the plasma is ignited.

Preparing to Ignite the 
Plasma

Make important checks and changes to avoid 
ignition problems.



26 Chapter 2 Performing Analyses

Checking the System

Proper setup and routine maintenance are required to keep your instrument in 
proper working condition so that you will get acceptable performance.

To check the system

Before starting the system, use this checklist to make sure that the system is in 
proper working order. Consult your Hardware Guide for additional information, as 
well as for information on cleaning and maintaining your system.

Exhaust vent

Check that your vent system is switched on, is working properly, and is not 
blocked.

Argon supply

Be sure that an adequate supply of argon is available and is connected to the 
system. Check that a spare tank is ready if necessary. For more information, 
see the Installation chapter in the Hardware Guide.

Check that the cylinder valve is open and the regulator for the argon outlet 
pressure is set within the range specified in the Hardware Guide.

Check for leaks at the gas connections.

Igniting the Plasma

Examining the Plasma Observe the plasma to determine its stability.

Correcting Unsuccessful 
Ignition

Troubleshoot problems if the plasma does not 
light.

Setup Step What's Required
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Nitrogen purge gas supply

Be sure that an adequate supply of nitrogen is available and connected to the 
system. Check that a spare tank is ready. For more information, see the 
Installation chapter in the Hardware Guide.

Check that the cylinder valve is open and the regulator for the nitrogen outlet 
pressure is set within the range specified in the Hardware Guide.

Check for leaks at the gas connections.

Shear gas supply (Axial or Dual View only)

The shear gas typically used is compressed air, although nitrogen may be used. 
If nitrogen is used, be sure that an adequate supply is available and connected 
to the system. Check that a spare tank is ready. For more information, see the 
Installation chapter in the Hardware Guide.

Check for leaks at the gas connections.

Cooling water supply

The cooling water (house water or chiller) should meet the required specifications 
and be installed according to the information in the Installation chapter in the 
Hardware Guide.

Check that the cooling water supply is connected to the instrument.

If using a chiller, check the electrical connections. Be sure the chiller is turned 
on and has been filled. Periodically check the liquid level. See the Hardware 
Guide for the appropriate coolant and for other details.

If using house water, check that the supply is turned on and is being filtered. 

Check for any leaks in the plumbing connections.
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Sample introduction system

Inspect the torch, glassware, and aerosol injector tube. The glassware should 
be clean. Small amounts of deposits are acceptable in most cases. Also check 
for signs of melting. Refer to the Maintenance chapter in the Hardware Guide 
for instructions on cleaning the torch.

Check that the RF coil is clean. This prevents arcing across the coils. Also, if 
the humidity in your lab is high, be sure that the coil is dry. If necessary, use a 
soft cloth to dry it.

Leakage of air into any part of the torch, nebulizer or spray chamber may cause 
ignition problems. Therefore, be sure to regularly check the following items:

Check the torch gas connections. For more information, see the Hardware 
Guide. 

Check that the nebulizer/end cap is tightly secured to the spray chamber.

Check that the sample capillary tubing is attached to the nebulizer sample inlet. 
The tubing should be clean and in good condition.

Check that the drain fitting is secured on the spray chamber drain. A loose-
fitting drain can cause pressure leaks and consequent plasma instability.

Peristaltic pump and tubing

Check that the pump tubing is in good condition, has no flat spots, and is 
correctly installed around the pump head. See the Hardware Guide for details.

Replace tubing regularly, after eight to sixteen hours of continuous use. If you 
are routinely using organic solvents, you will need special tubing, since 
standard tubing may not last as long as with aqueous solutions. Refer to the 
Hardware Guide for a list of replacement tubing.

Check that the pump rollers are clean and can move freely.
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Drains

Check that the spray chamber drain is properly set up on the pump so that waste 
is pumped out of the spray chamber. Replace the drain tubing if it has 
deteriorated. 

Check the spray chamber drain leads to the drain bottle. Empty the drain bottle 
if necessary. Dispose of waste properly. 

Autosampler

Install the tray in the autosampler and place the wash beaker in the rear left of 
the tray (location 0). 

Check that the sampling probe is installed at the correct height and the probe 
capillary is attached to the pump tubing for the sample.

Printer

Check that the printer has an adequate supply of paper to print your results.

Starting the Instrument and Accessories

We recommend that you leave the Main Instrument switch on even when the 
instrument is not in use. If the Main Instrument switch is turned off, the system will 
need to reinitialize when power is switched back on. The initialization sequence, 
automatically carried out by the system, can take from 15 minutes to over an hour, 
depending on how long the instrument power remained off. For more information 
on the initialization sequence and the location of system components such as 
switches, refer to the Hardware Guide.

To conserve the purge gas for the detectors, you can use Automatic Shutdown in 
the Automatic Shutdown/Startup dialog. This feature is an alternative to turning off 
the power to the main instrument, which also then shuts off the purge gas. 

You can also specify Automatic Startup in this dialog, indicating the time to start 
up, whether the plasma is to be ignited, and if the pump should begin operating 
upon startup.
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To start up the instrument

1. If you have not already done so, turn on the gases and the cooling water supply 
or chiller. See the checklists in Checking the System earlier in this chapter.

2. If the Main Instrument switch has been turned off, turn it on. Usually, this 
switch should remain on to avoid a waiting period for instrument startup.

3. Close the doors to the sample compartment. Be sure that the front door is fully 
closed and secured.

4. Turn on the autosampler and any other accessories.

Starting the Computer and Software

To start the computer and software

1. Switch on the computer, monitor, and printer.

2. Click on the Start button. Select Programs  PerkinElmer WinLab32  
WinLab32.

The WinLab32 software starts. 

To verify instrument configuration

1. For all instruments: 
Check that the autosampler type and tray are correct. Change, if required. To 
change the autosampler, exit the software and run the Reconfigure utility. To 
run the Reconfigure utility, click on Start  Programs  PerkinElmer 
WinLab32  Reconfigure.

To change the tray, use the Autosampler... command in the Options menu.

Note If you turn on any of the devices under GPIB control after you start the 
software, you will need to reset communication to the device in the 
Diagnostics window by clicking on the Reconnect button. (The devices 
under GPIB control include the instrument and the autosampler.)
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2. For all instruments: 
Check that the peristaltic pump and tubing type are correct. Change if required, 
using the Pump... command in the Options menu.

3. For the Dual View (DV) instruments: 
In the Spectrometer Control window, check that the correct plasma viewing 
mode (axial or radial) is set. Change the viewing mode if required, using the 
options in the Spectrometer Control window

Setting Up and Starting the Peristaltic Pump

Before setting up the pump, be sure you have made a daily check of the system, 
started the instrument and accessories, and started the computer and software. For 
more details on the pump, see the Hardware Guide.

To set up the peristaltic pump

1. Check that the sample tubing and the drain tubing leading from the spray 
chamber are properly set up on the pump, as shown in the Hardware Guide.

2. If the pump tubing is new, gently stretch it. Position the clips on the tubing in 
front of the tubing stops. 

3. Replace the tubing clamps for each channel and swing the cam levers over to 
apply tension to the clamps.

To start the pump

1. Place the sample capillary tubing in a container of a solution whose matrix 
matches that of the samples in your application (for example: deionized water, 
diluted acid, or organic solvents).

2. In the Toolbar, click on the Plasma icon or in the Tools menu click on Plasma 
Control to Display the Plasma Control window. Click on the Pump button to 
turn on the pump.

3. Adjust the flow rate to 1.5 mL/min for aqueous analysis. (The aqueous analysis 
default value is 1.5 mL/min.) For organic analysis adjust the flow rate to 0.8 
mL/min. (The organic analysis default value is 0.8 mL/min.)
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4. If necessary, adjust the tension on the pump tubing, one channel at a time. For 
the sample tubing, gradually tighten the adjustment screw until the liquid flows 
smoothly without bubbles. The drain tubing should have a segmented flow of 
liquid leading to the drain bottle. Bubbles in the drain tubing are normal. See 
the Hardware Guide for a more detailed adjustment procedure.

Preparing to Ignite the Plasma

Before beginning this step, be sure the system, instrument, computer, and pump are 
ready. These preliminary steps are outlined in Set Up: Summary of Steps.

Before igniting the plasma

Check that a method with the appropriate plasma conditions has been selected. 
Use the Method button on the toolbar to open a different method. 

Close and secure the doors to the sample compartment. An interlock prevents 
you from igniting the torch if the doors are not fully closed. 

If switching from organic to aqueous solutions

To avoid ignition problems when switching from organic to aqueous solutions, 
purge organic vapors that may remain in the torch. If needed, see Correcting 
Unsuccessful Ignition later in this chapter.

When the humidity in your laboratory is high (>75%), water can condense 
on the RF coil of the torch when the torch is not in operation. To prevent 
damage to the RF coil, use a soft cloth to dry the coil before igniting the 
torch.

Note PerkinElmer recommends having two torch and sample introduction 
systems, one for use with agueous solutions and one for use with organic 
solutions.
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If using wavelengths below 190 nm

If wavelengths below 190 nm will be measured, you must use the Spectrometer 
Control window to do a high nitrogen purge of the optical system. A high purge 
time of approximately 15 minutes is usually sufficient if the instrument has 
been purging for a long time. Additional purge time may be necessary if the 
intensity readings are not satisfactory.

Before running samples, return the purge rate to normal and take a 
measurement to make sure that you have achieved a steady-state signal, 
indicating that the high purge time was sufficient.

Igniting the Plasma

Before beginning this step, be sure the system, instrument, computer, and pump are 
ready, and that you have made the correct preparations to ignite the plasma. These 
preliminary steps are outlined in Set Up: Summary of Steps.

The Ignition Process

During the ignition process, argon gas flows through the torch and spray chamber, 
purging the sample introduction system of air. With the argon continuing to flow, 
power is applied to the RF coil. Then, a high voltage spark is injected into the argon 
flow causing the argon to ionize. The free electrons that are created then interact 
with the applied RF field to cause further argon ionization and form a plasma.

Messages appear in the Plasma Status display to inform you of the ignition status. 
The system sets the plasma gas flows. Then a message reads “Initial Purge” and the 
system counts down in seconds. The plasma is ignited, the plasma gas flows are 
then set to the starting plasma conditions of the active method in the Plasma 
Control Window, or if the override method is selected to those specific set points. 
At the end of this process, a message reads “Plasma has been ignited.”

To ignite the plasma

1. Read the entire procedure before igniting the plasma.

2. Observe the following precautions when igniting the plasma.
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3. If you have not yet started the pump, place the sample capillary tubing in a 
container of a solution whose matrix matches that of the samples in your 
application (for example: deionized water, diluted acid, or organic solvents). 

The pump automatically shuts off at the beginning of the ignition sequence and 
is restarted at the end of the ignition sequence.

4. Click the Plasma switch to On in the Plasma Control window (or press F9) to 
turn on the plasma.

The Plasma Status display indicates when the plasma has been ignited. 

5. Immediately examine the plasma through the viewing window.

Viewing the Plasma During Ignition

When you ignite the plasma, be sure to observe it closely through the 
viewing window. If the plasma is unstable, immediately click the Plasma 
switch to Off in the Plasma Control window (or press F9) to turn off the 
plasma; or, press the red Emergency Plasma Off button above the sample 
compartment.

An unstable plasma, as shown in the diagram, can cause the end of the 
torch to become overheated and to deform. If the deformity is severe, the 
argon gas flow patterns will be altered, and the torch must be replaced.

Note Pressing the red Emergency Plasma Off button allows you to shut off the 
plasma directly and bypasses the software. This button can be used if the 
software hangs up or if communication between the instrument and the 
computer is interrupted. Using this button does not harm the instrument. If 
you use this button, you must reset the system before you can reignite the 
torch. Be sure that the red button is in the “out” position, and select the 
Reset RF Emergency Off command in the System menu.
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Examining the Plasma

After igniting the plasma, you must examine it through the viewing window to 
determine whether it is stable or unstable.

To examine the plasma

Carefully note the characteristics of the plasma. A stable plasma will be 
situated just above the inner quartz tube in the torch and will have a bright 
discharge of the shape as shown. An unstable plasma has an irregular shape and 
may have an air gap underneath.

To proceed if the plasma is stable 

1. Wait one hour before running samples. This ensures accuracy in your results, 
since it allows the temperature of the sample introduction system to fully 
stabilize.

2. Proceed to Optimizing and Verifying Performance.

A stable plasma

An unstable 
plasma



36 Chapter 2 Performing Analyses

To shut off the plasma if the plasma is unstable

1. Click the Plasma switch to Off in the Plasma Control window (or press F9) to 
turn off the plasma, or press the red Emergency Plasma Off button that is 
located above the sample compartment.

2. Proceed to Correcting Unsuccessful Ignition.

To reignite the plasma after the plasma has been shut off

An unstable plasma is usually caused by air leaking into the system. To correct this 
problem, do the following: 

1. Check the torch gas connections. For more information, see the Hardware 
Guide. 

2. Repeat the ignition procedure. Click the Plasma switch to On in the Plasma 
Control window (or press F9). 

The Plasma Status window indicates the ignition status. 

3. Immediately examine the plasma as before. If no plasma is formed, see 
Correcting Unsuccessful Ignition. 

Correcting Unsuccessful Ignition

If the plasma fails to ignite during the ignition sequence, the plasma switch will go 
to the off position, indicating that ignition has failed but may be attempted again. 
Simultaneously, an error message is displayed in the Plasma Status display. 

Note Pressing the red Emergency Plasma Off button allows you to shut off the 
plasma directly and bypasses the software. This button can be used if the 
software hangs up or if communication between the instrument and the 
computer is interrupted. Using this button does not harm the instrument. If 
you use this button, you must reset the system before you can reignite the 
torch. To reset the system, be sure that the red button is in the “out” 
position, and select the Reset RF Emergency Off command in the System 
menu.
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To correct unsuccessful ignition

Check this list of possible reasons for unsuccessful ignition. Review the Instrument 
Message history which is found on the Plasma Tab of the Diagnostics window. 
Correct the problem if possible, and then try to ignite the plasma again. See Igniting 
the Plasma earlier in this chapter. 

Plasma Conditions

Be sure you are using the correct plasma conditions for your application. 
Check the Sampler:Plasma page in the Method Editor.

Ignitor Cable or Contact

On instruments with an ignitor cable, check to make sure that the cable is 
plugged in. On instruments with an ignitor contact, check that the copper strip 
on the torch is in close proximity to the ignitor contact finger.

Exhaust vent

Be certain that your exhaust vent is operating properly and is not blocked. 
Operation of the exhaust vent is required to establish proper argon gas flow 
patterns as well as for safety reasons.

Air leaks

An unstable plasma is usually caused by air leaking into any part of the torch, 
nebulizer, or spray chamber. To correct this problem, do the following: 

Check the torch gas connections. For more information, see the Hardware 
Guide.

Check that the torch O-rings are in good condition. Replace cracked or worn 
O-rings.
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Drain

Check that the fitting on the spray chamber drain is secure. Be sure that the 
pump is properly draining the spray chamber and that the drain liquid is not 
backing up into the spray chamber.

Nebulizer end cap

Check that it is tightly secured to the spray chamber.

Sample capillary and tubing

Check that one end is attached to the nebulizer and that the other end is 
immersed in solution.

Organics

If you are analyzing organic solutions and cannot ignite the plasma, turn on the 
nebulizer argon for two minutes with the pump off to purge the spray chamber. 

To purge organic vapors from the sample introduction system

If you are switching from organic to aqueous solutions, purge organic vapors using 
the following steps.

1. Open the Plasma Control window. Be sure Override Method is checked so 
you can make the following adjustments.

2. Start the nebulizer argon flow at 0.50 L/min by clicking on Neb and setting 
0.50 in the box above.

3. Start the auxiliary argon flow at 1.0 L/min by clicking on Aux and setting 1.0 
in the box above.

When you release the tension on the peristaltic pump tubing (that leads to 
the nebulizer), be sure that the free end of the sample capillary or sample 
probe is not immersed in the solution. Failure to make this check may 
result in the solution being siphoned into the spray chamber and torch.
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4. Start the plasma argon flow at a rate of 15 L/min by clicking on Plas and setting 
15.

5. Place the capillary tube from the peristaltic pump in a beaker of deionized 
water.

6. Change the pump rate to the high flush speed (approximately 2.5 mL/min) by 
clicking on Flush.

7. Continue aspirating water for approximately five minutes to thoroughly purge 
the sample introduction system of organic vapors.

Alternative procedure for purging organics: Aspirate an approximately 1% 
liquid soap solution for about 15 minutes at the normal pump rate, followed by 
deionized water for another five minutes. If this does not improve the plasma 
condition and the precision, remove the sample introduction system and give 
it a thorough cleaning.

Optimizing and Verifying Performance
Before proceeding, be sure you have completed instrument setup as outlined in 
Setting Up the Instrument earlier in this chapter.

Performance checks

Performance checks should be done regularly to help assure acceptable 
performance. The frequency of using these checks depends on how critical 
analytical precision is in your application. To help assure acceptable performance 
and to monitor instrument condition, it is suggested that a log be maintained. These 
tests include:

• Sodium bullet test, where the aspiration of a solution of 1000 mg/L or more 
of sodium should produce a defined “bullet” in the center of the plasma 
discharge. This test allows you to visualize the sample flow in the plasma, so 
that you can check that the sample introduction system is working correctly.

Note PerkinElmer recommends having two torch and sample introduction 
systems, one for use with agueous solutions and one for use with organic 
solutions.
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• Background Equivalent Concentration (BEC) test, which is a useful 
indicator of the relative sensitivity of the instrument for a particular emission 
line. The BEC value is the concentration of an element which would produce 
the same emission intensity as the plasma background measured at the analyte 
wavelength. The BEC checks torch alignment, plasma viewing height (only 
meaningful in radial view), nebulizer gas flow rate, and incident RF power.

• Precision Test, which expresses the short-term precision for several 
measurements for a strong emission line. This test indicates the Relative 
Standard Deviation (RSD) of the instrument's analyte emission intensity or 
concentration measurements. The RSD may also be referred to as the CV 
(Coefficient of Variation). A high RSD or CV is usually indicative of a 
problem with the sample introduction system such as improper drainage, leaks, 
improper tension on the pump tubing, worn pump tubing, or nebulizer 
problems.

• Detection Limit Test, which measures the noise of the baseline signal in 
concentration units to give an indication of the lowest concentration of an 
element which can be measured. The detection limit is calculated as three times 
the standard deviation of the blank.

To make performance checks

Use the following procedures in sequence or use the Browse buttons to move 
through each procedure. 

1. Sodium Bullet Test 

2. Creating a Method for the Performance Checks 

3. Setting Up for the Performance Checks 

4. Performing the Background Equivalent Concentration (BEC) Test 

5. Performing the Precision Test 

6. Performing the Detection Limit Test 
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Troubleshooting

If acceptable performance is not found with these tests, see the Hardware 
Guide for troubleshooting performance problems. The performance tests can 
often pinpoint the cause of the problem.

When you have completed the performance tests, refer to Selecting a Workspace, 
Method, and Sample Information File later in this chapter.

Sodium Bullet Test

To run the sodium bullet test:

1. For aqueous analyses, aspirate a 1000 mg/L solution of sodium. For organic 
analyses, aspirate an appropriate organic blank.

2. Examine the plasma through the viewing window in the sample compartment 
door. 

A yellow-orange bullet (or green, in the case of organic compounds) should be 
visible in the center of the discharge, and should extend from the base of the 
discharge to about 2-3 mm past the RF coil. If the bullet height is unsatisfactory, 
adjust the nebulizer argon flow in the Method Editor or Plasma Control windows. 

If no bullet appears or the bullet is faint:

• Check that your sample does contain sodium at the required concentration.

• Check that sample is being pumped to the nebulizer. Make sure that the pump 
lever is engaged and that the pump tubes are connected appropriately.

• Check that the drain is being pumped properly. You should see a segmented 
flow of bubbles through the tubing.

If the above checks fail to make an improvement, turn off the plasma, then check 
the following:

• Check that the nebulizer end cap is connected tightly.
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• Check the nebulizer spray pattern: run deionized water for several minutes, 
then remove the nebulizer end cap. If the nebulizer spray is sputtering or 
uneven, inspect the nebulizer tips for clogging and clean or replace them as 
necessary.

• Check that the injector is not clogged. You will need to disassemble the torch 
as described in Chapter 4, Maintenance in the Hardware Guide for your 
instrument. 

Creating a Method for the Performance Checks

The following procedure describes how to create the method you will need for the 
BEC, Detection Limit, and Precision tests. This method can be stored and recalled 
later for periodic performance checks at whatever interval is desired.

To create the method for the tests:

1. In the File menu, click on New  Method...

2. In the Create New Method dialog, select default conditions for an aqueous 
analysis.

3. When the Method Editor appears, click on Periodic Table. In the Periodic 
Table, select manganese using the 257.610 wavelength. Select other elements 
you may be interested in using for the performance checks. If available, 
cadmium or titanium (in addition to manganese) would be good choices to get 
an overall indication of the instrument's performance. For cadmium, select 
226.502 nm; for titanium, select 334.940 nm.

4. Type a description for the method. In the File menu, select Save  Method. 
Type a name for your method such as “perftest” and click on OK. 

If the plasma has been on, allow five minutes for the torch to cool before 
checking the following. !

Warning
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5. On the Spectrometer: Settings page, select:

Read Time: Min 10 sec.; Max 20 sec.
Read Delay:   60 sec. for manual sampling; approx. 120 sec. for an autosampler
Replicates:     3

6. Click on the Sampler tab. On the Plasma page, select Same for all Elements 
and use the parameters listed below for axial viewing:

7. Click on the Sampler tab. On the Peristaltic Pump page, select:

Sample Flow Rate:1.50 mL/min

8. Click on the Process tab. On the Peak Processing page, select:

Peak Algorithm: Peak Area
Points/Peak: 3

9. Click on the Calibration tab. On the Define Standards page, you need only 
one Calibration Blank and one Calibration Standard. On the Calib Units and 
Concentration page, select 10 mg/L of Manganese. If there are other elements 
in your method, select the standard concentrations for these elements. 
Typically, use a concentration 100 times greater than the expected detection 
limit.

Axial 
Viewing

Plasma Flow: 15 L/min 

Aux Flow: 0.5 L/min

Neb Flow: 0.75 L/min

RF Power: 1450 W

View Dist: 15 mm 
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10. Click on the Options tab. For the Results Display and Printed Log, select:

Analytical Header
Replicate Data
Means and Statistics 

11. In the File menu, select Save  Method.

Setting Up for the Performance Checks

Solutions You'll Need

To do the performance checks, you will need the following solutions:

• Manganese solution: 10 mg/L (in 1% HNO3 or another appropriate acid). 
Optionally, you can use a multielement solution containing other elements of 
interest (at a concentration 100 times greater than the recommended detection 
limit If available, cadmium or titanium (in addition to manganese) would be 
good choices to get an overall indication of the instrument's performance. 

• Blank solution containing deionized water and an appropriate acid to match the 
sample matrix.

• Rinse solution containing deionized water and an appropriate acid. The acid 
concentration should match the standard and samples.

Setting Up for the Tests

To run the tests, you will need a method. Refer to Creating a Method for the 
Performance Checks earlier in this chapter. 

Before running the tests, you should have completed the following procedures:

• Detector Calibration 

• Wavelength Calibration 

• Torch View Optimization 
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Performing the Background Equivalent Concentration (BEC) Test

How is the BEC Determined?

In performing the BEC test, you determine what concentration of analyte is 
equivalent to the plasma background at the analyte wavelength. This provides an 
indication of the sensitivity of the instrument. To do the test you first perform a 
calibration by running a blank followed by a standard. The calibration establishes 
the relation between emission intensity and concentration. A calibration also takes 
into account the dark current noise. 

Once the calibration is complete, you close the shutter, thereby blocking the light 
from the plasma source from reaching the detector. At this point, you take a reading 
(at zero intensity). This extrapolates the calibration line backward until it intercepts 
the concentration axis. The resulting concentration value is negative. By changing 
the sign to positive, you obtain the BEC value. 

Example of a 
calibration 
curve used in 
determining the 
BEC value.
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Performing the BEC Test

Before starting, you should have already set up the system for the tests. If not, see 
Setting Up for the Performance Checks earlier in this chapter. 

1. Check that the method you created for the performance tests (for example, 
“perftest”, is open. If not, in the File menu, click on Open  Method.

2. Click on the Manual icon to open the Manual Analysis Control window.

3. In the Manual Analysis Control window, select Print Log. In addition, if you 
want to save your results, click on Open... and select a Results Data Set Name.

4. Aspirate the blank and click on Analyze Blank.

5. Aspirate the manganese or multielement solution and click on Analyze 
Standard. This completes the calibration.

6. Aspirate the rinse solution.

7. In the Tools menu, click on Spectrometer Control.

8. In the Spectrometer Control window, close the shutter by selecting the 
“Closed” option.

9. Click on the Manual Analysis Control window to bring it to the front. For the 
Read Delay, select Override Method and set the Read Delay to 0.

10. While continuing to aspirate the rinse solution, click on Analyze Sample. 
(This will give you results in concentration units.) 

11. Click on the Spectrometer Control window to bring it to the front. Change the 
shutter from Closed to the Auto position, which returns it to instrument control. 

Check the results. By taking the negative value and making it a positive value, this 
gives you the BEC for Mn 257.610. It should be less than or equal to 0.04 mg/L. If 
it is not, refer to Performance Problems in Chapter 5, Troubleshooting, in your 
Hardware Guide.
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Performing the Precision Test

Before starting, you should have already set up the system for the tests. If not, see 
Setting Up for the Performance Checks earlier in this chapter. For convenience, 
you may want to run this test after the BEC test. You can use a solution of 10 mg/
L manganese for the test or, optionally, a multielement solution containing other 
elements of interest.

1. Check that the method you created for the performance tests (for example, 
“perftest”) is open. If not, in the File menu, click on Open  Method.

2. If you have just run the BEC test, the Manual Analysis Control window should 
be displayed. If not, click on the Manual icon.

3. In the Method Editor, click on the Spectrometer: Settings page and specify 
10 replicates.

4. In the Manual Analysis Control window, disable Override Method to use the 
Read Delay specified in the method. To disable it, click on the box to remove 
the check mark.

5. Aspirate the manganese or multielement solution.

6. In the Manual Analysis Control window, click on Analyze Sample.

Check the results. The RSD should be less than 1.0%. If it is not, refer to 
Performance Problems in Chapter 5, Troubleshooting, in your Hardware Guide.
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Performing the Detection Limit Test

Before starting, you should have already set up the system for the tests. If not, see 
Setting Up for the Performance Checks earlier in this chapter. For convenience, 
you may want to run this test after the BEC or Precision test. You can use a solution 
of 10 mg/L manganese for the test or, optionally, a multielement solution 
containing other elements of interest.

1. Check that the method you created for the performance tests (for example, 
“perftest”, is open. If not, in the File menu, click on Open  Method.

Make the following changes to the method:

On the Spectrometer: Settings page, select:

Read Time:   Min 50 sec.; Max 50 sec.
Replicates:     20

2. If you have just run the BEC or Precision test, the Manual Analysis Control 
window should be displayed. If not, click on the Manual icon.

3. Aspirate the rinse solution and rinse sufficiently, particularly if you have just 
done a Precision test (rinse for two minutes).

4. If you have already done the BEC test, this included a calibration so you can 
skip to Step 5. If you have not yet done a calibration:

• Aspirate the blank and click on Analyze Blank.

• Aspirate the manganese or multielement solution and click on Analyze 
Standard. Rinse for at least 2 minutes after the standard is analyzed. A full 
5-minute rinse is recommended. 

5. Aspirate the blank solution.

6. While continuing to aspirate the blank, press Analyze Sample. (This will give 
you results in concentration units.)

Note Increasing the Read Time in the method to 50 seconds will provide better 
detection limits.
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Check the results. To determine the detection limit, multiply the standard deviation 
of the blank by three. Compare your results with the required detection limits for 
the elements.

Detection limits for the three elements we suggested for the test are:

If your results are too high, refer to Performance Problems in Chapter 5, 
Troubleshooting, in your Hardware Guide.

Analyte Wavelength
Detection 
Limit

Mn 257.610 nm 1.0 µg/L

Ti 334.940 nm 0.5 µg/L

Cd 226.502 nm 1.6 µg/L
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Selecting a Workspace, Method, and Sample Information File
Before you can analyze samples, you need: windows suitable for your analysis; one 
or more methods; and a sample information file.

To select these items for automated analyses

1. In the File menu, click on Open  Workspace... and select the workspace 
desired.

The group of windows (a workspace) that appears enables you to carry out 
your analysis. The Automated Analysis Control window must appear in this 
workspace. For example, you can set up a workspace using the following 
windows; Spectra Display, Results Display, Calibration Display, and Plasma 
Control or any other windows of your choice.

If you do not select a workspace, you can select these windows individually 
from the Windows and Tools menus. The selected windows can be saved as a 
workspace by using Save As  Workspace... in the File menu.

2. Select a method on the Automated Analysis Control window Set Up page by 
double-clicking on the first empty cell in the Method column. In the Open 
Method dialog, select the method that you wish to use. For more information, 
see Opening and Saving Methods and Results in Chapter 11,  Menus and 
Toolbar.

If an appropriate method is not there, see Creating a Method earlier in this 
chapter.

3. To select more than one method, you must first select Open Methods in List 
on the Setup page. This option is located below the Methods and Sample 
Locations table. Repeat Step 2 to select additional methods. 

4. Select a sample information file if desired. By using a sample information file, 
information you supply about the samples (for example, sample weights or 
dilutions) is used in the analysis. In the Automated Analysis Control window 
Set Up page, click on Open… and select a sample information file in the Open 
Sample Information dialog.

If an appropriate file is not present, see Creating a Sample Information File in 
Chapter 4,  Sample Information Editor for details. 
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5. If you want to run samples from a sample information file, first select the check 
box for Use Sample Information. In the table, under the Sample Info File 
column, three options appear in a drop-down list. If you want to analyze all of 
the samples in the sample information file, select All Defined from the drop-
down list. If you want to select only certain autosampler locations, select 
Locations. If you want to select samples by the sample numbers listed in the 
sample information file, select Sample Nos. If you select Locations or Sample 
Nos., be sure to enter the autosampler locations or sample numbers in the 
appropriate columns. Example: 10-15,18,20,22,25-30

- or -

If you are not using a sample information file, deselect the check box for Use 
Sample Information below the name of the sample information file. Then 
enter the autosampler locations in the Locations column. 

Type individual locations or a range of locations. Use commas to separate the 
locations and ranges. It is not necessary to enter the locations of blanks, QC’s, 
check or calibration solutions. Enter locations for these if you want them to be 
treated as a sample within the analysis. Example: 10-15,18,20,22,25-30

6. The settings you have made can be saved in a workspace by using Save As  
Workspace... in the File menu.

To select these items for manual analyses

1. In the File menu, click on Open  Workspace... to select the workspace.

The group of windows (a workspace) that appears enables you to carry out 
your analysis. The Manual Analysis Control window must appear in this 
workspace. Optional windows include: Spectra Display, Results Display, 
Calibration Display, and Plasma Control.

If you do not select a workspace, you can select these windows individually 
from the Windows and Tools menus. The selected windows can be saved as a 
workspace by using Save As  Workspace... in the File menu.

2. In the File menu, click on Open  Method... to select a method,

If an appropriate method is not there, see Creating a Method earlier in this 
chapter.
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3. A sample information file is optional. You may want a sample information file 
if you want to enter all the sample information before an analysis begins. See 
Creating a Sample Information File in Chapter 4,  Sample Information Editor 
for details.

If you do not select a sample information file, the software uses the default file 
called “Untitled.” Be sure to open the Sample Information Editor and check that 
entries in the “Untitled” file are appropriate for your analysis. If some entries are 
completed, but others are not, the sample concentration may not be reported in 
sample units. See Sample Preparation Parameters in Chapter 4,  Sample 
Information Editor for details. 

4. The settings you have made can be saved in a workspace by using Save As  
Workspace... in the File menu.

Setting Options in Control Window
Before you can analyze samples, you need to set certain options in the control 
window that you are using. These options are not specified in the method and 
include: specifying the results data set where you will save data; specifying 
whether you want the results printed during the analysis; specifying special 
automatic startup and shutdown options; and specifying automatic export of data.

For all analyses, to select options for the analyses

1. In the Automated Analysis Control window Set Up page or the Manual 
Analysis Control window, click on Open... next to the Results Data Set Name 
information field. Select the name of the data set where you will save the 
results. If this data set already exists, new data will be added to it. When you 
select a results data set name, the Save Data box is selected automatically (a 
checkmark appears), confirming that data will be saved.

Note Archive result data sets periodically to avoid filling up space on the hard 
disk. For more information, please refer to the Maintaining Data section of 
the Data Manager Help. To calculate the amount of hard disk storage space 
that is required for storing result data sets, see Equation for Calculating 
Disk Storage for Results in Chapter 5,  Analysis Control Windows. 
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2. To print a log of intensity counts, analytical results, and other information 
about the analysis, select the Print Log During Analyses box.

For automated analyses only, to select other options

1. If you want certain components to be automatically switched off when the 
analysis is finished, first select the Automatic Shutdown box, then click on 
Set... to open the Automatic Shutdown/Startup dialog. Complete this dialog, 
and click on OK. 

2. If you want Automatic Startup to be enabled, use the above dialog to schedule 
an automatic startup. You can also specify whether the plasma is to be ignited 
and if the pump is to begin operating upon startup.

3. During the analyses, you can automatically export data contained in the results 
data set and write it into a file that can be read by many other programs, 
including spreadsheet and database management programs.To do this, select 
Auto Export, then click on Set... and select the Export Designs.You must first 
create the Export Design(s) in the WinLab32 Data Manager. An export design 
defines a subset of data items that you want to export from a data set. For more 
information, refer to WinLab32 Data Manager Help.

4. On simultaneous ICP instruments only, you can select automatic wavelength 
realignment to occur at regular intervals. Select the Auto Wavelength Realign 
box on the Automated Analysis Control window Set Up page and, then click 
on Set... to set a time interval.

5. The settings you have made can be saved in a workspace by using Save As  
Workspace... in the File menu.

For more information on analyses using an autosampler, see the Arranging 
Samples section below. For more information on manual analyses, see Analyzing 
Samples later in this chapter.

Arranging Samples
Before arranging samples in the autosampler using the autosampler loading list, 
you must have entered all information for your samples and solutions in your 
method or methods and in the sample information file if you have one.
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For details on where to enter this information, see: Manual Analysis Control 
window, Method Editor, and Sample Information Editor.

To get samples and solutions ready for analyses

Prepare the required samples and solutions according to your standard 
laboratory procedures.

To load samples and solutions in the autosampler using the Automated 
Analysis Control window

1. In the Automated Analysis Control window, click on the Analyze tab.

2. In the System menu, click on Autosampler Loading List to see a list of the 
locations of your samples and solutions.

3. Load samples and solutions in an empty tray.

4. Click on Load Tray.

5. Place the loaded tray in the autosampler.

6. In the Analysis menu, click on Autosampler  Go to Wash.

To load samples and solutions in the autosampler when the Manual Analysis 
window is open

1. In the System menu, click on Autosampler Loading List to see a list of the 
locations of your samples and solutions.

2. Load samples and solutions in an empty tray.

3. In the Analysis menu, click on Autosampler  Load Autosampler Tray or 
press Shift-F11.

4. Place the loaded tray in the autosampler.

5. Click on Go to Wash Loc. in the Manual Analysis Control window.
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Analyzing Samples
Before analyzing samples, be sure you have performed all preliminary steps as 
summarized in Performing Analyses: Overview earlier in this chapter.

Three types of analyses

Select how you will analyze samples from the options below.

Automated Analyses, using an autosampler to analyze all 
samples and solutions

Manual Analyses, manually presenting samples and 
solutions to the instrument

Manual Analyses Using the Autosampler, requiring both 
manual operations and an autosampler to analyze 
samples and solutions. In this case, often used for method 
development, you want direct control of the autosampler, 
so the autosampler is just holding samples for you.
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Automated Analyses

Automated analyses are performed using the Automated Analysis Control window. 
Other windows such as the Results window are optional.

To perform automated analyses

Step What it does

Examining the Run List Before analyzing samples, you should check 
the run list. If any changes are required, you 
must change either the method or the sample 
information file, then rebuild the run list.

Calibrating and 
Analyzing Samples

Solutions and samples are analyzed. A 
calibration is performed according to your 
specifications, and you can recalibrate if 
desired.

Stopping and Restarting During the analysis, you may need to stop 
operations and restart the analysis, according 
to these procedures.

Analyzing Additional 
Samples 

While an automated analysis is in progress,  
you can add samples to the sample sequence, 
enter information on a new sample, or analyze 
additional samples at the end of an analysis.

Note During an analysis, the shutter automatically opens and closes for each 
sample. If you have an extensive number of samples to analyze, however, 
you may wish to set the shutter to the open position manually to increase 
analytical throughput. You do this in the Spectrometer Control Window. 
Be sure to close the shutter when the analysis is complete.
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Examining the Run List

To examine the run list before analyzing samples

1. Examine the list of solutions in the run list on the Analyze page of the 
Automated Analysis Control window. If you have changed the method or 
sample information file, click on Rebuild List to view an updated run list. 
Verify that your run list is correct. If it is correct, skip steps 2 and 3 below.

A sample run list is shown below.

2. To make changes to the run list for unknown samples, go to the Sample 
Information Editor and make the changes in the Sample Information file. To 
make changes to QC samples, go to the Method Editor and make changes in 

Leaving the shutter in the open position with the plasma on could lead to 
deterioration of the optics and eventual degradation of UV performance. 
It is recommended that the shutter be closed when analyses are not being 
performed.

!
Warning
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the QC section of the method. If you have matrix check samples and need to 
make changes, these samples are defined in the method and scheduled in the 
sample information file.

3. To make changes to the run list for calibration solutions, go to the Method 
Editor Calibration: Define Standards Page and make the changes.

4. To analyze a selected group of samples that are a subset of samples in the 
sample information file, type the locations or sample numbers on the 
Automated Analysis Control window Set Up page. Example: 10-
15,18,20,22,25-30

Calibrating and Analyzing Samples

According to your calibration choices, select the appropriate steps below. All 
controls (Analyze All, Calibrate, and Analyze Samples) are located on the 
Automated Analysis Control Analyze page. You select the calibration parameters 
in the Method Editor Calibration pages and view the calibration curves in the 
Calibration Display window. You can also view a summary of the calibration data 
in the Results Display Window.

Select a calibration option and analyze mode

Note Directly before analyzing aqueous solutions, we recommend that you 
aspirate a solution of deionized water with an acid concentration that 
matches the calibration blank and standards for at least 10 minutes. This 
procedure stabilizes the sample introduction system.

To do this Use this

To generate a new calibration 
and continue with samples 
(overrides Initial Calibration 
page of the Method Editor)

Click on Analyze All.

To generate a new calibration, 
examine it, and continue with 
samples

Click on Calibrate. Examine the calibration 
and recalibrate if desired. When ready, click on 
Analyze Samples.
Continued on the next page.
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Stopping and Restarting

Select stop and restart options from the following

To recalibrate Click on Calibrate.

To analyze samples when a 
calibration is automatically 
recalled with the method (as 
directed on the Initial 
Calibration page of the 
Method Editor)

Click on Analyze Samples to analyze samples 
using this calibration.

To manually recall a 
calibration and then analyze 
samples

In the Analysis menu, click on Recall     
Calibration... Select the results data set that 
contains the desired calibration. Then, click on 
Analyze Samples. 

Note When you stop an analysis, the autosampler probe automatically goes back 
to the wash.

To do this Follow these steps

To stop an analysis • In the Automated Analysis Control window 
Analyze page, click on the button that you used 
to start the analysis, press F8 (Cancel), or select 
Cancel Analysis... from the Analysis menu.

• In the Stopping an Analytical Sequence dialog 
select the option that indicates how you want to 
stop.

Continued on the next page.
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To change Set Up 
options after an 
analysis has begun. 

• Click on the tab for the Set Up page. 

• Change any available set up option. For 
example, you can select whether or not to save 
data, change the sample information file or 
program an automatic shutdown. On 
simultaneous ICP instruments, you can select an 
auto wavelength realign. 

• Some options are locked. To change any locked 
option, you must first click on the tab for the 
Analysis page and then click on Reset Sequence. 
For example, you cannot change a data set until 
you click on Reset Sequence. 

To restart an analysis 
from a selected solution

• In the Automated Analysis Control window 
Analyze page, click on the button that you 
originally used to start the analysis. The other 
buttons will be disabled. 

• In the Continuing an Analytical Sequence 
dialog, select where you want the analysis to 
continue.

Tip: The Run List on the Analyze page of the 
Automated Analysis Control window shows the 
sample, highlighted in yellow, that was being run 
when the analysis stopped.

To restart an analysis 
from the beginning

In the Automated Analysis Control window Analyze 
page, click on Reset Sequence and then on a button 
(Analyze All, Calibrate, or Analyze Samples) that 
starts an analysis. 
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Analyzing Additional Samples

Several options are available when you need to analyze additional samples while 
an analysis is in progress: 

To add samples to the sample sequence while an automated analysis is in 
progress, click on Priority... on the Analyze page of the Automated Analysis 
Control window. The Add Sample Dialog appears.

To enter information on a new sample that you want to insert in the analytical 
sequence, in the Analysis menu, click on Automated Analysis  Append 
Samples to Analysis List while an automated analysis is in progress. The 
Append to Analysis List Dialog appears.

To analyze additional samples at the end of an analysis, in the Analysis menu, 
click on the Automated Analysis  Append Samples to Analysis List 
command to append samples from your sample information file to the end of 
the run list while an automated analysis is in progress. In the Append to 
Analysis List Dialog that appears, enter the sample numbers from the sample 
information file (do not enter autosampler locations).

After an automated analysis is completed, if you need to analyze additional 
samples, use the following procedure.

1. Check that the calibration curve still appears in the Calibration Display 
window. If not, select Recall Calibration... from the Analysis menu, then 
select the results data set that contains the calibration.

2. If you are using a Sample Information file, list the additional samples and 
autosampler locations.

3. In the Automated Analysis Control Set Up page, select the autosampler 
locations for the additional samples. 

4. Click on the Analyze tab in the Automated Analysis Control window. 

5. Click on Analyze Samples. 
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Manual Analyses

Manual analyses are performed using the Manual Analysis Control window. Other 
windows such as the Results window are optional.

To perform manual analyses

Calibrating

You select calibration information in the Method Editor Calibration page, analyze 
each calibration standard, and view the resulting calibration curves in the 
Calibration Display window. You can also view a summary of the calibration data 
in the Results Display window by clicking on the Calibration Summary command 
in the Analysis menu.

Step What it does

Calibrating A calibration is performed according to your 
specifications, and you can recalibrate if desired.

Analyzing Samples Solutions and samples are analyzed. 

Stopping and Restarting During the analysis, you may need to stop 
operations and restart the analysis, according to 
these procedures.

Note Directly before analyzing aqueous solutions, we recommend that you 
aspirate a solution of deionized water with an acid concentration that 
matches the calibration blank and standards for at least 10 minutes. This 
procedure stabilizes the sample introduction system.
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To generate a new calibration

1. To analyze each calibration blank: 

Select the calibration blank name from the list next to Analyze Blank in 
the Manual Analysis Control window.

Click on Analyze Blank.

2. To analyze each calibration standard, select the calibration standard name from 
the list next to Analyze Standard.

If you want to view the concentration for a given calibration standard, click 
on Conc...

To change these concentrations, go to the Method Editor Calibration: 
Calib Units and Concentrations page.

3. When you are ready to analyze each calibration standard, click on Analyze 
Standard. After you have analyzed a blank and a calibration standard, you can 
view a summary of the calibration data in the Results Display Window by 
clicking on Calibration Summary in the Analysis menu.

4. To analyze each reagent blank, select the reagent blank name from the list next 
to Analyze Blank. Click on Analyze Blank.

5. Use the Calibration Display window to examine the calibration curve and 
recalibrate if desired.

To recall a calibration

1. Open a method that has the same analytes as the calibration curves you are 
interested in viewing.

2. In the Analysis menu, click on Recall Calibration...

3. Select the results data set that contains the desired calibration.
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To recalibrate

Repeat the steps above for generating a new calibration.

Analyzing Samples

Manual analyses can be performed with or without a sample information file.

To analyze samples with a sample information file

The name of the sample information file you have selected is displayed in the 
Manual Analysis Control window next to Info. File.

1. In the Manual Analysis Control window, select the number (No.) of the sample 
you want to analyze.

2. Click on Analyze Sample.

To analyze samples without a sample information file

1. If desired, type a sample ID (ID) in the Manual Analysis Control window.

2. If desired, enter other information (such as sample weight and dilution values) 
about the sample. To do this, click on Details... 

3. Click on Analyze Sample.

Stopping and Restarting

To stop an analysis

In the Manual Analysis Control window, click on the button that you used to 
start the analysis, press F8 (Cancel), or select Cancel Analysis... from the 
Analysis menu.

Note If you want different categories of information to appear in the Sample 
Details dialog, you may open a sample information file that contains these 
categories.
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To restart an analysis

Click on a button that starts an analysis (Analyze Blank, Analyze Sample, 
Analyze Standard).

Manual Analyses Using an Autosampler

Manual analyses using an autosampler are performed using the Manual Analysis 
Control window. Other windows such as the Results window are optional.

To perform manual analyses using an autosampler

Calibrating

Step What it does

Calibrating A calibration is performed according to your 
specifications, and you can recalibrate if desired.

Analyzing Samples Solutions and samples are analyzed. 

Stopping and Restarting During the analysis, you may need to stop 
operations and restart the analysis, according to 
these procedures.

Analyzing Additional 
Samples

If you have completed a manual analysis using an 
autosampler and need to analyze additional 
samples, refer to this procedure.

Note Directly before analyzing aqueous solutions, we recommend that you 
aspirate a solution of deionized water with an acid concentration that 
matches the calibration blank and standards for at least 10 minutes. This 
procedure stabilizes the sample introduction system.
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To generate a new calibration

1. To analyze each calibration blank: 

Select the autosampler location from the values next to Go to A/S Loc.>> 
in the Manual Analysis Control window.

Click on Go to A/S Loc.>>.

Select the calibration blank name from the list next to Analyze Blank. 

Click on Analyze Blank.

2. To analyze each calibration standard, select the calibration standard name from 
the list next to Analyze Standard.

Select the autosampler location from the values next to Go to A/S Loc.>>.

Click on Go to A/S Loc.>>.

If you want to view the concentration for a given calibration standard, click 
on Conc... 

To change these concentrations, go to the Method Editor Calibration: 
Calib Units and Concentrations page. 

3. When you are ready to analyze each calibration standard, click on Analyze 
Standard.

4. To analyze each reagent blank: 

Select the autosampler location from the values next to Go to A/S Loc.>>.

Click on Go to A/S Loc.>>.

Tip Use Go to Wash Loc. between the calibration standards and the reagent 
blank to avoid carryover.
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Select the reagent blank name from the list next to Analyze Blank.

Click on Analyze Blank.

5. Use the Calibration Display window to examine the calibration curve and 
recalibrate if desired.

To recall a calibration

1. In the Analysis menu, click on Recall Calibration...

2. Select the results data set that contains the desired calibration.

To recalibrate

Repeat the steps above for generating a new calibration.

Analyzing Samples 

To analyze samples with a sample information file

The name of the sample information file you have selected is displayed in the 
Manual Analysis Control window next to Info. File.

1. In the Manual Analysis Control window, select the autosampler location from 
the values next to Go to A/S Loc.>>.
Note: In a manual analysis, the autosampler location in a sample information 
file is not used by the software; therefore, you must use Go to A/S Loc.>> to 
select the location each time you analyze a sample.

2. Click on Go to A/S Loc.>>.

3. Select the number (No.) of the sample you want to analyze.

4. Click on Analyze Sample.

Tip Use Go to Wash Loc. before analyzing samples to avoid carryover from 
your calibration standards.
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To analyze samples without a sample information file

1. In the Manual Analysis Control window, select the autosampler location from 
the values next to Go to A/S Loc.>>.

2. Click on Go to A/S Loc.>>.

3. If desired, type a sample ID (ID).

4. If desired, enter other information (such as sample weight and dilution values) 
about the sample. To do this, click on Details... 

5. Click on Analyze Sample.

Stopping and Restarting

To stop an analysis

In the Manual Analysis Control window, click on the button that you used to 
start the analysis, press F8 (Cancel), or select Cancel Analysis... from the 
Analysis menu.

To restart an analysis

Click on a button that starts an analysis (Analyze Blank, Analyze Sample, 
Analyze Standard).

Note If you want different categories of information to appear in the Sample 
Details dialog, you need to add the categories to the sample information 
file. For more information, see Customizing the Sample Information Editor 
in Chapter 4,  Sample Information Editor. 

Note When you stop an analysis, be sure to click on Go to Wash Loc. The 
autosampler probe returns to the wash location. 
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Analyzing Additional Samples 

If you have completed a manual analysis and need to analyze additional samples, 
use the following procedure.

1. Check that the calibration curve still appears in the Calibration Display 
window. If not, select Recall Calibration… from the Analysis menu, then 
select the results data set that contains the calibration.

2. If you are using a Sample Information file, list the additional samples and 
autosampler locations.

3. In the Manual Analysis Control window, select the autosampler location, 
Sample Number (No.) and ID for the additional sample that you want to 
analyze. 

4. Click on Analyze Sample.

Generating Reports
If you saved data in a results data set (as requested in an analysis control window), 
you can use the WinLab32 Data Manager to generate reports in a wide variety of 
formats. 

To start the WinLab32 Data Manager

In the File menu, click on Utilities  Data Manager.

or

Click on the Start button in Windows. Select Programs  PerkinElmer 
WinLab32  Data Manager.
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Shutting Down the Instrument
There are two ways to extinguish the plasma. You can extinguish the plasma 
manually or you can extinguish it automatically using Automatic Shutdown. 
Automatic Shutdown can be selected in the Automatic Shutdown/Startup dialog, 
which is accessed from the Automated Analysis Control Set Up page or using the 
Auto Shutdown/Startup command in the System menu.

Another mode is Automatic Startup, which can also be selected in the Automatic 
Shutdown/Startup dialog, as described above. If you selected Automatic Startup to 
restart your system, this affects the procedures that you follow when you shut 
down.

To automatically extinguish the plasma and put the spectrometer on standby

If you have selected Automatic Shutdown and indicated how you want the system 
to shut down, the system will automatically shut down and flush the sample 
introduction system according to your choices. The system next extinguishes the 
plasma and puts the spectrometer into standby if that option was selected. The 
software remains on.

To manually extinguish the plasma

1. Flush the sample introduction system for five minutes with the plasma on. 
During this five minutes, if you analyzed aqueous solutions, either flush with 
deionized water only or flush with a dilute acid solution, followed by deionized 
water. After analyzing organic solutions, flush the system with an appropriate 
clean solvent.

2. Extinguish the plasma by clicking on the Plasma Off switch in the Plasma 
Control window.

Note  If you have scheduled an Automatic Shutdown or Startup, you must leave 
the WinLab32 software on. Do not exit the software.
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When the plasma is extinguished, the plasma off/on switch in the Plasma Control 
window changes from blue to white and the peristaltic pump stops pumping 
solution to the plasma.

3. Proceed with this step depending upon the conditions of Automatic Startup.

If Automatic Startup is not being used

-or-

If Automatic Startup has been selected and does not include turning on the 
plasma and the pump

Take the sample capillary out of the flush solution, and then run the pump 
for a few minutes to clear solvent from the sample capillary and pump the 
spray chamber.

Release the clamp lever and remove the tubing. (This will increase the 
lifetime of the pump tubing.)

Note Pressing the red Emergency Plasma Off button on the instrument allows 
you to shut off the plasma directly and bypasses the software. This button 
can be used if the software hangs up or if communication between the 
instrument and the computer is interrupted. Using this button does not 
harm the instrument. If you use this button, you must reset the system 
before you can reignite the plasma. To reset the system, be sure that the red 
button is in the out position, and select the Reset Emergency Off 
command in the System menu.

Always remove the sample capillary or the autosampler probe from 
the solution when you are finished using the pump. Otherwise, the 
solution can siphon into the spray chamber and flood it.
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If Automatic Startup has been selected and includes turning on the plasma and 
the pump

Leave the sample capillary in the wash solution.

If the level of the wash solution reservoir in the autosampler is above the 
spray chamber, leave the peristaltic pump tubing clamped. This prevents 
the wash solution from being siphoned into the spray chamber.

-or-

If the level of the wash solution reservoir in the autosampler is below the 
spray chamber, release the clamp lever on the pump tubing. This prevents 
the solution from being pumped when the system automatically starts up.

4. If desired, you can manually put the spectrometer on standby as described 
below.

To manually put the spectrometer on standby

1. In the System menu, click on Auto Shutdown/Startup.

2. In the dialog, select Enable shutdown... and Immediately on OK. Be sure 
Put Spectrometer into Standby is selected.

3. If the plasma has already been extinguished, be sure that the Wash before 
shutdown option is not selected and that Turn off Plasma and Pump is not 
selected.

4. Be sure that you have enabled Automatic Startup and set the date and time.
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Method Editor Overview
You use the Method Editor to create a new method or to modify the parameters in 
an existing method. You must have one or more methods to perform analyses.

What is a method?

All analytical information needed to perform an analysis and report the results of 
an analysis is contained in a method (and a sample information file, if it is used). 
You can use an existing method as it is, modify an existing method to suit the 
purposes of your application, or create a new method.

Modified or new methods must be saved in a methods library if you wish to use 
them at a later date. You can delete, copy, or rename methods using the Data 
Manager application.

Methods in the Results Library

When you perform analyses, a copy of the method can be saved automatically in a 
results library as part of the results data set (if you so designated on the Method 
Editor Options page). You might want to do this so that you can recall such 
methods from a results library if, for example, you wanted information about the 
method used for a certain sample or wanted to save a particular method in a 
methods library for later use.

The active method

The “active” method, which is displayed in the toolbar, is the method that is open. 
When you start an analysis, the active method defines the parameters of the 
analysis. 

The pages of the Method Editor

The Method Editor window contains bottom tabs, and each tab provides access to 
a set of pages. 
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The contents of the pages are described here:

Tab/Pages Contents

Spectrometer Parameters for Spectrometer settings.

Sampler Parameters for the plasma, peristaltic pump and 
autosampler wash. 

Process Directions to convert spectral data into intensity 
data, correct for interferences and assign internal 
standards.

Calibration Calibration information, autosampler locations, and 
details on how sample results will appear. 

Checks Recovery tab - Spike concentrations for matrix 
check samples.

Sample Limits tab - Specifications for performing 
sample limit checks.

QC  Locations of quality control solutions and 
instructions for scheduling and performing quality 
control procedures.

Options Remarks about the method and options for the 
results display, printed log, and results data set.
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 Using the Method Editor
To display this window

In the Tools menu, click on Method Editor, or on the Toolbar click on 
MethEd 

If you do not have an open method, in the File menu, click on Open  
Method.

- or -

In the Method /Sample Info bar, click on Method:
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Using methods

There are several ways to get methods for your analyses. You can open an existing 
method and use it as it is, modify it to suit your application, or create a new method.

Summary procedure: using methods

1. Open an existing method or create a new one.

2. If you are creating a new method or modifying an existing method, open the 
Method Editor. On the pages of the Method Editor window, modify the 
parameter settings to suit the analysis. 

3. If you want to use the method later, save the method under a suitable name. The 
method will be stored in the methods database located in your user directory.
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To delete, copy, rename methods

In the File menu, click on Utilities  Data Manager and use that application 
to perform these tasks. For additional information, please refer to the Data 
Manager Help.

Useful conventions

Within the tables located in the Method Editor, entries that are in a normal font can 
be modified in that table. Entries that are in a bold font are for view only and cannot 
be modified from within that table.

Creating a New Method

To create a new method

1. In the File menu, click on New  Method.

The Create New Method dialog appears where you select the plasma 
conditions. If you wish, you can use a copy of any existing method. 

2. Decide what elements you want in your method and what wavelengths you 
wish to use. This information will be recorded in the table in the Method Editor 
Spectrometer: Define Elements Page.

To place this information directly into the Method Editor, enter the 
elements and wavelengths desired on the Method Editor Spectrometer: 
Define Elements Page. Proceed to step 3.

-or-

Use the Periodic Table to select the elements and their associated 
wavelengths. Your entries will automatically appear in the table on the 
Method Editor Spectrometer: Define Elements Page. 

3. In the Method Editor, complete the entries on the Spectrometer pages, clicking 
on the side tabs to view each page. 

4. Display the remaining pages of the Method Editor by clicking on the tabs at the 
bottom and side of the window and by completing the entries.
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5. To save the method, use Save  Method in the File menu.

Periodic Table

You can use this table to select the elements and their associated wavelengths for 
your method. The elements and wavelengths that you select will automatically be 
entered on the Method Editor Spectrometer: Define Elements Page. You can also 
enter elements and wavelengths directly into the Method Editor.

To display this table

In the Tools menu, click on Periodic Table.

- or -

On the Method Editor Spectrometer: Define Elements Page, click on the 
Periodic Table button.

To select elements and wavelengths for your method from the periodic table

On scanning CCD ICP spectrometers, you can select any element at any 
wavelength. On simultaneous ICP spectrometers, elements and wavelengths that 
are not available on the detector are indicated by grey typeface. 

The Periodic 
Table showing 
elements 
included in an 
example 
method 
prepared for a 
soils analysis.
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1. Double-click on an element symbol. This enters the element and its default 
wavelength directly into the active row in the table on the Method Editor 
Spectrometer: Define Elements Page. The Active Row in Method Editor 
automatically increments to the next row. Continue making your selections.

- or -

Click on an element symbol using the right mouse button. From the list of 
recommended wavelengths, double-click on the desired value. (If you want to 
select several wavelengths for one element, click on the wavelengths and then 
click on Enter in Method.) This enters the element and the recommended 
wavelength directly into the method. The Active Row in Method Editor 
automatically increments to the next row. Continue making your selections.

2. When you have completed making your choices, click on the window’s close 
box.

To select elements and wavelengths for your method from the alphabetical 
element list

1. Select each element and its associated wavelength from the drop down lists. 
This enters the element and its recommended wavelength directly into the 
active row in the table on the Method Editor Spectrometer: Define Elements 
Page. The Active Row in Method Editor automatically increments to the next 
row. Continue making your selections.

2. When you have completed making your choices, click on the window’s close 
box. 

To change the values in any row

Change Active Row in Method Editor to the desired row, select the new 
element and wavelength, and click on Enter in Method.

To search for elements at a particular wavelength or to choose wavelengths 
not on the wavelengths list

Click on Wavelength Table and complete the entries as desired.
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Wavelength Table

You use this table to search for elements at a particular wavelength or to choose 
wavelengths not on the recommended wavelengths list that is found on the Method 
Periodic Table. Additional information such as intensities and BEC’s are given for 
certain elements.

The elements and wavelengths that you have selected appear on the Method Editor 
Spectrometer: Define Elements Page.

On scanning CCD ICP spectrometers, you can select any element at any 
wavelength. On simultaneous ICP spectrometers, elements and wavelengths that 
are not available on the detector are indicated by grey rows.

Tip Double-click on a column header to sort the table by that parameter. For 
example you can sort by element, state, wavelength, BEC, signal-to-noise, 
intensity, or any other parameter in the column headers. Also see the table 
of references at the end of this section. These publications were used as 
sources for the Wavelength Table. 
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To display this table

In the Tools menu, in the Method Editor, or in the Periodic Table click on 
Wavelength Table.

- or -

In the Examine Spectra/MSF window, click on  ID.

- or -

In the IEC Model Builder Calculate Factors page, click on Display 
Wavelength Table.

The Wavelength 
Table.
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References used in the W avelength Table

Param eter Reference
DL mg/L (W , P & F):
Radial Detection Lim its
(mg/L)

W inge, Peterson, and Fassel,
Applied Spectroscopy  33, p. 206,
1979

Rel Sens (B):
Relative Sensitivity

Boumans, Line Coincidence
Tables for ICP -AES , Pergamon
Press, 1980

Sig/Noise (S &T):
S ignal-to-Noise Ratio

Schierle and Thorne,
Spectrochim ica Acta  50B, pp.
27-50, 1995

Intensity (W ):
Intensity

W ohlers, ICP Information
Newsletter 10, No.8, pp. 593-
688, Jan 1985
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To view the wavelengths for one element

1. Select an element.

2. Click on All Wavelengths or Recommended Wavelengths to specify what 
values you want to see. If you have a simultaneous ICP spectrometer, you have 
an On Arrays option as well. The On Arrays option will narrow down the 
search to just those wavelengths that appear on the subarray. 

3. If the Center Wavelength entry field is not clear, double-click on this box and 
press Delete to clear it.

4. Click on Search. 

The specified wavelengths for that element appear in the table. 

To display data for all elements

1. Select All Elements in the Element to Include entry field, or click on the All 
button. (All Elements means all elements in the wavelength table.)

2. Click on All Wavelengths or Recommended Wavelengths to specify what 
values you want to see. If you have a simultaneous ICP spectrometer, you have 
an On Arrays option as well. The On Arrays option will narrow down the 
search to just those wavelengths that appear on the subarray.

3. Type a number in the Center Wavelength entry field or double-click on a 
wavelength in the table.

4. Indicate the range in the Wavelength Range entry field. The default range is 
0.5nm.

5. Click on Search.

All wavelengths that fall in the wavelength range appear in the table.
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To copy an element and a wavelength into the method 
from the Wavelength Table

If you opened the Wavelength Table from the Method Editor, you can copy entries 
directly into the method.

1. Select the element and wavelength you want to add by clicking in that row. 

Active Row in Method Editor defaults to the first blank row in the Method 
Editor Spectrometer: Define Elements page. This is where the new information 
will be added.

If you wish to overwrite an existing Method Editor row, change Active 
Row in Method Editor as desired. 

2. Click on Enter Selected Wavelength in Method. The information is added to 
the Method Editor. 

To copy several elements and wavelengths into the method from the 
Wavelength Table

If you opened the Wavelength Table from the Method Editor, you can copy entries 
directly into the method.

1. Select the elements and wavelengths:

To enter a range, click on a row and then hold down the Shift key and click 
on another row. All of the rows in between will be selected. 

To enter information from noncontiguous rows, click on a row, then hold 
down the Control key and click on additional rows to select them. 

Active Row in Method Editor defaults to the first blank row in the Method 
Editor Spectrometer: Define Elements page. This is where the new 
information will be added. 

If you wish to overwrite information in existing Method Editor rows, 
change Active Row in Method Editor as desired. The row that you select 
will be where the first element and wavelength in the group you selected 
in the Wavelength Table will appear in the Method Editor.

2. Click on Enter Selected Wavelength in Method. The information is added to 
the Method Editor.
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Opening an Existing Method

A method is required for an analysis. It is used to set up the conditions under which 
the analysis will be run. Methods that you have saved are stored in a methods 
library (a large capacity structured database) so that you can use them at a later 
date. You can also get a copy of a method used in a particular analysis; this method 
is stored in a results library as part of the results data set (if you so designated on 
the Method Editor Options page). 

To open an existing method from a methods library

1. In the File menu, click on Open  Method.... 

2. In the Open Method dialog, select the method you want, then click on OK. If 
the method you want is stored in a different methods library, click on Browse 
and select the correct library location. Return to the Open Method dialog, and 
select the desired method

If the Method Editor is open, the method name appears in the title bar. The 
method name also appears in the Toolbar of the WinLab32 main window, next 
to the Method button. This is the active method, which controls your analysis. 
(You do not need to open the Method Editor window to open an existing 
method.)

3. Use this method for your analysis with no modifications if desired. To change 
parameters in this method, see Modifying a Method later in this chapter.

To get a copy of a method associated with a stored results data set

1. In the File menu, click on Import from Results Library....

2. Select the results data set and click on OK.

3. When the Import from Results Library dialog appears, select the method you 
want to import and then, at the bottom of the dialog, select the Method check 
box and click on OK.

If the Method Editor is open, the method name appears in the title bar.  The 
method name also appears in the Toolbar of the WinLab32 main window, next 
to the Method button.  This is the active method, which controls your analysis. 
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4. Use this method for your analysis with no modifications if desired. To change 
parameters in this method, see Modifying a Method in the next section. To save 
this method to a method library, use Save or Save As... from the File menu.

Modifying a Method

You may want to make modifications to an existing method. 

To modify a method

1. Open a method.

2. In the Tools menu, click on Method Editor. Modify the entries as desired on 
the Spectrometer pages, using the side tabs to view each page. 

3. Display the remaining pages of the Method Editor by clicking on the tabs at the 
bottom of the window and modifying the entries.

4. To save the changes, click on Save  Method in the File menu to save the 
method with its current name or Save As  Method in the File menu to save 
the method with a new name. The method is saved in the Method database.
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Selecting Options and Entering Values

• Some parameters have fixed options denoted by an option button. You may 
select only one of these options for any one parameter.

• Some options are associated with a check box. You may select as many of 
these as you wish. When a check box is selected, it contains a check mark.

• Options for some parameters are contained in drop-down lists. Click on the 
arrow at the right-hand side of the drop-down list to see the choices available.
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• Spin boxes are often used for numerical parameter settings. To increase or 
decrease the value, click on the appropriate arrowhead. You can also click on 
and type an acceptable value.

• To enter information in a text box, click on the text box, then type the necessary 
value or characters.

• To open another page of the Method Editor, click on the tab containing the 
name of the page at the bottom or side of the window. 

Tabs across the bottom 
of the Method Editor 
group parameters into 
several main areas.

Side tabs further 
group parameters 
into individual pages.
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Method Editor Pop-Up Menus

The following pop-up menus contain several convenient commands that are useful 
as you work with the Method Editor.

Method Editor pop-up menu

To display this pop-up, click with the right mouse button in the gray background 
area of the Method Editor.

Command Description

New Method Lets you select the starting conditions to 
include in the new method. 

Open Method... Opens a stored method.

Save Method Saves the contents of the Method Editor 
using the same file name.

Save Method As... Saves the contents of the Method Editor 
using a new file name.

Save Method As Text... Saves the contents of the Method Editor to a 
text file or comma-delimited ASCII file.

Periodic Table Displays the Periodic Table, where you can 
select elements and wavelengths. 

Print... Prints the contents of the Method Editor.



91Using the Method Editor

Pop-up menu for Tables with Column Fill dialogs

To display this pop-up, click with the right mouse button in a spreadsheet table. 
This pop-up only appears in tables that have column fill dialogs and is most useful 
when you are working with a block of selected entries.

Print Preview... Displays the formatted Method report in a 
preview window. Use the Zoom In and 
Zoom Out buttons to enlarge or reduce the 
report. Click on Close to return to the 
Method Editor.

Command Description

Cut Removes the contents of the selected entry fields and 
places it onto the Windows clipboard.

Copy Copies the contents of the selected entry fields and 
places it onto the Windows clipboard.

Paste Inserts contents from the Windows clipboard into an 
entry field.

Column Fill... Displays the Column Fill dialog for the selected col-
umn. To use the Column fill command, select a block 
of entry fields and then right click on the table and 
select this command.

Command Description
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Pop-up menu for individual text entries

To display this pop-up, double-click in an entry field to select the contents, then 
click with the right mouse button. In some text boxes within the Method Editor, a 
right click will display this pop-up.

Command Description

Undo Reverses the last command.

Cut Removes the contents of the selected entry field and 
places it onto the Windows clipboard.

Copy Copies the contents of the selected entry field and 
places it onto the Windows clipboard.

Paste Inserts contents from the Windows clipboard into an 
entry field.

Delete Removes the contents of the selected entry field.

Select All Selects all of the text in an entry field.
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Checking a Method

Before you use a method, you can let the software review all of the entries in the 
Method Editor pages using the Check Method dialog. This dialog alerts you to any 
existing problems or inconsistencies in the method that must be corrected before 
the method can be used for an analysis. When you save a method, the method will 
be checked automatically.

To display the Check Method message dialog, on the Edit menu, click on 
Check Method. 

The Check Method dialog appears. 

To print this information, click on Print in the Check Method dialog.

Saving a Method

You must save a method if you want to use it later. When you save a method, a copy 
of the method is placed in the Methods database. If you selected the Copy of 
Method option in the Method Editor Options page, a copy of the active method that 
was used to obtain the results of your analyses is stored with the results data set.

To save a method with its current name

In the File menu, click on Save  Method.

To save a method with a new name

1. In the File menu, click on Save As  Method.

2. Type a file name up to 25 characters in length, and click on OK.

Note When you save a method, the software reviews all of the entries 
automatically. If it finds any problems or inconsistencies, the Check 
Method message dialog is displayed to inform you of the error. 
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Printing a Method

You can print a method summary, which contains all of the parameters in the 
method. You can also save a method summary in a text file, then open it in a text 
editor such as Notepad and make notations or print selected sections.

To print a method summary

1. Click on the Method Editor window to make it active. Note that the title bar of 
an active window is a different color from other windows.

2. In the File menu, click on Print  Active Window.

3. In the Print dialog that appears, check that the correct printer is shown. If you 
need to select another printer or change other setup options such as the paper 
size, click on Setup.

4. Click on OK to start printing.

To save a method summary in a text file

1. Click on the Method Editor window to make it active.

2. In the File menu, click on Save As Text  Method.

3. Type a name for the file, and click on OK.

You can now open the file in a text editor such as Notepad and make notations 
or print selected sections.

Note To save a method as a text file for making notations or printing, see 
Printing a Method.
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Method Editor: Spectrometer Pages Overview 

You use these pages to define the parameters that control how the hardware is set 
up and how the system collects data.

To display the Spectrometer pages

Click on the Spectrometer tab at the bottom of the Method Editor window. 

Spectrometer Pages

To set the following parameters, click on the appropriate tab on the right-hand 
side of the window. 

Define Elements Page

Settings Page

Spectral Windows Page

Method Editor Spectrometer Pages: Define Elements Page

You use this page to define the symbol, wavelength, name, and function of an 
element. In the Method Editor, an “element” represents a combination of 
parameters associated with a measurement at a particular wavelength. If you are 
measuring an element at more than one wavelength, you must repeat the element 
on this page for each separate wavelength.
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Method Description

This short description of your method will appear next to your method name in the 
Open Method dialog. It will also appear in the Method Description field of the 
Analysis Header displayed in the Results Display and Printed Log.

Type up to 80 characters. 

Symbol

This is the symbol of the element to be measured.

To change or add an element, type the letters for the symbol in the entry field, 
or click on Periodic Table. When the Periodic Table appears, select the desired 
elements.

Wavelength

This is the wavelength in nm that the Spectrometer will use to measure the 
associated element.

Detail of the 
Define Elements 
page showing 
entries included 
in an example 
method prepared 
for a soils 
analysis.
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To add or change a wavelength:

Type an element symbol in the Symbol field to get the default wavelength for 
an element.

- or -

Type the value for the wavelength in the entry field.

- or -

Click on Periodic Table. When the Periodic Table appears, select the desired 
wavelength.

Name

This is the name that describes the element. The default entry is the element symbol 
followed by the wavelength. No two elements in a method can have the same name.

If you want to change the default name, type up to 20 characters, including 
spaces and punctuation. For example, if you are determining analytes using 
different plasma viewing modes or different plasma conditions, you may want 
to add information to the default name such as “Al 396.152–Axial” or “Ca 
317.933—0.8 neb”).

Function

This is the role of the element in the analysis.

Analyte
The element’s concentration will be determined based on a valid calibration.

Internal standard (Int. Std.)
The element will act as an internal standard. 

Click on the text and select Analyte or Int. Std. from the drop-down list. 

Periodic Table

Click on this button to display the Periodic Table, from which you can select 
elements and their associated wavelengths for your method.
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Wavelength Table

Click on this button to display the Wavelength Table, where you can search for 
elements at a particular wavelength or choose wavelengths not in the 
recommended wavelength list. 

Method Editor Spectrometer Pages: Settings Page

You use this page to set spectrometer parameters that control how the elements will 
be measured.

Spectral

Purge Gas Flow
This is the spectrometer purge gas flow rate. The time taken to purge air from 
the spectrometer depends on various factors, including how long the 
instrument has been in a low purge state.

Normal
A normal purge is used during routine operation. 

High
The high purge is normally used during the analysis for wavelengths below 
190 nm. A high purge performed before an analysis clears the system of air, 

Detail of the 
Settings page.
This shows entries 
included in an 
example method 
prepared for a 
soils analysis.
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which contains moisture and oxygen, before analyzing elements below 190 
nm. See the Spectrometer Control Window in Chapter 6,  Hardware Control 
Windows.

Spectral Profiling

This option is only available on simultaneous ICP spectrometers. If Spectral 
Profiling is selected, the slit image is scanned, which yields greater data density and 
shows smoother peak profiles. Using spectral profiling takes four times as long per 
measurement as when profiling is not being used. Spectral profiling is most useful 
for identifying spectral interferences and collecting data when the wavelength 
requires adjustment. In some circumstances, it is useful for analyses using 
Multicomponent Spectral Fitting.

Resolution

This option is only available on simultaneous ICP spectrometers. 

Fixed
The same resolution is used for all elements. There are three settings: High, 
Normal, and Low. The selection you make sets the slit width and determines 
how the detector will be read. 

Select Low for slightly better detection limits and analyte precision. This 
setting gives the poorest resolution. The slit width is at its widest and each 
pixel in the detector subarray is read as a whole. This gives the highest 
sensitivity per element, but poor freedom from spectral interferences.

Select Normal to provide performance that has the optimal combination of 
sensitivity and freedom from spectral interferences for most applications. 
The slit width provides the spectral bandpass equal to one pixel width and 
each pixel in the detector subarray is read as a whole. 

Select High to provide the greatest freedom from spectral interferences, but 
lower sensitivity than Normal or Low. This setting gives the greatest 
resolution, but the lowest intensities. The slit width is at its narrowest and 
each pixel in the detector subarray is read as two separate half-pixels.

Variable
Different resolutions are used for each analyte.
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Click on Set... and in the Set Element Resolution dialog that appears, select 
the resolution for each element. 

Time

This is the time in seconds that the signal is measured.

For automatic integration, click on Auto. The software automatically sets the 
integration time individually for each analyte based on intensity. Select the 
minimum and maximum times that you want to use for all analytes.

For manual control, click on Set... next to Manual. In the Set Manual 
Integration dialog that appears, select the integration and read times for each 
analyte. (Integration time is the time period in seconds in which the detector 
collects photons before transferring the charge and reading out the signal. The 
read time is the total measurement time in seconds per replicate.)

Delay Time 

This is the number of seconds that elapse before the instrument begins to measure 
the signal. 

Valid entry range: 0 - 999.

Replicates

This is the number of read cycles to be performed on each sample and calibration 
solution. 

Valid entry range: 1 - 999. 

If you are using the Optima 2000/2100, you can Measure by:  Element or Replicate.

• Element – Selecting Measure by Element tells the spectrometer to stay at 
the wavelength of the element for the number of Replicates selected. For 
example, if you selected six (6) replicates for Cu and Pb it will measure Cu 
six times before it changes wavelength to measure Pb six times.

• Replicate – Selecting Measure by Replicate tells the spectrometer to 
measure each element once then repeat for the number of replicates. For 
example, if you selected six (6) replicates for Cu and Pb, it will measure 
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Cu once then change the wavelength and measure Pb once for replicate 
one, then change the wavelength and measure Cu once then change the 
wavelength to measure Pb once for replicate two until it completes the 
cycle six times.

Method Editor Spectrometer Pages: Settings Page - FIAS Technique

You use this page to set spectrometer parameters that control how the elements will 
be measured. 

Spectral Settings

Purge Gas Flow: This is the spectrometer purge gas flow rate. The time taken to 
purge air from the spectrometer depends on various factors, including how long the 
instrument has been in a low purge state.

Normal: A normal purge is used during routine operation when all 
wavelengths are greater than 190 nm. 

High: The high purge is normally used during the analysis for wavelengths 
below 190 nm. A high purge performed before an analysis clears the system of 
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air, which contains moisture and oxygen, before analyzing elements below 190 
nm. See the Spectrometer Control window.

Read Parameters

Integration Time: This is the integration time used by the spectrometer to collect 
each spectrum of data.  Enter an integration time between 0.001 and 50 seconds.

BOC Time: The amount of time to measure the baseline just before the beginning 
of the read step. Enter a time between 0 and 5 seocnds

Element: The name of the analyte entered on the Spectrometer page.

Transient Read Delay: For each analyte this is the amount of time to wait after 
the read step begins before processing the signal. Double clicking this column 
heading displays a column fill dialog.

Transient Read Time: For each analyte this is the amount of time to be spent 
processing the signal.

Replicates: The number of measurements that should be made of each analytical 
line.

Transient Read Delay Column Fill

Enter the periodof time that exists between the start of time-based data and the 
point where peak height/area processing begins. (Enter a value between 0 and 120 
seconds to wait after the read step begins before processing the signal.)
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Transient Read Time Column Fill

Enter a period of time-based data on which peak height/area processing is done. 
(Enter a value between 0.1 and 120 seconds to be spent processing the signal.)

Method Editor Spectrometer Pages: Set Element Resolution Dialog

Use this dialog to select different resolutions for each element. Different resolution 
settings are only available on simultaneous ICP spectrometers. 

To display this dialog

Click on Set... next to Resolution on the Settings page.

Using this dialog

Select the resolution you want for each analyte from the drop-down list.

F'n (Function)

This view-only column shows parameters that describe the kind of action the 
instrument will take for this element. 

• A = Analyte

• IS = Internal Standard
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To change the parameter, use the Function entry field on the Spectrometer: Define 
Elements page. 

Element

This view-only column shows all names of the elements selected for the current 
analysis. To change the element, click on the Periodic Table button on the 
Spectrometer: Define Elements page. In the Periodic Table that appears, select the 
elements and wavelengths that are to be added.

Resolution

This is the resolution for the element.

There are three settings: High, Normal, and Low. The selection you make sets the 
slit width, which affects how the detector will be read. 

Select Low to provide the lowest resolution. The slit width is at its widest 
and each pixel in the detector subarray is read as a whole. This gives the 
highest sensitivity per element, but poor freedom from spectral 
interferences.

Select Normal to provide resolution that has the optimal combination of 
sensitivity and freedom from spectral interferences for most applications. 
The slit width provides the spectral bandpass equal to one pixel width and 
each pixel in the detector subarray is read as a whole. 

Select High to provide the greatest freedom from spectral interferences, but 
lower sensitivity than Normal or Low. The slit width is at its narrowest and 
each pixel in the detector subarray is read as two separate half-pixels.

Method Editor Spectrometer Pages: Set Manual Integration Dialog

Use this dialog to select different integration and read times for each element.

Note Using multiple resolution settings in your method will cause 
measurements to be made sequentially in groups as defined by resolution 
type during the analysis.
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To display this dialog

Click on Set... next to Manual on the Settings page, Read Time parameter.

Using this dialog

Type the integration times and read times that you want to specify.

F'n (Function)

This view-only column shows the kind of action the instrument will take for this 
element. 

• A = Analyte
• IS = Internal Standard

To change the parameter, use the Function entry field on the Spectrometer: Define 
Elements page. 

Element

This view-only column shows all the elements selected for the current analysis. To 
change the element, click on the Periodic Table button on the Spectrometer: 
Define Elements page. In the Periodic Table that appears, select the elements and 
wavelengths desired. 

Integration Time

This is the time period in seconds in which the detector collects photons before 
transferring the charge and reading out the signal. The maximum integration time 
is 8 seconds for a scanning CCD spectrometer and 50 seconds for a simultaneous 
spectrometer.

Notes #1: The read time divided by the integration time must be a whole number.

#2: On simultaneous ICP spectrometers, using multiple integration and 
read times in your method will cause measurements to be made 
sequentially in groups as defined by integration and read time during the 
analysis.
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Read Time 

This is the total measurement time in seconds per replicate. Read time divided by 
integration time gives you the number of integrations performed per replicate.

Method Editor Spectrometer Pages: Spectral Windows Page

You can use this page to set the survey window and auto integration window. The 
survey window is the wavelength range in which the plasma emission data is 
collected. The auto integration window is the wavelength range in which the 
integration time is calculated, based on the signal of highest intensity.

By default, the survey window and auto integration window are set to the same 
wavelength range. On simultaneous ICP spectrometers, this range is determined by 
the wavelength range of the subarray on which the wavelength of interest falls. On 
scanning CCD ICP spectrometers, the wavelengths are all directed to a single 
detector array, and the software sets the wavelength range to default values.

On either type of spectrometer, you can adjust the wavelength range for the survey 
window or the auto integration window. In some cases, it may be advantageous to 
set the auto integration window to be smaller than the survey window. For 
example, if your interferent signal is higher than the analyte signal, the auto 
integration time may be shorter than appropriate for your analysis. This is because 
the software calculates the auto integration based on the highest signal, which, in 
this example, would be the interferent. Therefore, you may want to limit the auto 
integration window to exclude the interferent, so the software will calculate a 
longer integration time.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.
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Element and Wavelength 

These view-only columns show the elements and wavelengths selected for the 
current analysis. To change the element, click on the Periodic Table button on the 
Spectrometer: Define Elements page. In the Periodic Table that appears, select the 
elements and wavelengths desired.

Survey Lower and Survey Upper

This sets the wavelength range in which plasma emission data is collected from the 
lowest to highest wavelength. The survey window must be set equal to or greater 
than the auto integration window.

Auto Lower and Auto Upper

This sets the wavelength range in which the integration time for the analyte is 
calculated.

When automatic integration is used, the software automatically sets the read time 
individually for each analyte based on the signals of highest intensity. However, for 
some analyses, you may want to select a smaller measurement range to exclude a 
strong interfering peak when the integration time is being determined. This will 
give you improved signal-to-noise characteristics for the analyte of interest. 

Detail of the 
Spectral 
Windows page 
showing entries 
included in an 
example method 
prepared for a 
soils analysis.
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Method Editor: Sampler Pages Overview
You use these pages to define the parameters that control the plasma, peristaltic 
pump and autosampler wash. 

To display the Sampler pages

Click on the Sampler tab at the bottom of the Method Editor window. 

Sampler Pages

To set the following parameters, click on the appropriate tab on the right-hand 
side of the window.

• Plasma Page

• Peristaltic Pump Page

• Autosampler Wash Page
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Method Editor Sampler Pages: Plasma Page

You use this page to set the plasma gas flows, RF power, viewing distance, and 
source equilibration delay. hese can be the same for all elements or different for one 
or all elements. You can also specify criteria for monitoring the nebulizer back 
pressure.

Source Equilibration Delay

This is a delay in seconds, which can be used to allow the plasma to stabilize after 
changes have been made to the plasma (source) conditions.

Plasma Conditions

You can assign the same gas flows, RF power, and viewing distance values to all 
elements in the method or you can vary these values for each element individually. 
If you have a dual-view instrument, you can also assign plasma view (axial or 
radial) in this way.

Same for All Elements
Select this option to use the same gas flows, RF power levels, viewing 
distances and plasma view for all elements.

Vary by Element
Select this option to vary the parameters for each element. Enter the values you 
want in the table.

Monitor Nebulizer Back Pressure

Click the Set... button to display the Monitor Nebulizer Back Pressure dialog from 
where you can specify that the system trigger an alarm when the nebulizer back 
pressure is out of range.

Note:  You can set up an audible alarm for when the nebulizer back pressure is out of range from the General 
Preferences Sound dialog.

To specify criteria for monitoring the back pressure:

1. From the Monitor Nebulizer Back Pressure dialog, check Monitor Nebulizer 
Back Pressure.
Check Upper % is enabled.
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2. Enter a value between 0 and 100 in the Check Upper % box. 
When the nebulizer back pressure has increased by the percentage you 
specified an alarm can be triggered.

3. Select the action to occur when the nebulizer back pressure is out of range from 
the Action taken after nebulizer back pressure alarm is triggered: drop 
down.

You can select from the following available actions:

Stop:  The system prints a message informing you that the nebulizer back 
pressure is out of range and stops the analysis. If an automatic shutdown is 
scheduled, Stop prevents system shutdown.

Alarm and Pause:  The system prints a message informing you that the 
nebulizer back pressure is out of range.  An alarm is activated and the analysis 
pauses. At this point, you have the option to stop or continue the analysis. If an 
automatic shutdown is scheduled, Alarm and Pause prevents system shutdown.

Alarm and Continue:  The system prints a message informing you that the 
nebulizer back pressure is out of range.  An alarm is activated and the analysis 
continues.

F'n (Function)

This view-only column shows the kind of action the instrument will take for this 
element. 

• A = Analyte

• IS = Internal Standard

To change the parameter, use the Function entry field on the Spectrometer: Define 
Elements page. 

Element

This view-only column shows all the elements selected for the current analysis. To 
change the element, click on the Periodic Table button on the Spectrometer: 
Define Elements page. In the Periodic Table that appears, select the elements and 
wavelengths desired.
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Plasma

This is the argon flow rate for the ICP torch plasma gas (also known as coolant or 
outer flow). 

Valid entry range: 0 - 20 L/min. However, most torch designs will require a 
minimum flow rate of about 10 L/min to achieve a stable plasma.

Aux

This is the argon flow rate for the ICP torch auxiliary gas. 

Valid entry range: 0 - 2.0 L/min.

Neb

This is the argon flow rate for the nebulizer or sample carrier gas. 

Valid entry range: 0 - 2.0 L/min. However, many nebulizer designs will allow a 
maximum gas flow rate of less than 2.0 L/min. See the information provided with 
your nebulizer to determine its maximum gas flow rate.

Power 

This is the amount of RF power delivered to the plasma discharge. 

Valid entry range: 750 - 1500 watts.

View Dist

This is the nominal position within the plasma for the light that is measured by the 
spectrometer. For radially viewed plasma, it is the distance from the load coil. For 
axially viewed plasma, the 15-mm position represents the center of the plasma 
discharge.

Note The following parameters have Column Fill dialogs that can be accessed 
by double-clicking on the parameter's column header.



112 Chapter 3 Using the Method Editor

Plasma View 

If you have a dual-view instrument, this column is present. Plasma view refers to 
the viewing position of the plasma torch, which can be set to radial or axial 
independently for each analyte. 

Radial
Light emitted from the side of the plasma passes through the torch slit and is 
directed to the spectrometer optics. 

Axial
Light emitted along the axis of the plasma is directed to the spectrometer 
optics. The observation zone of the plasma is circular and the spectrometer 
views a column of light from the central channel of the plasma. 

Attenuated Radial or Attenuated Axial
These settings are available only for scanning CCD ICP spectrometers. Use 
these settings when lower intensities are desired, for example, for samples of 
high concentration that would normally saturate the detector and for sensitive 
wavelengths, typically in axial mode.

Method Editor Sampler Pages: Peristaltic Pump

You use this page to select the rate of sample flow. You also select whether or not 
a sample flush time should be added to the analysis delay time.

Sample Flow Rate

Select the rate in mL/min that the sample solution will be pumped into the plasma 
during an analysis. As you change this value, the pump speed that appears will be 
changed appropriately. The value range and ratio of pump rate to pump speed 
depend on both the pump tubing and the pump model selected.

Detail of the 
Peristaltic 
Pump page.
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Flush Time

This is the time (if any) between the wash time and the read delay, when the pump 
will aspirate sample solution at the Sample Flush Rate. 

Valid entry range: 0 - 999. This is normally set to equal the time it takes for the 
sample to travel from the sample vessel to the nebulizer (while usually being 
pumped at a higher rate).

Method Editor Sampler Pages: Autosampler Page

You use this page to schedule when and for how long the sample delivery tubing 
will be washed, and to set the wash pump rate. 

Note You specify the type of autosampler that you are using when you install 
the software. If needed, you can change this setting using the Reconfigure 
utility: in Windows select Start, Programs, PerkinElmer WinLab32, 
Reconfigure and use the wizard to change the autosampler. To set the tray 
type, see Autosampler Configuration dialog in Chapter 11,  Menus and 
Toolbar. If you have an Optima 3000 Family instrument, you set the pump 
type from the Options menu, Configure Pump dialog.

Detail of the 
Autosampler 
page.
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Wash

A wash step is often used during an automated analysis to clean off the autosampler 
probe and rinse out the sample delivery tubing.

Wash Frequency

Never
Select this option to be sure that no washes will be performed.

Between Samples
Select this option to perform a wash between each sample. 

Only after samples whose concentrations exceed limits
Select this option to specify a wash for any analyte when its concentration 
exceeds a specified limit. 

After every sample + extra time if sample concentrations exceed limits
Select this option to increase the length of a wash for any analyte when its 
concentration exceeds a specified limit. 

Rate 

This is the flow rate in mL/min that will be used during the Wash Time.

Normal Time

This is the time in seconds that the autosampler probe is immersed in the wash 
solution. The value range and ratio of pump rate to pump speed depend on both the 
pump tubing and the pump model selected.

Wash Location

This is the location of the wash solution in the autosampler tray, usually zero (0).

Extra Time

This is the amount of extra wash time in seconds that will be added to a wash. Enter 
the amount of wash time directly or if you wish, you can increase the wash time 
based on the concentration of a sample. 
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Method Editor Sampler Pages: Extra Wash Concentration Limits 
dialog

Use this dialog to increase the length of a wash for any analyte when its 
concentration exceeds a specified limit. In automated analyses, this is useful if you 
are concerned that a particular analyte concentration may not be rinsed fully from 
the autosampler probe unless the wash is extended. 

To display this dialog

In the Autosampler page, select one of the following options: Only after 
samples whose concentrations exceed limits or After every sample + extra 
time, and then click on the Set... button.

Using this dialog

Type the concentration limits you want for each analyte. The units shown are 
calibration units. These are selected on the Calibration Units and Standard 
Concentrations page.

The total wash time will be the Normal Time + Extra Time selected on the 
Autosampler Wash page. 

When the concentration of any analyte exceeds the entered value, the wash 
time will be increased by the amount of time you selected.

Method Editor Sampler Pages: Autosampler Page - FIAS Technique

You use this page to tell the system when to wash the autosampler sample tube and 
sample probe, and for how long. You can make the wash procedure dependent on 
the concentration of the analyte in the solution.

You also select the autosampler location of the emission setup solution when you 
are using the flame emission technique.

Note The Concentrations parameter has a column fill dialog that can be accessed 
by double-clicking on the column header.
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You select the autosampler tray in the Options menu > Autosampler.

Frequency

Never: No wash steps during the analysis. When this option is selected, the 
entry fields for the options below are inactive.

Between Samples: The system washes the sample tube and probe after every 
solution that it analyzes. Select a suitable option for Normal Cycles to tell the 
system how long to wash the sampling system.

Only after solutions exceeding limit: The system washes the sample tube and 
probe after it has analyzed a solution where the measured concentration or 
absorbance exceeds the value you select for Limit.

After all solutions + extra time if solution exceeds limit: The system washes 
the sample tube and probe, after it has analyzed each solution, for the time you 
select for Normal Time or the number of Normal Cycles. If the measured 
concentration or absorbance of a solution exceeds the value you select for 
Limit, the system will wash the sample tube and probe after analyzing this 
solution for an additional period of time that you select for Extra Time or Extra 
Cycles.

Wash Location: The sample tray location of the wash solution.

Normal Cycles: This parameter appears only with flow-injection techniques. The 
system pumps wash solution through the system using the FIAS program steps that 
you select below, for the number of times you select here.

Extra Cycles: Enter a value here if you want to set extra wash time after solutions 
where the measured concentration or absorbance exceeds the value you select for 
Limit. The system pumps wash solution through the system using the FIAS 
program steps that you select below, for the number of times you select here in 
addition to the number of times you select for Normal Cycles. Use this option 
together with the option above: After all solutions + extra time if solution exceeds 
limit.

Use FIAS steps: Select the first and last steps in the FIAS program that you want 
the system to use for the wash cycle. You can set step 0, the Prefill step, as the first 
step in the wash cycle.
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FIAS Page

Use the FIAS page to enter the event versus time program that controls the flow 
injection system.

Operation

Sample Volume: Enter the volume, in microliters, of the sample loop you intend to 
use. The settings in the Recommended Conditions window are usually based on a 
volume of 500 µL.

Flow Injection Program

Step: This column shows the steps in the FIAS program. Every program contains 
a Prefill step and between one and eight additional steps.

Use the Prefill step to ensure that the sample tube that leads to the FIAS-valve is 
filled with sample solution. This step is used only for the first replicate. The other 
program steps are performed for each replicate.

Time (sec): This is the duration of the program step in seconds.

The duration of the steps before the read step must be at least as long as the BOC 
time that you select on the Spectrometer page.

Pump 1 and Pump 2 Speed (rpm): This is the speed of the pump during the 
program step. To switch off the pump during a program step, enter 0.

Valve Fill/Inject

Fill -- The sample loop is filled with sample.

Inject -- The sample in the sample loop is injected into the carrier stream.

Remotes: Remotes 2 through 10 are relays that can be used to control accessories 
that are connected to the Instrument Interface on the rear of the instrument. Remote 
1 is reserved for triggering the signal measurement on the spectrometer. Select the 
box in the Remote column for the step in which the accessory should be triggered. 
The system activates the relay for the duration of the step.
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Default: Use this button to enter the recommended FIAS program, for the element 
that you have selected, into the Method Editor.

Read Step: Select the FIAS program step where you want to start the signal 
measurement. Usually, this will be the inject step. The signal measurement starts 
at the beginning of the step and continues for the Read Time selected on the 
Spectrometer page.

Steps to Repeat: Select a range of FIAS program steps that you want to be 
repeated, for example, with the amalgam technique to make multiple injections.

If you do not want to repeat any steps, enter 0 for Number of Repeats.

Number of Repeats: This is the number of times the system will repeat the steps 
selected for Steps to Repeat. If you do not want to repeat any steps, enter 0.
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Method Editor: Process Pages Overview
You use the entries on the Process pages to control the data processing part of the 
analysis. Data processing involves converting spectral data into intensity data for 
each element and correcting for spectral overlaps. 

To display the Process pages

Click on the Process tab on the bottom of the Method Editor window.

Process pages

Click on the appropriate tab on the right-hand side of the window to select the 
pages.

• Spectral Peak Processing Page

• Spectral Corrections Page

• Assign Internal Standards Page
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Method Editor Process: Spectral Peak Processing Page

You use this page to select how the intensity peaks for your analytes will be 
measured. If you wish, you can set a different peak algorithm for each analyte.

F'n (Function)

This view-only column shows the action that the instrument will take for this 
element. 

• A = Analyte

• IS = Internal Standard, 

To change the parameter, use the entry field on the Spectrometer: Define Elements 
page. 

Element

This view-only column shows all the elements selected for the current analysis. To 
change the parameter, use the entry field on the Spectrometer: Define Elements 
page.

Detail of the 
Spectral Peak 
Processing 
page showing 
entries included 
in an example 
method pre-
pared for a 
soils analysis.
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Peak Algorithm

Select the mathematical algorithm that will be used to process the analytical data 
on this item. 

Peak Area
The system uses the sum of the intensities recorded by the pixels on the 
detector used for the read. The number of data points used is defined by the 
Points Per Peak entries on this page. Since the total number of data points for 
each spectrum increases by a factor of four when spectral profiling is turned 
on, you have to use four times as many points/peak to measure the same area 
under the peak if spectral profiling is on than you would if spectral profiling 
were off. You also must also quadruple the amount of time allowed for this to 
occur. 

Peak Height
If you are not using spectral profiling, the number that you enter in Points Per 
Peak defines the region that the software will search in order to locate the peak 
maximum. For example, if you entered 5 in Points Per Peak, the software will 
search 5 points around the calibrated center. When the software finds the point 
that produces the highest intensity, that point will be defined as the Peak 
Height. 

If you are using spectral profiling, the peak height is determined in different 
ways depending on the number of points chosen: 
1 point: uses theoretical wavelength or wavelength calibration point
2 points: uses highest of the 2
3 or 4 points: 3 point parabolic fit
5 or more points:  5 point cubic fit

The total number of data points for each spectrum increases by a factor of four 
when you use spectral profiling. Therefore, if spectral profiling is on, you have 
to use four times as many points per peak to define the same search region if 
spectral profiling is on than you would if spectral profiling were off. You also 
must also quadruple the amount of time allowed for this to occur.



122 Chapter 3 Using the Method Editor

MSF (Multicomponent Spectral Fitting)
The system uses a multiple linear regression to fit the spectra from the analysis 
to predetermined models. If there is no MSF model stored for the element 
being read, a warning message appears during the analysis. Because Points per 
Peak is not relevant when MSF processing is used, the Points Per Peak column 
is dimmed. 

Spectral profiling is not necessary for MSF. However, there may be certain 
instances where spectral profiling may be useful as a means of improving 
results for elements that have spectral interferences. 

Comparison of 
Peak Area and 
Peak Height 
algorithms with 
profiling off.

Comparison of 
Peak Area and 
Peak Height 
algorithms with 
profiling on.
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Points Per Peak

This is the amount of data to be captured depending on the type of algorithm that 
you selected:

• If you selected Peak Area, the value in the Points Per Peak entry is the number 
of data points to be summed. On simultaneous ICP spectrometers, this equals 
the number of subarray pixels that will be summed when spectral profiling is 
off. If spectral profiling is on, you need to use about four times as many points 
to cover the same spectral area.

• If you selected Peak Height, this entry is the width of the search window used 
for the peak height determination. On simultaneous ICP spectrometers, you 
need to use about four times as many points to cover the same spectral area 
when spectral profiling is on.

• If you selected MSF, this entry is dimmed.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.
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Method Editor Process Pages: Spectral Corrections Page

You use this page to select the corrections to be made for spectral overlaps and 
shifting background emission. Two kinds of overlap correction are possible, 
Interelement Correction and Multicomponent Spectral Fitting.

F'n (Function)

This view-only column shows the action that the instrument will take for this 
element. 

• A = Analyte

• IS = Internal Standard

To change the parameter, use the entry field on the Spectrometer: Define Elements 
page. 

Element

This view-only column shows all the elements selected for the current analysis. To 
change the parameter, use the entry field on the Spectrometer: Define Elements 
page. 

Detail of the 
Spectral 
Corrections 
page showing 
entries included 
in an example 
method 
prepared for a 
soils analysis.
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Overlap Correction

Select a mathematical method that will be used to process the analytical data on this 
item for spectral overlaps. It is possible to use one, two, or all three settings in a 
method, although each individual element can only use one setting. The selections 
that appear for Overlap Correction depend upon the peak algorithm that you 
selected on the Method Editor Process: Spectral Peak Processing page, as shown 
below.

None
No overlap correction will be made for this item.

IEC (Interelement Correction)
Interelement correction is a technique of correcting for spectral interferences 
that uses mathematical correction factors to reallocate element concentrations. 
See Interelement Correction Model Builder in Chapter 8,  Interferences & 
Interelement Correction for more information. This option is only available if 
Peak Area is selected as Peak Algorithm on the Process: Peak Algorithm, 
Points/Peak page. If IEC is selected for any element, an IEC Table name must 
also be selected on this page.

MSF (Multicomponent Spectral Fitting)
A multiple linear regression is done to fit the spectra from the analysis to 
predetermined models. It can be used for spectral interference correction or for 
improving detection limits. See the Examine Spectra/MSF window in Chapter 
9,  Using the Examine/MSF Window for more information. This option is 
automatically selected if MSF was selected as Peak Algorithm on the Process: 
Peak Algorithm, Points/Peak page. If MSF is selected for any element, an MSF 
Table name must also be selected on this page.

If the Peak Algorithm is: Then, Background Correction is:

Peak area None or IEC

Peak height None

MSF MSF
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Background Correction

Select a method that will be used to correct for background changes for this 
element. 

None
No background correction will be made for this element.

1-point
One-point background correction will be made for this element (using BGC1).

2-point
Two-point background correction will be made for this element (using BGC1 
and BGC2).

MSF (Multicomponent Spectral Fitting)
A multiple linear regression is done to fit the spectra from the analysis to 
predetermined models. See Examine Spectra/MSF window in Chapter 9,  
Using the Examine/MSF Window for more information. This option is 
automatically selected if MSF was selected as Peak Algorithm on the Process: 
Peak Algorithm, Points/Peak page.

BGC1 (Background Correction Point 1)

This entry is dimmed unless 1-point or 2-point background correction is selected. 
It sets the offset from the wavelength selected on the Spectrometer: Define 
Elements page to be used for the first background point.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.
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Type a number for the offset. BGC1 can be on either the left or right side of the 
peak wavelength. If you wish to enter a negative offset to specify a point on the 
left side of the peak wavelength, type a minus sign (-) and then a number. 

- or -

You can select background points in the Examine Spectra/MSF window. For 
more information, see Using the Background Correction Point Option in 
Chapter 9,  Using the Examine/MSF Window.

BGC2 (Background Correction Point 2)

This entry is dimmed unless 2-point background correction is selected. It sets the 
offset from the wavelength selected on the Spectrometer: Define Elements page to 
be used for the second background point.

Type a number for the offset. BGC2 can be on either the left or right side of the 
peak wavelength. If you wish to enter a negative offset to specify a point on the 
left side of the peak wavelength, type a minus sign (-) and then a number.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.
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Method Editor Process Pages: Assign Internal Standards Page

This page is used to assign internal standards to the elements they will be 
correcting. To assign internal standards, you must define at least one element to be 
an Internal Standard on the first page of the Method Editor.

Assign Internal Standards

Assign an internal standard for each analyte that you want to be corrected using 
internal standardization during the analysis. If an analyte does not have an internal 
standard assigned to it, internal standardization will not be performed for that 
analyte.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.

Detail of the 
Assign Internal 
Standards page 
showing entries 
included in an 
example method 
prepared for a 
soils analysis.
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Internal Standard Options

Do Calib Blanks contain internal standards?

Set this to “yes” if the calibration blanks in the method contain internal standards, 
otherwise set this to “no.” 

If you select “yes,” then the first calibration blank analyzed will be used to initialize 
the internal standardization correction routine. If you select “no,” the software uses 
the internal standard intensity in the first calibration standard to initialize the 
internal standard routine. 

With either choice, you have the option of entering an ID and autosampler location 
for an Internal Standard blank on the Calibration: Define Standards page. Scroll 
down to the Int Std Blank entry line. The software subtracts this blank intensity 
from the internal standard intensities measured in all solutions, i.e. the calibration 
standards and samples.

Report apparent concentrations for internal standards:

No
Internal standards are reported using intensities only.

As a Percent
During an analysis, the internal standards will be reported as a percentage of 
an initial concentration of 100 and units will be “%.” This lets you compare the 
intensity of the internal standard to the initial value to see if drift has occurred.

As Concentrations
Define the initial (or actual) concentrations of the internal standards by 
clicking on Set... and entering the information in the Internal Standards 
Concentrations dialog. Then internal standard results will be reported in 
concentration during analysis. 

Using Internal Standardization

Using internal standardization

Internal standardization can be applied to an analysis to correct for physical 
interferences that affect your results.
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The two types of physical interferences that internal standardization can correct for 
are:

1. Sample viscosity variations which affect the pumping efficiency and hence the 
amount of sample delivered to the nebulizer.

2. Sample surface tension variations of the solutions being aspirated which affect 
the nebulization efficiency, and hence the amount of sample being vaporized 
into the spray chamber.

How internal standardization works

Internal standardization uses a non-analyte element as an internal standard. This 
element must be absent from your original samples, or at the same, known, 
concentration in all samples, so that the reference signal it generates can be used as 
a measure of sample being delivered to the plasma. The element selected as the 
internal standard and the elements you are determining should have similar 
excitation characteristics so that other interferences do not invalidate the 
relationship between analyte and internal standard signals. The concentration of 
internal standard added to or present in all samples, standards and blanks must be 
identical. 

The software takes the intensity observed for the internal standard elements in the 
solution and references this with the intensity recorded for either the blank or the 
first calibration standard (depending on whether the calibration blanks contain the 
internal standard as specified on the Internal Standards page of the method). It then 
divides the analyte intensities it observes by the result. For instance, if the amount 
of sample delivered to the plasma drops in half, both the internal standard and the 
analyte intensities drop in half. When the internal standard correction is applied, 
the effect of the reduced sample flow is canceled out. Hence, an accurate result can 
be obtained. For information on the equations used in Internal Standardization, see 
Internal Standardization in Chapter 12,  Calibration and Calculations.

Selecting internal standards

We recommend that you select background correction when using internal 
standardization to correct for any background contribution to the signal. The 
theoretical basis for internal standardization requires the use of the net analyte 
signal only, as opposed to the gross uncorrected analyte signal.
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Ideally, the internal standard element you select for your analysis should satisfy the 
following requirements:

• Not present in the sample, or present in all at exactly the same known 
concentration.

• Similar excitation requirements.

• Free from contaminants.

• Readily available.

• No spectral lines that would interfere with the spectral lines of the analyte. 
Iron, for example, can be a poor choice at higher concentrations due to its 
complex emission spectrum.

• Present at a concentration from 500 to 1000 times the detection limit 
concentration or from 1 to 10 mg/L.

For calibration, the software uses internal-standard-corrected emission intensities 
rather than analyte-to-internal standard ratios. This allows stored calibrations with 
or without internal standards to be used. 

Specifying internal standardization in the method

Decide on the following selections in your method when using internal standards:

1. Select the element(s) you want to use as internal standard(s) and define their 
function as “Int. Std.” on the Spectrometer: Define Elements page.

2. Select the Process tab of the method, then select the Internal Standards page. 
On this page:

• Assign the internal standard(s) to the analyte(s) in the table.

• Select whether or not the calibration blanks contain the internal standard. 
The internal standard must be in all calibration solutions and samples. You 
can choose to use a special internal standard blank. The internal standard 
blank intensity is subtracted from the internal standard intensity measured 
in all solutions. An Internal Standard blank is useful if the internal standard 
selected has a comparatively low intensity and the blank’s intensity is 
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significant relative to that of the internal standard. It may also be useful if 
there is structure in the blank such as an OH-band.

• Select if you want to report the apparent concentrations of the internal 
standard element. If so, you can report the concentrations as a percent 
(with the initial percentage assigned as 100%) or as a concentration 
referenced to a value you enter. 

Results corrected for internal standardization

Results that have been internal standard corrected are marked with a footnote 

symbol. The  symbol is placed just after the analyte name.

Method Editor Process Pages: Internal Standards Concentrations 
Dialog

Use this dialog to define the initial (or actual) concentrations of the internal 
standards.

To display this dialog

Click on Set... beneath Report apparent concentrations for the internal 
standards on the Assign Internal Standards page.

Using this dialog

Type the concentration for each internal standard and select the units from the 
drop-down list. You cannot change the Internal Standards listed here. You 
select these on the Method Editor Spectrometer: Define Elements page.

Perform Internal Standards Checks

On this page the system checks the intensity of the internal standard elements 
whenread and compares this reading with the initial reading and calculates the 
percent change in the intensity. Next, the percent drift is compared with a customer 
specified allowable drift. If the drift exceeds the customer specified limit a selected 
action will occur.
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Perform Internal Standard Checks (check box)

This check box turns the feature on or off. The default is off. When the check box 
is on, all other controls on the page are enabled, when the check box is off, all other 
controls on the page are disabled (grayed out).

Internal Standards Limits (spreadsheet)

The check boxes in the Apply Internal Standard Check column turn checking on/
off for each individual internal standard. The default for all of these is on.

The analytes listed in the Int. Std Name column are those already specified as 
internal standards on the Spectrometer > Define Elements page. All analytes 
specified as internal standards will appear in this spreadsheet, regardless of 
whether they have been assigned or not. The numbering of the entries corresponds 
to their analyte number in the method.

The analytes listed cannot be changed by the user on this page.

The edit fields for Check Lower and Check Upper define the lower and upper limits 
(as a percent) for each internal standard. These limits can be changed on an analyte 
by analyte basis; there is no column fill to change one set of values and have it 
apply to all analytes. The following properties apply to this edit field:

• Default values are 80 for Check Lower, and 120 for Check Upper.

• The values are always integers.

• For either lower or upper, the allowed range is 0 to 200; no other values 
can be typed into the entry field.

• When one of these fields loses focus, the currently entered values are 
checked that the lower limit is less than or equal to the upper limit. If it is 
not, the field that lost focus will be reset to its previous value.

Maximum Retries After Internal Standards Failure
Note:  You can select to have a sound played when an Internal Standard Check fails from the General Pref-
erences Sound dialog.
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Action taken after Internal Standard check failure:

Reanalyze

This edit field defines the number of times to reanalyze a solution after an internal 
standard check failure. It includes the usual spin buttons, and has an allowable 
range of 0 to 3. The default is 1.

Failure Actions combo box

This combo box will have the following choices:

• Continue

• Next Method

• Alarm and Pause

• Stop

The default is Continue.
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Method Editor: Calibration Pages Overview 

You use the Calibration pages to define calibration standards and concentrations 
and to select parameters such as the type of calibration equation and the 
autosampler locations for blanks and standards. You also select how blanks will be 
used, and whether or not to use a stored calibration.

To display the Calibration pages

Click on the Calibration tab on the bottom of the Method Editor window. 

Calibration pages

Click on the appropriate tab on the right-hand side of the window to select 
these pages:

• Define Standards Page

• Calibration Units and Standard Concentrations Page

• Calibration and Reagent Blank Usage Page

• Calibration Equation and Sample Units Page

• Initial Calibration Options Page

• Multiline Calibration Page
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Method Editor Calibration Pages: Define Standards Page

You use this page to select the IDs and autosampler locations that you want to use 
for the blanks, standards, and other calibration solutions.

Method of Additions

Check this option to analyze samples using method of additions.  When Method of 
Additions is checked a drop down list of method of additions equations becomes 
enabled.  From the drop down select the appropriate method of additions equation 
to use in your method.  You can select from the following equations:  Method of 
Additions, Sample Intercept, Method of Additions, Calculated Intercept, 
Method of Additions Calibrate.  Please note that the equation you select here will 
be applied to all analytes specified in your method. 

ID

This is the name that you give to each calibration solution. It will be printed on the 
log and saved in the results data set. If you do not type a name, the system uses pre-
set IDs such as Calib. Blank, Calib Std 1, etc.

Detail of the 
Define 
Standards page 
showing entries 
included in an 
example method 
prepared for a 
soils analysis.
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A/S Location

This is the autosampler location you wish to use for each calibration solution. For 
autosampler trays that have multiple size tube capacities, the larger containers 
located in positions 1 through 8 typically are used for blanks, calibration standards, 
and QC samples, if any. The next available autosampler location is automatically 
assigned by the software when a new calibration blank, calibration standard, or 
reagent blank ID is entered. The user may modify the settings.

Calibration Blank 1-5

You can use up to 5 calibration blanks. The calibration blanks are analyzed before 
the standards in an automated analysis. How the calibrations blanks are used in the 
analysis is defined on the Blank Usage page. (It is useful to have 5 calibration 
blanks available, for example, if you need to create a blank to match each matrix 
in each standard.) 

Type the ID for each calibration blank.

Internal Standard Blank

If you have entered an internal standard, this option appears on the bottom of the 
scrolling list of Calib Blanks. (You may need to scroll to reach it.) If you select an 
internal standard blank for the method, you decide which internal standards it is 
used for on the Blank Usage page.

Type the ID for the internal standard blank.

Calibration Standard 1 - 30

You can use up to 30 calibration standards. These standards will be analyzed in 
sequence (following the calibration blanks) in an automated analysis, beginning 
with Calibration Standard 1.

Type the ID for each calibration standard.

Addition 1-30

You can use up to 30 additions.

Type the ID for each addition
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Reslope Standard
Note: This option is disabled if you checked Method of Additions.

You use the reslope standard to make small corrections to the slope of the 
calibration curve using a single calibration standard following small changes in 
instrumental conditions. 

Type the ID for the reslope standard. 

Reagent Blank 1-5
Note: This option is disabled if you checked Method of Additions.

You can use a reagent blank to compensate for differences in composition between 
the reagents used to prepare the samples and those used to prepare the calibration 
standards. Reagent blanks are analyzed immediately after the calibration standards 
in an automated analysis. The reagent blank concentrations measured are 
subtracted from all subsequently analyzed samples. If multiple reagent blanks are 
analyzed, their concentrations are averaged and the average concentration is 
subtracted from each sample.

Type the ID for each reagent blank.

Note When you select Method of Additions, the software assumes that the 
aliquots of sample containing the additions (addition 1, addition 2, etc) 
immediately follow the orginal sample in the autosampler tray. If there are 
two or more samples to analyze, each sample has its own additions. The 
samples should be placed in the autosampler in the following order: blank, 
sample, A1 (sample + addition 1), A2 (sample + addition 2), etc. You run 
a blank for the first sample only. This blank will be used for all other 
samples.

Note You must also schedule when the Reslope Standard should be analyzed. 
You schedule the Reslope Standard using the Recalibrate Before 
parameter in the Sample Information Editor.
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Deleting Blanks and Standards

It is important to clear the information for blanks and standards that are not to be 
included in an automated analysis. All blanks and standards that are present in the 
method will be analyzed in an automated analysis.

To clear the information for unwanted blanks and standards, click on the left-
most column to highlight the rows for blanks and standards you want to 
remove and press the Delete key.

The rows for the blanks and standards will remain in the tables, but the information 
in them will be cleared along with any information relating to them (including 
concentrations) in the remainder of the pages in the Calib section of the Method 
Editor.
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Method Editor Calibration: Calibration Units and Standard 
Concentrations Page

You use this page to select the units and concentrations for your calibration 
standards or additions, if Method of Additions is checked on the Define Standards 
page of the Method Editor.

Analyte

This view-only column shows all the elements designated as analytes for the 
current analysis. To change the parameter, use the entry field on the Spectrometer: 
Define Elements page.

Calib Units

This column shows the units in which the concentrations of your calibration 
solutions/additions solutions are expressed. 

To change the units for an analyte, select an option from the drop-down list.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.

Detail of the 
Calibration 
Units and 
Standard 
Concentrations 
page showing 
entries included 
in an example 
method pre-
pared for a soils 
analysis.
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To select your own units

The units available in the drop-down lists are stored in an ASCII file called units.ini 
located in the C: (or chosen drive) \Program Files\WinLab32 directory. You can 
use any text editor to add units to the file. You can also rearrange the units in the 
file so that those used frequently are on the top of the list. The units.ini file contains 
information on the format and content of the file. If the units.ini file contains 
improper information, the software may fail.

Standard Concentrations

These columns show the standard concentrations for each analyte in each 
calibration standard. If the concentration entry for an analyte in a standard is left 
blank, then that analyte will not be measured when that standard is analyzed. Do 
not enter zero for a calibration standard. 

To enter or change the standard concentration for an analyte, type the new 
concentration in the entry field.

To clear the standard concentration for an analyte, click on the entry field and 
press Delete.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.
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Method Editor Calibration Pages: Calibration and Reagent Blank 
Usage Page

You use this page to select which calibration blanks should be used in calibrating 
the elements in your analysis. You can also decide whether the blanks should be 
subtracted from the analyte intensities, used for calibration, or both.

F'n (Function)

This view-only column shows the action that the instrument will take for this 
element. 

• A = Analyte

• IS = Internal Standard

To change the parameter, use the entry field on the Spectrometer: Define Elements 
page. 

Element

This view-only column shows all the elements selected for the current analysis. To 
change the parameter, use the entry field on the Spectrometer: Define Elements 
page.

Detail of the 
Calibration and 
Reagent Blank 
Usage page 
showing entries 
included in an 
example method 
prepared for a 
soils analysis.
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Use Calibration Blank

This column shows which calibration blank should be used as part of the 
calibration for this element. Having multiple calibration blanks allows you to select 
different calibration blanks for different elements to correct for differences in 
baseline of each blank solution. The calibration blank is usually analyzed before 
the standards. 

The way in which the calibration blank is treated in the calibration is based on the 
calibration equation. For more information, see Chapter 12, Calibration and 
Calculations.

To change the calibration blank for one element, select an option from the 
drop-down list.

Subtract Reagent Blank

This column allows you to use reagent blanks to correct for variations in analytes. 
The normal way of using a reagent blank is to subtract the results for all elements. 
By turning off reagent blank subtraction for certain elements that you know are not 
present in the reagent blank, you can reduce the noise or bias that subtracting a 
near-zero reagent blank concentration would otherwise add to a measurement. The 
column is active only if one or more reagent blanks have been defined on the 
Define Standards page.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.
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Method Editor Calibration Pages: Calibration Equations and Sample 
Units Page

You use this page to select the type of calibration equation you will use and the 
units and concentration reporting format for your samples.

Note: If you checked Method of Additions on the Define Standards page, then the Calibration Equation cells 
are read-only. The Calibration Equation that is displayed for each element, when Method of Additions is 
enabled, is the equation that is selected on the Define Standards page.

F'n (Function)

This view-only column shows the kind of action that the instrument will take for 
this element. 

• A = Analyte

• IS = Internal Standard

To change the parameter, use the entry field on the Spectrometer: Define Elements 
page. 

Detail of the 
Calibration 
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Element

This view-only column shows all the elements selected for the current analysis. To 
change the parameter, use the entry field on the Spectrometer: Define Elements 
page.

Calibration Equation

This column shows the calibration equation used to process the analytical data on 
this item, defining the relationship between intensity and concentration for your 
samples. See Chapter 12, Calibration and Calculations for further details.

Select the calibration equation for an analyte.

Linear (Lin, Calc Int)
This equation creates a calibration curve that relates concentration to intensity 
linearly. 
Linear equations are used when you expect a linear relationship between 
concentration and intensity. Generally, this is 4 to 6 orders of magnitude 
greater than the detection limits and will depend on wavelength region and 
your sample matrix. In this equation, the calibration blank is subtracted from 
all solutions and included in the calculation of the calibration curve. The 
intercept with the intensity axis is calculated rather than fixed at zero intensity 
and zero concentration.

Linear-thru-zero
This creates a linear calibration curve, but forces the curve through the origin 
of the graph. Linear equations are used when you expect a linear relationship 
between concentration and intensity. Generally, this is 4 to 6 orders of 
magnitude greater than the detection limits and will depend on wavelength 
region and your sample matrix. In this equation, the blank is subtracted from 
all solutions and included in the calculation of the calibration curve. The 
calibration curve is forced to go through zero intensity and zero concentration.

Linear (Bracketing)
This is a linear calibration technique designed for use over a restricted 
concentration range. The calibration is performed with at least two standards 
that bracket the calibration range of interest. The use of a blank is optional. If 
you use a blank, it is subtracted from all solutions, but is not included in the 
calculation of the calibration curve. 
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Non-linear (Non Lin, Calc Int)
Non-linear equations are used when you expect your sample concentrations to 
be outside of the linear range of the technique. This option covers the widest 
concentration range and requires that you use a blank and at least three 
standards. In this equation, the blank is subtracted from all solutions and 
included in the calculation of the calibration curve. The intercept with the 
intensity axis is calculated rather than fixed at zero intensity and zero 
concentration.

Non-linear (Bracketing)
Non-linear equations are used when you expect your sample concentrations to 
be outside of the linear range of the technique. Bracketing is a calibration 
technique designed for use over a restricted concentration range. The 
calibration is performed with at least three standards that bracket the 
calibration range of interest. The use of a blank is optional. If you use a blank, 
it is subtracted from all solutions, but is not included in the calculation of the 
calibration curve.

Sample Units

This column shows the units in which the sample results are expressed. Conversion 
from sample results determined in Calib Units to results expressed in Sample Units 
involves corrections made for weight, volume, and dilution information supplied 
for samples in a Sample Information File (or the Sample Details dialog in a manual 
analysis), e.g. converting from mg/L to mg/kg. Corrections are also automatically 
made for converting units with order-of-magnitude differences, e.g. converting 
mg/L to µg/L.

To change the units for an analyte, select an option from the drop-down list.

You can select either Weight/Volume units or Weight/Weight units. There are, 
however, some restrictions on using combinations of certain Calib Units with 

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.
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certain Sample Units with respect to information that needs to be supplied in the 
Sample Information File (SIF) for each sample. Failure to include the proper 
information with samples will cause sample results to be reported in Calib Units 
only. See Sample Preparation Parameters in Chapter 4,  Sample Information 
Editor for more details about the sample quantity information required in the 
Sample Information Editor.

To select your own sample units

The units available in the drop-down lists are stored in an ASCII file called units.ini 
located in the C: (or chosen drive) \Program Files\WinLab32 directory. You can 
use any text editor to add units to the file. You can also rearrange the units in the 
file so that those used frequently are on the top of the list. The units.ini file contains 
information on the format and contents of the file. If the units.ini file contains 
improper information, the software may fail.

Max. Decimal Places

This column shows the maximum number of figures to the right of the decimal 
point that are displayed for the concentrations reported in sample units or 
calibration units.

It is possible that the final result will not include the number of decimal places 
specified here, depending on the value that is specified for Max. Significant 
Figures. In general, when the result is small, the Max. Decimal Places value is used. 
However, when the result is large, the Max. Significant Figures is used. 

Example 1

Max. Decimal Places = 3, Max. Significant Figures = 2
Calculated Concentration: 11.001
Reported Concentration: 11

The calculated concentration has three decimal places, but it exceeds the maximum 
number of significant figures. Therefore, the result is reported as 11 with two 
significant figures.
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Example 2

Max. Decimal Places = 3, Max. Significant Figures = 4, 
Calculated Concentration: 0.03587
Reported Concentration: 0.036

The calculated concentration has four significant figures, but it exceeds the 
maximum number of decimal places. Therefore, the result is reported as 0.036 with 
three decimal places.

Max. Significant Figures

This column shows the maximum number of significant figures that are displayed 
for the concentrations reported. 

It is possible that the final result will not include the number of figures specified 
here, depending on the value that is specified for Max. Decimal Places. See the 
examples under Max. Decimal Places for more information.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter’s column header.
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Method Editor Calibration Pages: Initial Calibration Options Page

You use this page to decide whether to create a new calibration using standard and 
blank solutions, or to use a calibration that has been stored.

When opening this method manually:

Load the calibration curve selected below:
All calibration curves will be cleared when the method is opened, and the 
calibration curves you select will be recalled from a stored results data set. If 
you are performing a manual analysis, the calibration curves that you have 
selected here will be used for the analyses. If you are performing an automated 
analysis, you can use the calibration curves that you have selected here instead 
of generating a new calibration. When you click on Analyze Samples in the 
Automated Analysis Control window, the calibration curves selected here will 
be used.

When using this method in a multimethod sequence:

When two or more methods are entered in the Set Up page of the Automated 
Analysis Control window, the options are:

Start by constructing new calibration curves
New calibration curves will be created for each method by analyzing the 

Detail of the 
Initial 
Calibration 
Options page.
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blanks and standards specified in the method.

Start using the existing calibration curve set
The calibration curves currently appearing in the Calibration Display window 
from the previous methods used will be carried over. 

Start using the stored calibration curve set selected below
The calibration curves you select will be recalled from a stored results data set. 
If several calibrations are contained in the results data set, the last set of 
calibration curves generated will be recalled.

Method Editor Calibration Pages: Multiline Calibration Page

You use this page to select various reporting options when using two or more 
wavelengths for the same element. You can choose to:

• select the appropriate wavelength based on the concentration of the sample. 
You must have a different concentration range for each wavelength. See the 
Select Line action described below.

• report the average concentration of two or more wavelengths. You must have 
the same concentration range for each wavelength. See the Average Lines or 
Report and Average actions described below.

The Multiline 
Calibration 
Page. For easy 
reference, blue 
highlighting 
helps distin-
guish between 
each element 
group.
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The list of analytes on this page is taken from the Method Editor Spectrometer: 
Define Elements page, but only the analytes to which multiline calibration applies 
appear here. The results will appear in the Results Display window.

Multiline Calibration
Note: Multiline Calibration is disabled when Method of Additions is checked on the Define Standards 
page.Select this checkbox to use multiline calibration. Note:  If the spreadsheet table is dimmed, you must 
select this checkbox to activate it. 

Sequence

This column shows the order in which each analyte will be considered within each 
element group.   This is meaningful for only the Select Line action and can be 
changed using the Move Up and Move Down buttons. 

Element

This view-only column shows the elements in the current method that meet the 
criteria for multiline calibration, that is, two or more wavelengths have been 
assigned to this element. The elements are sorted first alphabetically and then by 
concentration range. 

Action

This is how you want to have the concentration reported for each analyte. 

Note: This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.

Select an action for each analyte. 

Always Report
Use this action to report the concentration of an element at each wavelength 
assigned, without the use of the multiline calibration feature. In the example 
page shown at the beginning of this section, the individual concentration will 
be reported for copper at each wavelength.  In the Results Display window, this 
action shows the concentrations at each wavelength, as in normal reporting.

Select Line
Use this action to determine an element at two or more wavelengths, but report 
the concentration at only one wavelength, based on the element concentration 
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found in the sample. 

In the example page shown at the beginning of this section, the Select Line 
action has been assigned to iron at three wavelengths. Suppose that, when the 
analysis is performed, the concentration of iron is found to be 150 mg/L. This 
concentration will be reported at the 234.349 wavelength. 

The software compares the 150 mg/L result with the concentration range of the 
first wavelength in the sequence, 238.204.  Because the concentration does not 
fall within the 0 to 100 mg/L range, the next wavelength in the sequence, 
234.349, is considered.  The 150 mg/L concentration does fall within the 100 
to 500 mg/L range, which was used for this wavelength. Therefore, the Results 
Display window will show only the result at Fe 234.349, 150 mg/L. 

Note:  If the concentration range does not fall within the range of any of the 
wavelengths, then the last wavelength in the sequence is reported. 

You can change the sequence using the Move Up and Move Down buttons. 
The software will consider each wavelength in the sequence you specify.

Average Lines
Use this action to report an average concentration for an element at two or more 
wavelengths. In the example page shown at the beginning of this section, the 
concentration of titanium is determined for each wavelength. The three 
concentration values are averaged and the result is reported. To use this action, 
you must have the same concentration range and units assigned to each analyte. 
However, you can assign different calibration equations. One average 
concentration per element is calculated.

In the Results Display window, only the calculated average concentration is 
shown. The average concentration is displayed with a new analyte name using 
the element symbol and the word “Average.” For example, “Ti Average.”

Note: A saturated wavelength will not be included in the calculation.

Report & Average
Use this action to report individual concentrations for an element at two or 
more wavelengths as well as the average concentration. In the example page 
shown at the beginning of this section, the concentration of zinc is determined 
for each wavelength, an average calculated and all information reported. To 
use this action, you must have the same concentration range and units assigned 
to each analyte.  However, you can assign different calibration equations. The 
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Results Display window shows the concentration of the element at all 
wavelengths and the calculated average of these concentrations.

Analytes

This view-only column shows all of the analytes in the current analysis that meet 
criteria for multiline calibration. This information was entered on the Method 
Editor Spectrometer: Define Elements page.  

Low

This view-only column shows the lower limit of the calibration range.  A zero 
appears here for any calibration equation except linear or nonlinear bracketing.  For 
either bracketing equation, the lower limit that you entered in the Method Editor 
Calibration: Calibration Units and Standard Concentration page will appear here. 

High

This view-only column shows the upper limit of the calibration range. You entered 
this information on the Method Editor Calibration: Calibration Units and Standard 
Concentration page.  

Units

This view-only column shows the units in which the concentration will be 
expressed. 

Move Up

When you choose Select Line, you use this button to move an analyte up one place 
within the sequence of an element group. The software will consider each 
wavelength in the sequence you specify.

Move Down

When you choose Select Line, you use this button to move an analyte down one 
place within the sequence of an element group. The software will consider each 
wavelength in the sequence you specify.
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Method Editor: Recovery Checks Page 
(Analyte Concentrations added to Recovery Check)

You use this page to enter the concentrations of analytes added to matrix recovery 
check (i.e., “spike”) samples analyzed using this method. Scheduling of matrix 
recovery check samples for an analysis is performed using the Sample Information 
Editor.

To display the Checks page

Click on the Checks tab at the bottom of the Method Editor window. 

Analyte

This view-only column shows all the analytes selected for the current analysis. To 
change the parameter, use the entry field on the Spectrometer: Define Elements 
page.

Detail of the 
Analyte 
Concentrations 
page.
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Conc Units

This view-only column shows Calibration Units or Sample Units, depending on the 
selection made at the bottom of this page.

Recovery Set 1 to Set 6

These are the concentrations of analytes added to samples to create matrix recovery 
check (i.e. “spike”) samples to be analyzed using this method. You may enter up 
to six different sets of concentrations for each method. In an analysis, a recovery 
set can be used more than once. For example, you may analyze three recovery 
check samples that are spiked with high analyte concentrations as defined in Set 1 
and three other recovery check samples that are spiked with low analyte 
concentrations as defined in Set 2.

To perform spike recovery measurements, you must enter information about the 
matrix check samples in the Sample Information Editor using the Matrix Check 
Sample Entry Dialog. The equation used to calculate recovery checks is shown in 
the help topic for the Matrix Check Sample Entry Dialog.

Concentration Units

Calibration 
Select this option to perform recovery calculations using the matrix check 
sample concentrations expressed in Calib Units.

Sample 
Select this option to perform recovery calculations using the matrix check 
sample concentrations expressed in Sample Units.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header.
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Method Editor: Sample Limits Checks Page
The Sample Limits page allows you to quickly and easily set up sample limit 
checks. When a sample result falls above or below a sepcified range, a message is 
displayed in the Results window to indicate the failure
.

Using the Sample Limits Page

On this page you specify limits for analytes that are defined in your method.  These 
limits will be used to determine whether or not a flag is displayed when a sample 
result falls above or below a specified limit.  You have the option to enter a 
Concentration value for a particular analyte/s and then use the Calculate Limits 
button to automatically calculate upper and lower limits for the analytes where a 
concentration is specified.  Or, you can simply enter a value in the Upper and/or 
Lower Limit cells for a particular analyte.  

Detail of the 
Sample Limits 
Checks page.
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To display the Sample Limits page

1. Open the Method Editor.

2. Click on the Checks tab, which is located on the bottom of the Method Editor 
window.

3. Click on the Sample Limits tab page.

To automatically calculate limits:

1. Enter the sample Concentrations.

2. Click on the Calculate Limits... button.
The Calculate Limits dialog appears.

3. On the Calculate Limits dialog, specify the upper and lower limits in percent 
to be used to calculate the limits.

4. Click OK.
You are returned to the Sample Limits page and limits are only calculated for 
analytes that have a Concentration specified.

5. Select whether you want concentrations expressed in Calibration units or 
Sample units. 

6. Check the Show range along with limit remark option to have the range 
displayed on the results screen along with the upper/lower limit fail message, 
if a sample falls above/below the specified limit.

Note:  Whenever you change the parameters on the Calculate Limits dialog and click OK, the Upper and 
Lower Limits, displayed on the Sample Limits page, are automatically updated for all analytes that have a 
concentration specified.
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To specify an upper and/or lower limit:

1. Type in the sample Upper and/or Lower limit values. 

2. Select whether you want concentrations expressed in Calibration units or 
Sample units.

3. Check the Show range along with limit remark option to have the range 
displayed on the results screen along with the upper/lower limit fail message, 
if a sample falls above/below the specified limits.
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Method Editor: QC Pages Overview
You use the QC pages to enter parameters that describe quality control samples. 
QC samples are used to perform runtime checks of instrument performance. You 
schedule when and under what conditions the QC samples are to be analyzed. QCs 
can be scheduled after the initial calibration, after any recalibration, periodically 
throughout the analysis and at the end of the analysis. 

The periodic QCs also can be scheduled in the Sample Information Editor. If 
periodic QCs are scheduled in both the Method Editor and the Sample Information 
Editor, then the Sample Information Editor takes precedence.

To display the QC pages

Click on the QC tab on the bottom of the Method Editor window.

To perform QC analyses

To enter the required QC information, you must perform these steps:

1. Enter descriptive information about each QC sample including the QC sample 
ID and autosampler location on the first QC page. 

2. Enter the concentration and the upper and lower limits for each QC sample on 
the second QC page. The software can calculate the upper and lower 
concentration limits, or those limits can be entered manually. 

3. Select when each QC sample is to be analyzed on the third QC page. The 
frequency can be the same for all QC samples or different for each one. 

4. Select the action to be performed when the measured concentration is outside 
of the acceptable limit for each QC sample on the fourth and fifth QC pages. 

Note QC Samples can also be scheduled using the Sample Information Editor.
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5. Select the maximum number of times a group of standards or standards and 
samples may be reanalyzed to prevent the system from going into an infinite 
loop on the Actions: End and Retry page.

QC Pages

Click one of the tabs on the right side of the Method Editor to select a page.

• QC Sample Definition Page

• QC Sample: Concentration and Limits Page

• Schedule for QC Analyses Page

• Failure Actions for After-Calibration and Periodic QC’s Page

• Failure Actions for At-End QC’s
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QC Flow Charts

There are four QC flow charts. The first flow chart shows an example of how a QC 
schedule might look. The second flow chart shows the sequence of an initial 
calibration. The third flow chart shows the analysis of an initial calibration QC. 
Lastly, the fourth flow chart shows an example of a failure action. The failure 
action used is Recalibrate and Continue.
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Note If the QC fails and there are zero retries specified, then the instrument will 
perform the failure action for that QC.



163Method Editor: QC Pages Overview



164 Chapter 3 Using the Method Editor

Method Editor QC Pages: QC Sample Definition Page

You use this page to enter the names and autosampler locations for the QC samples. 
You also indicate whether to count a QC as a sample and whether to subtract 
reagent blanks from the QC samples. This page contains a table with columns for 
up to 20 QC samples and includes rows for the following parameters.

QC Sample ID

This is the quality control sample ID that will be displayed in the Results Display 
window and in the results data set and printed or sent to a log file. You must first 
enter an ID in order to enter any other information for a QC. The maximum number 
of characters is 20.

Example: EPA Check #1

Autosampler Location

The software will automatically assign the next available autosampler location 
when a QC Sample ID is entered. Enter the autosampler location for each quality 
control sample if the location selected by the system is not appropriate.

Click on an entry field and type a value between 0 and the maximum location 
number on your autosampler tray.

Detail of the 
Sample 
Definition page 
showing entries 
included in an 
example 
method 
prepared for a 
soils analysis.
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Count as Sample

If you want the QC to be considered part of the sample count, select this box. For 
example, for a frequency of every 10 samples, there are nine unknown samples and 
one QC sample. 

Subtract Reagent Blank

Selecting this box for this parameter will cause the reagent blank concentrations to 
be subtracted from the measured QC Sample concentrations. 

If the QC Sample is to be analyzed as an unknown sample, then you would 
normally subtract the reagent blank. If the QC Sample is a calibration standard that 
is similar in matrix to the unknown sample and was reanalyzed to check the 
calibration, then you would not subtract the reagent blank. This is because the 
reagent was not subtracted from the calibration standard when the reagent was 
originally analyzed.

Method Editor QC Pages: QC Samples: 
Concentrations and Limits Page

This page is used to enter QC sample concentrations and the upper and lower limits 
which trigger failure actions by the software.

Detail of the 
Concentrations 
and Limits page 
showing entries 
included in an 
example method 
prepared for a 
soils analysis. 
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QC Sample ID

This specifies the QC sample whose parameters are displayed.

Analyte

This view-only column shows all the analytes selected for the current analysis. To 
change the parameter, use the entry field on the Spectrometer: Define Elements 
page.

Units

This view-only column shows Calibration Units or Sample Units, depending on the 
selection made at the bottom of this page.

Concentration/Upper Limit/Lower Limit

This specifies the action limits for each QC sample. If the measured concentration 
is between the specified upper and lower limits, no action will be taken. If the 
measured concentration is above the upper limit or below the lower limit, the 
appropriate failure action, which is defined on the appropriate Actions page, will 
be performed. 

To automatically calculate the upper and lower limits:

1. Enter the QC sample concentrations. 

Since the significant figures and decimal places in the calculated limits are 
based on those in concentration entries, you must enter the concentrations 
using enough significant figures and decimal places so that the limits to be 
calculated have enough significant figures and decimal places for proper limit 
checking. For example, if you only use one figure for the concentration entry, 
then the limits will also have only one figure. 

2. Click on the Calculate Limits... button. 

3. When the Calculate Limits dialog appears, specify the upper and lower limits 
in percent to be used to calculate the limits.

4. Click on OK.
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Automatic limit calculation can only be done on a percentage basis of the 
entered QC sample concentration. Limits based on detection limits have to be 
entered manually since the QC sample concentration is usually zero.

Calculate Limits...

This button displays the Calculate Limits dialog, which you use to calculate the 
upper and lower limits for QC samples. 

Calculate Limits Dialog

Use this dialog to calculate the upper and lower limits for QC samples.

To display this dialog

Click on the Calculate Limits... button on the QC Sample Concentrations 
and Limits page of the Method Editor.

Using this dialog

1. Specify the upper and lower limits in percent to be used to calculate the limits.

2. Click on OK.

Automatic limit calculation can only be done on a percentage basis of the 
entered QC sample concentration. Limits based on detection limits have to be 
entered manually since the QC sample concentration is usually zero.

Note This parameter has a Column Fill dialog that can be accessed by double-
clicking on the parameter's column header. You also enter the QC 
concentration for the analytes of interest.
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Method Editor QC Pages: Schedule for QC Analyses Page

This page is used to enter the schedule for the QC analyses.

Schedule for QC Analyses

QC Sample ID

This view-only row specifies the QC sample whose parameters are displayed.

After Initial Calib

The QC will be analyzed after the initial calibration has been performed.

Note QC samples can also be scheduled using the Sample Information Editor. If 
scheduling is done using the Sample Information Editor, this takes 
precedence over any scheduling in the Method Editor.

Detail of the 
Schedule for QC 
Analyses page 
showing entries 
included in an 
example method 
prepared for a 
soils analysis. 
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After Recalibration

The QC will be analyzed after any recalibrations that are part of the analysis. 

Periodically

The QC will be analyzed at specified intervals during the current analysis, based 
on the frequency you select.

Frequency
This is the frequency at which the periodic QC samples are analyzed. For 
example, if you select a frequency value of 20, then every 20 samples the QC 
sample will be analyzed.

If you use the same frequency for all periodic QC samples, the values in the 
Frequency row in the table will have a grey background and cannot be 
changed.

If you select Variable for the frequency, the values displayed in the table will 
have a white background. You may then enter different frequency values for 
each QC sample.

At End

The QCs will be analyzed at the end of the current analysis. 

Periodic Timing of Analyses

Frequency

This is the frequency at which QC samples are analyzed. You can use the same 
frequency for all periodic QC samples, or vary the frequency for each QC sample.

Note If you schedule one or more After Initial Calib QC samples and then 
perform an Automated Analysis using the Analyze Samples button, the 
instrument will analyze the QC as part of the sample list. This is useful if 
you wish to use an existing calibration curve, analyze the After Initial 
Calib QC sample as a check (without reanalyzing your calibration 
standards), then take action based on the pass or fail status of the QC.
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Maximum time between QC’s 

This is only available when Same for All QC's option has been selected for the 
frequency.

To specify a maximum amount of time between periodic QC samples, click on the 
check box, then select the time.

Method Editor QC Pages: Failure Actions for After-Calibration and 
Periodic QC's Page

You use this page to define the actions to be taken if any of the QC samples that 
are analyzed after a calibration or are analyzed periodically fail. You may select 
from one of several actions.

Failure Actions for After-Calibration QC’s

QC Sample ID

This view-only row shows the name that you assigned to each individual QC 
sample.

Detail of the 
Failure Actions 
for After-
Calibration and 
Periodic QC's 
page showing 
entries included 
in an example 
method pre-
pared for a 
soils analysis.
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Times to retry QC

Select an option from the drop-down list. If it fails initially, the QC sample is 
reanalyzed up to the specified number of times. If it passes at any one time, the 
analysis continues. If all tries fail, the failure action will be performed. If you select 
None from the drop-down list, the QC will not be reanalyzed. Instead, the system 
will go directly to performing the failure action.

When All Tries Fail

Select a failure action from the drop-down list:

Continue
The system prints a failure message and any optional message that you typed 
and continues with the analysis.

Recal & Cont
The system prints a failure message and any optional message that you typed. 
The system performs a complete recalibration as defined on the Calibration 
page including the reagent blank if selected, then continues with the analysis.

Rslp & Cont
The system prints a failure message and any optional message that you typed. 
The system analyzes the calibration blank and reslope standard as defined on 
the Calibration page including the reagent blank if selected, then continues 
with the analysis.

AZ & Cont
The system prints a failure message and any optional message that you typed. 
The system performs an autozero using the calibration blank and the reagent 
blank (if you are using one), then continues with the analysis. An autozero sets 
the reading of the calibration blank or reagent blank to zero automatically.

Alarm and Pause
The system prints a failure message and any optional message that you typed. 
An alarm is activated and the analysis pauses. At this point, you will get an 

Note If there are any after-calibration QCs, they will be analyzed after the 
recalibration action. If the QCs pass, then the rest of the action is 
performed (continue or rerun samples).
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option to stop or continue the analysis. If an automatic shutdown is scheduled, 
Alarm and Pause will prevent system shutdown.

Next Method
The system prints a failure message and any optional message that you typed. 
The current method is stopped and the system proceeds to the next method, if 
any. If there is no next method, the system stops the analysis. If an automatic 
shutdown is scheduled, Next Method will prevent system shutdown.

Stop
The system prints a failure message and any optional message that you typed. 
The system stops the analysis. If an automatic shutdown is scheduled, Stop will 
prevent system shutdown.

Additional Message

The system will automatically print standard messages indicating what is 
happening if the measured QC concentration does not fall within the range 
specified by the limits.

You can type an optional message up to 60 characters in length in this entry field 
that will be printed when a failure action is performed in addition to the standard 
message.

Failure Actions for Periodic QC’s

QC Sample ID

This view-only row shows the name that you assigned to each individual QC 
sample.

Times to retry QC

Select an option from the drop-down list. If it fails initially, the QC sample is 
reanalyzed up to the specified number of times. If it passes at any one time, the 
analysis continues. If all tries fail, the failure action will be performed. If you select 
None from the drop-down list, the QC will not be reanalyzed. Instead, the system 
will go directly to performing the failure action. 

When All Tries Fail

Select a failure action from the drop-down list:
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Continue
The system prints a failure message and any optional message that you typed 
and continues with the analysis.

Recal & Cont
The system prints a failure message and any optional message that you typed. 
The system performs a complete recalibration as defined on the Calibration 
page including the reagent blank if selected, then continues with the analysis.

Rslp & Cont
The system prints a failure message and any optional message that you typed. 
The system analyzes the calibration blank and reslope standard as defined on 
the Calibration page including the reagent blank if selected, then continues 
with the analysis.

AZ & Cont
The system prints a failure message and any optional message that you typed. 
The system performs an autozero using the calibration blank and the reagent 
blank if selected, then continues with the analysis. An autozero sets the reading 
of the calibration blank or reagent blank to zero automatically.

Alarm and Pause
The system prints a failure message and any optional message that you typed. 
An alarm is activated and the analysis pauses. At this point, you will get an 
option to stop or continue the analysis. If an automatic shutdown is scheduled, 
Alarm and Pause will prevent system shutdown.

Recal & Rerun
The system prints a failure message and any optional message that you typed. 
The system performs a complete recalibration as defined on the Calibration 
page including the reagent blank if selected. Then, the samples are rerun, 
starting after the last QC that passed.

Reslp & Rerun
The system prints a failure message and any optional message that you typed. 

Note If there are any after-calibration QCs, they will be analyzed after the 
recalibration action. If the QCs pass, then the rest of the action is 
performed (continue or rerun samples).
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The system analyzes the calibration blank and reslope standard as defined on 
the Calibration page including the reagent blank if selected. Then, the samples 
are rerun, starting after the last QC that passed.

AZ and Rerun
The system prints a failure message and any optional message that you typed. 
An autozero is performed using the calibration blank and the reagent blank if 
selected. Then, the samples are rerun, starting after the last QC that passed. An 
autozero sets the reading of the calibration blank or reagent blank to zero 
automatically. 

Next Method
The system prints a failure message and any optional message that you typed. 
The current method is stopped and the system proceeds to the next method, if 
any. If there is not a next method, the system stops the analysis. If an automatic 
shutdown is scheduled, Next Method will prevent system shutdown.

Stop
The system prints a failure message and any optional message that you typed. 
The system stops the analysis. If an automatic shutdown is scheduled, Stop will 
prevent system shutdown.

Additional Message

The system will automatically print standard messages indicating what is 
happening if the measured QC concentration does not fall within the range 
specified by the limits.

You can type an optional message in this entry field that will be printed when a 
failure action is performed in addition to the standard message.
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Method Editor QC Pages: Failure Actions for At-End QC's

You use this page to define actions to be taken for QC’s run at the end of an 
analysis. You select the number of times to retry the QC sample before a failure 
action is performed. When the At-End QC samples pass, the analysis ends. If all 
tries fail, or if no retries are scheduled, then the failure action that you select is 
performed immediately. 

Detail of the 
Failure Actions 
for At-End QC's 
showing entries 
included in an 
example method 
prepared for a 
soils analysis. 
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Failure Actions for At-End QC’s

QC Sample ID

This view-only row shows the name that you assigned to each individual QC 
sample.

Times to retry QC

Select an option from the drop-down list. If it fails initially, the QC sample is 
reanalyzed up to the specified number of times. If it passes at any one time, the 
analysis continues. If all tries fail, the failure action will be performed. If you select 
None from the drop-down list, the QC will not be reanalyzed. Instead, the system 
will go directly to performing the failure action.

When All Tries Fail

Select an failure action from the drop-down list.

Continue
The system prints a failure message and any optional message that you typed 
and continues with the analysis.

Recal & Rerun
The system prints a failure message and any optional message that you typed. 
The system performs a complete recalibration as defined on the Calibration 
page including the reagent blank if selected. Then, the samples are rerun, 
starting after the last QC that passed.

Rslp & Rerun
The system prints a failure message and any optional message that you typed. 
The system analyzes the calibration blank and reslope standard as defined on 
the Calibration page including the reagent blank if selected. Then, the samples 
are rerun, starting after the last QC that passed. 

Note If there are any after-calibration QCs, they will be analyzed after the 
recalibration action. If the QCs pass, then the rest of the action is 
performed (continue or rerun samples).



177Method Editor: QC Pages Overview

AZ & Rerun
The system prints a failure message and any optional message that you typed. 
An autozero is performed using the calibration blank and the reagent blank if 
selected. Then, the samples are rerun, starting after the last QC that passed. An 
autozero sets the reading of the calibration blank or reagent blank to zero 
automatically.

Alarm and Pause
The system prints a failure message and any optional message that you typed. 
An alarm is activated and the analysis pauses. At this point, you will get an 
option to stop or continue the analysis. If an automatic shutdown is scheduled, 
Alarm and Pause will prevent system shutdown.

Next Method
The system prints a failure message and any optional message that you typed. 
The current method is stopped and the system proceeds to the next method, if 
any. If there is no next method, the system stops the analysis. 

Stop
The system prints a failure message and any optional message that you typed. 
The system stops the analysis. If an automatic shutdown is scheduled, Stop will 
prevent system shutdown.

Additional Message

The system will automatically print standard messages indicating what is 
happening if the measured QC concentration does not fall within the range 
specified by the limits.

You can type an optional message up to 60 characters in length in this entry field 
that will be printed when a failure action is performed in addition to the standard 
message.
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Maximum Retries After QC Failure

You use this parameter to select the maximum number of reanalyses of samples 
before an action is taken. You select the action to be taken when the number of 
times you run the sample is equal to the maximum number of retries. See Flow 
Chart 4: An Example of a Failure Action in QC Flow Charts earlier in this chapter.

1. Type a value for the maximum number of retries that you want the system to 
perform.

2. Select an option from the drop-down list.

Next Method
The system prints a failure message and any optional message that you typed. 
The current method is stopped and the system proceeds to the next method, if 
any. If there is no next method, the system stops the analysis. If an automatic 
shutdown is scheduled, Next Method will prevent system shutdown.

Continue
The system continues with the next unknown sample as if no failure occurred.

Stop
The system prints a failure message and any optional message that you typed. 
The system stops the analysis. If an automatic shutdown is scheduled, Stop will 
prevent system shutdown.

Alarm and Pause
The system prints a failure message and any optional message that you typed. 
An alarm is activated and the analysis pauses. At this point, you will get an 
option to stop or continue the analysis. If an automatic shutdown is scheduled, 
Alarm and Pause will prevent system shutdown.
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Method Editor: Options Page 
You use the entries on the Options page to set up your Results Display and Printed 
Log. You also set some options for information to be stored with a Results Data Set 
for an analysis.

Headers to include in Results Displays and Printed Log:

Select the type of information you wish to include in the Results Display and the 
Printed Log for your analysis. For detailed descriptions of the following headers, 
see Results Display Window in Chapter 7,  Information Display Windows. 

Analytical Header
Select this to include a header when a new analysis is begun. This header 
includes the analysis start time, technique, the sample information file name, 
the results data set name, the results library name, and other general 
information. Each time the current method is modified and another sample is 
analyzed, a new analytical header is displayed.

Detail of the 
Options page 
showing 
entries 
included in an 
example 
method pre-
pared for a 
soils analysis. 
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Method Header
Select this to include a header that contains the name of the method, the method 
description, the date the method was last saved, and names of IEC and MSF 
files. The expanded header includes information from the method on the 
calibration equation, peak processing, plasma viewing, and spectral 
corrections. You can select from a Short or Expanded method header.

Sample Header
Select this to include a header with sample information, including sample ID, 
sample weight, dilution, and sample prep volume. You have the option to start 
each sample on a new page. 

Sample Data Items:

Select the type of information you wish to include in the Results Display and the 
Printed Log for your analysis.

Auto Integration Report
Select this option to include an Auto-Integration Report for each measurement 
when auto integration is being used. Information includes the integration time, 
number of integrations and read time.

Replicate Data
Select this option to include data for each replicate. 

Means and Statistics
Select this option to include the mean values of each set of replicates, the 
standard deviation, and the relative standard deviation. 

Analysis List
Select this option to include a summary of the operations that were performed 
on all of the samples. 

Calibration Summary (Auto Analysis only)
Select this option to include a calibration summary in the Results Display 
window. If this is selected, the calibration summary is automatically included 
for automated analyses after the last standard is analyzed. Note: For manual 
analyses, you must select the Calibration Summary command in the Analysis 
menu.
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Sample Data Items:

Select the type of information you wish to include in the Results Display and the 
Printed Log for your analysis. 

Replicate Data
Select this option to include data for each replicate. 

Means and Statistics
Select this option to include the mean values of each set of replicates, the 
standard deviation, and the relative standard deviation.

Auto Integration Report
Select this option to include an Auto-Integration Report for each measurement 
when auto integration is being used. Information includes the integration time, 
number of integrations and read time.

Note: In the FIAS technique, Auto Integration Report is not displayed.

Display over calibration message
Select this option to display an over calibration message when the sample 
concentration is greater than the entered percentage of the highest standard.  
When this option is checked the % spin box is enabled.  In the % spin box enter 
a value between 100 and 999 %.  

Summary Items:

Analysis List
Select this option to include a summary of the operations that were performed 
on all of the samples. 

Matrix Test Reports
Select this option to include information about matrix check samples 
(duplicates, recovery samples and spikes) analyzed.  

Calibration Summary (Auto Analysis only)
Select this option to include a calibration summary in the Results Display 
window. If this is selected, the calibration summary is automatically included 
for automated analyses after the last standard is analyzed. 

Note: For manual analyses, you must select the Calibration Summary command in the Analysis menu.
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Detailed Cal. Summary
Select this option to display a detailed summary of each calibration curve, 
including the calculated concentration of each standard.  This summary will be 
displayed after the final standard has been run.

Save with Results

Spectral Data
Select this to include the spectral data in the results data set. The spectral data 
must be stored in a results data set if it is to be displayed in the Examine Spectra 
window or used for setting up MSF models or Data Reprocessing.

Universal Data Acquisition
Select this option to run in Universal Data Acquisition (UDA) mode.  When 
this option is checked, the Optima records all of the emission spectra for every 
sample, regardless of the elements being determined.  This UDA capability 
allows you to retroactively use data that was not in the original method to 
determine additional elements or measure at alternative wavelengths. 

Note:  If you have a dual view method, then the Radial and Axial radio buttons will become enabled 
when Universal Data Acquisition is checked.  You can then select the Radial radio button to collect 
Universal Data in radial viewing mode, or you can select the Axial radio button to collect Universal 
Data in axial viewing mode.

Remarks 

Use this entry field to type your comments regarding the method. 
(duplicates, recovery samples and spikes) analyzed. 
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Universal Data Acquisition (UDA)
Universal Data Acquisition (UDA) is an option available on the Options tab page 
of the Method Editor.  When this option is checked, the Optima records all of the 
emission spectra for every sample, regardless of the elements being determined.  
This UDA capability allows you to retroactively use data that was not in the 
original method to determine additional elements or measure at alternative 
wavelengths.

Enabling Universal Data Acquisition Mode

This section shows you how to record all of the spectral data for each sample.

Note:  When Universal Data Acquisition mode is enabled all of the spectral data is recorded behind 
the scenes and only the data for elements defined in your method are reported.  If, at a later time, 
you wish to determine additional elements or measure at alternative wavelengths, you can select the 
UDA data from a results data set and reprocess the data with a method that contains the elements 
you want to measure.  For more information on reprocessing UDA data see Reprocessing Universal 
Data.

To set up a method with Universal Data Acquisition enabled:

1. Open the Method Editor and set up a method to suit your analysis. When 
setting up your method, make sure that steps 2-5 are followed, so that the 
emission spectra for every sample are recorded. 

2. From the Method Editor Options tab page, check Spectral Data.

3. Check Universal Data Acquisition.

Note:  If you have a dual view method, then the Radial and Axial radio buttons will become enabled when 
Universal Data Acquisition is checked.  You can then select the Radial radio button to collect Universal Data 
in radial viewing mode, or you can select the Axial radio button to collect Universal Data in axial viewing 
mode.

4. Click on the Spectrometer tab > Settings tab.
The Spectrometer Settings are displayed.

5. On the Settings tab, make sure that Resolution is set to Fixed and Time(sec) 
is set to Auto.
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6. Set up the rest of your method as required for your analysis and then save your 
method. 

7. Analyze your samples.
All of the spectral data is captured in the data set you specified and is available 
for reporting via the Reprocess command. For more information on 
reprocessing UDA data, refer to the next section of this manual. 

Note:  You cannot perform an analysis with a method that has all three of the following parameters enabled:   
Spectral Profiling, High Resolution, and Universal Data Acquisition.  At least one of these parameters must 
be unchecked in order for your method to be valid.  For example, you can perform an analysis using a 
method that has Spectral Profiling and Universal Data Acquisition enabled.
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Reprocessing UDA Data
If you collected data with Universal Data Acquisition enabled, you have the ability 
to retroactively use data that was not in your original method to determine 
additional elements or measure at alternate wavelengths. The steps outlined below 
show you how to reprocess UDA data.

To reprocess UDA data:

1. On the Toolbar click on the Reprocessing icon.
OR
From the Tools menu, click on Data Reprocessing. 
The Data Reprocessing window is displayed.

2. Next to Data Set to Reprocess, click on Browse... and select a results data set 
that containst the data you want to reprocess.
Results data sets that contain Universal Data are marked with a > in the row 
number. 

In the Data Reprocessing window, the results from the reprocessed data will be 
saved to the data set shown in the Reprocessed Data Set field. This field 
defaults to the data set from the most recent analysis. A cehck mark appears in 
the Save Reprocessed Data box, confirming that the reprocessed data will be 
saved. If you do not want to store reprocessed data, uncheck Save Reprocessed 
Data.
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3. To change to a different data set, click on Browse... (next to Reprocessed Data 
Set).
The Select Results Data Set dialog appears.

4. Type in a new data set name or select an existing one and then click OK.

5. Open the method that you want to use for reprocessing.

6. Confirm that hte method in use contains the correct settings for the results data 
set that is to be reprocessed.

7. In the Data Reprocessing table, review the information. The IDs in the 
selected results data set are listed along with the sample information that was 
used when the data was orginally collected.

8. To edit this information, type the new information into the fields as desired. To 
access a pop-up menu containing commands for editing the table, right click 
anywehre in the table. 

Note: There is a column fill dialog available for each of the parameters in teh table, except Sample Type and 
Original method. To access a column fill dialog, doulbe-click on the parameter’s column header.

9. To hide columns that do not contain data, check Hide Empty Columns. 

10. To only display samples with UDA data, check Only show samples with 
Universal Data.

11. To select items of interest for reprocessing, select the associated row numbers 
in the table. To select a series of rows, click on the first row number of interest, 
hold down the Shift key, and click on the last row number of interest. YOu can 
also drag over the row numbers column using hte mouse cursor. To select non-
consecutive rows, hold down the Ctrl key and click on each row number.

Tip:  The order in which samples are selected is the order in which reprocessing occurs.  As you 
select each row, the reprocessing sequence appears in the Sequence column. 

12. Click on Reprocess.
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About the Sample Information Editor
We recommend that you use a sample information file to store information about 
the samples. The system uses this file to label the data from your samples both on 
the printed log of the results and in the results data set. Information in this file is 
also often needed by the system to calculate final concentrations.

Enter IDs only for samples and matrix check samples in the sample information 
file. Enter IDs for the blanks, standards, and QC samples in the Method Editor. If 
you enter IDs for blanks, standards, or QC samples in the Sample Information 
Editor, these solutions are analyzed as samples.

The Sample 
Information 
Editor showing 
entries for a 
soils analysis 
with solid 
sample units.
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To display this window

On the Toolbar, click on SamInfo. 

- or -

In the Tools menu, click on Sample Information Editor.

File format

The sample information file is written in comma-delimited ASCII, a format that 
you can also create using other software such as a BASIC program, a spreadsheet 
program, or a database program. You can also create this file on a laboratory 
information management system and load it into your instrument control computer 
to perform analyses.

Using the Sample Information Editor
Customizing the Sample Information Editor

You can select the exact parameters that you need to describe your samples and add 
them to the Sample Information Editor. You select the sample description, 
preparation, and scheduling parameters from a list of available parameters. 

For the sample description and sample preparation parameters, you decide whether 
the information will be the same for all samples or will vary for particular samples:

• If the Information you enter will be the same for all samples, you assign the 
parameter to the Parameters Common to All Samples table.

• If the information you enter will vary for individual samples, you assign the 
parameter to the Parameters That Vary By Sample table.

In addition, you can define your own parameters by selecting User Defined in the 
list of parameters. 

Once you have included all the parameters that you need, you can save this 
configuration as a sample information design. In the File menu, select Save As  
Samp Info Design to save as a .sid file. By saving the design, you can reuse it later 
for similar sample information files. 
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Editing Information in the Sample Information Editor

To edit information about the samples or to remove the assigned parameters from 
either table, you use commands in the Edit menu. In the Parameters That Vary By 
Sample table, you can click with the right mouse button in the table and a pop-up 
menu appears. This pop-up menu contains commands similar to those found in the 
Edit menu.

Appending Samples to an Automated Analysis

You can modify and append samples to an automated analysis.

1. While the instrument is performing an automated analysis, in the Sample 
Information Editor modify the information in samples as desired, then click on 
the Append to Analysis List button.

2. When the Append to Run List dialog appears, type the range of samples that 
you want to append and click on OK to add the samples to the end of the run 
list in the Automated Analysis Control window.

To delete, copy, or rename sample information files or sample information 
designs

Use the Windows Explorer. These files are stored in the pe\username\sample 
information directory, where username will be replaced automatically with the 
name that you used to log in to the computer. For example, if your login name 
is “smith,” the directory name will be pe\smith\sample information. For more 
information, see your Windows documentation.

Creating a New Sample Information File

To create a new sample information file

Note You can drag the mouse cursor through a range of samples in the Sample 
Information Editor and, when you click on the Append to Analysis List 
button and the Append to Run List dialog appears, the range of the selected 
samples already appears in the dialog. 
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1. In the File menu, click on New  Sample Info File... The New Sample 
Information File dialog appears.

2. Select a design from the Design List and click OK. This list includes a default 
design and any other designs that have been previously created and stored. To 
create a name for the sample information file, in the File menu, click on Save 

 Sample Info File. Type a name for the new sample information file, then 
click on Save.

3. You can customize the Sample Information Editor by selecting the parameters 
you need to describe your samples. See Customizing the Sample Information 
Editor below.

4. Enter the sample information. For example, autosampler locations, Sample ID, 
Initial Sample Weight, etc.

5. If desired, annotate the file using the File Description field to provide further 
descriptive information. When you move the mouse cursor to this text area and 
click with the right mouse button, a pop-up menu of editing commands 
appears.

6. In the File menu, click on Save As  Sample Info File... The Save As dialog 
appears. Type a name for the file, then click on OK.

Customizing the Sample Information Editor

To fully describe your samples, you can add or remove parameters in the Sample 
Information Editor and then save the configuration as a sample information design 
to use again. 

To add parameters to the Sample Information Editor

1. If you have not created a name for the new sample info file, do the following:

• In the File menu, click on New  Sample Info File... The New Sample 
Information File dialog appears.

• Select a design from the Design List and click OK. This list includes a 
default design and any other designs that have been previously created and 
stored. To create a name for the sample information file, in the File menu, 



190 Chapter 4 Sample Information Editor

click on Save  Sample Info File. Type a name for the new sample 
information file, then click on Save.

2. In the Edit menu, click on Parameter List... 

- or -

Click with the right mouse button anywhere on the background area in the 
Sample Information Editor. In the pop-up that appears, select Parameter 
List... 

The Sample Information Parameters dialog appears.

3. In the Available list, click on a parameter to select it. (To deselect the 
parameter, click again.) The parameters are shown in alphabetical order.

4. Click on the arrow button that points to the list where you wish to move the 
selected parameter. Parameters marked with an asterisk (*)override settings in 
the method.

If the entry for the parameter is common to all samples, move the parameter 
to the Common list. 

If the entry for the parameter varies for each sample, move the parameter 
to the Variable list. For example, the analyst name might be the same for 
all samples, while the sample IDs would vary for each sample. 

The parameter is removed from the Available list and appears in the list 
you chose. 

To change your selections, click on a parameter in the Common list or in 
the Variable list, then click on an arrow pointing back to the Available 
list. 

The parameter is returned to the Available list.

5. Select additional parameters, if desired, and move them to the appropriate lists. 
When you are finished, click on OK.
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In the Sample Information Editor, use the scroll bars to see the changes you 
made. Parameters that you added to the Common list appear in the Common 
Parameters table, and those added to the Variable list appear in the 
Parameters That Vary by Sample table. 

To remove parameters from the Sample Information Editor

To remove parameters from the Parameters Common to All Samples table:

Click with the right mouse button anywhere on the background area in the 
Sample Information Editor. In the pop-up that appears, select Parameter 
List... Click on a parameter in the Common list, then click on an arrow 
pointing back to the Available list.

To remove parameters from the Parameters That Vary By Sample table:

Click with the right mouse button anywhere on the background area in the 
Sample Information Editor. In the pop-up that appears, select Parameter 
List... Click on a parameter in the Variable list, then click on an arrow pointing 
back to the Available list.

To save the sample information design

1. In the File menu, click on Save As  Sample Info Design... The Save As 
dialog appears.

2. Type a name for the design, then click on OK.

Opening a Stored Sample Information File

1. In the File menu, click on Open  Sample Info File... The Open Sample 
Information dialog appears.

2. Select the sample information file that you want to open, then click on Open.

Modifying a Stored Sample Information File

1. In the File menu, click on Open  Sample Info File...
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2. Select the sample information file that you want to open, then click on Open.

3. You can customize the Sample Information Editor by selecting the parameters 
you need to describe your samples. See Customizing the Sample Information 
Editor earlier in this chapter.

4. Change the sample information as desired.

5. Change the information in the File Description field as desired, using the pop-
up menu for editing commands. 

6. Save the file:

To save the file with the same name, click on Save  Sample Info File 
in the File menu. 

To save the file with a new name, click on Save As  Sample Info File... 
in the File menu. The Save As dialog appears. Type a name for the file, 
then click on Save.

Note If you modify a sample information file and then attempt to create a new 
one, a message appears asking if you wish to save the changes to the first 
sample information file. This also happens when you attempt to exit the 
WinLab32 software.
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Printing a Sample Information File

To print the contents of a sample information file:

1. Click on the Sample Information Editor to make it active. Note that the title bar 
of an active window is a different color from other windows. (The colors that 
appear on the screen depend on the colors you have selected in your 
Windows® application.)

2. In the File menu, click on Print Active Window. 

3. In the Print dialog that appears, check that the correct printer is shown. To 
select a different printer, click on the drop-down arrow in the File Name field 
and make a selection. To make other changes, such as paper size or graphic 
attributes, click on the Properties button.

4. Click on OK to start printing.

Editing Sample Information Parameters

You can edit the entry fields and add or delete rows in the Parameters that Vary by 
Sample table.

To clear information in the table

When you clear information, the content in an entry field is removed, not the entry 
field itself. 

1. Click on the entry field that contains the information you want to remove.

2. In the Edit menu, click on Clear.

- or -

Click with the right mouse button. A pop-up menu appears. Click on Clear. 

- or -

Press the Delete (Del) key. 
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To insert rows in the table

When you insert rows, the new rows are inserted before the first row you select in 
the table.

1. Select a row in the table by clicking on a number in the Sample Number 
column of the table. The entry fields in the row become highlighted to indicate 
that the row is selected. 

2. If you want to insert more than one row, you select the same number of rows 
in the table. For example, to insert three new rows, you would select three 
existing rows. To select additional rows, hold down the Shift key while 
clicking on additional row numbers.

3. In the Edit menu, click on Insert Rows.

- or -

Click with the right mouse button. A pop-up menu appears. Click on Insert 
Row.

To delete rows in the table

When you delete rows, the contents of the row and all the entry fields in the row 
are removed.

1. Select a row in the table by clicking on a number in the Sample Number 
column of the table. The entry fields in the row are highlighted to indicate that 
the row is selected. 

2. To select additional rows, hold down the Shift key while clicking on additional 
row numbers.

3. In the Edit menu, click on Delete Rows.

- or -

Hold down the right mouse button. A pop-up menu appears. Click on Delete 
Rows.
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Sample Information Editor Pop-Up Menus

The following pop-up menus contain several convenient commands as you work 
with the Sample Information Editor. 

To display the pop-up menus

Click with the right mouse button in the Sample Information Editor. 

When you click with the right mouse button in the Parameters that Vary by 
Sample table, a pop-up menu containing editing commands for the table 
appears. 

When you click with the right mouse button anywhere on the background 
area in the window, the Sample Information Editor pop-up menu appears.

Sample Information Editor pop-up menu

Command Description

Parameter List... Adds new parameters to the Sample Information 
Editor.

New Sample Info 
File...

Selects a design and a creates a name for the new 
sample information file. 

Open Sample Info Opens a stored sample information file.
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Table editing pop-up menu

Save Sample Info Saves the contents of the Sample Information Editor 
using the same file name.

Save Sample Info 
As...

Saves the contents of the Sample Information Editor 
using a new file name.

Save As Text... Saves the contents of the Sample Information Editor to 
a text file or comma-delimited ASCII file. 

Save Sample Info 
Design As...

Saves the configuration of the Sample Information Edi-
tor as a design file. You can use a design file to quickly 
customize the Sample Information Editor with the 
parameters you need to describe your samples.

Print... Prints the contents of the Sample Information Editor.

Print Preview... Displays the formatted sample information report in a 
preview window. Use the Zoom In and Zoom Out but-
tons to enlarge or reduce the report. Click on Close to 
return to the Sample Information Editor.

Command Description

Clear Removes the contents of the selected entry fields. 

Insert Row Inserts a new row before the currently selected row. 

Delete Rows Removes the selected rows in the table. 

Command Description
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Sample Information Parameters and Dialogs
Sample Information parameters

The parameters in the Sample Information Editor fall into three different 
categories:

Column Fill... Displays the Column Fill dialog for the selected col-
umn. You use this dialog to automatically enter infor-
mation for a range of samples. 

Entry Dialog... Displays the Entry dialog for the selected entry field. 
You use this dialog to type information for a text entry 
field. 

Parameter Description

Sample Description parameters These parameters include the sample 
and batch names used to identify the 
sample, the autosampler location, and 
other optional information for describ-
ing the sample.

Sample Preparation parameters These parameters include information 
about the way in which the sample was 
prepared and the units in which the final 
sample concentrations will be reported.

Analysis Schedule parameters These parameters are used to schedule 
QC’s, periodic recalibration, and matrix 
check samples. You can also select a 
Read Delay or Wash Time for a sample 
that differs from the method.

Command Description
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Sample Information dialogs

Aliquot Volume Column Fill Dialog
Analyze QC's Before Column Fill Dialog
Autosampler Location Column Fill Dialog 
Diluted to Volume Column Fill Dialog 
Initial Sample Volume Column Fill Dialog 
Initial Sample Weight Column Fill Dialog 
Matrix Check Sample Entry Dialog 
Remarks Entry Dialog 
Sample ID Column Fill Dialog
Sample Information Editor Column Fill Dialogs
Sample Information Parameters Dialog
Sample Units Column Fill Dialog
Solids Ratio Column Fill Dialog
Units Column Fill Dialogs
User Defined Entry Field Dialog 

Sample Description Parameters

Batch ID

This is the name you give to this batch of samples. 

Type up to 25 characters for each sample. You can use any combination of 
letters and numbers.

- or -

To automatically enter a sequence of IDs, double-click on an entry field and 
use the Column Fill dialog.
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Sample ID

This is the name you give to each sample.

Type up to 25 characters for each sample. You can use any combination of 
letters and numbers.

- or -

To automatically enter a sequence of IDs, double-click on an entry field and 
use the Sample ID Column Fill dialog.

Remarks

Click on the entry field. The Remarks Entry dialog appears, in which you can type 
up to 50 characters.

Autosampler Location

This is the location of the solution in the autosampler tray.

Type the location for each solution.

- or -

To automatically enter the locations for a sequence of samples, double-click on 
an entry field and use the Autosampler Location Column Fill dialog.

Analyst Name

This is the name of the person setting up or performing the analysis. 

Type up to 20 characters for each sample. You can use any combination of 
letters and numbers.

- or -

To automatically enter a sequence of names, double-click on an entry field and 
use the Column Fill dialog. Note: If the name is the same for all samples, assign 
this parameter to the Parameters Common to All Samples table.
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User Defined...

Use this parameter to define your own parameter. For example, you may want to 
record an account name for the batch of samples. You can customize up to five 
sample information parameters. Select User Defined... in the list of parameters, 
then type a name for the parameter using up to 20 characters in the User Defined 
Entry field dialog. 

Sample Preparation Parameters

Use the following guidelines when entering information about sample preparation 
in the Sample Information Editor. 

                                    Sample Preparation Parameters

If your 
Calibration 
Units are...

And your 
Sample Units 
are...

Initial Sample 
Weight 
and Sample Prep 
Vol.

Initial Sample Vol. 
and Sample Prep 
Vol.

Aliquot Volume 
and 
Diluted to 
Volume.

Wt/Vol Wt/Wt Required * Optional
(but must enter 
both)

Wt/Vol Wt/Vol Enter both or
omit both*

Optional
(but must enter 
both)

Wt/Wt Wt/Wt Not used in conver-
sion

Not used in conver-
sion

Optional
(but must enter 
both)

Wt/Wt Wt/Vol The software will not convert Wt/Wt calibration units to Wt/Vol 
sample units. The software will only report the sample concentra-
tion in calibration units, not sample units. 
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Sample Preparation Parameters

The Sample Preparation parameters are shown below. For an example using Initial 
Sample Weight, Sample Prep Volume, Aliquot Volume, and Diluted to Volume 
see, Sample Preparation: An Example later in this chapter.

Aliquot Volume

If an aliquot of the sample solution is taken and diluted to a final volume, record 
the aliquot volume for this entry and the final volume for the Diluted to Volume 
entry.

Enter the volume using the units selected for the Volume Units. To automatically 
enter the same value for a sequence of samples, double-click on an entry field and 
use the Aliquot Volume Column Fill dialog.

Diluted to Volume

This is the final volume of solution obtained by diluting an aliquot of the sample 
solution.

You can also record the dilution as the ratio of the original sample volume to the 
final sample volume. For example, if 10 mL of sample is diluted to 200 mL, this 

Notes * Without the required entries, the software will only report the sample 
concentration in calibration units, not sample units. If both entries are 
required and you only enter one, again, the concentration in sample units 
will not be reported. 

If you enter the Aliquot Volume, you must also enter the Diluted to 
Volume for correct reporting of results.

You select calibration units and sample units in the Method Editor on the 
Calibration Units and Concentrations page. Or, you can select sample units 
in the Sample Information Editor. If the sample units in the Sample 
Information Editor differ from those in the Method Editor, the sample units 
in the Sample Information Editor will be used. 



202 Chapter 4 Sample Information Editor

ratio would be 10:200 or 1:20. Enter 20 for the Diluted to Volume entry and 1 for 
the Aliquot volume.

Enter the volume using the units selected for the Volume Units. To automatically 
enter the same value for a sequence of samples, double-click on an entry field and 
use the Diluted to Volume Column Fill dialog.

Solids Ratio

This is the ratio of the wet and dry weights for the sample. This ratio is used to 
correct the sample concentration. For more information, see the Solids Ratio 
Column Fill dialog later in this chapter.

Initial Sample Weight

If you weigh the sample during sample preparation, you must enter the Initial 
Sample Weight and the Sample Prep Volume. 

Enter the weight using the units selected for the Weight Units. To automatically 
enter the same value for a sequence of samples, double-click on an entry field and 
use the Initial Sample Weight Column Fill dialog.

Initial Sample Volume

If you measure the sample volumetrically during sample preparation, you can enter 
the Initial Sample Volume and the Sample Prep Volume. 

Enter the volume using the units selected for the Volume Units. To automatically 
enter the same value for a sequence of samples, double-click on an entry field and 
use the Initial Sample Volume Column Fill dialog. 

Weight Units

Select the units for the weight value(s) you enter for each individual sample or for 
all samples. These weight units are used for the Initial Sample Weight and the 
Nominal Sample Weight entries.

To automatically enter the same value for a sequence of samples, double-click on 
the column header and use the Units Column Fill dialog. 
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Volume Units

Select the units for the volumes you enter for each individual sample or for all 
samples. These weight units are used for the Initial Sample Volume, the Sample 
Prep Volume, the Aliquot Volume, and the Diluted to Volume entries.

To automatically enter the same value for a sequence of samples, double-click on 
the column header and use the Units Column Fill dialog. 

Sample Prep Volume

After a solid sample has been dissolved or a liquid sample has been acidified (or 
otherwise treated), the resulting solution is prepared to a specific volume. This is 
the Sample Prep Volume. 

Enter the volume using the units selected for the Volume Units. To automatically 
enter the same value for a sequence of samples, double-click on an entry field and 
use the Column Fill dialog.

Nominal Sample Weight

This is the target weight when samples are weighed. This entry is required only if 
corrections are being made to weight/volume measurements to compensate for 
weight variations among samples. The Nominal Sample Weight is divided by the 
Initial Sample Weight to correct the final concentration value.

Enter the weight using the units selected for the Weight Units. To automatically 
enter the same value for a sequence of samples, double-click on an entry field and 
use the Column Fill dialog.

Sample Units

These are the units used to report the concentrations of the samples. If the sample 
units in the Sample Information Editor differ from those in the Method Editor, the 
sample units in the Sample Information Editor will be used. You can select 
different sample units for different samples in the Sample Information Editor, but 
concentrations for all elements will be reported using the same units. 

To automatically enter the same value for a sequence of samples, double-click on 
the column header and use the Sample Units Column Fill dialog. 
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To select your own units

The units available in the drop-down lists are stored in an ASCII file called 
UNITS.INI located in the WinLab32 directory. You can use any text editor to add 
units to the file. You may also rearrange the units in the file so that those used 
frequently are near the top of the list. 

To modify the UNITS.INI file.

1. In Windows operating system, start the Windows Explorer.

2. Display the WinLab32 directory.

3. Double-click on the units.ini file. 
The Notepad application is automatically started and the UNITS.INI file is 
opened.

The UNITS.INI file contains four sections: volume units [Vol], weight units 
[Wt], weight/volume units [Wt/Vol] and weight\weight [Wt/Wt] units. The 
first unit in each section is the base unit and has a conversion factor of 1.0. Do 
not change or move the base unit. 

4. Add the units and the conversion factor to the appropriate section of the file 
using the following format.

Units12=new_units,conversion factor

The conversion factor is multiplied by the value in new units to convert it to a 
value in base units. For example, to convert milliliters to the base unit of liters, 
1 mL = 1.0E-3 L, so the conversion factor is 1.0E-3.

5. In the File menu, click on Save.

6. Restart the WinLab32 software.
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Sample Preparation: An Example

The following is an example of sample preparation: 

An analyst weighs 1.54 grams of sample into a beaker. This is the Initial Sample 
Weight.

Next, hydrochloric acid is added to the sample and the solution is heated so that the 
sample is dissolved. After the solution is allowed to cool, the analyst quantitatively 
transfers it into a 250 mL flask and fills the flask to the 250 mL mark. This is the 
Sample Prep Volume. 

A 10 mL aliquot of this solution (the Aliquot Volume) is pipetted into a 100 mL 
volumetric flask and diluted to the 100 mL mark. This is the Diluted to Volume.

To summarize, for the above example, you would enter the following values:

Analysis Schedule Parameters

Recalibration Before

Select a recalibration, reslope, or autozero before the solution identified in this row 
is analyzed. Select None or leave the entry field blank if you do not want any of 
these options performed before this solution. To automatically enter the same 
information for a sequence of samples, double-click on an entry field and use the 
Recalibrate Before Column Fill dialog. 

Initial Sample Weight 1.54 grams

Sample Prep Volume 250 mL

Aliquot Volume 10 mL

Diluted to Volume 100 mL

Note You can also record the Diluted to Volume as the ratio of the original 
sample volume to the final sample volume. In this example, 10 mL of 
sample is diluted to 100 mL, so the ratio would be 10:100 or 1:10. You can 
enter 1 for Aliquot Volume and 10 for Diluted to Volume.
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Matrix Check Samples

Use this parameter when analyzing a pair of matrix check samples. The first sample 
in the pair is the reference sample and the second sample is the matrix check 
sample. The first sample must be scheduled for analysis before the second sample. 
Double-click on the entry field for the second sample in the pair of matrix check 
samples. The Matrix Check Sample Entry dialog appears, in which you select 
options for the matrix check calculation and identify the two samples in the matrix 
check pair.

Analyze QCs Before

Use this parameter to analyze quality control samples before the selected samples. 
Type the numbers of the QC samples in the entry field. These numbers are found 
in the QC section of the method. Type individual QC numbers or a range of QC 
numbers. Use commas to separate the numbers and ranges. Example:  1, 3-5.

To analyze QC samples at a specified frequency, double-click on the entry field. 
The Analyze QCs Before Column Fill dialog appears.

Read Delay

Use this parameter to use a Read Delay that differs from the read delay that is 
entered in the method. Enter the Read Delay in seconds. To automatically enter the 
same value for a sequence of samples, double-click on the column header and use 
the Column Fill dialog.

Wash Time

Use this parameter to use a Wash Time that differs from the Wash Time that is 
entered in the method. Enter the Wash Time in seconds. To automatically enter the 
same value for a sequence of samples, double-click on the column header and use 
the Column Fill dialog. Note that the Wash Frequency is selected in the method. 
You must select Between Samples for the Wash Frequency in order for a wash to 
occur.

Note Periodic QC Scheduling in the sample information file will override 
Periodic QC Scheduling in the Method Editor. 
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Sample Information Parameters Dialog

You use this dialog to select the exact parameters that you need to describe your 
samples. You also modify the maximum number of samples displayed in the 
Sample Information Editor.

To display this dialog

1. Display the Sample Information Editor.

2. In the Edit menu, click on Parameter List... 

- or -

Click with the right mouse button anywhere on the background area in the 
Sample Information Editor. In the pop-up that appears, select Parameter 
List... 

The Sample Information Parameters dialog appears.
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To add parameters to the Sample Information Editor

1. In the Available list, click on a parameter to select it. (To deselect the 
parameter, click again.) The parameters are shown in alphabetical order.

2. Click on the arrow button that points to the list where you wish to move the 
selected parameter. Parameters marked with an asterisk (*)override settings in 
the method.

If the entry for the parameter is common to all samples, move the parameter 
to the Common list. 

If the entry for the parameter varies for each sample, move the parameter 
to the Variable list. For example, the analyst name might be the same for 
all samples, while the sample IDs would vary for each sample. 

The parameter is removed from the Available list and appears in the list 
you chose.

To change your selections, click on a parameter in the Common list or in 
the Variable list, then click on an arrow pointing back to the Available 
list.

The parameter is returned to the Available list.

3. Select additional parameters, if desired, and move them to the appropriate lists. 
When you are finished, click on OK.

In the Sample Information Editor, use the scroll bars to see the changes you 
made. Parameters that you added to the Common list appear in the Common 
Parameters table, and those added to the Variable list appear in the 
Parameters that Vary by Sample table.

To specify the maximum number of samples:

Use the up or down arrows to specify the number of samples you have and then 
click on OK. In the Sample Information Editor, the Parameters that Vary by 
Sample table will contain this number of rows, one for each sample. 



209Sample Information Parameters and Dialogs

User Defined Entry Field Dialog

You use this dialog to enter a name for a parameter you want to add to the Sample 
Information Editor. You can select a common user defined entry field for all 
samples or you can vary the information in this entry field by sample. For more 
information, see Customizing the Sample Information Editor earlier in this chapter. 

To display this dialog

This dialog automatically appears when you select a User Defined Entry field in 
the Sample Information Parameters dialog.

To define the entry field

Type a name for the entry field using up to 20 characters, then click on OK. The 
entry field is added to the Sample Information Editor. 

Sample Information Editor Column Fill Dialogs

To automatically enter information for a range of consecutive samples, the Sample 
Information Editor contains Column Fill dialogs.

To display a Column Fill dialog

Double-click on either an entry field in the column or the column header.

To automatically enter information for a range of samples

1. Type the information in the entry field in the dialog. Enter values or text, as 
appropriate for the entry field. For a definition of the sample parameter, see 
Sample Information Parameters and Dialogs earlier in this chapter.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the values in the Sample Information Editor.
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To display a Column Fill dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Autosampler Location Column Fill Dialog

You use this dialog to enter autosampler locations for a range of consecutive 
samples in the Sample Information Editor. 
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To display this dialog

Double-click on either an entry field in the column or the column header.

To automatically enter autosampler locations for a range of samples

1. Select the first autosampler location for this range of samples in the Starting 
Location box. 

2. Select the increment for the autosampler locations. For example, if you want 
to fill each autosampler location, select 1. If you want to fill every other 
location, select 2.

3. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

4. Click on OK. The software enters the IDs in the Sample Information Editor.

To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Sample ID Column Fill Dialog

You use this dialog to enter Sample IDs for a range of consecutive samples in the 
Sample Information Editor. The sample IDs have a common prefix, followed by a 
variable number, followed by a common suffix. For example: water1march95 and 
water2march95. 
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To display this dialog

Double-click on either an entry field in the column or the column header.

To automatically enter sample IDs for a range of samples

1. Type the sample ID prefix. This is a combination of numbers or letters that will 
precede the sample ID number. The total number of characters allowed for the 
prefix, number, and suffix is 25.

2. Type the sample ID number. This number will be incremented by the value you 
select in the Increment by box.

3. Type the sample ID suffix. This is a combination of numbers or letters that will 
follow the sample ID number.

4. Select a value for the increment. The Sample ID number is incremented by this 
value.

5. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

6. Click on OK. The software enters the IDs in the Sample Information Editor.
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To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Sample Units Column Fill Dialog

You use this dialog to enter the same sample units for a range of consecutive 
samples in the Sample Information Editor. The sample units that you enter in the 
Sample Information Editor will be used in place of the units selected in the method.

To display this dialog

Double-click on either an entry field in the column or the column header.

To automatically enter sample units for a range of samples

1. Select the units in the list.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the units in the Sample Information Editor.

To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.
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Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Units Column Fill Dialogs

You use these dialogs to enter the same Weight Units or Volume Units for a range 
of consecutive samples in the Sample Information Editor. 

To display these dialogs

Double-click on the column header for Weight Units or Volume Units.

To automatically enter units for a range of samples

1. Select the units in the list.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the units in the Sample Information Editor.

To display these dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...
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Sample Information Editor: Initial Sample Weight Column Fill Dialog

If the final sample concentrations are being reported in weight/weight units, you 
must enter the sample weights in the Sample Information Editor. You use this 
dialog to enter the same Sample Weights for a range of consecutive samples.

To display this dialog

Double-click on either an entry field in the column or the column header.

To automatically enter initial sample weights for a range of samples

1. Type a value for the initial sample weight.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the values in the Sample Information Editor.

To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...
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Sample Information Editor: Initial Sample Volume Column Fill Dialog

You use this dialog to enter the same Initial Sample Volumes for a range of 
consecutive samples in the Sample Information Editor.

To display this dialog

Double-click on either an entry field in the column or the column header.

To automatically enter initial sample volumes for a range of samples

1. Type a value for the initial sample volume.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the values in the Sample Information Editor.

To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Aliquot Volume Column Fill Dialog

You use this dialog to enter the same aliquot volume for a range of consecutive 
samples in the Sample Information Editor. 

To display this dialog

Double-click on either an entry field in the column or the column header.
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To automatically enter aliquot volumes for a range of samples

1. Type a value for the aliquot volume.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the values in the Sample Information Editor.

To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Diluted To Volume Column Fill Dialog

You use this dialog to enter the same final sample volume for a range of 
consecutive samples in the Sample Information Editor.
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To display this dialog

Double-click on either an entry field in the column or the column header.

To automatically enter final sample volumes for a range of samples

1. Type a value for the final sample volume.

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the values in the Sample Information Editor.

To display this dialog and pre-select a range of samples

If desired, you can pre-select the range of samples in the Sample Information 
Editor by selecting a range of entry fields in the column. When the dialog is 
displayed, this range will automatically be entered.

Click on the first row in the range of samples and drag the mouse cursor over 
the entry fields that you want to fill in the column. The rows are highlighted. 
In the Edit menu, click on Column Fill...

Sample Information Editor: Recalibrate Before Column Fill Dialog

You use this dialog to enter the same recalibration information for a range of 
consecutive samples in the Sample Information Editor. 

To display this dialog

In the Sample Information Editor, double-click on either an entry field in the 
Recalibrate Before column or the column header.
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To automatically enter recalibration information for a range of samples

1. Select a recalibration, reslope, or autozero before the solution identified in this 
row is analyzed. Select None or leave the entry field blank if you do not want 
any of these options performed. 

2. Select the frequency in which you want to recalibrate, then select the sample 
numbers for a range of samples. For example, to recalibrate before every five 
samples in a range numbered 10 through 20, select Schedule after every 5 
samples, then select 10 for the Start number and 20 for the End number. In this 
example, the software would automatically recalibrate before Sample 
Numbers 15 and 20.

Sample Information Editor: Analyze QCs Before Column Fill Dialog

You use this dialog to schedule quality control samples. 

To display this dialog

In the Sample Information Editor, double-click on either an entry field in the 
Analyze QCs Before column or the column header.

To schedule the QC samples

1. Type the numbers of the QC samples in the entry field. These numbers are 
found in the QC section of the method. Type individual QC numbers or a range 
of QC numbers. Use commas to separate the numbers and ranges.
Example:  1, 3-5.

2. Select the frequency in which you want to analyze the QC samples, then select 
the sample numbers for a range of samples. For example, to analyze the QCs 
before every five samples in a range numbered 10 through 20, select Schedule 
after every 5 samples, then select 10 for the Start number and 20 for the End 
number. In this example, the software would automatically enter the QC 
sample numbers to be analyzed before Sample Numbers 15 and 20.
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Sample Information Editor: Solids Ratio Column Fill Dialog

You use this dialog to enter the ratio of the wet and dry weights for the sample. 

To display this dialog

In the Sample Information Editor, double-click on an entry field in the Solids 
Ratio column.

To enter the solids ratio

1. You may enter this ratio in one of two ways, depending on how you want to 
report the results.

If you are analyzing a dry sample and want the result converted to a wet 
basis, enter the ratio of dry weight divided by wet weight.

- or -

If you are analyzing a wet sample and want the result converted to a dry 
basis, enter the ratio of wet weight divided by dry weight. 

In either case, the concentration in calibration units is multiplied by the solids 
ratio as part of the conversion from concentration in calibration units to 
concentration in sample units. 

2. Select the sample number range for your group of samples:

In the Start box, select the sample number for the first sample in the group.

In the End box, select the sample number for the last sample in the group.

3. Click on OK. The software enters the values in the Sample Information Editor.
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To convert a measured concentration in calibration units to a final concentration in 
sample units:

Sample Information Editor: Remarks Entry Dialog

You use this dialog to enter comments about a sample or batch of samples. 

To display this dialog

In the Sample Information Editor, click on the Remarks entry field.

To enter remarks

Type up to 50 characters of text, then click on OK.
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C  = concentration in sample units
f   =  convert sample units to wt / wt (mg / g) or wt / vol (mg / L) base units
C  =  concentration in calibration (standard) units
f   =  convert calib units to wt / vol (mg / L)  base units
Q  =  initial sample quantity (wt or vol) converted to wt (g) or vol (L) base units
V  =  sample preparation volume converted to vol (L) base units
V  =  diluted to volume converted to vol (L) base units
V  =  aliquot volume converted to vol (L) base units
SR =  solids ratio

Note:  All f  values are taken from the units.ini file.

:
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Sample Information Editor: Matrix Check Sample Entry Dialog

To display this dialog

In the Sample Information Editor, double-click on an entry field in the Matrix 
Check Sample column. You should select the entry field for the second sample 
in the pair of matrix check samples.

- or -

In the Sample Information Editor, click on an entry field in the Matrix Check 
Sample column, then click using the right mouse button and in the pop-up 
menu that appears, click on Entry Dialog.... 
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To select options for the matrix check calculation

1. Select an option:

Duplicate
A matrix check duplicate measurement is performed. The software calculates 
the relative percent difference using the equation:

where:
conc #1 = the result obtained for the concentration of the reference sample
conc #2 = the result obtained for the concentration of the duplicate sample

Recovery Set Number
A spike recovery measurement is performed. Select the number of the recovery 
set on the Checks page of the Method Editor. The recovery set number 
indicates the analyte concentrations added to the reference sample to create the 
recovery sample. The software calculates the spike recovery for each analyte 
using the equation:

where:
conc #1 = the result obtained for the concentration of the reference sample
conc #2 = the result obtained for the concentration of the recovery sample

Relative % Difference =    |conc. #1 -  conc. # 2|  X 100
(conc. #1 +  conc. # 2) 2 ÷

Spike % Recovery =    (conc. # 2 -  conc. #1)
spike conc. added

 X 100
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Diluted x fold
A matrix check dilution measurement is performed. Enter the dilution factor. 
This is the ratio of the original sample volume to the final sample volume. For 
example, if 1 mL of sample is diluted to 10 mL, type 10. The software 
calculates the percent difference using the equation:

where:
conc #1 = the result obtained for the concentration of the reference sample
conc #2 = the result obtained for the concentration of the diluted sample
DF = dilution factor

2. Select the sample number of the Reference Sample. This is the first sample in 
the pair of matrix check samples. This sample must be scheduled for analysis 
before the second sample in the pair.

3. Check the sample number for the Current Sample. Change the number, if 
necessary, so that it is the matrix check sample, which is the second sample in 
the pair.

% Difference =    |conc.  #1 -  (conc.  # 2  DF)|  X 100×
conc. #1
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About Analysis Control Windows
You can operate the instrument in either a manual mode (with or without an 
autosampler), or in an automated mode (with an autosampler only). When you 
operate in manual mode, you define the order and control the analysis. When you 
operate in automated mode, the application runs Blanks, Standards and Samples in 
a pre-defined order. You can also reprocess data stored in the Results library using 
different analytical conditions such as wavelength, peak processing algorithm, 
background correction, standard concentrations, units of concentration or QC 
concentrations. 

Select the appropriate analysis control window depending on the task you wish 
to perform.

To do this Use

Analyze a few samples manually. Manual Analysis Control 
window

Analyze many samples using an 
autosampler.

Automated Analysis Control 
window

Recalculate stored data using 
different analytical conditions.

Data Reprocessing window
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 Manual Analysis Control Window
You use this window to set up and perform an analysis manually.

To display this window

On the Toolbar, click on Manual.

-or-

In the Tools menu, click on Manual Analysis Control.
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Window Displays

Sample Progress

This display shows the status of the analysis.

Sample Progress shows how much (the approximate percentage) of the anal-
ysis has been completed for the current sample.

Step shows the current operation being performed. 

Window Controls and Entries

Analyze Blank

Click on this button to analyze the calibration or reagent blank solution shown 
in the entry field. When you do this, you are defining the calibration or reagent 
blank for the analysis. To interrupt the blank analysis, click again on Analyze 
Blank. 

To change the blank shown in the entry field, select an option from the drop-
down list. Only the blanks that you have defined in the Calib: IDs and 
Locations page in the active method appear here. 

Analyze Standard

Click on this button to analyze the calibration standard shown in the entry field. 
The results of this analysis are used to set up a calibration. To interrupt the 
standard analysis, click again on Analyze Standard. 

To change the standard shown in the entry field, select an option from the drop-
down list. The list shows all of the standards, including reslope, that you 
defined in the active method. A calibration curve is created after all blanks and 
standards defined in the method are run. To view a calibration curve, click on 
the Calib button, or from the Options menu, click on Calibration Display.

To check the concentration values that were entered for the standard in the 
method, click on Conc.... In the View Standard Concentrations dialog that 
appears, the concentrations and units of each standard are shown. To change 
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the concentration of a standard, use the Method Editor-Calibration-Calib Units 
and Concentration.

Analyze Sample

Click on this button to analyze the sample indicated by the No: (Number) entry 
field. To interrupt the analysis, click again on Analyze Sample.

No. 

This shows the sample number of the current sample in the sample information file. 

Enter a different sample number, if needed. The Sample ID entry field shows 
the ID of the sample you selected. 

ID

This identifies the sample that you are currently analyzing. If you are using a 
Sample Information file, the ID shown in the file appears here. Enter a different ID, 
if needed. 

To add or change dilution or other data for the sample, click on Details... In the 
Sample Details dialog that appears, change the appropriate entries by replacing 
the existing text or selecting an item from a drop-down list. For example, type 
a new Batch ID, then make a selection in the list of Volume Units.

Info File

This shows the sample information file that describes the sample sequence. The 
next sample ID appears in the ID box so you can analyze each sample in the proper 
sequence.

Click on Open... and, in the Open Sample Information dialog that appears, 
select an existing sample information file. If you wish to create a new file, use 
the Sample Information Editor.

Note The sample information file should contain entries for samples only. All 
other solutions, such as blanks and standards, are defined in the Method 
Editor.
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Results Data Set Name

This shows the name of the results data set where the analysis results will be stored. 
Saving data is optional.

To save data, select a results data set name where the data will be stored: Click 
on Open and in the Select Results Data Set dialog that appears, type a new data 
set name or select an existing one. A check mark appears in the Save Data box 
next to During Analysis, confirming that data will be saved.

If you do not want to save data, disable Save Data, or do not specify a results 
data set name.

During Analyses

This shows two options for handling data generated in an analysis.

Save Data
When you select a results data set name, this box is selected automatically (a 
check mark appears) confirming that data will be saved.

Print Log
Select the Print Log box to print a log of signals, analytical results, and other 
information about the analysis. The log includes an analytical header and, for 
each sample, a sample header and the data that is shown in the Results Display 
window.   Look at all of the selections on the Method Editor Window Options 
page to get an overview of the selected analytical results that will appear in the 
printout. 

Note To be able to reprocess data, it must be saved.

Note For information on the amount of disk storage space that is required for 
your results, see Equation for Calculating Disk Storage for Results later in 
this chapter.
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Go to A/S Loc>> 

Click on this button to move the probe to the selected autosampler location 
shown in the entry field. The Auto Sampler Monitor reflects the change.

Go to Wash Location

Click on this button to move the probe to the wash location. The Auto Sampler 
Monitor reflects the change.

Read Delay (sec)

This is the time, in seconds, that the system waits after it receives an analyze 
command before it starts to measure the signal. This delay allows the sample to 
reach the plasma before measurement begins. If the method contains a flush time 
that is greater than zero, the system will perform a sample flush before beginning 
the read delay. By default, the read delay from the method will be used.

To use a read delay that is different than that shown in the method, select the 
Override Method box and enter a new read delay value.

Override Method

When using the Read Delay process, this box controls whether the instrument will 
use the values in the active method or the changes you make in this window. If it 
is left blank, the values in the active method are used. If the Override Method box 
is checked, the values entered in this page are used. The values entered in the 
method are not changed.

View Standard Concentrations Dialog

This is an information-only dialog that provides the concentrations and units for the 
standards in the active method. You cannot make changes in this dialog. You must 
use the Method Editor, Calibration, Calib Units and Concentration to make any 
changes. 
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To display this dialog

In the Manual Analysis Control window, click on Conc.... 

Using this dialog

Select the standard of interest from the drop-down list. The table shows the ID, 
concentration and units of the analytes present in the standard, according to the 
active method.

To change any of these parameters, go to the Method Editor, Calibration pages: 
Define Standards and Calib Units and Concentration. 

Sample Details Dialog

You use this dialog to view and change parameters in the current Sample 
Information file during manual analysis.

To display this dialog

In the Manual Analysis Control window, click on Details.

Using this dialog

Review the parameter values and make changes as desired. For example, to 
enter a Batch ID, double-click in the Batch ID entry field and type a name. To 
enter Volume Units, click in the Volume Units entry field and select units from 
the drop-down list.

Changes made using this dialog will be reflected in the active sample 
information file. If you want to save the parameters entered using this dialog, 
save the active sample information file.

Parameters Common to All Samples

These are parameters that are the same for all samples such as the Batch ID and 
volume and weight units. The parameters that appear in this dialog depend on the 
parameters in the active Sample Information file. Refer to the Sample Information 
for details on the individual parameters.
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Parameters that Vary by Sample

These are parameters that vary for individual samples, such as the sample ID, A/S 
location and the initial sample weight. The parameters that appear in this dialog 
depend on the parameters in the active Sample Information file. Refer to Sample 
Information for details on the individual parameters. 

Select Results Data Set Name

You use this dialog to create a new, or select an existing data set for saving results 
or reprocessing data.

To display this dialog

In the Manual Analysis Control window, the Automated Analysis Control 
window: Set Up page, or the Interelement Correction Model Builder, click on 
Open... next to Results Data Set Name. 

In the Data Reprocessing window, click on Browse... next to Reprocessed 
Data Set or Data Set to Reprocess. 

Check the Results Database Library location

The current database library location is shown. This is where the results data set 
will be stored.

To change the library location:

1. Click on Browse.

2. In the Open dialog that appears, select the directory and click Open.

3. In the Select Results Data Set dialog, click on the name of the data set you want 
to use.

4. Click on OK.
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To select a results data set for saving data

To create a new data set, type a name in the Name entry field and click on OK. 
The Results Data Set dialog closes and the name you typed appears in the 
window where you initiated the command.To save results to an existing data 
set:

Click on the name of the results data set in the table, then click on OK.

-or-

Double-click on the results data set name.

Automated Analysis Control Window
When you want to perform an automated analysis, (the application runs blanks, 
standards and samples in a pre-defined order) use this window to control the system 
and autosampler.

To display this window

On the Toolbar, click on Auto.

-or -

From the Tools menu, click on Automated Analysis Control.

Automated Analysis Control window pages

Click on the labeled tabs in the Automated Analysis Control window to display the 
following pages. 

• Set Up. This page defines the methods and sample information files to be used, 
where to store analytical data, and other setup parameters, such as wavelength 
recalibration, automatic shutdown and automatic export. You are not required 

Note You can only have the Manual Analysis or Auto Analysis or Reprocessing 
window open at one time.
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to enter any information on this page. By default the method in memory will 
be used for the analysis. Note the other settings that are selected. You can 
change any of them that you wish.

• Analyze. This page indicates instrument analysis status, controls the 
instrument and autosampler and contains options for starting and stopping an 
analysis.

Using a sample information file

Usually, you enter information in the method for analyzing blanks, calibration 
standards, and QC samples. If, however, you wish to analyze any of the blanks, 
calibration standards, or QC samples as samples, you must enter their IDs in the 
sample information file. As a result, they will be treated like samples in addition to 
the usage specified in the method.

Automated Analysis Control: Set Up Page
You use this page to select methods and a Sample Information file. You also can 
select a results data set to store the data, print an analysis log, and select other 
actions to occur during an analysis.

Note You can change setup options even after an analysis has begun by 
returning to the Set Up page.
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To display this page

Click on the Set Up tab on the bottom of the Automated Analysis Control 
window.

Methods and Sample Locations

Method

You use this entry field to select the methods for the automated analysis.

Double-click on an entry field in the Method column. In the Open Method 
dialog that appears, select a method.

Note To select more than one method, you must first select Open Methods in 
List on the Setup page. This option is located below the Methods and 
Sample Locations table. You can select up to 50 methods.

The Automated 
Analysis 
Control window: 
Set Up Page.
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Delay

This is the time, in minutes, that the system waits before it starts the method. 
(Maximum of 99 minutes)

Sample Info File

By selecting samples from a sample information file, information you have 
supplied about the samples (for example, sample weights or dilutions) is used in 
the analysis. Use this column to specify the samples you want to use from a sample 
information file. First, open a sample information file. Then, select the check box 
for Use Sample Information below the name of the sample information file. Then 
three options appear in the Sample Info File column in a drop-down list. If you 
want to analyze all of the samples in the sample information file, select All Defined 
from the drop-down list. If you want to select only certain autosampler locations, 
select Locations. If you want to select samples by the sample numbers listed in the 
sample information file, select Sample Nos. 

Locations

If you do not want to analyze all of the samples in the sample information file, use 
this entry field to select only the autosampler locations of the samples that you want 
to analyze. If you have selected All Defined or Sample Nos. in the Sample Info File 
drop-down list, you cannot enter locations here. If you have not selected the check 
box for Use Sample Information below the name of the sample information file, 
the locations do not apply to a sample information file. 

Type individual locations or a range of locations. Use commas to separate the 
locations and ranges. It is not necessary to enter the locations of blanks, QC’s, 
check or calibration solutions. Enter locations for these if you want them to be 
treated as a sample within the analysis.

Example: 10-15,18,20,22,25-30.

Sample Nos.

If you do not want to analyze all the samples in the sample information file, use this 
entry field to select only the sample numbers that you want to analyze. If you have 
selected All Defined or Locations from the Sample Info File drop-down list, you 
cannot enter sample numbers here.
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Example: If you only want to analyze #s 1, 3, 4, and 5, but not #2, in the Sample 
Info File column, select Sample Nos. This opens the Sample numbers field so that 
the sample numbers can be entered.

Method Source

Choose Use Method in Memory to use the Method file currently active (and 
displayed on the toolbar.) Choose Open Methods in List if you want to choose one 
or more methods to use during analysis.

Sample Information File

A sample information file stores information about the samples. The system uses 
this file to label the data from your samples and often needs it to calculate final 
concentrations. The sample information file also specifies the autosampler 
locations of the samples.   

To select a sample information file, click on Open. In the Open Sample 
Information dialog that appears, select the name of the file. Then make a 
selection in the Sample Info File column.

Use Sample Information

Select this box to specify the samples you want to use from a sample information 
file and to use the information specified in the Sample Information File (initial 
weight, dilution, volume, etc.) during the analysis. WinLab32 uses the information 
to calculate corrections for final results.

Results Data Set Name

This shows the name of the results data set where the analysis results will be stored. 
Saving data is optional. 

To save data, select a results data set name where the data will be stored: Click 
on Open and in the Select Results Data Set dialog that appears, type a new data 
set name or select an existing one. When you click on OK, the dialog closes 

Note If a sample information file is not entered, the “Untitled” sample 
information file that is currently open in the editor is listed.
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and on the Automated Analysis Set Up page (Method and Sample Locations), 
a check mark appears in the Save Data box, confirming that data will be saved. 

If you do not want to save data, do not specify a results data set name, or click 
on the Save Data check box to clear the check mark. 

Save Data During Analyses

When you select a results data set name, this box is selected automatically (a check 
mark appears) confirming that data will be saved. To select options for the type of 
data to be saved and for the type of results to be displayed and printed, use the 
Options page in the Method Editor.

Additional Options

Auto Shutdown 
To schedule an automatic shutdown, click on Set... In the Automatic 
Shutdown/Startup dialog that appears, select options controlling time of and 
events to occur at shutdown and startup. This feature allows you to shut down 
the plasma at the end of the analysis and start it up again at a later specified 
time.

Auto Export
To automatically export data and write it into a file that can be read by many 
other programs, including spreadsheet and database management programs, 
select this box and click on Set... to select one or two export designs. For more 
information, see the Data Manager Help.

Auto Wavelength Realign
It may be important to correct for small changes in wavelength alignment that 
may occur during an analysis. This is done using the autowavelength realign 
feature. Select this box to have the system perform an auto wavelength realign. 
For more information, see Automatic Wavelength Realignment later in this 
chapter.

Note For information on the amount of disk storage space that is required for 
your results, see Equation for Calculating Disk Storage for Results later in 
this chapter.
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Print Log During Analyses
Select this box to print a log of signals, analytical results, and other information 
about the analysis. The log includes an analytical header and, for each sample, 
a sample header and the data that is shown in the Results Display window as 
selected in the Options page of the Method Editor. Look at the selections on 
the Method Editor Window Options page to get an overview of the selected 
analytical results that will appear in the printout. 

Sample Info File Column Fill dialog

You use this dialog to automatically enter the samples you want to use from a 
sample information file when using several methods in an analysis. 

To display this dialog

On the Set Up page of the Automated Analysis Control window, select the 
Open Methods in List option and then double-click on the Sample Info File 
column header.

To automatically enter sample information for a range of methods

1. In the Automated Analysis Control window, select the methods for the 
analysis. You must have more than one method listed.

2. In the Automated Analysis Control window, open a sample information file.

3. Select the check box for Use Sample Information.

4. On the Set Up page of the Automated Analysis Control window, double-click 
on the Sample Info File column header.

5. In the dialog, select one of the following options:

All Defined
Select this option to analyze all of the samples in the sample information file.

Locations
To analyze only certain autosampler locations listed in the sample information 
file, select this option and enter the locations.
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Sample Nos.
To analyze only certain sample numbers listed in the sample information file, 
select this option and enter the sample numbers.

Automatic Wavelength Realignment

To set the interval time for performing a wavelength realignment, on the 
Automated Analysis Control dialog, click the Set button next to Auto Wavelength 
Realign. In the Automatic Wavelength Realignment dialog that appears, enter the 
interval for the auto wavelength realign. 

To select Start of Analysis or Start of Each Method, click the radio button next to 
these options. To set a different time, click in the check box next to Periodic and 
enter the interval time in minutes. Click on OK to close the dialog.

Append Method
You use this dialog to add methods to a run list after an analysis has started.
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To append a method to a run list:

1. After an analysis has started click the Append Method button, which is 
located on the Automated Analysis Control Window.
The Append Method dialog appears.

2. Double-click on an entry field in the Method column.
The Open Method dialog appears.

3. In the Open Method dialog, select a method.

4. Specify a Delay time for the method you just added.
Delay is the time, in minutes, that the system waits before it starts the method. 
The maximum delay you can specify is 99 minutes.

5. Use the Sample Info File column to specify the samples you want to use from 
a sample information file. By selecting samples from a sample information file, 
information you have supplied about the sample (for example, sample weights 
or dilutions) is used in the analysis.

You can select from three options. If you want to analyze all of the samples in 
the sample information file, select All Defined from the drop-down list. If you 
want to select only certain autosampler locations, select Locations. If you want 
to select samples by the sample numbers listed in the sample information file, 
select Sample Nos.

Note: For this column to be enabled you must have checked Use Sample 
Information on the Set Up tab of the Automated Analysis Control dialog.

6. If you selected Locations from the Sample Info File drop down, then you can 
use this entry field to select only the autosampler locations of the samples that 
you want to analyze. In this field type individual locations or a range of 
locations. Use commas to separate the lcoations and ranges. It is not necessary 
to enter the locations of blanks, QCs, check, or calibration solutions. Enter 
locations for these if you want them to be treated as a sample within the 
analysis.

Note: If you have selected All Defined or Sample Nos. in the Sample Info File 
drop-down list, you cannot enter locations here.  If you have not checked Use 
Sample Information on the Automated Analysis Control Set Up tab, the 
locations do not apply to a sample information file.
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7. If you selected Sample Nos. from the Sample Info File drop down, then use 
this entry field to select only the sample numbers that you want to analyze. 

Note:  If you have selected All Defined or Locations from the Sample Info 
File drop-down list, you cannot enter sample numbers here. 

8. Click the Add Method button.

WinLab32 performs a method and analysis check for the new method.  The 
method now appears in the next available row on the Set Up tab of the 
Automated Analysis Control dialog.  

Note:  Each time you click the Add Method button, the Append Method screen 
is cleared thereby allowing you to add another method.

9. The Append Method dialog will remain open until you click Close. 

Automated Analysis Control: Analyze Page
You use this page to start or stop an analysis, and view and make changes to the 
analytical sequence and monitor the progress of the analysis.

The Automated 
Analysis 
Control 
window: 
Analyze Page 
showing a soils 
analysis in 
progress.
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To display this page

Click on the Analyze tab on the bottom of the Automated Analysis Control 
window.

Window Displays

Sample Progress

This display shows how much of the analysis (percent complete) has been 
performed for the current sample. 

Analysis Progress

This display shows how much of the entire analysis (percent complete) has been 
performed.

To view autosampler operation during an analysis:

1. In the Options menu, click on General Preferences.

The General Preferences dialog appears.

2. Click on the View tab.

3. Select Autosampler Monitor.

4. Click on OK.

Window Controls and Entries

Analyze All

Click on this button to analyze all of the samples in the analytical sequence. 

Note Before you begin an analysis, make sure you have selected a method and 
defined the location on the Automated Analysis Control: Set Up page.



245Automated Analysis Control: Analyze Page

To interrupt the analysis sequence, click again on Analyze All. The Stopping 
an Analytical Sequence dialog appears, so that you can select when the 
analysis will stop.

Usually, Analyze All first calibrates the system, then analyzes the samples 
identified on the Set Up page. If, however, you stopped the automated analysis 
before all the samples were analyzed (and did not click on Reset Sequence), 
you may resume the analysis at a particular place in the analytical sequence by 
clicking again on Analyze All. The Continuing an Analytical Sequence dialog 
appears so that you can select the point where the interrupted analysis will 
restart.

Calibrate

Click on this button to start the calibration sequence. The system uses the blank 
and standards defined in the method. 

To interrupt the calibration sequence, click again on Calibrate. The Stopping 
an Analytical Sequence dialog appears so that you can select when the blank 
and standard analysis will stop. If you stopped the blank and standard analysis, 
(and you did not click on Reset Sequence), you may resume at a particular 
place in the calibration sequence by clicking again on Calibrate. The 
Continuing an Analytical Sequence dialog appears so that you can select the 
point where the interrupted analysis will restart.

When calibration is complete, you may want to examine the calibration curves 
in the Calibration window before analyzing samples.   

Analyze Samples

Click on this button to start analyzing samples after the instrument has been 
calibrated. 

Click on the button a second time to stop the analyses. The Stopping an 
Analytical Sequence dialog appears, so that you can select when the sample 
analysis will stop.

The analysis usually starts at the beginning of the sequence that is shown on 
the Set Up page. If, however, you stopped the automated analysis before all 
samples were analyzed, (and you did not click on Reset Sequence), you may 
resume the analysis at a particular place in the analytical sequence by clicking 



246 Chapter 5 Analysis Control Windows

again on Analyze Samples. The Continuing an Analytical Sequence dialog 
appears so that you can select the point where the interrupted analysis will 
restart.

Reset Sequence

This button resets the analytical sequence back to the beginning.

Click on this button to reset the analytical sequence to 1. The next time you 
click on Analyze All, Analyze Samples or Calibrate, the sequence will be 
rebuilt and the system will start with the first item in the list. 

Analytical Sequence

Method

If more than one method is listed on the Set Up page, you can view which method 
is being used for the current analysis. The methods are numbered on the Set Up 
page. Type in, or click the arrow, to choose the Method number.

Rebuild List

To refresh the display (to show changes you have made to the method or 
sample information file), click on this button.

Print List

To print the sequence, location, sample type, ID, and status information shown, 
click on this button. The printed report also shows the current date and time as 
well as the method name.

Note If you schedule one or more After Initial Calib QC samples in the 
method, Analyze Samples will analyze the QC as part of the sample list. 
This is useful if you wish to use an existing calibration curve, analyze the 
After Initial Calib QC sample as a check (without reanalyzing your 
calibration standards), then take action based on the pass or fail status of 
the QC. For more information on QCs, see the Method Editor: QC Pages. 
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Priority...

To insert a new sample into the sequence (only during an analysis), click on 
this button and in the Add Sample dialog that appears, enter new sample 
information. 

Load Tray

Click on this button to raise the autosampler probe and move it to the back so 
that the sample tray can be removed or installed. Click on Load Tray again to 
restore the probe to its operating position.

Stopping an Analytical Sequence Dialog

When you stop an analysis, you use this dialog to give the system further 
instructions.

To display this dialog

When an analytical sequence is in progress, click on the button that you used 
to begin the analysis:  Analyze All, Calibrate, or Analyze Samples. These 
buttons are located in the Automated Analysis Control window: Analyze page.

Using this dialog

1. Select one of the options.

Stop immediately
The system stops the analysis immediately when you click on OK.

Complete current replicate
The system finishes the measurement for the current replicate and then stops 
the analysis. 

Complete all replicates for current sample
The system finishes all the replicate measurements on the current sample and 
then stops the analysis.

2. Click on OK. 

Or, if you decide not to stop the analysis, click on Cancel.
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Continuing an Analytical Sequence Dialog

When you stop an analysis and then decide to continue it, you use this dialog to 
give the system instructions. 

To display this dialog

After you stop an analysis, click on the button that you originally used to start 
the analysis. Do not click on Reset Sequence unless you want to start a new 
analysis. These buttons are in the Automated Analysis Control window:  
Analyze page.

Using this dialog

1. Select one of the options.

Continue with next sequence # 
The analysis will continue with the next solution in the analytical sequence. 
The next sequence number is the one that follows the last completed sequence 
number.

Reanalyze previous sequence # and continue
The analysis will continue with the previous solution in the analytical 
sequence. The previous sequence number is the one that was being analyzed 
when the analysis stopped. 

Continue with sequence # n
The analysis will continue with a selected solution in the analytical sequence. 
Type the autosampler location of the sequence in the entry field. 

Restart current Method
The analysis will restart the method that was being performed when the 
analysis was interrupted. This performs the same action as clicking on Reset 
and then on Analyze All, Analyze Samples or Calibrate.

2. Click on OK. The system continues the analysis, based on the option selected.

Or, if you decide not to continue the analysis, click on Cancel.

Note If you have multiple methods, only the current method is rerun.



249Automated Analysis Control: Analyze Page

Reset Automated Analysis Dialog

After you have stopped an automated analysis, you can use this dialog to reset it to 
the beginning of the analytical sequence. The analytical sequence indicates the 
order in which the solutions will be analyzed. Calibration curves will be cleared 
when the analysis is restarted.

Using this dialog

1. After you stop an automated analysis, click on Reset Sequence in the 
Automated Analysis Control window. 

2. In the dialog, select:

OK to reset the analysis to the beginning of the analytical sequence. 

-or-

Cancel if you decide that you do not want to reset the analysis. 

Other options are available for restarting the analysis. For example, you may 
want to continue the analysis from the next solution in the analytical sequence. 
For more information, see the Continuing an Analytical Sequence Dialog 
earlier in this chapter.

Add Sample Dialog

You use this dialog to enter information on a new sample that you want to insert in 
the analytical sequence.

To display this dialog

In the Automated Analysis Control window: Analyze page, click on Priority... 
The Priority button is active only while an analysis is in progress.

Using this dialog

1. Enter the information on your sample in the same way you usually do. The 
parameters shown are the same as those in the Sample Information Editor. 
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2. Select an option from the When to Analyze drop-down list.

3. If you want to add another sample, click on Add Sample. This button adds the 
sample to the run list and refreshes the dialog.

Go To Location Dialog

You use this dialog to analyze samples in selected locations or move the 
autosampler probe to a particular location. 

To display this dialog

In the Analysis Menu, select AutoSampler. Then select Go to Location.

Using this dialog

Click on an option button, then click on OK.

Go to wash
This moves the autosampler probe to the location defined in the Method Editor 
and lowers it.

Go to location
This moves the autosampler probe to the location shown and lowers it. To 
change the location, type a location number or use the spin buttons. 

Data Reprocessing Window
You use this window to reprocess sample data that is stored in a results data set. 
There are several reasons why you might want to reprocess data:

• You can “peak” or adjust the wavelength and change the analytical conditions 
of the method. For example, the line for Co 228.616 is showing up at 228.652, 
but all the concentrations are being calculated at 228.616. After “peaking” and 
updating the method, the wavelengths are changed to 228.652. Reprocessing 
allows the stored data to be recalled and the concentrations to be corrected 
according to the new and proper wavelength.

• You chose peak height and wanted peak area.
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• You chose 3 points per peak and want 5 or 7.

• You created a MSF model to correct for some overlapping peak and want to 
obtain the true concentration of your analyte.

• You entered 0.1 for a concentration of a standard and it is actually 1.0.

• You chose mg/mL but you need the results to print out in ppb or oz/ton.

• You chose a linear calibration equation instead of nonlinear.

• You ran just the samples and forgot to recall the calibration from another data 
set. Therefore, no concentrations are given and you need that information.

• You entered the wrong QC concentration or wrong QC limits the first time.

Reprocess cannot be accessed unless the Analysis Control Windows are closed.

The Data 
Reprocess-
ing win-
dow.
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To display this window

On the Toolbar, click on Reproc.

-or -

From the Tools menu, click on Data Reprocessing.

Using this window

1. Next to Data Set to Reprocess, click on Browse... and select a results data set 
that contains the data you want to reprocess.

2. In the Data Reprocessing window, the results from the reprocessed data will be 
saved to the data set shown in the entry field. This field defaults to the data set 
from the most recent analysis. A check mark appears in the Save Reprocessed 
Data box, confirming that reprocessed data will be saved.

To change to a different data set, click on Browse... and in the Select Results 
Data Set dialog that appears, type a new data set name or select an existing one. 
A check mark appears in the Save Results in Data Set box, confirming that 
reprocessed data will be saved. If you do not want to store reprocessed data, 
click the check box to clear it.

3. The Method should be open in the Method Editor so if you want to reprocess 
using different method parameters, that information can be used. Confirm that 
the method in use contains the correct settings for the results data set that is to 
be reprocessed.

4. In the table, review the information. The IDs in the selected results data set are 
listed along with the sample information that was used when the data was 
originally collected. To edit this information, type the new information into the 
fields as desired. To access a pop-up menu containing commands for editing 
the table, right click anywhere in the table. To hide columns that do not contain 
data, select the Hide Empty Columns check box. 

Note There is a column fill dialog available for each of the parameters in the 
table, except Sample Type and Original Method. To access a column fill 
dialog, double-click on the parameter's column header.
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5. To select items of interest for reprocessing, select the associated row numbers 
in the table. To select a series of rows, click on the first row number of interest, 
hold down the Shift key, and click on the last row number of interest.  You can 
also drag over the row numbers column using the mouse cursor. To select non-
consecutive rows, hold down the Ctrl key and click on each row number.

6. Click on Reprocess.

Data Reprocessing Display

This shows a status of the reprocessing operation.

Reprocess

Click on this button to begin reprocessing. Click again to interrupt reprocessing. 

Save Reprocessed Data
This box is selected automatically (a check mark appears), indicating that the 
reprocessed data generated will be saved to the results data set shown in the 
entry field. To select a different results data set, click on Browse..., and in the 
Select Results Data Set dialog that appears, type a new data set name or select 
an existing one. Note that the spectral data is not saved with the reprocessed 
results and does not change with reprocessing. 

Print Log
Select this box to print a log of signals, analytical results, and other information 
about the analysis. The log includes an analytical header and, for each sample, 
a sample header and the data that is shown in the Results Display window as 
selected on the Options page of the Method. Look at all of the selections on the 
Method Editor Window Options page to get an overview of the selected 
analytical results that will appear in the printout.

Hide Empty Columns
Select this box to hide columns that do not contain data. 

Tip The order in which samples are selected is the order in which reprocessing 
occurs. As you select each row, the reprocessing sequence appears in the 
Sequence column. 
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Data Set to Reprocess

Select the results data set that contains the data you want to reprocess. Click on 
Browse... and in the Results Data Set dialog that appears, select an existing data set 
name.

The sample parameters from the results data set you selected are brought into the 
Data Reprocessing window. The column heads in bold indicate that this 
information from the original analysis cannot be modified.

Sequence

This is the sequence in which samples will be reprocessed. This sequence appears 
as you select each row number. 

Sample ID

This is the name you gave to each sample. 

Sample Type

This is the solution type:  blank, standard, sample, etc. 

Omit Replicates

This is the entry for replicate numbers that you do not wish to reprocess for a 
sample.

Matrix Check Samples

This shows any samples that are designated as matrix checks. 

Date/Time

This shows the date and time that each sample was analyzed. 

Note For an example using Initial Sample Weight, Sample Prep Volume, 
Aliquot Volume, and Diluted to Volume see, Sample Preparation:  An 
Example in Chapter 4,  Sample Information Editor.
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Initial Sample Wt.

This is the quantity of sample weight before sample preparation. 

Initial Sample Vol.

This is the quantity of sample volume before sample preparation. 

Sample Units

Use this column to change the sample units on a per sample basis before 
reprocessing data.  The concentration will be calculated based on the new units.  
(All of the analytes in a sample must have the same sample units to use this 
parameter.)

Weight Units

This shows the units of the Initial Sample Quantity. These are either weight or 
volume units.

Sample Prep. Volume

After a solid sample has been dissolved or a liquid sample has been acidified (or 
otherwise treated), the resulting solution is prepared to a specific volume. This is 
the Sample Prep Volume. 

Aliquot Volume

If an aliquot of the sample solution is taken and diluted to a final volume, record 
the aliquot volume for this entry and the final volume for the Diluted to Volume 
entry. 

Diluted to Volume

This is the final volume of solution obtained by diluting an aliquot of the sample 
solution. You can also record the dilution as the ratio of the original sample volume 
to the final sample volume. For example, if 10 mL of sample is diluted to 200 mL, 
this ratio would be 10:200 or 1:20. Enter 20 for the Diluted to Volume entry and 1 
for the Aliquot volume.
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Volume Units

If the final sample concentrations are being reported in weight/weight units, you 
must enter the units for the Sample Volume. 

Solids Ratio

This is the ratio of the wet and dry weights for the sample. This ratio is used to 
correct the sample concentration. For more information, see the Solids Ratio 
Column Fill dialog in Chapter 4,  Sample Information Editor.

Nominal Sample Weight

This is the target weight when samples are weighed. This entry is required only if 
corrections are being made to weight/volume measurements to compensate for 
weight variations among samples. The Nominal Sample Weight is divided by the 
Initial Sample Weight to correct the final concentration value.

Batch ID

This is the name you give to this batch of samples. 

Original Method

This shows the method you used in the analysis. This information cannot be 
modified. 

Remarks

The remarks you entered in the Sample Information file before the initial analysis.
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Data Reprocessing Window Pop-Up Menu

The following pop-up menu contains several convenient commands as you work 
with the Data Reprocessing window. 

To display the pop-up menus

Click with the right mouse button in the Data Reprocessing window table. The 
Table editing pop-up menu appears:

Command Description

Clear Removes the contents of the selected entry fields. 

Insert Row Inserts a new row before the currently selected row. 

Delete Rows Removes the selected rows in the table. 

Column Fill... Displays the Column Fill dialog for the selected column. 
You use this dialog to automatically enter information for 
a range of samples. 
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Reprint Data Window
You use this window to specify which results data you want to reprint.  The Reprint 
function will allow you to create an exact copy of your original results data 
printout.

Note:  Data can only be reprinted if it was obtained using versions 4.0 and higher of the ICP 
WinLab32 software.  

To display this window:

 On the Toolbar, click on Reprint

-or -

From the Tools menu, click on Reprint Data.

Entry Dialog... Displays the Matrix Check Sample Entry dialog for the 
selected entry field. You use this dialog to type informa-
tion for a text entry field. 

Command Description
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Using this window

Note:  If you plan on using the Reprint Data function, we recommend that you enable the Spectral 
Data option when collecting data.  You enable Spectral Data by checking this option on the Options 
tab page of the Method Editor.  If Spectral Data is not checked and you run an analysis, the samples 
will still be stored in a batch and will be available for reprinting, however, no data will be shown 
for those samples.

1. Next to Results Data Set Name, click on Open... and select a results data set 
that contains the data you want to reprint. 

2. Next to Analysis Batch Date/Time, click Open... to select a batch that you 
want to reprint.
The Select Analysis Batch dialog appears and displays the batches that are 
available in the data set you selected.  Batches are identified by the date and 
time they were initially created.  

The rules for how batches are created are as follows:  

When you are performing Manual Analyses, a batch is created when you run 
the first solution after opening the Manual Analysis window.  The batch will 
end when you close the Manual Analysis window.  All samples that are run in 
between are stored as part of the same batch.

When you are performing Automated Analyses a new batch is created when 
you first select one of the analyze buttons (Analyze All, Calibrate, and Analyze 
Samples).  The batch will end when you close the Automated Analysis Control 
window.  If the analysis is paused and then continued, the continuation of the 
analysis will be part of the same batch.  

When you are Reprocessing Analyses a new batch is created when you first 
open the Data Reprocessing window and click the Reprocess button.  The 
batch will end when you close the Data Reprocessing window.
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3. Click Preview to preview the selected data in the Results window, without 
printing.

4. Click Print to print the selected data.

Output is sent to the Results window.  It should be noted that no new data is 
stored to the Results database when you use the Reprint function.

Equation for Calculating Disk Storage for Results

To roughly calculate the amount of hard disk storage space that is required for 
storing results data sets, use the following equation:

Database size in bytes

Type-Factor = 300 Not Storing Spectra
500 Storing Spectra, normal resolution, no slit scanning
1100 Storing Spectra, normal resolution, 4-position

slit scanning
Storing Spectra, high resolution, no slit scanning

Database Size 
Increase

= (Analytes * Samples) * 550 + (Analytes * Samples * Replicates) * Type-Factor

Samples = actual samples + number of standard analyses + number of blank analyses + 
number of QC analyses (I.E. number of entries in analysis list)

Analytes Samples Replicates Type-Factor Approximate Size
Increase (Bytes)

10 54 1 500 567,000

20 54 7 500 4,374,000

20 54 3 300 1,566,000

40 29 3 1100 4,466,000
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About Hardware Control Windows
These windows are used to manually control specific parts of the hardware. 
Because a method usually controls some of these functions automatically during an 
analysis, these windows will be most useful to you during method development 
and for setup.

Select the appropriate hardware control window depending on the task you 
wish to perform.

 Plasma Control Window
You can use the Plasma Control window to modify plasma parameters, to monitor 
the status of major components affecting the plasma and sample introduction 
system, and to ignite the plasma and shut it off.

To do this Use

Manually adjust the 
plasma and monitor the 
settings.

Plasma Control 
Window

Perform special 
spectrometer operations, 
including adjusting 
alignment.

Spectrometer Control 
Window
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The following table shows tasks related to the Plasma Control Window.

Plasma Control Window: A Quick Look

For information on: See:

Making the correct preparations to ignite 
the plasma and correcting unsuccessful 
ignition.

Igniting the Plasma

Performance checks that should be done 
periodically.

Optimizing and Verifying Performance

Parameters in the method that correspond 
to the Plasma Control window.

Method Editor

Selecting different types of pump tubing. Pump Configuration Dialog

Note The heater control shown above is not available on Optima 3000 Family 
spectrometers.
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To display this window

 On the Toolbar, click on Plasma.

- or -

 In the Tools menu, click on Plasma Control.

Plasma Control Window: Controls and Displays 

Plasma Switch

Click on this switch (or press F9) to turn the plasma on and off. 
To turn the plasma off, you can also use the Emergency Plasma Off button 
located on the instrument above the sample compartment.

The Plasma Status window indicates if ignition is successful or if there is a 
problem. For more information, see System Monitors in Chapter 10 and see 
Igniting the Plasma, for details about the ignition process. Wait one hour before 
analyzing samples. This warm-up time ensures accuracy in your results since it 
allows the temperature of the sample introduction system to fully stabilize. 

Override Method

If this box is checked, the instrument will use values for your next analysis as 
specified in this window. If the box is not checked, the instrument will use the 
values in the active method. Selecting Override Method does not change the values 
in the active method or the method stored in the results library. 

Gas Flows Display and Controls: Plas, Aux, and Neb Buttons

If you select the Override Method checkbox, the Plas, Aux, and Neb buttons allow 
you to change the post-ignition flow rates of the argon gases and to monitor their 
current values. Plas, Aux, and Neb refer to the plasma, auxiliary, and nebulizer 
gases. The blue numbers in the display indicate the current flow rate. 

Hint You can press F9 to turn the plasma on and off even if the Plasma Control 
window is not open.
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To start or stop gas flow, click on the desired button beneath the display. The 
green light on a gas button indicates that the gas is flowing.

To change a gas flow rate, select or type a value in the box beneath the 
appropriate gas display. For more information, see Recommended Settings for 
Plasma Parameters and Recommended Settings for Nebulizers later in this 
chapter. The maximum flow rate that you can enter cannot actually be attained 
by some nebulizers. If the nebulizer cannot reach the highest value, it will 
return the value it reached to the display. An error message will be recorded on 
the Plasma tab of the Instrument Diagnostics window.

Click on Apply after you have adjusted the setting for the flow rates.

RF Power Display and Controls: Apply Button

These allow you to change the radio frequency power that is dissipated in the 
plasma and to monitor the current power.

To change the power setting, select or type a value. For more information see 
Recommended Settings for Plasma Parameters later in this chapter. Click on 
Apply after you have adjusted the RF power.

Pump Gauges and Controls: Pump, Flush, and Apply Buttons

These allow you to change the sample flow rate and to monitor the status.

To change the sample flow rate, select or type the appropriate value. The 
software adjusts the pump speed based on the type of pump tubing you selected 
in the Pump Configuration dialog. To change the pump tubing, in the Options 
menu, click on Pump. A typical sample flow rate is 1.5 mL/min for all 
instruments. Ranges for sample flow rates vary with the pump and pump 
tubing you are using. For example, values are from 0.6 to 5.7 mL/min for the 

If you stop the plasma gas flow while the torch is ignited, the torch will go 
out. 
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PerkinElmer pump (with 0.76 mm i.d. tubing) and from 0 to 2.5 mL/min for 
the Gilson pump. Then, click on Apply. For more information, see the Pump 
Configuration dialog in Chapter 11,  Menus and Toolbar.

Click on Pump to start or stop the peristaltic pump. The green light indicates 
that the pump is turned on.

Click on Flush to set the pump speed to the flush setting in the Pump 
Configuration dialog.

Heater Control: Heat and Apply Buttons

These allow you to set the temperature of the spray chamber enclosure to provide 
a constant temperature for the spray chamber. For aqueous analyses, set the 
temperature to a few degrees above the lab temperature. A setting of 38 °C is 
typically used. If you set the temperature much higher than the lab temperature, it 
will take longer for the system to stabilize. For organic analyses, the spray chamber 
should be as cool as possible, therefore we recommend that you do not use the 
heater.

To change the setting, select or type a value. Click on Apply after you have set 
the temperature. 

Click on Heat to turn the heater on or off. The green light indicates that the 
heater is turned on.

Overriding Method Settings

If you modify the settings in the Plasma Control window and want to test them for 
your next analysis, you do not need to modify the method. To override the method 
settings, see the illustration.
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Recommended Settings for Plasma Parameters

Parameter Aqueous Organic
Plasma Flow: 15 L/min 15 L/min

Auxiliary Flow: 0.5 L/min
(for Optima 3000 Family ICP
spectrometers)

0.2 L/min
(for other simultaneous ICP
spectrometers or for scanning CCD
ICP spectrometers)

1.0 L/min

Nebulizer Flow:
(for Low-Flow
GemCone or the
Concentric Glass
nebulizer)

0.80 L/min 0.50 L/min

RF power: 1300 watts 1300 watts

Sample Flow
Rate

1.50 mL/min 0.80 mL/min
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Recommended Settings for Nebulizers

Argon Flow Rate 

Nebulizer Part number
typical
value

operating
range

GemTip Cross-Flow N068-0503 0.8 L/min 0.7 - 1.3 L/min

Low-Flow GemCone N069-0671 0.6 L/min 0.4 - 0.95 L/min

High Solids GemCone N069-0670 1 L/min 0.7 - 1.0 L/min

Concentric Glass
(MEINHARD) Type A

0047-2020 0.8 L/min 0.7 - 1.3 L/min

Concentric Glass
(MEINHARD) Type C

0047-2022 0.8 L/min 0.7 - 1.3 L/min

Concentric Glass
(MEINHARD) Type K

N068-1574 0.6 L/min 0.4 - 0.7 L/min

Ultrasonic (115 V) N069-1709 1.0 L/min or less n/a

Ultrasonic (230 V) N069-1710 1.0 L/min or less n/a



272 Chapter 6 Hardware Control Windows

Spectrometer Control Window
You can use the Spectrometer Control window to adjust and align the position from 
which the plasma is viewed, control various spectrometer manual settings, and 
perform calibrations of the spectrometer.

The following table shows tasks related to the Spectrometer Control Window.

For information on: See:

Adjusting the wavelength, a procedure 
which allows you to fine-tune the peak 
maximum for a wavelength for a particular 
data set or for subsequent analyses on the 
instrument. 

Adjusting the Wavelength 

Performance checks that should be done 
periodically.

Optimizing and Verifying 
Performance

Parameters in the method that correspond to 
the Spectrometer Control window. 

Method Editor: Spectrometer 
Pages Overview
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Spectrometer Control Window: A Quick Look 

The Spectrometer 
Control window 
is shown as it 
appears for 
simultaneous ICP 
spectrometers and 
is set for axial 
viewing.
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To display this window

In the Tools menu, click on Spectrometer Control. 

The Spectrometer 
Control window is 
shown as it 
appears for scan-
ning CCD ICP 
spectrometers and 
is set for radial 
viewing.
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Spectrometer Control Window: Adjusting the Torch Viewing Position

In the Spectrometer Control window, you can:

modify the coordinates for the torch viewing position 

-or-

automatically align the torch viewing position for the highest signal intensity 
by clicking on Align View. The spectrometer uses a computer-controlled 
mirror in the transfer optics to adjust the area of the plasma viewed by the 
optical system.

Spectrometer Control Window: Modifying the Coordinates for the 
Torch Viewing Position 

Due to the various temperature zones in the plasma and differences in analyte 
ionization processes, slight adjustments to the torch viewing position may give 
higher intensity signals for particular analytes. Adjustments should be made on an 
empirical basis. After verification of the desired results, the new settings may be 
used to override the Viewing Distance setting in the method for all analytes. Keep 
in mind that, alternatively, the software can automatically align the torch viewing 
position for a particular analyte using Align View. 

The crosshair on the Torch Viewing Position display shows what part of the plasma 
is currently being viewed by the spectrometer. After modifying one or both 
coordinates, click on Apply to set the new viewing position. The crosshair then 
moves to the new position and the blue numbers in the display indicate the current 
settings for the coordinates.
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To use the new settings in place of the settings in the method, select Override 
Method. The settings for both coordinates will be used. If you do not select 
Override Method, the system will use the setting for the Viewing Distance 
parameter. This parameter is in the method on the Sampler: Plasma page. It has 
only one coordinate and assumes the other coordinate to be 0. For example, a 
setting of 15.0 indicates the coordinates of 15.0 and 0.0.

If you want to set the torch viewing position individually for each analyte, you can 
do this using the Viewing Distance parameter in the method. 

Spectrometer Control Window: Automatically Aligning the Torch 
Viewing Position

Perform this procedure when:

• the instrument or software is first installed
• the instrument is moved to a new location
• the torch is removed or replaced

For radial viewing, you can modify:
1) the viewing position from the RF coil 
to the tip of the plasma. (horizontal scale 
0 to 30 mm) 

2) the position relative to the plasma 
center (vertical scale -10 to 10 mm)

For axial viewing, you can modify 
the viewing position relative to the 
plasma center on two axes. 
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• the RF coil is replaced
• you want to optimize intensities for an individual analyte

1. In the Tools menu, click on Spectrometer Control.
The Spectrometer Control window appears.

2. On Dual View instruments, select Axial or Radial. We recommend that you 
first do the alignment in one viewing mode, then select the other viewing mode 
and repeat the procedure. 

3. To view spectra collected during the procedure, open the Spectra Display 
window.

4. Click on Align View in the Spectrometer Control window to open the Align 
View dialog.

5. Select the element and wavelength. This is the wavelength that the system will 
use to measure the intensities at different viewing positions and locate the 
position that gives the highest intensity. You have the following choices.

Click on the Select Analyte option and then select Manganese, which is 
typically used as the alignment wavelength for the majority of analyses. 

-or-

Click on the Select Analyte option and then select another element from the 
drop-down list. This feature is for specialized analyses where you want to 
optimize the intensity for an individual analyte of interest. This may adversely 
affect the intensities of other analytes.

-or-

Click on the Other option and type in an element and/or wavelength not in the 
drop-down lists. 

6. Set the Read Delay time.

7. Aspirate a solution containing the element you have selected. If you are using 
Manganese (Mn), use 10 mg/L for radial viewing or use 1 mg/L for axial 
viewing.



278 Chapter 6 Hardware Control Windows

When using radial viewing, the system adjusts the lateral viewing position 
only.

When using axial viewing, the system adjusts both coordinates. 

The system will determine the intensity at the selected wavelength, while 
adjusting the viewing position in incremental steps. In the Results window, a 
report is generated that gives the intensities found at each position. The system 
changes the Torch Viewing Position to the position that gives the highest 
intensity. In the Spectrometer Control window, the software resets the 
coordinates so that the 0 and 15 position is at the location of highest intensity.

Extended Search

For axial viewing only:  If you have performed the procedure above, but are not 
satisfied with the results, you can extend the search over a larger area. This search 
takes longer than the usual procedure. Before using Extended Search, you should 
perform the sodium bullet test to make sure that the sample is reaching the plasma.

To perform an Extended Search, select the Extended Search checkbox and 
then repeat the procedure above. A search is performed over a larger area of 
the torch.   

If any of the following conditions are found, a message dialog appears to give you 
an opportunity to confirm that you wish to use the new alignment (or cancel it) if 
desired: 

• The distance from the last alignment is greater than 5 mm. 

• The value of the peak is less than 10,000 counts. 

• The element wavelength used for the last optimization is not the same as 
the one used for the previous optimization.
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Align View Dialog

You use this dialog to automatically align the torch viewing position for the highest 
signal intensity.

To display this dialog

1. In the Tools menu, click on Spectrometer Control.
The Spectrometer Control window appears.

2. On Dual View instruments, select Axial or Radial. We recommend that you 
first do the alignment in one viewing mode, then select the other viewing mode 
and repeat the procedure. 

3. To view spectra collected during the procedure, open the Spectra Display 
window.

4. Click on Align View in the Spectrometer Control window.

Using this dialog

You have the following choices.

1. Click on the Select Analyte option and then select Manganese, which is 
typically used as the alignment wavelength for the majority of analyses. 

-or-

Click on the Select Analyte option and then select another element from the 
drop-down list. This feature is for specialized analyses where you want to 
optimize the intensity for an individual analyte of interest. This may adversely 
affect the intensities of other analytes.

-or-

Click on the Other option and type in an element and/or wavelength not in the 
drop-down lists. 

2. Set the Read Delay time.

3. Aspirate a solution containing the element you have selected.



280 Chapter 6 Hardware Control Windows

The system will determine the intensity at the selected wavelength, while 
adjusting the viewing position in incremental steps.

For axial viewing only:  If you have performed the procedure above, but are 
not satisfied with the results, you can perform an extended search. To do so, 
click on the Extended Search check box and repeat the procedure above. A 
search is performed over a larger area of the torch. 

For more information, see Automatically Aligning the Torch Viewing Position 
earlier in this chapter. 

Spectrometer Control Window: Manual Settings

Override Method

If this box is checked, the instrument will use the value for your analysis as 
specified in this window. If the box is not checked, the instrument will use the value 
in the active method. Selecting Override Method does not change a value in the 
active method or in the method stored in the results library. 

Purge Gas

Nitrogen is used to purge the optical system during operation to remove oxygen 
and moisture. Usually, the purge should be set to Normal. The High setting may be 
used to improve sensitivity for elements with wavelengths below 190  nm since 
oxygen absorbs below 190 nm. On scanning CCD ICP spectrometers, you have the 
option of turning the purge gas off. 

Note This search takes longer than the usual procedure. Before using Extended 
Search, you should perform the sodium bullet test to make sure that the 
sample is reaching the plasma.
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View Mode (Dual View instruments only)

Select the plasma viewing mode. 

Radial
Light emitted from the side of the plasma passes through the torch slit and is 
directed to the spectrometer optics. 

Axial
Light emitted along the axis of the plasma is directed to the spectrometer 
optics. The observation zone of the plasma is circular and the spectrometer 
views a column of light from the central channel of the plasma. 

Attenuated (Attn) Radial or Attenuated (Attn) Axial
These settings are available only for scanning CCD ICP spectrometers. Use 
these settings when lower intensities are desired, for example, for samples of 
high concentration that would normally saturate the detector and for sensitive 
wavelengths, typically in axial mode.

Shutter Auto/Closed/Open

A shutter in the transfer optics allows light from the plasma to enter the 
spectrometer optics. This shutter may be set to the Auto, Closed, or Open position. 
The Auto setting indicates that the shutter is under instrument control. 

Usually, the shutter is set to Auto. If you have an extensive number of samples to 
analyze, however, you may wish to set the shutter to the open position manually to 
increase analytical throughput. Be sure to close the shutter when the analysis is 
complete.

To measure dark current, take measurements with the shutter in the closed position. 

 Leaving the shutter in the open position with the plasma on could lead to 
deterioration of the optics and eventual degradation of UV performance. 
It is recommended that the shutter be closed when analyses are not being 
performed.

!
Warning
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Hg Lamp Off/On

This control appears only for simultaneous ICP spectrometers. An internal mercury 
lamp, under system control, is used for the mercury realignment procedure and 
periodic mercury recalibration. Manual control of this lamp is available for 
diagnostic purposes to verify that the signal is reaching the detector and that the 
mercury lamp is working. 

Spectrometer Control Window: Overriding Method Settings

In the Spectrometer Control window, the following settings can override method 
settings.

To override a setting in the method, select the Override Method box next to the 
setting in the Spectrometer Control window.

Setting in Spectrometer Control 
Window

Setting in Method

Torch Viewing Position: To change 
the position, select new coordinates 
and click on Apply. 

For either axial or radial viewing, both 
coordinates will be used. 

The View Dist (Viewing Distance) 
parameter is set in the method on the 
Sampler: Plasma page.

The Viewing Distance parameter has 
only one coordinate and assumes the 
other coordinate to be 0. For example, 
a setting of 15 indicates the 
coordinates of 15 and 0.

Purge Gas The Purge Gas Flow parameter is set 
on the Spectrometer: Settings page.
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Table of Spectrometer Alignment and Calibration Controls

Control What it Does When to Use

Align View Optimizes the torch viewing 
position for the highest signal 
intensity.

Perform this procedure when:

• the instrument or software is first installed

• the instrument is moved to a new location

• the torch is removed or replaced

• the RF coil is replaced

• you want to optimize intensities for an 
individual analyte

Wavelength 
Calibration

(simultaneous 
spectrometers 
only)

Gathers data for UV or VIS 
emission lines to compensate 
for slight variations in optical 
alignment. At the end of the 
UV or VIS wavelength 
calibration, the system 
determines the wavelength 
offset of an emission line 
from the internal mercury 
lamp and records the slit 
position as a reference point 
for future mercury 
realignments.

The instrument must be operated with the 
plasma on for at least one hour before 
initiating wavelength calibration on Optima 
3000 Family spectrometers. 

Perform this procedure:

• when the instrument or software is first 
installed

• when the instrument is moved to a new 
location

• after reinstalling or upgrading the 
software

• if analyte peaks in the Examine Spectra 
window are significantly offset from the 
central line for the wavelength on a 
consistent basis



284 Chapter 6 Hardware Control Windows

Initialize 
Optics

(scanning 
CCD 
spectrometers)

Performs a prism scan to 
optimize wavelength for the 
slit in the instrument optics. 
The system takes an intensity 
reading, scans the 
surrounding intensity range 
and locates the midpoint. If 
this midpoint varies from the 
initial intensity measurement, 
the system will optimize 
optics for use in subsequent 
analyses.

The instrument must be operated with the 
plasma on for at least 10 minutes before 
initializing optics.

Initialize Optics is performed automatically 
during analyses. However, if there are wide 
fluctuations in ambient laboratory 
temperature that appear to affect intensity, 
you can initialize optics manually. To do this, 
click on the Initialize Optics button in the 
Spectrometer Control window.

Hg Realign

(simultaneous 
spectrometers 
only)

To compensate for 
spectrometer drift (for 
example, changes in 
barometric pressure), the 
system compares the mercury 
slit position recorded at the 
end of the wavelength 
calibration to the current 
position found on the 
detector. 

The spectrometer must be in the ready mode 
before initiating a mercury realignment on 
Optima 3000 Family spectrometers. 

Use before adjusting the peak wavelength, a 
procedure which allows you to fine-tune the 
calibration for a particular wavelength. For 
more information, see Adjusting the 
Wavelength in Chapter 9, Using the Examine/
MSF Window.

Use before collecting data for MSF models.

Control What it Does When to Use
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Performing a System Wavelength Calibration

This section covers the procedure for simultaneous ICP spectrometers.

Perform this procedure:

• when the instrument or software is first installed

• when the instrument is moved to a new location

• after reinstalling or upgrading the software

• if analyte peaks in the Examine Spectra window are significantly offset 
from the central line for the wavelength on a consistent basis

Detector 
Calibration

The system collects and 
processes the detector signal 
bias and dark current data in 
order to quantify signals from 
the detector properly.

Perform this procedure when:

• the instrument or software is first installed

• the instrument is moved to a new location

• after reinstalling or upgrading the 
software

• before checking detection limits 

Note: On scanning CCD ICP spectrometers, a 
detector calibration is performed 
automatically when you start the software.

Control What it Does When to Use
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Solutions You'll Need for Wavelength Calibration

• Calmix 3 solution (Part No. N058-2152) available through PerkinElmer, which 
contains 100 mg/L of P, K, S; and 20 mg/L of As, La, Li, Mn, Mo, Ni, Sc, Na.

• For spectrometers that have a visible wavelength channel on the detector, you 
will need VIS Wavecal mix (Part No. N930-2946) available through 
PerkinElmer, which contains 1 mg/mL Ba, Ca; and 10 mg/L of La, Li, Mn, Na, 
Sr; and 50 mg/L of K. 

• Rinse solution

To initiate a wavelength calibration

1. Make sure that the plasma is lit and has been on for at least one hour on Optima 
3000 Family spectrometers. On other PerkinElmer spectrometers, wait one-
half hour before starting the wavelength calibration.

2. In the Tools menu, click on Spectrometer Control.
The Spectrometer Control window appears.

Notes If your peaks are slightly offset, a system wavelength calibration is usually 
not necessary. Instead, fine adjustments to wavelengths can be made using 
the Examine Spectra window. For more information, see Examine Spectra 
Window in Chapter 9, Using the Examine/MSF Window. 

If using MSF and a wavelength calibration is performed, you must recreate 
your MSF models before performing an analysis for accurate results.

Important Since spectrometers are sensitive to thermal effects, it is important that the 
instrument be operated with the plasma on for at least one hour before 
initiating wavelength calibration on Optima 3000 Family spectrometers. 
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To perform UV channel wavelength calibration:

1. Aspirate the Calmix 3 solution (Part No. N058-2152).

2. Select UV, then click on Wavelength Calibration in the Spectrometer Control 
window. In the dialog that appears, click on OK to perform the calibration.

The UV calibration may take several minutes. You may view the spectra used for 
calibration by clicking on Spectra in the toolbar. When the UV calibration is 
complete, the UV coefficients and RMS (Root Means Square) value will be 
displayed in the Results window. These values should meet the following 
specifications. 

If these specifications are not met, repeat the wavelength calibration and make sure 
all peaks can be seen in the Spectra Display window. If the specifications are still 
not met, a complete optical alignment may be required. Contact your PerkinElmer 
service engineer.

For spectrometers that have a visible wavelength channel on the detector, to 
perform VIS channel wavelength calibration:

1. Aspirate VIS Wavecal mix (Part No. N930-2946).

Note On Axial (XL) instruments, you may need to dilute the wavecal solution 
1:10 to keep certain emission lines from saturating the detector. On Dual 
View (DV) instruments, select radial viewing. If you have selected axial, 
a message appears informing you to change to radial.

UV Coefficients and RMS Specification

First Coefficient absolute value < 2.0

Second Coefficient absolute value < 2.0

Third Coefficient absolute value < 8.0

RMS 
measures variability of 
wavelength offsets)

< 2.0
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2. Select VIS, then click on Wavelength Calibration in the Spectrometer 
Control window.

The VIS calibration may take several minutes. You may view the spectra used for 
calibration by clicking on Spectra in the toolbar. When the VIS calibration is 
complete, the VIS coefficients and RMS (Root Means Square) value will be 
displayed in the Results window. These values should meet the following 
specifications. 

If these specifications are not met, repeat the wavelength calibration and make sure 
all peaks can be seen in the Spectra Display window. If the specifications are still 
not met, a complete optical alignment may be required. Contact your PerkinElmer 
service engineer.

Note On Axial (XL) instruments, you may need to dilute the wavecal solution 
1:10 to keep certain emission lines from saturating the detector.On Dual 
View (DV) instruments, select radial viewing. If you have selected axial, 
a message appears informing you to change to radial.

VIS Coefficients and RMS Specification

First Coefficient absolute value < 3.0

Second Coefficient absolute value < 3.0

Third Coefficient absolute value < 12.0

RMS 
measures variability of 
wavelength offsets

< 2.0
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Wavelength Calibration Dialog

You use this dialog to perform wavelength calibration for the spectrometer.

Wavelength Calibration Dialog for Simultaneous ICP Spectrometers

This dialog appears only for simultaneous ICP spectrometers.

To display this dialog

In the Spectrometer Control window, click on Wavelength Calibration.

Information in this dialog

Current values for the UV or VIS coefficients and RMS (Root Means Square) value 
are displayed in this dialog. These values indicate whether the current wavelength 
calibration meets specifications. You may want to note these values before clicking 
on OK to begin the wavelength calibration.

For more information, see Performing a System Wavelength Calibration earlier in 
this chapter.

The Wavelength 
Calibration
dialog for 
Simultaneous ICP 
Spectrometers.
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Performing a Mercury Realignment 

This function is available only on simultaneous ICP spectrometers.

A mercury realignment compares the known wavelengths of the internal mercury 
lamp with the found positions on the detectors and is used to compensate for 
spectrometer drift. It is especially useful before collecting data that you will use for 
a Wavelength Adjustment (Examine Spectra window) or MSF.

To perform a mercury realignment

1. In the Tools menu, click on Spectrometer Control.
The Spectrometer Control window appears.

2. Click on Hg Realign to display the Hg ReAlignment dialog. Click on OK to 
start the mercury realignment. 
The routine takes about one minute.

Mercury Realignment Dialog

This function is available only on simultaneous ICP spectrometers.

During a mercury realignment, the spectrometer compares the mercury slit position 
recorded at the end of the wavelength calibration to the current position recorded 
on the detector. 

Note In the Automated Analysis Control window, you can specify a mercury 
realignment (called Auto Wavelength Realign) to occur at defined 
intervals during an automated analysis (one-hour intervals are 
recommended). For more information, see Automated Analysis Control: 
Set Up Page in Chapter 5,  Analysis Control Windows.

Important Since spectrometers are sensitive to thermal effects, it is important that the 
spectrometer is turned on for at least one hour before initiating mercury 
realignment on Optima 3000 Family spectrometers. 
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To display this dialog

In the Spectrometer Control window, click on Hg Realign. 

Information in this dialog

This dialog displays the peak offset for the mercury realignment performed during 
Wavelength Calibration and the peak offset, drift, and slit adjustment for the last 
mercury realignment. You may want to note these values before clicking on OK to 
begin Hg Realign.

For more information, see Performing a Mercury Realignment earlier in this 
chapter.

Performing a Detector Calibration

The system collects and processes the detector signal bias and dark current data in 
order to quantify signals from the detector properly.

Perform this procedure when:

• the instrument or software is first installed

• the instrument is moved to a new location

• after reinstalling or upgrading the software

• before checking detection limits.

The plasma does not need to be on for this procedure.

Note On scanning CCD ICP spectrometers, a detector calibration is performed 
automatically when you start the software and takes 15 to 30 seconds.
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To perform a detector calibration

1. In the Tools menu, click on Spectrometer Control.
The Spectrometer Control window appears.

2. Click on Detector Calibration in the Spectrometer Control window to display 
the Detector Calibration dialog. Click on OK to begin Detector Calibration.
The system automatically closes the shutter to measure signal bias and dark 
current. The detector calibration routine may take up to twenty minutes.

Detector Calibration Dialog

This dialog displays information about detector calibration.

To display this dialog

In the Spectrometer Control window, click on Detector Calibration

For more information, see Performing a Detector Calibration earlier in this 
chapter.
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Detection Limit Diagnostics - Performance Check
The Detection Limit Performance Check calculates detection limits for analytes, 
the results of which are displayed in the Mean Data and Replicate Data sections of 
your analysis report. You can use this Performance Check to evaulate how well 
your instrument is reading.

To display this dialog:

1. From the Tools menu, select Spectrometer Control.
The Spectrometer Control dialog is displayed.

2. Click on the Performance Checks button.

To use this window:

1. Use the Replicate spin box to select the number of replicates.

2. Use the SD spin box to enter the factor to multiply by the standard deviation to 
calculate the detection limit.

3. In the ID text box, specify a name to identify the sample.
By default “DL Check” is used as the sample ID.

4. Select which set of Concentration Units will be used for detection limit 
calculations. Your choices are: Calibration units or Sample units.

5. Select the Manual radio button if you wish to run manually.

OR

Select the Autosampler radio button if you wish to run with an autosampler. 
If you select Autosampler, the Location spin box becomes enabled. 
From the Location spin box, specify the sample location.
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6. Open a method that contains at least one analyte with a valid calibration curve.
The equation used cannot be Bracketing or Method of Additions.

7. Click OK on the Performance Checks dialog to begin the Detection LImit 
analysis.
The Performance Checks dialog closes and the Detection LImit Checks 
analysis begins.

FIAS Control Window
You use the FIAS Control window to manually control the FIAS pump module and 
view the progress of the FIAS program. The status of the FIAS pump module and 
the FIAS program are shown at the top of this window. The FIAS On/Off and Goto 
Next Step buttons will always be disabled since there is no FIAS program in this 
configuration.
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FIAS Control Window: A Quick Look

To display this window

On the Toolbar, click on FIAS or In the Tools menu, click on FIAS Control.

Controls and Displays

You use the FIAS Control window to manually control the FIAS pump module and 
view the progress of the FIAS program. The status of the FIAS pump module and 
the FIAS program are shown at the top of this window.

You can only use these controls when there is no analysis in progress.
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Valve Fill/Inject

To change the position of the valve, click on this button.

Fill -- The sample loop is filled with sample.

Inject -- The sample in the sample loop is injected into the carrier stream.

Pump 1

To start or stop the pump, click on this button. To the right of the button you can 
select a value for the speed of pump 1.

Pump 2

To start or stop the pump, click on this button. To the right of the button you can 
select a value for the speed of pump 1.

Remotes

Remotes 2 through 10 are switches that you use to control instruments that are 
connected to the Remote contacts on the rear of the flow-injection unit. Remote 1 
is always used to trigger the Read function on the spectrometer.

Select the box to switch the remote on; a cross appears in the box. Clear the box to 
switch off the remote.
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Controlling a FIAS Pump

When a FIAS is configured, its pumps, valve, and remotes are controlled directly 
via the FIAS Control window with one exception. When the plasma is extinguished 
for any reason (turned off by the user, or due to a hardware error), the FIAS pumps 
(if a FIAS is configured and connected), will turn off.  

The following processes are not affected by the presence of a FIAS:

• "ICP peristaltic pump.  If you do not want to use the ICP peristaltic pump while using 
the FIAS, you must turn it off manually by setting the pump speed to 0.  In this case, 
0 should be considered a valid speed; no functionality should be disabled due to a 
speed of 0.

• Startup/Shutdown.  The Pumps Off At End feature (which automatically turns the 
FIAS pumps off at the end of an analysis), is not used in ICP.  Of course, as described 
above, if the plasma is automatically shut down at the end of an analysis, the FIAS 
pumps will be turned off as part of that process.
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About Information Display Windows
An overview of the Information Display Windows follows:

Spectra Display Window

View spectra and associated information, as each spectrum is generated during an 
analysis.

The Results Display Window

View a list of the analytical results as they are generated from an analysis.

You can also print a paper copy report of the analytical results shown in the Results 
Display window.

Calibration Display Window

View the calibration curves: 

• during routine analysis to visually check the calibrations.

• during Method Development to ascertain an appropriate curve fitting 
algorithm.
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Autosampler Loading List

View the samples listed according to the autosampler location number.

Spectra Display Window
This window displays the spectra of analytes by sample either generated from the 
analysis or reprocessed from stored data. You can specify the number of panes (and 
thereby spectra) you wish to view at one time.

Use this window to:

• Evaluate the spectral data from your solutions during an analysis.
• Check the progress of an analysis.

Note Since the y-axis of every signal is expanded automatically, even baselines 
can look like analyte signals. You must look carefully at the emission scale 
to distinguish background from actual spectra. A convenient alternative is 
to view representative spectra (of blanks, standards, and samples) that are 
overlaid in the Examine window. See the Select Scale & Offset Dialog in 
Chapter 9,  Using the Examine/MSF Window, where you can maintain a 
constant y-axis scale, if desired.
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The Spectra Display window showing the spectral results of a soils analysis.

To display this window

On the Toolbar, click on Spectra.

- or -

In the Tools menu, click on Spectra.

Selecting Layout and Colors

You use the Spectra Display Options dialog to select the layout and colors for both 
the on-screen and printed Spectra window. To select this dialog, double-click 
anywhere inside the Spectra Display window or select Options menu  Spectra 
Display.

Using the Spectra Display Options dialog, you can select the layout and number 
(and, therefore, spectra to be viewed at one time). You can also select colors to 
display on screen and for printing the Spectra display window.
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In addition, if you are using Multicomponent Spectral Fitting, you can select 
whether or not to display the MSF analyte spectra along with the uncorrected 
spectra.

Resizing, labeling, and order of spectra

You can resize the Spectra Display window by placing the cursor on any side, or 
corner, of the window until the cursor changes to a double-headed arrow shape. 
Click and hold the left mouse button as you drag the mouse and change the window 
size.

• Resizing the window changes the size of each pane but not the number of 
panes.

• As the size is increased, you can view additional information, which includes 
the Intensity and Concentration values for every element to be measured in that 
solution. Also, you can see the concentration units and range for the x- and y-
axes.

• The number in the lower left-hand corner of a pane corresponds to the row 
number of the element in the Method Editor. To rearrange the order of the 
elements in the panes, you can reorder the elements in the Method Editor.

• The number in the upper right-hand corner of a pane represents the most recent 
replicate analyzed.

Spectra Display Window: Printing Spectra

You can print the spectra that is shown in the Spectra Display or Examine 
Spectra windows. To adjust the printout colors, from the Options menu select 
Spectra Display or Examine Spectra/MSF and change the colors in the Options 
dialog. If the printer color selections have been modified, and you wish to return to 
the default colors, click on Printer under the default color settings. Click OK to 
close the dialog.

Note If an analyte is displayed as “saturated,” you can correct for the saturated 
data. See Correcting Saturated Samples later in this chapter for more 
information.
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To print spectra:

1. Click on the Spectra Display or Examine Spectra window to make it the active 
window. Note that the title bar of an active window is a different color from 
other windows. (The colors displayed on your screen depend on the Windows 
colors you have defined for your PC.)

2. In the File menu, click on Print  Active Window.

3. In the Print dialog that appears, check that the correct printer is shown. If you 
need to select another printer, click the drop-down arrow next to the Printer 
Name field. Click on the Printer name to select it. To change other setup 
options such as the paper size, click on Properties.

4. Click on OK to start printing.

The Spectra Display window always uses a layout of three rows and two columns 
for printouts. Changing the layout on the screen will not affect the printout. Up to 
six spectra are printed on one page. 

When you print the Examine Spectra window, the spectra are overlaid in one graph 
on the page. 

Spectra Display Options Dialog

Using the Options menu  Spectra Display  Spectra Display Options dialog, 
you can select the layout and number of spectra to be viewed at one time. You can 
also select colors to display on screen and for printing a screen of the Spectra 
Display window. In addition, if you are using Multicomponent Spectral Fitting, 
you can select whether or not to display the MSF analyte spectra along with the 
uncorrected spectra. 
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To select a display layout

To use the default layout of all spectra, place a check mark next to Auto-
Layout. An appropriate number of rows and columns will automatically be 
selected to display all the spectra. For example, if there are 11 analytes, Auto 
Layout displays a 4 x 3 grid.

To customize row and column layout, first remove the check mark next to 
Auto-Layout. Then click on the counter spin buttons to specify the number of 
rows and columns in the display. The number of rows and columns each range 
from 1 to 16, which means that 1 to 256 panes can be displayed at once. 

Selecting Colors

To change Spectra Display screen colors:

1. In the Screen column, click on the drop-down menu for the item you want to 
change and select a color.

2. To change the colors without closing the Spectra Display Options dialog, click 
on Apply. You can see the effect of the screen color changes in the Spectra 
Display window and modify them if desired.

- or - 

If you are satisfied with the colors, click on OK to apply the changes and close 
the dialog.

Note To return to the original screen colors, click on the Screen button under 
Default Color Settings.
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To change colors for a printout of the Spectra Display screen:

1. In the Printer column, click on the drop-down menu for the item you want to 
change and select a color.

2. To change the colors without closing the Spectra Display Options dialog, click 
on Apply. To see the effect of the printer color changes, you must print the 
Spectra Display window on a color printer.

- or -

If you are satisfied with the colors, click on OK to apply the changes and close 
the dialog.

Printing Spectra

To create a printout of the spectra, select File  Print  Active Window. 
The spectra are printed in black and white or in color, depending on the type of 
printer you have. See Printing Spectra earlier in this chapter for more 
information.

Displaying MSF Analyte Spectra 

To display the corrected MSF analyte spectra, select the Enabled checkbox on 
the bottom of the screen. You can then view the corrected MSF spectra in 
comparison with the uncorrected spectra.

Selecting line widths

To select line widths for displaying spectra, type a number from 1 to 10 to 
designate the relative line width for MSF Spectra and for All Other Spectra. 
MSF Spectra Line Width defaults to 1 and All Other spectra Line Width 
defaults to 2. 

Smoothing

Check this option to smooth the displayed spectra. Analytical values are not 
effected.
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Return to the Default Colors

1. To change all of the screen colors or printer colors back to their default 
settings, select the Screen or Printer buttons under Default Color Settings.

2. To change the colors without closing the Spectra Display Options dialog, click 
on Apply. 

- or -

To apply the change and close the dialog, click on OK. 

Return to the Default User-Configurable Options

1. To change all of the user-configurable options (other than the colors) in this 
dialog back to their default settings, select Default under the Default Options 
Settings section. 

2. To change the user-configurable options without closing the Spectra Display 
Options dialog, click on Apply. You can see the effect of the changes in the 
Spectra Display window and modify them if desired.

- or -

If you are satisfied with the user-configurable options, click on OK to apply 
the changes and close the dialog.
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Results Display Window
The Results Display window shows the measurements made on the current 
samples, such as the calculated concentration values and statistical information. 

You use this window to display results that are generated from the Manual Analysis 
Control window, the Automated Analysis Control window, the Spectrometer 
Control window or the Data Reprocessing window. The format of the Results is not 
variable in this window, but you can create custom reports from the Data Manager 
Utility. (In the File menu, select Utilities, then Data Manager.)

The Results 
Display window 
showing the 
results of a soils 
analysis. Here, 
Yttrium is the 
internal 
standard. (The † 
symbol 
indicates results 
that have been 
corrected using 
internal stan-
dardization.) 
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To display this window

On the Toolbar, click on Results.

- or -

In the Tools menu, click on Results. 

To print this window

All information shown in this window can be printed in one of three ways: 

• automatically (See Printing Results later in this chapter for further 
information) 

• by selecting File  Print  Active Window (while the Results Display 
window is opened). Then click OK on the Print dialog that appears.

• by selecting File  Active Window Preview (while the Results Display 
window is opened).Click Print on the dialog that appears, then click OK on the 
Print dialog.

Tip When you clear the Results Display (Analysis  Clear Results Display), 
the contents are written to a log file called results.log in the user's home 
directory (for example, C:\pe\Default User\Temporary Files\Results.log). 
This log file is erased each time you restart WinLab32. A log file is an 
ASCII text file that can be printed, modified in a text editor (e.g., Notepad) 
or saved.

Note The Results Display window can only contain 2000 lines of information at 
a time (approximately 12 pages). When the 2000-line limit is exceeded, 
new lines are added at the end of the display and old lines are removed 
from the beginning. The lines removed from the display are stored in 
results.log under the user's home directory, for example: C:\pe\Default 
User\Temporary Files\Results.log.
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Using this window

Customize the Results Display by selecting the items you wish to include from 
Tools  Method Editor  Options page:

Select the type of information you want to include in the Results Display and the 
Printed Log for your analysis. 

Analytical Header

Select this to include a header when a new analysis is begun. A new analysis header 
is also displayed each time the current method is modified and another sample is 
analyzed.

Method Header

Select this to include a header that contains information on the method. Select short 
or expanded. 

Tip To obtain the most abbreviated list of results, select only Means and 
Statistics from the Method Editor  Options page.
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Sample Header

Select this to include a header with sample information. Click the checkbox if you 
want to start each sample on a new page.

Auto Integration Report

Select this to include auto integration data for each measurement when auto 
integration is being used. 

Replicate Data

Select this to include data for each replicate. 

Means and Statistics

Select this to include the mean values of each set of replicates and to include the 
standard deviation and the relative standard deviation. You must have means 
selected in order to display statistics.

Analysis List

Select this option to include a summary of the operations that were performed on 
all of the samples.

Calibration Summary (Auto Analysis only)

Select this to include a calibration summary in the Results Display window. If this 
is selected, the calibration summary is automatically included for automated 
analyses after the last standard is analyzed. 

Matrix Test Reports

If there is a sample matrix, mark this box to include matrix reports.

Note For manual analyses, you must select the Calibration Summary command 
in the Analyses menu.
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Save with Results: Spectral Data

Select this to include the spectral data in the results data set. The spectral data must 
be stored in a results data set if it is to be displayed in the Examine Spectra window 
or used for setting up MSF models or Data Reprocessing.

Save with Results: Copy of Method

Select this to include a copy of the method used to generate results in the results 
data set. A new copy of the method is included with the results each time the 
method is modified and another sample is analyzed. The method stored with the 
results can be recalled into memory by using the Import from Results Library... 
command in the File menu.

Remarks 

Use this entry field to type your comments regarding the method.

Saving this window

When you clear the Results Display (Analysis  Clear Results Display), the 
contents are written to a log file called results.log in the user's home directory (for 
example C:\pe\Default User\Temporary Files\Results.log). This log file is erased 
each time you restart WinLab32. A log file is an ASCII text file that can be printed, 
modified in a text editor (e.g., Notepad,) or saved. 

An overview of this window 

The following are the major sections that may appear in the Results Display 
window:

• Analytical Header

• Auto Integration Header and Information

• Replicate Header and Information

Note The Results Display window is not cleared automatically when you start a 
new analysis. To clear the window, select Analysis  Clear Results 
Display.
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• Mean Header and Information

• Calibration Summary Header and Information

• Sample Header 

• Method Header 

For information on saturated samples, see Correcting Saturated Samples later in 
this chapter.

Results Display Window: Analytical Header

A discussion of each entry from the Analytical Header appears below:

Start Time

The date and time when the current analysis began.

Logged In Analyst

The name of the Analyst taken from the Windows system log in.

Spectrometer Model

The Spectrometer Model selected in the current configuration.

Plasma On Time

The time the plasma was ignited.

Technique

The name of the sampling technique selected in the Select Sampling Technique 
dialog. (ICP, Continuous, ETV, AA - Flame, fumes.)

Note To set the format for Date/Time, from the Windows Control Panel click 
the Date/Time icon and enter the information in the dialog box.
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Autosampler Model

The type of Autosampler model you are using.

Sample Information File

The name of the Sample Information File (.SIF file) and the full pathname.

Results Data Set 

The name of the Results Data Set. A Data Set contains the essential components of 
an analysis, i.e., the Method, the spectral data, Sample Information and the 
analytical results. You specify the Results Data Set name when any one of the 
following actions is performed:

• Manual Analysis Control window  Results Data Set Name (Open button) 
 Results Data Set dialog 

• Automated Analysis Control window Set Up tab  Results Data Set Name: 
(Open... button)  Results Data Set dialog 

• Data Reprocessing window  Save Results in Data Set (Open... button)  
Results Data Set dialog

Results Library

The name and location of the Library where the Results are saved.

Results Display Window: Auto Integration Header and Information

Auto Integration entries:

Analyte

The name of the analyte.

Note Look at all of the selections on the Method Editor window  Options 
page to get an overview of the selected Analytical Results that will appear 
in the Results data set or the Results window.
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Integration Time

The time period in seconds in which the detector collects light from the plasma 
before dumping the charge and reading out the signal.

Number of Integrations

Read time divided by integration time gives you the number of integrations 
performed per replicate.

Read Time

The total measurement time in seconds per replicate.

Refer to the Method Editor for a full discussion of each parameter.

Results Display Window: Replicate Header and Information

Following each sample header is the replicate header along with the results for each 
analyte. (A replicate is a repeated read cycle performed on a sample and calibration 
solution.)

Replicate Data

The identification name you gave to the sample solution.

Replicate Number

The number of the current replicate in a series of replicates performed on each 
analyte. You select the number of total replicates for the analytes in the: 

• Method Editor  Spectrometer  Settings tab 

Analyte

The name of the element analyzed. The element symbol is shown along with the 
emission wavelength that was used. The element and wavelength are taken from 
the active method. 

Net Intensity

The resulting intensity from the element analysis minus the background signal. 
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Corrected Intensity

The resulting intensity after an internal standard correction (for example, blanks, 
reagent blanks, internal standards, IEC models) has been applied.   

Calibration Concentration Units

The concentration of the element in calibration units. You select these units in the:

• Method Editor  Calibration pages  Calibration Units and Standard 
Concentrations page.

Concentration Sample Units

The concentration of the element in sample units. Conversion from sample results 
determined in Calib Units to results expressed in Sample Units involves 
corrections made for weight, volume, and dilution information supplied for 
samples in a Sample Information File (or the Sample Details dialog in a manual 
analysis), e.g., converting from mg/L to mg/kg. Corrections are also automatically 
made for converting units with order-of-magnitude differences, e.g. converting 
mg/L to µg/L.

You select these units in the:

• Method Editor  Calibration pages  Equations and Sample Units tab or in 
the Sample Information Editor.

If the sample units in the Sample Information Editor differ from those in the 
Method Editor, the sample units in the Sample Information Editor will be used.

Analysis Time

The time when the current sample was analyzed.

Note To set the format for Date/Time, open the Windows Control Panel and 
double-click on the Date/Time icon.
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Results Display Window: Mean Header and Information

An explanation of the Mean information appears below:

Analyte

The name of the element analyzed at a specified wavelength. The element symbol 
is shown along with the emission wavelength that was used. The element and 
wavelength are taken from the active method.

Mean Corrected Intensity

For each sample, the mean corrected intensity. The mean concentration is 
expressed in standard units or sample units.

Concentration in Calibration Units

For each sample, the concentration calculated using the mean corrected intensity 
value.

Standard Deviations

For each sample, the standard deviation of the mean standard concentration values 
expressed in calibration units or sample units.

Sample Concentration Units

For each sample, the mean sample concentration expressed in sample units.

%RSD

For each sample, % RSD of either the corrected signal and the mean standard (or 
sample) concentration.

Information Line

Additional information about the sample measurements that may be of interest to 
you, e.g., standard applied, QC messages (including QC recoveries), etc.
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Results Display Window: Sample Header

A discussion of each entry from the Sample Header appears below:

Sequence No.

This is the sequence in the run list.

Sample ID

The name you give to each sample. Can be any combination of letters and numbers 
up to 25 characters.

Analyst

The name of the person performing the analysis. This is entered in the Sample 
Information file.

Nebulizer Back Pressure

This is the argon flow rate for the nebulizer or sample carrier gas. 

Valid range: 0 - 2.0 L/min. 

(This option is not available on the Optima 3000 series instruments.)

Sample Wt:

When working with weight units, this is the sample weight entered in the Sample 
Information File.

Dilution

If a sample was diluted, the dilution factor (10ml to 100 ml is a factor of 10).

Autosampler Location

The location of the solution in the autosampler.

Date Collected

The date and time when the current sample was analyzed.
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Sample Prep Volume

After a solid sample has been dissolved or a liquid sample has been acidified (or 
otherwise treated) the resulting solution is prepared to a specific volume. This is 
the Sample Prep Volume. The information is from the Sample Information File.

Data Type

Original or Reprocessed.

Results Display Window: Method Header

You can display a short or expanded method header in the Results Display window. 
Make a selection in the Method Editor  Options tab. 

A discussion of each entry from the Method Header appears below.

Method Name 

The method name used for the analysis. You specify this name when you select

• File menu  Save As...  Method  Save Method As dialog 

IEC

The name of the Interelement Correction File (.IEC file) will appear only if you 
make the appropriate selections:

• Method Editor  Process page  Spectral Corrections tab (select IEC for 
an element under the Overlap Correction Column and select an IEC Table) and 
Results are saved.

Note To set the format for Date/Time, from the Windows Control Panel click 
the Date/Time icon and enter the information in the dialog box.
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Method Description

A brief description of the method used for the analysis. You specify this name 
when you select

• Method Editor window  Spectrometer page  Define Elements tab  
Method Description

Method Last Saved

The date and time of the method was last saved.

MSF

The name of the Multicomponent Spectral Fitting File (.MSF file) will appear only 
if you make the appropriate selections:

• Method Editor  Process page  Peak Algorithm..., tab (select MSF for an 
element under the Peak Algorithm Column). Also select an MSF Table on the 
Spectral Corrections page.

Method Header Expanded

The Expanded Method Header contains all the above entries, plus the additional 
entries listed below.

Analyte

The name of the element analyzed. The element symbol is shown along with the 
emission wavelength that was used. The element and wavelength are taken from 
the active method. 

Calib Eq'n

This is the calibration equation that is specified in the current method. (A list of 
calibration types is shown on the Calibration page of the Method Editor window.) 
After the calibration curve has been determined, you can clear (delete) the 
calibration by clicking on Clear Calibration Blank from the Analysis menu.

Processing

Peak area, peak height or MSF.
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View

Plasma viewing condition: Attenuated Axial or Attenuated Radial. 

Internal Standard

Lists the name of the Internal Standard as it appears on the Spectrometer pages, 
Define Elements tab. If there is no Internal Standard, then None or N/A is 
displayed.

IEC

InterElement Correction, Yes/No.

Results Display Window: Calibration Summary Header and 
Information

The following information is shown in the Calibration Summary:

Analyte

The name of the element used for the calibration. The element symbol is shown 
along with the emission wavelength that was used for the calibration. The elements 
and wavelengths are taken from the active method.

Standards

The total number of standards applied. The standards are taken from the active 
method. 

Equation

The type of calibration equation used to calculate the calibration curve, taken from 
the active method. Possible choices are linear, linear-bracketed, linear-thru-zero or 
non-linear. See the Method Editor Calibration pages: Calibration Equations and 
Sample Units page in Chapter 3,  Using the Method Editor.

Intercept

The calculated y-intercept of the calibration curve. The y-intercept is the point 
where the calibration curve crosses the y-axis of the calibration plot. It represents 
zero concentration. 
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Slope

The calculated slope of the calibration curve. Slope represents the relationship of 
the increase in intensity to the increase in concentration. It is the ratio of the change 
in the y-axis to the change in the x-axis.

Curvature

The calculated curvature is the “a” coefficient in the equation (b = slope and c = 
intercept):

where x is the concentration and y is the intensity for a non-linear calibration curve. 

Correlation Coefficient

The calculated correlation coefficient. The correlation coefficient shows how well 
the data fit the calibration curve. A value of 1.000000 indicates a perfect fit.

Reslope

The reslope standard is used to make small corrections to the slope of the 
calibration curve. Usually, a calibration blank is analyzed just before the reslope 
standard. The new reslope value is then compared with a multipoint curve. 

Reslope is a time-saving device that lets you adjust a curve without running 
multiple calibration sites. The application uses the new curve (reslope) to 
determine the concentration values.

Note The value will always be 1.000000 if your calibration curve has only two 
points (calibration blank and 1 calibration standard).

y ax bx c= + +2
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Results Display Window: Printing Results

You can automatically send a hard copy report of the analytical results to the 
printer as the results are generated.

To print a log of your results

Make sure that there is a checkmark in the Print Log box in the Manual 
Analysis Control, Automated Analysis Control, or Data Reprocessing 
window. If it is blank, click on the checkbox if to select it. You must have a 
printer online. The default printer is automatically selected. Options for the 
printed log can also be selected on the Options tab of the Method Editor.

Correcting Saturated Samples

One or more of the samples you analyzed may indicate an intensity of “saturated.” 
If an analyte saturates, you will either see the indication of “Saturated” in the 
Results Display window (listed under Net Intensity) or the Spectra Display 
window. In the Examine Spectra window, the sample ID will be crossed out and 
either the saturation intensity value or the word “Saturated” will appear in the 
Intensity column.

When an analyte saturates, it means that the measurement at the chosen wavelength 
could not be made because the intensity of the emitted light was too high to 
measure. 

The reasons for an analyte saturating are:

• The sample contained too high a concentration of the analyte

• The wavelength chosen for the analyte was too sensitive

In some cases, saturation may occur if the read delay is not sufficient when the 
instrument takes an initial measurement (called a pre-shot) to determine the auto 

Note If you want to be certain that all of the analytical results generated by the 
Optima are documented you are encouraged to print a log during the 
analysis.
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integration time. Try increasing the read delay to allow the signal to be fully 
stabilized in the plasma before a measurement is taken.

The software displays a saturation error code or message to give further 
information. Refer to Saturation Codes.

To correct for saturation, do one of the following:

Choose a less intense wavelength for the analyte.

To change the wavelength, open the Method Editor, and select a different 
wavelength for the element. Make this selection from the Spectrometer page. 
Save the method and then reanalyze the samples. 

On Dual View instruments, you can change the plasma viewing type from 
Axial to Radial.

By changing the viewing type to Radial, the intensity at the wavelength of 
interest may decrease.

Change the viewing type on the Sampler: Plasma page of the Method Editor. 
Save the method and then reanalyze the samples.

Dilute the sample.

To decrease the concentration of the element, you can dilute the sample. If you 
choose to dilute the sample, be sure to update the dilution information in the 
Sample Information File and save the file before reanalyzing the samples. See 
Using the Sample Information Editor in Chapter 4,  Sample Information 
Editor, for more information.

Note On scanning CCD ICP spectrometers, you have the option of using 
Attenuated Axial or Attenuated Radial as the plasma viewing type in the 
method. Use these settings to provide lower intensities for samples of high 
concentration that would normally saturate the detector and for sensitive 
wavelengths.
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Saturation Codes

The software provides the following saturation error codes or messages. In some 
cases, saturation is indicated during “preshot.” This is an initial reading that is 
taken to determine the optimum auto-integration time. On the Options page of the 
method you can select Auto Integration Report which will give you the exact 
integration times determined during “auto-integration” or “pre-shot.”

Code Description

2 “Saturated2” appears in the Net Intensity column in the Results 
Display. This information also appears in the Spectra Display 
window. This code and message applies only to simultaneous ICP 
spectrometers. 

The intensity measured during pre-shot is too high for several 
wavelengths and the detector cannot read out the data. You may be 
able to rerun the analysis and select only one of the wavelengths to 
prevent saturation from occurring. 

3 “Saturated3” appears in the Net Intensity column in the Results 
Display. This information also appears in the Spectra Display 
window. 

The intensity measured for the analyte during pre-shot is too high, 
even for a 1 ms integration (the shortest integration time available). 
Either the wavelength chosen for the analyte was too sensitive or 
the sample contained too high a concentration of the analyte. 
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4 “Saturated4” appears in the Net Intensity column in the Results 
Display. This information also appears in the Spectra Display 
window. 

The intensity measured for the analyte during the replicate readings 
is too high. This may have occurred because the signal wasn’t 
stabilized before the pre-shot measurement, so the signal intensity 
changed between the “pre-shot” reading and the time the replicate 
was measured.

For the Optima 2000/2100, in manual integration, the message 
“Saturation within survey window” appears in the Results Display. 
For either type of integration, the message “Saturated. Code = 4” 
appears in the Spectra Display. 

First, try increasing the read delay and rerunning the analysis. If 
saturation still occurs, the wavelength chosen for the analyte was 
too sensitive or the sample contained too high a concentration of the 
analyte.

5 In auto integration, the message “Saturation outside of integration 
window” appears in the Results Display. A peak with too high an 
intensity was found outside of the auto integration window but 
within the survey window. 

For the Optima 3000/ 4000/5000, in manual integration, the 
message “Saturation within survey window” appears in the Results 
Display. For either type of integration, the message “Saturated. 
Code = 5” appears in the Spectra Display. 

For more information on the integration and survey windows, refer 
to the Spectral Windows page in the Method Editor. The saturated 
peak may not be the analyte of interest, but an interferent. If you are 
using background correction, be sure to check that the background 
correction points are not placed in the range where saturation is 
occurring, which can invalidate your results. 
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Calibration Display Window
The Calibration Display window shows the active calibration as it is being 
generated and when it is being used by the system. If this window is empty, there 
is no active calibration curve.

You use this window to:

• Determine whether the standards lie on the curve and compare this graphic 
display of the calibration to the correlation coefficient.

• Check that you have selected the correct algorithm (linear, linear-bracketing, 
inear through zero, and nonlinear) for the calibration.

• View the effect on the calibration after selection of different algorithms or 
other Method parameters (e.g., subtraction). 

• Print this window for your reports to present a graphical display of the 
calibration.

• Reslope. Run a calibration curve with two or three standards (a multipoint 
curve). Use Reslope to determine a new value for the curve to compare it with 
the multipoint curve. 

6 In auto integration, the message “Saturation outside of integration 
window” appears in the Results Display. In manual integration, the 
message “Saturation outside survey window” appears in the Results 
Display. A peak with too high an intensity was found outside of the 
survey window. For either type of integration, the message 
“Saturated. Code = 6” appears in the Spectra Display. 

For more information on the integration and survey windows, refer 
to the Spectral Windows page in the Method Editor. 

The saturated peak may not be the analyte of interest, but an 
interferent. If you are using background correction, be sure to check 
that the background correction points are not placed in the range 
where saturation is occurring, which can invalidate your results. 
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To display this window

On the Toolbar, click on the Calib button .

- or -

In the Tools menu, click on Calibration.

Selecting Layout and Colors

To select the layout, number of calibration curves to be viewed at one time, and 
colors for both the on-screen and printed Calibration window, you use the 
Calibration Display Options dialog. To display this dialog, double-click anywhere 
inside of the Calibration Display window. Or, in the Options menu, click on 

The Calibration 
Display window 
showing 
calibration 
curves for a 
soils analysis.)
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Calibration Display. For information on printing, see Printing the Calibration 
Display window later in this chapter.

Reslope

Run a calibration curve with two or three standards (a multipoint curve). Use 
Reslope to determine a new value for the curve to compare it with the multipoint 
curve. The reslope curve, which appears as a dashed line, lets you adjust a curve 
without running multiple calibration sites. The application uses the new curve 
(reslope) to determine the concentration values.

Resizing, labeling and order

You can resize the Spectra Display window by placing the cursor on any side or 
corner of the window until the cursor changes to a double-headed arrow shape. 
Click and hold the left mouse button as you drag the mouse and change the window 
size.

• Resizing the window changes the size of each pane but not the number of 
panes.

• As the size is increased, you can view additional information, which includes 
the Intensity and Concentration values for every element to be measured in that 
solution. Also, you can see the concentration units and range for the x- and y-
axes.

• The number in the lower-left corner of a pane corresponds to the row number 
of the element in the Method Editor. To rearrange the order of the elements in 
the panes, you can reorder the elements in the Method Editor. 

Calib Eq'n

This is the calibration equation that is specified in the current method. (A list of 
calibration types is shown on the Calibration page of the Method Editor window.) 
After the calibration curve has been determined, you can clear (delete) the 
calibration by clicking on New Calibration from the Analysis menu.

Corr. Coeff.

The correlation coefficient indicates how well the data fit the generated calibration 
curve. A value of 1.0000 would indicate a perfect fit.
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Calibration Display Window: Printing Calibration Curves

You can print the calibration curves shown in the Calibration Display window. To 
adjust the printout colors, from the Options menu select Calibration Display and 
change the colors in the Calibration Display Options dialog.

If the printer color selections have been modified and you wish to return to the 
default colors, click on the Printer button under Default Color Settings. 

To print calibration curves:

1. Click on the Calibration Display window to make it active. Note that the title 
bar of an active window is a different color from other windows. (The colors 
that appear depend on the Windows settings you have chosen on your PC.)

2. In the File menu, click on Print  Active Window.

3. In the Print dialog that appears, check that the correct printer is shown. If you 
need to select a different printer, click the drop-down arrow next to the Printer 
Name field. Click on the Printer name to select it. To change other setup 
options, such as the paper size, click on Properties.

4. Click on OK to start printing.

The calibration curves are always printed in a layout of two columns and three 
rows. Changing the layout on the screen will not affect the printout. Up to six 
calibration curves are printed on one page.

Calibration Display Options Dialog

Using this dialog, you can select the layout and number of calibration curves to be 
viewed at one time. You can also select colors to display on screen and for printing 
a screen of the Calibration Display window.To display this dialog:

In the Options menu, click on Calibration Display.

- or -

Double-click anywhere inside of the Calibration Display window.
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To select a display layout 

To use the default layout of all calibration curves, select Auto-Layout. An 
appropriate number of rows and columns will automatically be selected to 
display all the calibration curves. For example, if there are 11 analytes, Auto 
Layout displays a 4 x 3 grid.

To select rows and columns, first click the check box next to Auto-Layout to 
clear the check mark. This makes the row and column fields available. Then 
click on the counter spin buttons to specify the number of rows and columns in 
the display. The number of rows and columns each range from 1 to 16, which 
means that 1 to 256 panes can be displayed at once. 

Selecting Colors

To change individual screen colors:

1. In the Screen column, click on the drop-down menu for the item you want to 
change and select a color.

2. To change the colors without closing the Calibration Display Options dialog, 
click on Apply. You can see the effect of the screen color changes in the 
Calibration Display window and modify them if desired.

- or -

If you are satisfied with the colors, click on OK to apply the changes and close 
the dialog.

Note To return to the original screen colors, click on the Screen button under 
Default Color Settings.
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To change colors for a printout of the Calibration Display screen:

1. In the Printer column, click on the drop-down menu for the item you want to 
change and select a color.

2. To change the colors without closing the Calibration Display Options dialog, 
click on Apply. To see the effect of the printer color changes, you must print 
the Calibration Display window on a color printer. 

- or -

If you are satisfied with the colors, click on OK to apply the changes and close 
the dialog.

To Print Calibration Curves

To create a print out of the calibration curves, in the File menu, click  Print  
Active Window. The calibration curves are printed in black and white or color, 
depending on the type of printer you have. 

Return to the Default Colors

1. To change all of the screen colors or printer colors back to their default 
settings, select the Screen or Printer buttons under Default Color Settings.

2. To change the colors without closing the Spectra Display Options dialog, click 
on Apply. 

- or -

To apply the change and close the dialog, click on OK. 
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Autosampler Loading List

Use this window to view and print the list of solutions you need to fill the 
autosampler tray. The information shown is taken from the active method and the 
current sample information file.

To display this window

Make the appropriate entries on the Set Up page of the Automated Analysis 
Control window and then click on the Analyze tab.

In the System menu, click on Autosampler Loading List.

An example of an Autosampler Loading List window follows:

Using this window

1. Set up an automated or manual analysis by selecting a method and sample 
information file.

2. In the Autosampler Loading List, review the following information:  the name 
of the method used, the sample information file used and the blanks, 
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calibration standards and samples in the order that they are to be placed in the 
autosampler tray. 

3. To print the list, in the File menu, select Print Active Window, and in the print 
dialog that appears, click on OK.

Note In the list of autosampler locations and solutions, the method is not shown 
for samples (unknowns). 
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Spectral Interference Overview
The presence of Spectral Interferences can cause the results of an analysis to be 
incorrect. The software provides several techniques for minimizing or completely 
removing spectral interferences.

For information on WinLab32 interference correction techniques, see About 
Interference Correction later in this chapter.

About Spectral Interferences

Spectral interferences encountered in ICP-OES fall into four different categories, 
each with its own causes and remedies.
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Simple Background Shift

A shift in background 
that is essentially 
constant over a given 
range. The background 
may shift either up or 
down. 

Cause

A high concentration 
of the interfering 
analyte may emit a 
continuum of radiation 
in the given 
wavelength range

Remedy

Set a background 
correction point 
somewhere near, but not 
falling on, the profile of the 
analyte you are measuring. 
Or select a different 
wavelength that is not 
affected by the interferent.
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Sloping Background Shift

A shift that occurs on only 
one side of the given 
wavelength range

Causes

(1) Overlapping of an 
analyte line by one 
wing of another 
severely broadened line 
nearby

(2) Molecular emission 
bands are sometimes 
present in the ICP 
discharge, especially 
when the plasma is not 
shielded from the 
ambient atmosphere.

Remedy

Since the slope of the 
interferent is 
constant on either 
side of the peak, set 
two background 
correction points, 
one on either side of 
the peak of the 
analyte you are 
measuring.
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Direct Spectral Overlap

Ideally no interfering emission 
line can fall directly on the 
analyte emission line; 
however, because spectral 
lines have a finite width and 
measurement systems are 
imperfect, direct spectral 
overlap does occur.

Cause

Two lines may 
appear to be 
overlapped when 
they cannot be 
resolved by the 
spectrometer.

Remedy

Use an alternate 
wavelength for the 
analyte you are 
measuring, if available. 
Or use the Inter-
Element Correction 
(IEC) technique.
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Complex Background Shift

This type of shift is 
represented by a shift in 
background intensity that 
varies significantly on either 
side of the analyte line.

Cause

This interference is 
usually caused by 
the occurrence of a 
number of intense, 
closely spaced 
emission lines 
nearby, and 
perhaps directly 
overlapping, the 
analyte 
wavelength.

Remedy

Use an alternate 
wavelength for the 
analyte you are 
measuring, if available. 
Or use the Multi-
spectral component 
Fitting (MSF) 
technique.
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About Interference Correction

WinLab32 offers several methods to correct spectral interference.

Choose a topic that describes a method you are interested in learning more about:

• Setting Background Correction Points

• Using Inter-Element Correction (IEC)

IEC corrects interferences as long as the concentration of the interfering 
element remains within the linear concentration range, the matrix remains 
constant, and the plasma conditions remain unchanged. 

For information on the similarities and differences between IEC and MSF, see 
IEC or MSF: Which to Use later in this chapter.

• Using MSF (Multicomponent Spectral Fitting)

MSF uses mathematical models to distinguish analyte spectra from interfering 
spectra. MSF involves a very different process for interference correction as 
compared to IEC. 

As well as correcting for interferences, MSF can improve detection limits and 
precision. MSF uses a multiple linear regression to fit the models created to 
unknown spectra during an analysis. Since, only the peak shapes need to 
remain constant, typically, the models are independent of concentration, 
plasma conditions, and matrix effects.

For information on how to apply MSF, see Using the MSF Menu in Chapter 9,  
Using the Examine/MSF Window.

For background and tutorial information about MSF, see Overview of How 
MSF Functions in Chapter 9,  Using the Examine/MSF Window. 
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IEC and MSF: Which To Use

IEC and MSF are two techniques you can use to minimize or remove spectral 
interferences. Inter-Element Correction (IEC) uses mathematical correction factors 
to reallocate emission intensities. Multicomponent Spectral Fitting (MSF) uses 
multivariate calibration to determine the concentration of an analyte.

Use IEC if...

• You expect direct spectral overlaps.
• You are taking data for use by an organization that requires Interelement 

Correction.

Use MSF if...

• You want better interference correction, better detection limits, and better 
precision than are normally obtained with IEC.

IEC and MSF: Similarities, Differences, and Restrictions on Use

Similarities

Both IEC and MSF:

• Involve mathematical adjustment/recalculation of intensity data

• Require an initial analysis to create a mathematical model

• Save the model as a file for use in the Process Page/Spectral Corrections tab of 
the method.
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Differences

IEC MSF

Model created and 
edited

IEC Model Builder 
window

Examine MSF window

Model stored IEC file MSF file

Model used in the 
method

Overlap Correction set to 
IEC and IEC table name 
selected in method 

Processing mode is set to 
MSF and MSF table name 
selected in method 

Restrictions on use You must use the same 
resolution, profiling, 
background correction 
points, and plasma 
parameter entries for IEC 
data collection as for end 
use. 

You must use the same 
resolution and profiling 
settings for data 
collection as for end use. 
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Overview of the IEC Process
Interelement Correction (IEC) is a method of correcting for spectral interferences. 
It uses mathematical correction factors to reallocate emission intensities. Use the 
Interelement Correction Model Builder window to set up and update IEC 
corrections for the elements and wavelengths you are analyzing. IEC can be run 
using Data Reprocessing or in an analysis.

Before you use this window, you must complete the Preliminary Steps described 
below. Once the data have been collected, use the IEC window as a tool to 
interactively determine the factors. This window also gives you the option of 
changing certain method parameters and having the new settings incorporated into 
the calculated IEC factors.

Preliminary Steps

Before you create an Interelement Correction Table (IEC), you must:

• Open the Method Editor and, in your method, define the calibration standards 
and a pure solution for each interfering analyte. 

• Run an analysis, making sure you store the data so that it can be reprocessed 
using IEC. 
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• Once analysis is completed, set up an IEC model to calculate factors and set 
correction limits. 

Using IEC

Here is a summary of how to use the IEC model.

• Open the IEC Model Builder from the Tools menu

• Create and save the model (the .IEC file)

• Specify the IEC file in the method and save the method

• Analyze your samples or reprocess your data

Notes You should have the same Resolution setting, background correction 
points, and plasma parameter entries for IEC data collection as for the 
analysis you want to correct. If you change any of these parameters in the 
method, you should recreate IEC factors.

If you have some elements for which you want to create IEC factors for 
multiple wavelengths, refer to Multiple Wavelengths per Element.

If you do not follow the procedures in Multiple Wavelengths per Element, 
you will get errors if you try to collect IEC data for any element with more 
than one wavelength in the method. 
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Interelement Correction Model Builder
How IEC Works

When the calibration standards and interfering analyte solutions are read, 
WinLab32 builds a mathematical matrix that defines the concentrations observed 
for each analyte. This matrix, which is stored in the IEC table file, is a model of the 
spectral interferences expected from the elements you analyzed.

Each IEC standard solution is measured for the analytes you designate in the active 
method. (It is possible to deselect or “disable” elements from this analysis using the 
Enable/Disable Elements dialog.) The IEC correction factors are the ratios of the 
apparent concentration for each analyte to the concentration measured for the IEC 
reference element.

You do not have to analyze an IEC Standard solution for every element in your 
analysis, only those that produce interferences you want to correct for using IEC. 
If you skip IEC Standard solutions, WinLab32 assumes that there is no interference 
from these elements and will use zeros for these elements in the IEC table.
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Creating an Interelement Correction Table

You create an Interelement Correction Table by entering information on the pages 
of the IEC Model Builder window. The following steps provide an overview of this 
process. For complete information about using each page, click on the page name 
in the steps below.

To create a new IEC table: 

1. In the Tools menu, select IEC Model Builder.

The IEC Model Builder window Set Up page appears.

2. If another IEC model already exists, and you want to start a new one, select 
New from the File menu. Then select IEC Model. (This option is grayed out 
unless the IEC Model Builder window is open.)

3. On the Set Up page, click on Open... to select the Results Data Set to be used 
in determining the factors. Enter any remarks you want to save with the file.

4. On the Set Limits page you can enter correction limits for each analyte in the 
Minimum Concentration for Interference Correction column. Note that you 
can skip this page and set low factors to zero after calculation using the 
Calculate Factors page.

5. On the Calculate Factors page, select samples (the pure solutions of the 
interferents), and then match the various analytes requiring interference 
correction with the samples that contain the pure interfering element. Factors 
are automatically calculated after you choose an interfering analyte. 

6. On the Summarize Factors page you can print the factors. You can also edit the 
factors on this page before saving. 

7. Save the IEC model by selecting Save from the File menu. Then select IEC 
Model. 

Note Before you set up the IEC model, run an analysis as you normally would 
and save the data.
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8. Click Update Method to update analytes in the method which require IEC 
correction. 

To modify and re-save the IEC factors:

• If you modify the IEC factors and want to save the changes, on the File menu, 
select Save  IEC Model.

• If you modify the IEC factors and want to save the changes but also retain the 
original file, from the File menu select Save As  IEC Model.

• To save the information as a text file, from the File menu, select Save As Text 
 IEC Factors.

To use an existing IEC model with a new result data set

You can recalculate the factors of an existing IEC model to use with a different 
results data set, i.e., a results data set other than the one you used to create the IEC 
model.

1. Create a new IEC table or open an existing one.

2. On the Set Up page, click Open… to select a different results data set.

A warning message appears asking if you want to recalculate IEC factors.

3. Click on Yes to recalculate IEC factors based on the selected result data set. (If 
you click No, the current model is cleared.) 

The samples in the selected results data set are checked against samples in the 
IEC model.

If the new results data set does not contain samples that are in the current 
IEC model, a message appears informing you that samples are missing.

If the new results data set contains the same samples as in the IEC model, 
the new results set is checked for duplicate sample IDs. If duplicate sample 
IDs exist, you are given an opportunity to choose one sample from each 
group of duplicates. Samples from the new result data set are checked if 
they contain analytes that are part of the current IEC model. A message 
appears that describes each sample along with its missing analytes.
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Modifying an Interelement Correction Table

You can modify an existing IEC table by reanalyzing IEC standards, analyzing 
new IEC standards or directly editing the table. 

To edit IEC factors directly:

1. In the Tools menu, click on IEC Model Builder.
The IEC window, Set Up page appears.

2. In the File menu, click on Open  IEC Model... and select the IEC file 
name, or on the Set Up page, click on Open… to find and select the results data 
set used. 

3. Enter new factors on the Calculate Factors Page.

To save the changes:

1. If you modified the IEC factors and want to save the changes, on the File menu, 
select Save  IEC Model.

2. If you modified the IEC factors and want to save the changes but also retain the 
original file, from the File menu select Save As  IEC Model.

3. To save the information as a text file, from the File menu, select Save As Text 
 IEC Factors. 

Multiple Wavelengths per Element

Refer to the following guidelines when you want to create IEC factors for elements 
with multiple wavelengths.

For a given analyte, you cannot have IEC factors for more than one Reference 
Element per interfering element.

Note If you do not use these guidelines, you will get errors if you try to collect 
or use IEC data for any element with more than one wavelength in the 
method.
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For example, if multiple Fe lines are used in an analysis and the analyst needs 
to correct for Fe interference on an analyte line, only one of the Fe lines (i.e. 
Reference Elements) can have a non-zero IEC factor in the row for that analyte. 

Also, it is important when an IEC Standard for an interfering element with 
multiple lines in a method is analyzed, that the other “elements” defined for the 
interfering element are not analyzed as analytes. Otherwise, you would be 
making a correction for an element on itself. 

For example, you would be correcting for the interference of Fe on Fe.

To ensure that only one Reference Element per interfering element has IEC 
factors associated with a given analyte, it is best to analyze only one IEC 
Standard per interfering element. To avoid the situation where an element is 
corrected for interference upon itself, you can disable data collection for those 
elements by using the Enable/Disable Elements function. See the Analysis 
Menu in Chapter 11,  Menus and Toolbar. 

Example 1

As an example, suppose you have a method that contains three Fe lines named Fe1, 
Fe2, and Fe3. For the simplest case, we will use Fe1 as the Reference Element for 
all IEC corrections. To create IEC factors for Fe interference correction:

1. Calibrate using the method as usual using the Calib page. 

2. When ready to analyze the Fe IEC Standard on the Analyze page: 

• Select Fe1 as the Reference Element.

• In the Analysis menu, open the Enable/Disable function and disable Fe2 
and Fe3.

• Analyze the Fe IEC Standard.

Note Remember to re-enable Fe2 and Fe3 before measuring IEC Standards for 
other elements.
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Example 2

In a more complex example, suppose that you are using the same method 
containing three Fe lines, but you want to use Fe1 as the Reference Element for 
correction of Fe on As and Fe2 for correction of Fe on Cr. You may want to do a 
correction of this sort so that you can match an interferent atom line with an analyte 
atom line and interferent ion line with an analyte ion line to improve the quality of 
the interference correction. To create the Fe IEC factors for this situation: 

1. Calibrate as usual.

2. To create the factor for correction of Fe on As,

• Select Fe1 as the Reference Element.

• Disable Fe2, Fe3, and Cr.

• Analyze the Fe IEC Standard.

• Select Fe2 as the next Reference Element.

• Re-enable Fe2 and Cr and disable Fe1 and As (Fe3 should still be 
disabled).

• Analyze the Fe IEC Standard.

Remember to enable the disabled elements before measuring other IEC Standards.
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Interelement Correction Model Builder: 
Set Up Page

Use this page to select the Results Data Set containing the data to be used in 
determining the factors. Enter comments in the Remarks field.

To display this page

In the Tools menu, click on IEC Model Builder. The Inter-Element 
Correction Model Builder opens with the Set Up page displayed.

To use this page

1. If you already have a model that you want to change, from the File menu, click 
on Open - IEC Model.

The Open dialog appears.

2. Select a file name, or enter a new file name. 

3. Click on OK.
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To open a data set:

1. Click the Open button on the Set Up page to search for an existing data set.
The Select Results Data Set window appears.

2. Click the Browse button if you need to search for another data base.
The Open dialog appears.

3. Search for and select the file.

4. Click on Open.

The data sets are listed in the Select Results Data Set window.

5. Select a data set.

6. Click on OK. 

After you have selected a data set, the file name appears in the Results Data Set 
field. The Method Used to Collect Data field is automatically filled in.

Remarks

Use this entry field to type your comments regarding the IEC table.
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Interelement Correction Model Builder: 
Set Limits Page

On the Set Limits page of the IEC Model Builder you can define the correction 
limit for elements that you are measuring. For example, you can enter the detection 
limits of the analytes. Any apparent concentration from an interfering element at or 
below the value entered should be set to zero. Note that the units should be the same 
as the calibration units entered on the Calibration page in the method. 

To display this page

1. On the Tools menu, select IEC Model Builder.

2. Click the Set Limits tab.

Note You may choose to skip this page and simply set low factors to zero after 
calculation using the Calculate Factors page.
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To Use This Page

Analytes

This column automatically lists the analytes from the results data set chosen on the 
Set up page. Read through this list to make sure that these are the analytes for which 
IEC factors should be calculated. 

Minimum Concentration for Interference Correction

You can manually change any entry in the Minimum Concentration column by 
typing in a new entry on the Set Limits page. 

You can also double-click on the Minimum Concentration heading to display the 
Minimum Concentration Column Fill dialog. The concentration limit you enter in 
this dialog will be entered for all analytes on the Set Limits page. Click OK to close 
the dialog. 

You can also select a range of entries or select noncontiguous entries and then 
display the Minimum Concentration Column Fill dialog. 

To select a range of entries, click on an entry, press the Shift key and click on 
another entry. All of the entries in between these two will be selected. 

To select non-contiguous entries, click on an entry, then press the Control key 
and click on additional entries. 

Once your entries are selected, right click. When the pop-up Edit menu appears, 
click on Column fill... and the Minimum Concentration Column Fill dialog will 
appear. You can also display the Minimum Concentration Column Fill dialog by 
clicking on the Edit menu and selecting Column fill.... 
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Units

The units are the standard units, not the sample units.

Using Correction Limits

The correction limits are applied automatically and are used during IEC factor 
creation and during sample analysis.

During IEC factor creation:

• If an apparent analyte concentration (concentration measured at the analyte 
line, but due to the interferent instead of the analyte) is greater than or equal 
to the analyte’s correction limit, an IEC factor for the analyte/interferent pair 
is calculated and entered into the IEC factors table. 

• If an apparent analyte concentration is less than the correction limit, the IEC 
factor entered into the IEC table for the analyte/interferent pair is zero. This is 
because the effect of the interferent on the analyte was not sufficient to warrant 
a correction. 

During sample analysis:

• If an apparent analyte concentration is greater than or equal to the correction 
limit, the software then applies the IEC factor to the analyte concentration and 
a final result is calculated and appears in the Results Display window.

• If an apparent analyte concentration calculated by applying IEC is less than 
the correction limit, correction for this analyte/interferent pair is not 
performed. This is because the effect of the interferent on the analyte was not 
sufficient to warrant a correction. 
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Minimum Concentration Column Fill Dialog

Use this dialog to enter a correction limit for each analyte before you collect IEC 
standard data. When you make an entry in this dialog, it fills in the Minimum 
Concentration for Interference Correction column for all the analytes listed on the 
Set Limits page of the IEC Model Builder.

To display this dialog

1. On the Tools menu, select IEC Model Builder.

2. Click the Set Limits tab to display the Set Minimum Concentration Limits 
page.

3. If desired, select a range of rows by shift-clicking in the column.

4. Double-click on the heading of the second column, Minimum Concentration 
for Interference Correction. (You can also right-click the column and choose 
Column Fill.) The Minimum Concentration Column Fill dialog appears.

Using this dialog

1. Enter the Limit number you want to appear in the Minimum Concentration for 
Interference Correction column.

Usually, you type a value that is based on the detection limit for the analyte. 
This is the minimum apparent analyte concentration from an interferent for 
which interference correction should occur.

2. Click OK to close the dialog.

The number you entered is listed in the Minimum Concentration for 
Interference Correction column for every analyte listed (or for the ones you 
selected). 

3. You can change individual analyte limit numbers by clicking on the number 
listed in the Minimum Concentration for Interference Correction column and 
typing in a new number.
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Interelement Correction Model Builder: 
Calculate Factors Page

The Calculate Factors page is used to match the analytes requiring interference 
correction with the samples that contain pure interfering element. 

The formula for calculation is:

For an example of how factors are calculated, see Interelement Correction Model 
Builder: Summarize Factors Page later in this chapter.

Note You may choose to skip this page and simply set low factors to zero after 
calculation using the Calculate Factors page.



360 Chapter 8 Interferences & Interelement Correction

To display this page

1. On the Tools menu, select IEC Model Builder.

2. Click on the Calculate Factors tab.

Using this page

1. Select an analyte that requires IEC correction.

Use the control buttons on the top of the page to scroll through the names of all 
the analytes in the active method.

2. Click on the Select Samples button or double-click on the Sample ID header. 
In the Select Samples dialog that appears, select the samples (that is, the pure 
solutions of the interferents) which will appear on the Calculate Factors page. 
Click on OK to return to the Calculate Factors page.

3. For each sample, designate the interfering analyte by selecting the analyte 
name from the drop-down list in the Interfering Analyte column. Select None 
if you want to turn off that sample during the calculation of factors for the 
current analyte.
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4. Click on Display Wavelength Table to display the Wavelength Table dialog. 
Use this Table to search for elements at a particular wavelength or to choose 
wavelengths not found on the Method Periodic Table. Additional information 
such as intensities and BEC’s are given for certain elements.

5. WinLab32 automatically calculates factors for all combinations of interfering 
analyte with the active analyte.

The Actual Concentration of Interferent and Apparent Analyte Concentration 
and IEC factor are automatically entered.

6. Any factors that are very small can be set to zero by clicking on the check 
boxes under Set to Zero. Any factors not calculated are set to zero.

User Entered IEC Factor Dialog

Use this dialog to set automatic calculation or manually enter factors for the 
Interferent Reference Analytes listed on the Summarize Factors page of the IEC 
Model Builder. 

If the automatically calculated factor is not yielding the results you expect, you can 
enter an IEC factor manually. Also, your analysis may require that you enter a 
factor manually, such as an EPA factor (realizing that factors vary depending on 
plasma conditions, instrument type, etc.)

To display and use this dialog

1. On the Tools menu, select IEC Model Builder. 

2. Click the Summarize Factors tab.

Note Any errors encountered are displayed in the IEC Factors column. Error 
types are:
#No sample: Sample ID not found.
#No analyte: Interfering Analyte not found.
#DIV/0: IEC Factor calculation encountered a divide by zero error.
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3. Double-click on the IEC factor shown for an Interferent Reference Analyte. 
For example, if P 213.617 is shown in Interferent Reference Analyte column 
with an IEC factor of 7.50, double-click on 7.50

The User Entered IEC Factor dialog appears. 

4. Click the radio button next to Manually Set Factors and enter a number. The 
number can be a predetermined factor, or it can be an offset of the 
automatically calculated factor, that may produce better results for the solution 
of a known concentration. 

5. Click OK to return to the Summarize Factors page.

The number you entered appears in the Interferent Reference Analyte column 
and row you selected.

Note To reset the IEC factor back to automatically calculated, open the User 
Entered IEC factor dialog and click the radio button next to Automatic 
Calculation.
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Interelement Correction Model Builder: Summarize Factors Page
Use this page to view the IEC table selected on the Setup Page, and, if needed, edit 
factors directly. The values calculated on the Calculate Factors page are transferred 
automatically to this summary page. You can update the method to use the factors 
and print the factors. You can also edit the factors on this page before you save 
them.

To display this page

1. On the Tools menu, select IEC Model Builder. 

2. Click on the Summarize Factors tab on the bottom of the Interelement 
Correction Window.

Using this page

Each factor is applied to the analysis results of the analyte shown in the row to 
compensate for interference caused by the Reference Element in the column. If you 
want to change a factor, you can either edit directly (by double-clicking it), 
reanalyze standards or analyze new standards.
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IEC Factors

Analytes

These are analytes from the method used to create the IEC table.

Interferent Reference Element

These are the names for the elements whose signals may be interfering with the 
analyte signal. Each analysis element is also a potential Interferent Reference 
Element. 

For a given analyte, you cannot have IEC factors for more than one Reference 
Element per interfering element. For example, if multiple Fe lines are used in an 
analysis and the analyst needs to correct for Fe interference on an analyte line, only 
one of the Fe lines (i.e. Reference Elements) can have a non-zero IEC factor in the 
row for that analyte.

Double-click on an Interferent Reference Element IEC factor to display the User 
Entered IEC Factors dialog, where you can choose Automatic Calculation or 
Manually Set Factors.

Show

Click the radio button to either Show All Analytes and all factors, even the ones 
that are zero; or Only Non-zero Factors, which limits the display to only those 
analytes and interfering elements where at least one value in every row and column 
is not zero.

Update Method

After you save the IEC file (File/Save command), click the Update Method button 
to update the method in the Method Editor. When you click Update Method, the 
name of the IEC file is entered in the Method Editor, Process Page, Spectral 
Corrections page of the active method. The Interference Correction on all analytes 
with nonzero factors will be set to IEC. IEC is automatically selected to perform 
Overlap Correction for analytes with nonzero factors.

Note You can also enter a factor manually into the spreadsheet:  Click on the 
entry and type the new factor.
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Print Factors

Click the Print Factors button to print the table of factors as currently displayed. 
Print the complete table showing all analytes, or the table that contains only 
analytes and interfering elements where each row and column contains at least one 
nonzero IEC factor.

Select the radio button to print in either Portrait (vertical) or Landscape (horizontal)

How Factors are Calculated

The value of each factor is equal to the apparent analyte concentration divided by 
the interferent concentration. The apparent analyte concentration is the 
concentration measured at the analyte line, but due to the interferent instead of the 
analyte.

When you analyze samples, the software multiplies the interferent concentration 
by the IEC factor. It then subtracts this product from the measured analyte 
concentration to result in the corrected analyte concentration.

For example, suppose you are determining As and you know that Fe is creating an 
interference. You find that: 

The IEC factor is calculated at:

Apparent Analyte Conc.
Interferent Conc.

 =  IEC Factor

( )Measured Analyte Conc.  -  Interferent Conc.   IEC Factor  =  Corrected Analyte Conc.∗

2000 ppm of Fe will create a reading of 20 ppb of As

20 As ppb
2000 Fe ppm

 =  0.01 ppb As / ppm Fe
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You then analyze a sample with the measured results of:

Multiplying:

40 ppb is the signal in As that is actually due to Fe.

The corrected concentration of:

As =  60 ppb and Fe =  4000 ppm

4000 ppm Fe  0.01 ppb As / ppm Fe =  40 ppb As ∗

As =  60 ppb (measured) -  40 ppb (due to Fe) =  20 ppb.
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Select Samples Dialog

This dialog is used to select the samples that appear in the Sample ID column of 
the Calculate Factors page of the IEC Model Builder.

To display this dialog

1. From the Tools menu, select IEC Model Builder.

2. Click the Calculate Factors tab.

3. Click the Select Samples button or double-click on the Sample ID header.
The Select Samples dialog appears.

Using this dialog

1. Click on the sample name to select it. To select all the samples listed, click 
Select All, or press the Shift or Ctrl key as you click to select a group or 
individual samples.

2. Click OK to close the dialog.
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Overview of Examine/MSF
The Examine Spectra/MSF (Multicomponent Spectral Fitting) window serves a 
dual purpose: 

• You can examine the spectra that have been saved to a data set.

• You can correct for spectral interference by setting background correction 
points or by using the MSF technique.

Refer to About Interference Correction in Chapter 8,  Interferences & Interelement 
Correction, for more information on the different ways you can use the software to 
correct interferences.

To display this window

On the Toolbar, click on Examine.

-or-

In the Tools menu, click on Examine/MSF.

Using the Examine Spectra/MSF window for the first time

By default, this window opens in the Examine Spectra mode. In this mode, the 
word Examine is displayed in the top-left corner of the window. In Examine 
Spectra mode, you can:

• modify method parameters directly from the Examine window.

• modify the appearance of the spectra to aid in method development.

• set up spectral displays for reports.

For more information on using this window in Examine Spectra mode, see the next 
section, Overview of the Examine Spectra Window later in this chapter.

To change this window to Examine MSF mode, select MSF from the drop-
down list in the top-left corner of the window. For more information on using 
MSF, see Overview of How MSF Functions later in this chapter.
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Overview of the Examine Spectra Window

The main function of the Examine Spectra window is to display spectra that were 
saved to a Data Set so that you can:

1. Modify Method parameters:

• Select Peak Wavelength and Background Correction Points directly from 
the graphic display.

• Select Peak Algorithm (peak height or peak area) and the Points/Peak 
based on your observation of spectra in the Examine Spectra window.

Refer to the Update Method Parameters dialog later in this chapter.

2. Change the presentation of the spectra to aid in Method Development so that 
you can identify interferences and select appropriate wavelength(s) for an 
element, etc. 

3. Set up spectral displays for your printouts.

4. Troubleshoot possible hardware problems by evaluating standard spectra. 
(e.g., not enough sample entering plasma, clogs, etc.)

5. Fine-tune the instrument wavelength calibration.

6. Correct saturated data. See Correcting Saturated Samples in Chapter 7,  
Information Display Windows, for more information.

Note For information about using multicomponent spectral fitting (MSF), see 
How to Use the MSF Window later in this chapter.
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To display this window

On the Toolbar, click on Examine .

- or -

In the Tools menu, click on Examine Spectra/MSF.
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Using this window

The lists and menus along the top of this window are:

Tip 1 If you want to modify the method, open it before you begin using the 
Examine Spectra/MSF window. In order for you to interact with the 
method, this method must contain the same elements and wavelengths as 
the one used for data collection of the samples (data set). To ensure that 
you save both the spectral data and the method used to collect them, make 
sure to select both the Spectral Data check box and the Copy of Method 
check box in the Method Editor window Options page. Optionally, you can 
open a data set from the Data Reprocessing window and determine the 
appropriate method from the Original Method column. You would then 
open the appropriate method (using the MethEd button on the Toolbar).

Tip 2 Save the method, if you wish to retain the changes made to method 
parameters from the Examine Spectra/MSF window.

Tip 3 Save spectra to the same data set if you will want to overlay these spectra 
in the same display because you can select only one Data Set per Examine 
session.

Menu/List Description

Examine or MSF: Select either Examine or MSF to toggle the window 
between two different modes

Data menu Select data set, samples, and analytes to work with

Line menu Modify the spectra display.

Method menu This menu is present only in Examine mode. Set and 
adjust peak wavelength, update method parameters.
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Analyte and Wavelength selection buttons:

• First, Previous, Next, Last analyte in the list. Use these buttons to change the 
currently displayed analyte.

• List of analytes button. Click this button to view a list of selected analytes. You 
can select any analyte from the list to display it.

• Wavelength display. Displays the wavelength of the cursor position.

• Wavelength ID button. Opens the Wavelength Table dialog.

How to Use the Examine Spectra Window

Before you begin using the Examine Spectra window, open the method that was 
used to generate the spectra. If you are not sure which method was used, select 
Import from Results Library... in the File menu, then select the results data set. If 
you want to use a different method, it must contain some (but not all) of the 
elements and wavelengths that were originally used when the spectral data was 
collected.

MSF Menu This menu is present only in MSF mode. Set blank, ana-
lyte, interferents, mask for interference correction

Graph menu Modify display options.

Replicates List Display Average, First, or Last replicate

Note For information on using MSF, see How to Use the Examine MSF Window 
later in this chapter.

Menu/List Description
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Selecting spectra to display

1. Open the Examine Spectra/MSF window (in the Toolbar, click on the 
Examine button). Select Examine from the top-left drop-down list, if 
necessary.

2. In the Examine window, click on the Data menu, and then click on Data Set.

3. Complete the Data Selection Wizard to select samples and analytes. 

The Examine Spectra window displays the first analyte.

What You See in the Examine Spectra Window

The window is split vertically with the graph on the left and the legend on the 
right. The graph shows all spectra of a chosen analyte for the sample selected.

The legend shows you the list of samples for each analyte. It displays columns to 
indicate and set the hidden attribute, scaling, and offset. Since there is an entry for 
each sample, it is easy to tell at a glance how these settings are adjusted relative to 
all of the samples. More importantly, all of the samples’ intensities are listed 
together in one column. Also, you can click on one sample and it is highlighted in 
the graph.
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Along the bottom of the graph are buttons for Select First Analyte, Select 
Previous Analyte, Select Next Analyte, Select Last Analyte, Select Analyte and 
Select a Wavelength. (You can also access these commands from the Data menu.)

Select: To display:

The Analytes list, which lists the wavelength for each element that was 
selected from Go to Analyte. 

Double-click on one of the analyte names. You can then view that wavelength 
for all of the sample(s) listed in the legend. 

The first analyte in the Analytes list.

The prior element in the Analytes list (starting from the analyte that was 
displayed before you clicked on this button). If you continue to press this 
button, you will make analyte selections that move back up toward the top 
of the Analytes list. At the top of the list, this button ceases to function. Then, 
you can press the Next button or Last button to move down the list.

The next analyte in the Analytes list (starting from the analyte that was 
displayed before you clicked on this button). If you continue to press this 
button, you will make analyte selections that move downward toward the 
bottom of the Analytes list. At the last analyte in the list, this button ceases to 
function. Then, you can click on the Back button or First button to move back 
up the list.

The last analyte in the Analytes list.

Select a Wavelength.
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At the top of the graph, there is a drop-down list to select which replicate mode is 
displayed. There are four replicate modes:  Average Replicate, First Replicate, Last 
Replicate and All Replicates. All Replicates displays all of the replicates for a 
particular sample. This is different than the other modes, which display the first, 
the last, or the average of all replicates for all samples.

By default, the system automatically positions the splitter bar, which separates the 
graph from the legend, so that the legend is exactly wide enough to display the text 
it contains. This is constantly updated as that text changes. However, it is possible 
to allow more space for the graph or legend. 

To allow more space for the graph or legend

When you place the mouse pointer over the splitter bar, it changes to a double-
headed arrow. Drag left or right to increase the size of the graph or legend pane.

If you want the software to position the splitter bar for you automatically, click on 
the auto-position splitter bar check box to display a check mark. 

Note  If your cursor does not change to a double-headed arrow, you must disable 
the auto-position splitter bar check box in the Examine Display Options 
dialog. In the Options menu, click on Examine Spectra/MSF.... At the 
bottom of the Examine Display Options dialog, click on the auto-position 
splitter bar check box to clear the check mark. 
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Printing from the Examine Spectra/MSF Window

You can print the graph and legend displayed in the Examine Spectra/MSF window 
as follows:

1. From the File menu, choose Print.

2. From the Print menu, choose Active Window (or Active Window Preview).

Examine Spectra/MSF window: Keyboard Shortcuts
The following keyboard shortcuts exist in the Examine Spectra/MSF window:

In Examine and MSF modes:

f First Analyte

< Previous Analyte

> Next Analyte

e Last Analyte

g Go to Analyte

v Toggles Hide/Visible for the active sample

<del> Deletes the active sample from the current analyte’s sample list

Moves the Wavelength Cursor to the left by one picometer

Moves the Wavelength Cursor to the right by one picometer

The rest of the cursor keys (up, down, page up, page down, home, end) always 
apply to the legend. For example, to advance to the next sample in the legend, press 
the down-arrow key. Provided that there is indeed another sample to advance to, 
that will become the active sample and be highlighted.
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In Examine mode only:

p Set Peak Wavelength

b Add Background Point

m Opens the Update Method Parameters dialog

w Opens the Adjust Wavelength dialog

Hold down the CTRL key and click in the graph area to assign a new Background 
Correction Point at that position, provided that there are not already 2 of them 
assigned and you do not click at the exact Peak Wavelength. (To remove a 
Background Correction Point, drag it (press and hold down the left mouse button) 
out of the graph window. When you release the mouse button outside the graph 
window, the Background Correction Point will be removed).

In MSF mode only:

b Assign as Blank

a Assign as Analyte

i Assign as Interference

c Clear Assignment

m Mask

n No Mask
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In addition to keyboard shortcuts, if you double-click in the following areas of the 
Examine Spectra/MSF window the following dialogs will appear: 

Selecting Data for the Examine/MSF Window
Before you begin using the Examine Spectra window, open the method that was 
used to generate the spectra. If you are not sure which method was used, in the File 
menu, select Import from Results Library..., then select the results data set. If 
you want to use a different method, it must contain some (but not necessarily all) 
of the elements and wavelengths that were originally used when the spectral data 
was collected. To ensure that you save both the spectral data and the method used 
to collect them, make sure to check both the Spectral Data check box and the Copy 
of Method check box from the Method Editor window Options page. 

Save the method, if you wish to retain the changes made to Method parameters 
from the Examine Spectra window.

Save spectra to the same data set if you will want to overlay these spectra in the 
same display. This is because you can select only one Data Set per Examine 
Spectra session.

To display data in the Examine/MSF window, select Select Data Set from the Data 
menu. A three-step Wizard walks you through the data selection process.

If you double-click here: This dialog will open:

left of the y-axis in the graph area Define Y-axis Options Dialog

right of the y-axis in the graph 
area

Examine Spectra/MSF Display Options 
Dialog

in the header of visible column of 
the legend

Visible Column Fill Dialog

anywhere in the scale or offset 
columns of the legend

Select Scale & Offset Dialog
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Select Results Data Set

Use the Data Selection Wizard to perform any of the following functions:

Select a results library from which to retrieve a data set

Click on the Browse button to select a path from the Results Path dialog. (The 
default pathname appears.)

Select spectra to display in the Examine Spectra Window

Click on a data set name to select a data set from which you wish to display 
spectra. (You will specify the sample(s) and analyte(s) in subsequent dialogs.)

Sort the data set list

Click on the appropriate option button to sort the Data Set list by Name or 
Date/Time.

Select samples and elements from a data set

After you choose a data set, click Next to display Step 2., the Select Samples 
page of the Data Selection Wizard.

Select Samples 

Open the Data Selection Wizard by choosing Select Samples from the Data menu 
in the Examine Spectra/MSF window. If this option is not available, choose Select 
Data Set.

Note You can select only one data set per Examine Spectra session.

Note If you are selecting samples for MSF, select at least one analyte and either 
a blank or an interference. For MSF, each sample selected must have a 
unique name (multiple samples with the same name cannot be selected for 
use with MSF.)
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Use the Select Samples dialog to perform any of the following functions:

Select every sample from the data set

Click on the Select All button and then click on Next. By default, all samples 
are initially selected (highlighted). To deselect the samples, click on any 
sample in the list. 

Select a specific sample from the data set

Click on a specific sample from the list.

Select a set of samples that are listed sequentially 

Click on a sample, then press and hold the Shift key and click on another 
sample. All samples between these two will be selected (highlighted). Click on 
the Next button.

Select a set of samples that are NOT listed sequentially 

Press and hold the Ctrl key while clicking on any samples you wish to 
highlight. Release the Ctrl key, confirm your selections, and then click on the 
Next button.

Note If you wish to view the replicates for a sample:
1) Select only one sample from this dialog.
2) From the Replicates drop-down list in the Examine/MSF window, select 
First Replicate, Last Replicate or Average Replicate. See Selecting 
Replicates later in this chapter.

Note 1 If you accidentally select (highlight) a sample, simply deselect it by Ctrl/
clicking on that sample again. (You can use this technique to deselect no 
matter how you originally chose to select an item).
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Select Analytes

Open the Data Selection Wizard by choosing Select Analytes from the Data menu 
in the Examine Spectra/MSF window. If this option is not available, choose Select 
Data Set.

Use the Select Analytes dialog to perform any of the following functions:

Select every analyte in the data set

Click on the Select All button then click on Finish. (By default, all samples are 
initially highlighted.)

Select a specific analyte in the data set

Click on a specific analyte from the list.

Select a set of analytes that are listed sequentially

Click on a sample, then press and hold the Shift key and click on another 
sample. All samples between these two will be selected (highlighted). Click on 
the Finish button.

Select a set of analytes that are NOT listed sequentially 

Press and hold the Ctrl key while clicking on any analytes you wish to 
highlight. Release the Ctrl key, confirm your selections, and then click on the 
OK button.

Note 2 Once you have made selections, click Next to display Step 3., the Select 
Analytes page of the Data Selection Wizard. 

Note If you accidentally highlight an analyte, simply unhighlight it by Ctrl/
clicking on that analyte again. (You can use this technique for 
unhighlighting no matter how you originally chose to highlight an item.)
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Exporting Spectra

Open the Export Spectra dialog by selecting Export Spectra from the Data menu 
in the Examine MSF window. You must have a data set open to use this option.

You can export spectral data, which includes all the data points collected in the 
spectral measurement range for each analyte to construct the peak that represents 
the intensity values. Then you can view the exported data in a spreadsheet or 
database program of your choice and graph the data points, if desired.

For example, after exporting the spectral data, here is an excerpt from the resulting 
spreadsheet:

The first column lists the wavelengths in the spectral measurement range for the 
analyte, Cu 324.752. The number of wavelengths will depend on how the peak was 
processed as defined by the method parameters (peak algorithm, points/peak, and, 
on simultaneous ICP spectrometers, whether signal profiling was used). The 
remaining columns list the intensities for each data point in counts per second 

Data Set: test1
Analyte: Cu 324.752
Wavelength Calib Blank 1 Calib Std 1 Sample001

324.689 10 10 10
324.699 10 10 10
324.709 10 10 10
324.719 10 10 10
324.729 10 10 10
324.739 27.6 110.1 2090
324.749 50.2 200.2 3800
324.759 27.6 110.1 2090
324.769 10 10 10
324.779 10 10 10
324.789 10 10 10
324.799 10 10 10
324.809 10 10 10
324.819 10 10 10
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(cps). By using the spreadsheet program to graph the following data points, you can 
re-create the peaks from the Examine Spectra/MSF window.

Fill in the appropriate choices in the Export Spectra dialog: 

Format: Choose the column format you wish to use for displaying the 
wavelength data for each sample. If all samples share the same wavelengths, 
select the option for Single Wavelength Column, and the first column in the 
resulting spreadsheet will display the wavelengths in the spectral measurement 
range as shown above. If one or more of the samples uses a different set of 
wavelengths, select the option for Wavelength Column for Each Sample, and 
the wavelength column in the spreadsheet will be repeated for each sample.

Analytes: Choose to export data for the analyte currently displayed in the 
Examine window, or choose all analytes.

Replicates: Choose to include data from the first or last replicate, the average 
(mean) values, or all replicates.

Data Delimited by: Choose the delimit character preferred by your 
spreadsheet or database program. Columns of data can be separated by 
commas, tabs, or semicolons. 

File name: Select a name for the export file. Choose the same name as the data 
set or create a different name. 

Extension: Choose the extension preferred by your spreadsheet or database 
program.

Directory: Use the default Reports directory or browse to locate the directory 
where you want to save the exported file.
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Selecting Replicates
You can choose the replicates you wish to view in the Examine Spectra/MSF 
window. The Replicates list is next to the Graph menu. Click on the drop-down 
arrow to make a selection, as described below.

View spectra of the first replicate only 

Click on First Replicate in the Replicate drop-down list.

View spectra of the last replicate only 

Click on Last Replicate in the Replicate drop-down list.

View spectra of the average of all replicates

Click on Avg. Replicate in the Replicate drop-down list.

Note You may wish to view a single replicate when you are optimizing 
instrument parameters for the maximum signal/noise which will be critical 
for detection limit measurements.

Note During routine analysis you will most often just want to view an average 
of the replicates, which is the default setting. An exception to this may be 
if the Replicate Data from the Results Display window shows any 
significant discrepancies in replicate results.



387Using the Examine/MSF Line Menu Options

Using the Examine/MSF Line Menu Options
Choose from the Line menu options described in the following sections.

Select Line Styles Dialog

Use the Line Styles dialog to customize the appearance of the spectra by color or 
line style. Before you display this dialog you must open a data set in the Examine 
Spectra/MSF window.

To display this dialog:

In the Line menu of the Examine Spectra/MSF window, click on Styles. 

- or -

Double-click anywhere in the Styles column of the legend.

Selecting analytes

Select whether the line styles that you set in this dialog will apply to either the 
Current Analyte or All Analytes.

Selecting color(s) for the unknown sample spectra

To select a range of colors:

In the Colors panel, select a color from the drop-down list for the First 
Unknown and select another color from the drop-down list for the Last 
Unknown, either under the Screen or Printer headings. 

This specifies the range’s starting and ending colors. A corresponding range of 
colors appears. This range will be used to display the various unknown sample 
spectra. The colors closest to the First Unknown value designate the first samples. 
The sample color gradually changes until it approaches the Last Unknown color, 
which designates the last sample.
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To select one color for all unknown sample spectra:

In the Colors panel, select the same color from the drop-down lists for both the 
First Unknown and Last Unknown, either under the Screen or Printer 
headings. The color you selected will be used for all unknown sample spectra.

Selecting a line style

In the Styles panel, for each Sample ID listed, select a line style from the drop-
down lists in the Styles column. This is useful if you need to differentiate 
between various samples when printing to a black and white printer. The 
available styles are:  Solid, Dashed, Dotted, Dash Dot, or Dash Dot Dot.

Note The settings on your computer display affect how the range appears:

If the setting is 256 colors or less, the number of colors available to create 
the range is extremely limited between the first and last colors.

If the setting is greater than 256 colors, you should see a smooth transition 
in the color range between the first and last colors.

Note The colors for blank spectra, standard spectra, and Hg/QC spectra are set 
using the Spectra Display Options Dialog and always correspond to the 
same colors in the Spectra Display window.

Note You must use a line width of 1 in order to use line styles. When line widths 
of greater than 1 are selected, the line style is always displayed as Solid. If 
you selected line styles, but cannot display them, make sure that Line 
Widths for the Current Sample and/or Other Samples are set to 1.
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Selecting line widths

To select line widths for displaying spectra, type a number from 1 to 10 to 
designate the relative line width for the Current Sample (the currently selected 
sample) and for Other Samples. The Current Sample defaults to 2 and Other 
Samples defaults to 1.

Return to the Default Colors

1. To change all of the screen colors or printer colors back to their default 
settings, select the Screen or Printer buttons under Default Color Settings.

2. To change the colors without closing the Line Styles dialog, click on Apply. 

- or -

To apply the change and close the dialog, click on OK. 

Return to the Default Style Settings

1. To change all of the style settings (other than the colors) in this dialog back to 
their default settings, select Default under the Default Options Settings 
section. 

2. To change the style settings without closing the Line Styles dialog, click on 
Apply. You can see the effect of the changes in the Examine Spectra/MSF 
Display window and modify them if desired.

- or -

If you are satisfied with the style settings, click on OK to apply the changes 
and close the dialog.
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Select Scale & Offset Dialog

To display this dialog:

In the Line menu of the Examine Spectra/MSF window, click on Scale and 
Offset... 

- or -

Double-click anywhere in the Styles or Offset column of the legend.

Note If the dialog does not appear, you must first open a data set.

Tip 1 Select an Active Spectrum BEFORE YOU SELECT THIS DIALOG.

To apply a Scale Factor and/or a Baseline Offset to a spectrum, you must 
first select that spectrum by clicking on one of the sample names in the 
legend (i.e., the sample list in the right-hand side of the Examine Spectra 
window). Notice that the spectrum name will be highlighted and data 
points (which are indicated by small squares) appear on the associated 
spectrum to designate it as the active spectrum. (Data points will only 
appear if the data points option is selected from Select Graph Options 
Dialog.)

Tip 2 View the current status of an active spectrum by noting the right-hand side 
of the Examine Spectra window. You can check the intensity of the peak 
at the current cursor position, as well as the offset value and the scale factor 
that have been applied to the active spectrum. (The values for the offset 
and scale will be zero and one respectively, when you first select an active 
spectrum). 

For example, if you use this dialog to apply both an offset and scale factor, 
then you will see those values listed.
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Use the Select Scale & Offset dialog to perform any of the following functions:

Apply the Scale and Offset to the current sample only or to all samples

Select a scale factor to apply to the sample(s)

Type a value (0.001 to 1 million). The appearance of the spectrum will be 
scaled larger or smaller based on the specified value. Click on the Apply or 
OK button to apply this factor to the scale for the active spectrum.

Select an offset to apply to the sample(s)

Type a value (- one billion to + one billion). Click on the Apply or OK button 
to move the baseline position of the spectrum up or down based on the 
specified value.

Note 1 Check the box next to Automatically determine full scale factors and the 
software fills in the scale and offset factors that cause the sample(s) to 
appear to utilize the entire y-axis dynamic range. If the All Samples is 
selected, the factors for each sample will be optimized (separately.)

Note 2 A Scale factor only changes the appearance of the spectrum; the original 
data (stored in the data set) remains unchanged.

Note 3 It is possible to detect low level contaminants by using scale factors, since 
an expansion factor is applied uniformly across the spectrum. Also, if a 
spectrum has an interference, this scale factor can help you to evaluate the 
active spectrum in comparison to any other spectra displayed. For 
example, you may want to compare the scaled spectrum (as the unknown 
mixture) with a spectrum containing only the suspected interfering 
component.
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Reset the Scale and Offset factors for the active sample or all 
samples.

With the appropriate option selected for Current Sample Only or All Samples, 
click on the Reset button. A scale factor of 1.0 and an offset of 0.0 will be 
displayed. Click Apply or OK to apply the factors. 

Add or Subtract Spectra Dialog

Open the Add or Subtract Spectra dialog by choosing Add from the Line menu in 
the Examine Spectra/MSF window. If this option is not available, you must first 
open a data set.

Use this dialog to add or subtract spectra by following the steps below:

1. Select the operation to perform: addition or subtraction.

Click on either the Add or Subtract option button. 

2. Select the spectra you wish to add or subtract.

Identify Spectrum 1 and Spectrum 2 by opening each selection box and 
clicking on the desired spectrum name. 

3. Select the name of the resulting spectrum from the addition or 
subtraction.

Note 1 An Offset only changes the appearance of the y-axis of the spectrum and 
so the original data (stored in the data set) remains unchanged.

Note 2  When you have a group of spectra that are closely spaced (and sometimes 
overlaid on top of each other), you can apply an offset to move the active 
spectrum up or down (which does not change the scaling) so that you can 
make a direct comparison to the other spectra.
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Type a name in the New Spectrum Name entry (if you do not enter a new 
spectrum name the system specified name, “Sample” will appear in the 
Samples list).

4. Perform the addition or subtraction and view the spectrum.

Click on the OK button to apply the selections you have made in the dialog.

The resulting spectrum appears in the Examine Spectra window. Also, the new 
spectrum name is included in the Samples list and appears as the active 
spectrum (as designated by the box).

Note: When used appropriately, here are some of the uses for spectral addition or 
subtraction: 

• Detect possible contaminants

• Evaluate concentrations required for the analysis.

• Identify chemical and spectral interferences 

• Evaluate peak wavelength selection (by elimination of a peak (subtraction) 
or by spiking (addition)).

• Make an assessment of instrument parameters and possibly use as an aid 
in troubleshooting

• Make an assessment needed to select parameters during Method 
Development (e.g. Background correction points, determine appropriate 
data treatments (such as IEC), etc.)
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Using the Hide/Visible Line Option

In the Line menu of the Examine Spectra/MSF window, click on the Hide/Visible 
option to perform the functions listed below. Also you can perform the same 
functions in the right side of the Examine window, under the Hide/Visible column 
by checking or unchecking the box next to each sample.

Remove a spectrum from the display but retain the name in the 
samples list

Select the active spectrum and then click on Line menu and then click on the 
Hide option. The active spectrum is automatically removed from the display.

Re-display a previously hidden spectrum

Select a Hidden spectrum from the samples list (it will have a spectrum name 
but there will be no line color next to it) and then click on Line menu  Hide/
Visible (or click the box in the Visible column of the legend). The active 
spectrum reappears in the display.

Remove or display all samples

Double-clicking on the word “visible” at the legend’s visible column heading 
will open a column-fill dialog. There is a single checkbox in the dialog, label 
“visible”. Checking or unchecking that checkbox and clicking the OK button 
will cause all samples to be either visible or hidden, respectively.

Note 1 The spectrum name remains in the Samples list but the line showing its 
color is removed to indicate that this spectrum is “hidden.”

Note 2 You can hide any number of spectra.
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Using the Delete Line Option

From the Line menu in the Examine Spectra/MSF window, click on the Delete 
option to perform the following function:

Delete a spectrum from the display

Select the active spectrum and then in the Line menu, click on Delete. The 
active spectrum is removed from the current analyte’s display (but not from the 
data set).

Using the Examine/MSF Method Menu Options
Choose the options described in the following sections to set method parameters 
for examining spectra.

Setting a New Peak Wavelength for the Method

When you view the peak for an analyte, the peak's highest intensity may not occur 
exactly at the wavelength that you specified in the method. In this situation, you 
can modify the peak wavelength in the method directly from the Examine Spectra 
window.

Note 1 To redisplay a “deleted” spectrum you will need to reselect it: In the Data 
menu, click on Select Samples.

Note 2 You can delete any number of spectra.

Tip See Example: Setting a New Peak Wavelength for the Method later in this 
chapter for more information.



396 Chapter 9 Using the Examine/MSF Window

To set and update the peak wavelength

1. Display the spectra for the analyte of interest in the Examine Spectra/MSF 
window.

2. Open the method that was used to generate the data. If you are not sure which 
method was used, select Import from Results Library... in the File menu, 
then select the results data set.

3. In the Examine Spectra/MSF window, click on the name of the sample in the 
Samples list to designate the active spectrum on the graphics display.

4. Drag the vertical cursor to the point of maximum intensity on the peak. The 
peak maximum can be determined by observing the value in the Intensity 
column on the right side of the window. The Wavelength display shows the 
cursor position. 

5. In the Method menu, select Set Peak Wavelength.
The Wavelength display shows the chosen wavelength, and the peak 
wavelength symbol is repositioned to align with the cursor.

6. In the Method menu, select Update Method Parameters...
The Update Method Parameters dialog appears. The current wavelength from 
the method and the revised wavelength are shown.

7. Be sure a check mark appears next to Peak Wavelength, then select one of the 
following:

Update
Click on the Update button to update the method according to the revised 
wavelength and any other selections you have made in this dialog. However, 
the method changes will not be saved to disk. 

Update and Save Method
Click on the Update and Save Method button to modify the method according 
to the revised wavelength and any other selections you have made in this dialog 
and save the method to disk.

8. You can view the change in the Method Editor on the Spectrometer: Define 
Elements page.
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Example: Setting a New Peak Wavelength for the Method

For example, let’s say you are collecting data using a method that contains the 
analyte Cadmium at the wavelength of 228.802. When you display the Cadmium 
spectrum in the Examine Spectra window you may find that while the method 
expects the wavelength to be at exactly 228.802 nm, shown by the peak wavelength 
symbol, the vertical cursor is not aligned with the center of the peak.

You can move the cursor so it is aligned with the center of the peak and a readout 
of the cursor's wavelength position (at the bottom of the Examine Spectra window) 
shows that the peak is actually appearing at another wavelength, for example 
228.799 as shown below. Then, you can choose to set the peak wavelength to the 
peak maximum at 228.799.

Note The analyte name specified in the method usually contains the reference 
wavelength (for example As193.696), but can be renamed if desired.
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After setting the new peak wavelength, you can update the method with the revised 
wavelength using the Update Method Parameters dialog. For more information, see 
Setting a New Peak Wavelength for the Method earlier in this chapter.

Adjusting the Wavelength

You can choose to fine-tune the wavelength for future analyses and/or for a 
particular data set.

Note In some special situations, you may want to update the instrument and/or 
data set with the new wavelength, as described in the next section.

Important This adjustment should only be done when determined to be fully 
necessary. Before making this adjustment, see Tips: Adjusting the 
Wavelength later in this chapter.
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To adjust the wavelength

1. Display the spectra for the analyte of interest in the Examine Spectra/MSF 
window.

2. Click on the name of the sample in the Samples list to designate the active 
spectrum on the graphics display.

3. Drag the vertical cursor to the point of maximum intensity on the peak. The 
peak maximum can be determined by observing the value in the Intensity 
column on the right side of the window. The Wavelength display shows the 
cursor position. 

4. In the Method menu, select Adjust Wavelength...
The Adjust Wavelength dialog appears. The original wavelength and the 
revised wavelength are shown.

5. Choose how you want to use the revised wavelength value:

Update Instrument and Data Set
The revised wavelength will be entered in an instrument offset table, which is 
used to correct for wavelength differences in all subsequent analyses. On 
simultaneous ICP spectrometers, the entire subarray for this wavelength will 
be updated to compensate for offsets for other wavelengths in the range of this 
subarray. On scanning CCD ICP spectrometers, this modification applies only 
to the specific wavelength you have revised. In addition to updating the 
instrument offset table, the revised wavelength will be applied to the current 
data set open in the Examine Spectra window. Updating the data set is useful 
when you need to make adjustments for method development (for example, 
adjusting background correction points) or if you will be reprocessing the data 
set at a later time. 

Update Instrument
The revised wavelength will be entered in an instrument offset table, which is 
used to correct for wavelength differences in all subsequent analyses. On 
simultaneous ICP spectrometers, the entire subarray for this wavelength will 
be updated to compensate for offsets for other wavelengths in the range of this 
subarray. On scanning CCD ICP spectrometers, this modification applies only 
to the specific wavelength you have revised. 
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Update Data Set (only)
The revised wavelength will be applied to the current data set open in the 
Examine Spectra window. Select this option if the revised wavelength applies 
only to the current data set and you do not wish to revise the method or the 
instrument for future analyses. Updating the data set is useful when you need 
to make adjustments for method development (for example, adjusting 
background correction points) or if you will be reprocessing the data set at a 
later time.

Tips: Adjusting the Wavelength

To determine accurate peak wavelengths during Method Development, consider 
the following:

Consider the Peak Algorithm

Depending on the Peak Algorithm, peak wavelength has different effects:

• If Peak Ht. processing is chosen, it defines the center of the window in 
which the software will search for a peak.

• If Peak Area processing is chosen, it defines the center pixel that will be 
summed in the spectral measurement range.

Updating the Instrument Offset Table

The revised peak wavelength can be used in an instrument offset table, which is 
used to correct for wavelength differences in all subsequent analyses. It is 
recommended to keep a log book (or file) of the dates and pertinent information 
such as the element(s) and wavelength(s) that were revised.

When determining peak wavelengths, be sure you are using a pure single-element 
standard for the analyte of interest at a reasonable concentration (for example 1 
ppm).

On simultaneous ICP spectrometers, be sure to perform a Hg Alignment before 
updating the instrument offset table. For more information, see Table of 
Spectrometer Alignment and Calibration Controls. The Adjust Wavelength dialog 
allows you to fine-tune the wavelength calibration for each subarray.
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After updating the instrument offset table, all previous methods may be invalidated 
for use on the newly “calibrated” instrument. Methods that were used prior to the 
new offsets may need to be revised for selected wavelengths. In addition, if you 
have set up previous methods that already compensate by using slightly different 
wavelengths, then changing the instrument offsets will cause these wavelengths to 
be incorrectly adjusted.

Spectral Profiling

On simultaneous ICP spectrometers, if you are not achieving the desired results 
with spectral profiling off, you may want to turn on Spectral Profiling while you 
are determining peak wavelengths. It is sometimes easier to discern the peak 
wavelength position when the peak is symmetrical and has a smooth shape. It is 
recommended that you overlay both the lowest and highest concentration standards 
(and, of course, some samples) to determine peak wavelength. Then, for routine 
analysis, you can turn off Spectral Profiling.

Using the Background Correction Point Option

To set a background correction point, choose Add Background Point from the 
Method menu in the Examine/MSF window.

To select Background Correction (BGC) points follow the steps below:

1. Select the active spectrum

Click on the spectrum name in the samples list to designate the active 
spectrum on the graphics display.

Tip 1 When the standards and samples are not matrix matched, it is considered 
good practice to use at least a one-point background correction. 

Tip 2 For any type of sloping background, use a two-point background 
correction, and select an alternate wavelength for the element whenever it 
is possible.
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2. Graphically select a BGC point

Use the drag technique (or the horizontal scroll bar) to position the cursor 
wherever you want to place a BGC point. Alternately, you can place a 
BGC point with your mouse. To do so, hold down the Ctrl key, point your 
mouse where you want a BGC point, and click.

Click on the Method menu and then click on Add BGC Point. Note that 
green crosshairs appear on the graph to indicate the position of the BGC 
point. To reposition an existing BGC point, simply drag it with the cursor.

3. For a second BGC point repeat step 2, otherwise skip to step 4

You may only select up to two BGC points per spectrum.

4. Update the Method

In the Method menu, click on the Update Method Parameters option to 
display the Update Method Parameters dialog. Note that up to three check 
marks will appear when you have selected two BGC points and the offset 
values for selected BGC point(s) are listed automatically. For example: 

Note A red BGC point located at either end of the X axis indicates that the 
background offset in the method is outside of the wavelengh range shown 
in Examine. To reposition the BGC point within the x axis, simply drag it 
with the mouse cursor. The color returns to green. 

Note To remove a BGC point, drag it to any position outside of the graphic 
display.
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Click on the Update button to enter the new BGC points into the Method.

Identifying Elements Using the Button

To help you identify an element responsible for an interfering peak:

1. Move the vertical cursor to the interfering peak, note the wavelength and click 
on ID.

2. The Wavelength table appears showing a list of elements and wavelengths in 
the same spectral measurement range as the current peak. 

Update Method Parameters Dialog

To update method parameters, choose Update Method Parameters from the 
Method menu in the Examine/MSF window.

The Update Method Parameters dialog has several different uses described below:

Note Save the Method if you wish to save the updated BGC offset value(s) and 
correction type (i.e., 1-Point, 2-Point or None).

For using this dialog to: See:

Set the peak wavelength and 
update the method. 

Setting a New Peak Wavelength for the 
Method earlier in this chapter.

Adjust Background Correction Using the Background Correction 
Point Button earlier in this chapter.

Modify the Peak Algorithm and 
Points/Peak

Method Editor Process: Spectral Peak 
Processing Page in Chapter 3,  Using 
the Method Editor, for information on 
these parameters. 
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Update

Click on the Update button to modify the method according to the selections 
you have made in this dialog. However, the method changes will not be saved 
to disk. If you have selected that you want to update the method to a new peak 
wavelength, be sure to select the check box for Peak Wavelength, then click on 
Update.

Update and Save Method

Click on the Update and Save Method button to modify the method according 
to the selections you have made in this dialog and save the method to disk.

Show Analytical Points

Select Show Analytical Points from the Method menu in the Examine Spectra 
window.

This feature allows you to view a highlighted region of points along the active 
spectrum that were used to calculate intensity.

To hide the highlighted analytical points region, reselect Show Analytical Points 
from the Method menu.

Using the Examine/MSF Graph Menu Options
Choose the options described in the following sections to modify options for the 
spectral display area.

Define Y-axis Options Dialog

Open the Define Y-axis dialog by choosing Define Y-axis from the Graph menu in 
the Examine Spectra/MSF window. If this option is not available, you must first 
open a data set.



405Using the Examine/MSF Graph Menu Options

Use this dialog to perform the following functions:

Change the y-axis options for ONLY the Current Analyte or All 
Analytes in the data set

Click on the appropriate option button at the top of the dialog.

Set the scale to linear or log

To display graphs using a logarithmic scale (to compress large values without 
compressing small values) select Logarithmic. 

Select the maximum value for the y-axis

To automatically scale the y-axis so the maximum Y value is at least 100, click 
on the Automatic (min 100) option button.

To automatically scale the y-axis for the highest intensity peak in the window, 
click on the Automatic option button.

To enter a specific maximum value for the y-axis scale, click on the Manual 
option button and enter a value (that ranges from -1 billion to 1 billion, 
inclusive).

Select the minimum value for the y-axis

To automatically scale the y-axis so that the zero point on the Y-axis must be 
shown, click on the Automatic with zero axis option button. If log scale mode 
is selected, then the minimum y-axis value is 1, so the zero point is not shown.

To automatically scale the y-axis for the minimum intensity in the window, 
click on the Automatic option button.

Note Double-clicking on the graph area (the left-hand side) of the Examine 
Spectra/MSF window, but to the left hand side of the y-axis, is a 
convenient way to open the Define Y-axis Options dialog.
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To enter a specific minimum value for the y-axis scale, click on the Manual 
option button and enter a value (that ranges from -1 billion to 1 billion; 
inclusive).

Select Label Options Dialog

Open the Label Options dialog by choosing Label Options from the Graph menu 
in the Examine Spectra/MSF window. If this option is not available, you must first 
open a data set.

Use this dialog to perform the following functions:

Apply label options to the Current Analyte Only or All Analytes in the 
data set

Click on the appropriate option button at the top of the dialog.

Select the desired label options:

Click on the appropriate option button for the desired graph title (i.e., to use the 
analyte name, to enter your own title, or no title at all.)

Click on the appropriate option button to display x-axis and/or y-axis labels. 

Display Options Dialog

Open the Examine Spectra/MSF Display Options dialog by choosing Display 
Options from the Graph menu in the Examine Spectra/MSF window. If this option 
is not available, you must first open a data set.

From the File menu, choose Print  Active Window.

Select the Examine Display Options dialog to perform the following functions:

Note You can choose Printer colors in this dialog and then print the graph 
displayed in the Examine Spectra/MSF window as follows:
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Apply color selections to the Current Analyte Only or All Analytes in 
the data set

Select colors for the following items:

Axes and Label

Graph Title

Examine Graph Background

MSF Graph Background

BGC Point Mark(s)

Wavelength Cursor (if enabled)

Y-Axis Grid Divisions (if enabled). The number of Y-Axis Grid Divisions can 
also be selected (from 1 to 100.)

Data Points on Active Spectrum (if dialog has Active Spectrum points enabled)

Enable or Disable the following items:

X-Axis Grid Divisions (When enabled, x-axis grid divisions are displayed at 
every tenth picometer.)

Auto-position splitter bar (Disabling this option lets you resize the Graph and 
Legend panes of the Examine window by positioning your mouse on the bar 
and dragging left or right.)

Return to the Default Colors

1. To change all of the screen colors or printer colors back to their default 
settings, select the Screen or Printer buttons under Default Color Settings.

2. To change the colors without closing the dialog, click on Apply. 

- or -
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To apply the change and close the dialog, click on OK. 

Add Label Dialog

Open the Add Label dialog by choosing Add Label from the Graph menu in the 
Examine Spectra/MSF window. If this option is not available, you must first open 
a data set.

Use this dialog to add text labels to an active spectrum by following the steps 
below:

1. Select the active spectrum.

Click on the spectrum name.

2. Open the Add Label dialog.

Click on the Graph menu and then click on Add Label.

3. Enter the desired title for the active spectrum.

Type a label name for the active spectrum and click on OK. The text 
appears in the window. 

To move the text, position the mouse cursor where you want the text to 
appear. Hold down the Shift key and click on the desired position.

To label another spectrum on the window repeat steps 1 through 3. See 
below, for an example showing a label for each spectrum.
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Automatically use the spectrum Sample ID as the label text:

Click the Use Sample ID button to automatically enter the Sample ID as the label 
text.

Label all samples with their Sample ID’s as their label text:

Check the Label all samples with their Sample ID’s checkbox to enable this 
feature. If this checkbox is checked when the OK button is pressed, all of the 
samples for the current analyte will be assigned labels and each will be the Sample 
ID for the respective spectrum.

Clear all labels:

Check the Clear labels from all samples checkbox to enable this feature. If this 
checkbox is checked when the OK button is pressed, any existing labels will be 
removed from the display of the current analyte. This does not refer to the axes 
labels or the graph title label – to clear them, use the Select Label Options Dialog.
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How to Use the Examine MSF Window
Before using the Examine MSF window, select MSF from the list at the top left of 
the Examine Spectra window. The window toggles from Examine mode to MSF 
mode. The two modes share much of the same functionality. However, several 
differences exist between the Examine Spectra window and the Examine MSF 
window. These differences are shown in the following pictures and also described 
below.

To start using the Examine MSF window, select spectra to display:

1. Click on the Data menu, and then click on Data Set.

2. Complete the Data Selection Wizard to select samples and analytes.
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The Examine MSF window displays the first analyte. You can now use the MSF 
menu to assign values for an MSF model (blank, analyte, interferent). You save the 
model as an MSF file, to be used during analysis or reprocessing to correct for 
spectral interferences.

What You See in the Examine MSF Window

The window is split vertically with the graph on the left and the legend on the right. 
Notice that the default background color in MSF mode is different than Examine 
Spectra mode to help you tell at a glance which mode you are using. The graph 
shows you the spectrum for the selected analyte. The legend shows you the list of 
samples for each analyte.

The legend displays columns to indicate and set the MSF values, as well as the 
visible attribute, line style scaling, and offset. Since there is an entry for each 
sample, it is easy to tell at a glance how these settings are adjusted relative to all of 
the samples. More importantly, all of the samples' intensities are listed together in 
one column. Also, you can click on one sample and its spectrum is identified in the 
graph with data points (which are indicated by small squares along the line).

In Examine MSF mode, there is no Method menu. Instead there is an MSF menu 
which you use to assign values for an MSF model that you can use to correct for 
spectral interferences.

Along the bottom of the graph are buttons for Select First Analyte, Select Previous 
Analyte, Select Next Analyte, Select Last Analyte, and Select Analyte.

The replicates list is grayed out in Examine MSF mode. 

You can easily allow more space for the graph or legend.To do so, position your 
mouse over “splitter bar” that separates the left and right panes. Your cursor 
changes to a double-headed arrow. Drag left or right to increase the size of a pane. 
(If your cursor does not change to a double-headed arrow, you must disable the 
“auto-position splitter” option in the Examine Display Options dialog.)
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Using the MSF Menu

Once you have collected spectra of the blank, analyte, and individual solutions for 
each interferent (if any), then you can build the MSF model that will be used to 
correct for spectral interferences when you analyze samples.

Before using the MSF menu, use the Data menu to open a data set. Then use the 
analyte selection toolbar, located at the bottom of the graph, to display the first 
analyte for which you want to correct for interferences.

About the MSF Menu 

Once the blank, analyte and individual spectra for each interferent are displayed, 
you can use the MSF menu to make assignments to the spectra:

• blank or global blank 

• analyte or global analyte

• interferent(s) or global interferent

You can also mask (and unmask) a portion of the model spectrum.

As you develop the MSF model for each analyte in the data set, you can use the 
MSF Viewer/Editor to view your blank, analyte, and interference selections and 
make changes if you wish. For more information on the Viewer/Editor see Using 
the MSF File Viewer later in this chapter.

Note The Examine MSF window is used to create the MSF model. To view the 
results of using MSF in an analysis, you must open the Results Display and 
the Spectral Display windows. The Results Display window lists the 
analytical results and indicates that the sample was processed by MSF (as 
applicable, the .msf file name will be listed for each analyte in the sample). 
The Spectra Display window shows both the uncorrected data and the 
MSF-corrected analyte data.
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How to Use the MSF Menu

1. Make sure you have a data set open and that the analyte you wish to model is 
displayed.

2. To designate the blank as the active spectrum, click on its spectrum name in 
the legend. 

3. Click on the MSF menu and then on Blank or Assign Global Blank. A b will 
appear next to the blank spectrum name in the legend.
To remove the b, select Blank (or Assign Global Blank) again.

4. To designate the sample as the active spectrum, click on its spectrum name in 
the legend. 

5. Click on the MSF menu and then on Analyte or Assign Global Analyte. An a 
will appear next to the analyte spectrum name in the legend.
To remove the a, select Analyte (or Assign Global Analyte) again.

6. To designate an interferent as the active spectrum, click on its spectrum name 
in the legend. 

7. Click on the MSF menu and then on Interfence or Assign Global Interferent. 
An i will appear next to the interferent spectrum name in the legend. 
To remove the i, select Interference (or Assign Global Interferent) again.

8. If desired, mask any area of the spectrum that you do not wish to include in the 
spectra profile of the MSF model. Click on the MSF menu and then on Mask, 
and drag the vertical cursor that appears across the area to be ignored in the 
MSF calculation. A series of X’s appears confirming the area to be masked. 
For details on when to use masking, see Masking later in this chapter. (To 
remove the masking, click on the MSF menu and then on No mask.)

Save the Model

In the File Menu, click on Save  MSF Model and specify a name. Note that this 
MSF file name will appear as a selection in the MSF Table drop-down list in the 
method (on the Process page, Spectral Corrections tab).

Note  You can repeat steps 6 and 7 for each interferent spectrum.
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To reuse the model, first open the new data set in the MSF window. Then, in 
the File Menu, click on Open  MSF Model and select the MSF file that has 
the assignments you want to use. The Sample IDs must be the same.

Analyze samples 

Analyze check samples (to evaluate results) and unknowns.

Save the Method and repeat the steps above, as necessary, to optimize the MSF 
model.

About Masking

An area of a model spectrum can be selectively excluded from the spectral profile 
of the model. For example, if you have a spectrum of an analyte solution that has 
an interferent with minimal or no overlap then you can use the Mask button to 
selectively remove the interferent from being included in the model of the analyte. 
Masking makes it possible to avoid adding an unnecessary component to the matrix 
model and this means you do not have to collect a spectrum of the component 
to be masked.

Note Once you have created and saved an MSF file, you can automatically reuse 
the model with a new data set as long as the Sample IDs are the same. 

Note In the Method make sure to select:

Process page, Peak Processing tab, select MSF as the Peak Algorithm for 
the appropriate Element.

Process page, Spectral Corrections tab, select MSF as the Overlap 
Correction. Then from the MSF Table drop down list, select the .msf file 
that has been saved as the MSF model for that element.
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To use masking appropriately, the interferent must have minimal or no overlap 
with the analyte. (When you make this judgment, be sure that you are viewing the 
maximum concentration of the interferent). Under these circumstances when you 
apply masking, you can expect the same precision as if the interferent was included 
in the MSF model.

Be cautious about masking an area. Before you apply masking, check to see 
whether the area will help you distinguish the analyte, as in the following example.
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Here, the first peak of the interferent profile occurs at the same wavelength as the 
analyte. Because the analyte completely overlaps this peak, it is difficult to discern 
the interferent peak intensity. The second interferent peak occurs at a slightly 
higher wavelength and provides information on intensity that may help you to 
discern the intensity of the overlapping interferent peak. Therefore, the spectral 
region where the second interferent peak occurs should not be masked.

In the following example, the first peak in the interferent profile partially overlaps 
the analyte and should be included in the MSF model. A second peak does not 
overlap and the spectral region where the peak occurs can be masked.

About Global Assignments

When you are assigning a blank, analyte, or interferent to an MSF model (in the 
Examine MSF window), you can make either a single assignment or a global 
assignment. You use the global assignments to streamline the model creation 
process.

For example, if your blank is common to all analytes, you can first select a data set 
that includes the blank and the standard containing the analyte(s). Then you can 
highlight the blank in the Examine MSF legend and choose Assign Global Blank 
from the MSF menu to assign that sample as the blank for the MSF model for each 
analyte in your data set.
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Similarly, you can highlight the standard containing the analyte(s) in the legend 
and choose Assign Global Analyte from the MSF menu. This will assign that 
standard as the analyte in the MSF model for your data set.

In addition, if you have an interference that is common to all analytes, choose 
Assign Global Interference from the MSF menu.

To view or edit your blank, analyte, and interference selections, open the MSF 
Viewer/Editor. 

Using the MSF File Viewer/Editor

Open the MSF File Viewer/Editor from the MSF menu in the Examine Spectra/
MSF window.

This dialog lists the analytes currently modeled. For each analyte, the sample ID's 
and their assignments in the model are listed. 

A green check mark indicates an assignment was made. For example, if you have 
assigned a blank, it is identified with a check mark and the word “blank” in 
parentheses.

If a sample does not have an assignment, a red X appears next to it.

Use this dialog as follows:

• Click the plus or minus sign next to an analyte to show (or hide) its blank, 
analyte, and interferent.

• Click Expand All to show all blanks, analytes, and interferents for each 
analyte model.

• Click Collapse All to show only a list of analytes.

• To delete a specific analyte or an individual sample ID from a particular model, 
highlight it and click on Delete. For example, to delete a blank, highlight the 
name of the blank, and click on Delete.

You must save the .MSF file after you make any changes in the File Viewer/Editor. 
To save the file, choose Save from the File main menu, and then choose MSF.
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An Overview of How MSF Functions
Multicomponent Spectral Fitting (MSF) uses multivariate calibration to determine 
the concentration of an analyte. Multivariate calibration is analogous to a 
mathematical filter that can distinguish between the components of a complex 
spectral profile. The signal contribution of three components can be separated from 
the analyte:

• interference
• background
• noise

Although MSF is very useful for correction of spectral overlap it requires that you 
have knowledge of the expected components in the real samples (for an exception, 
see Masking earlier in this chapter). In practice, this means you will need to prepare 
individual solutions for the blank, interferent(s), and analyte. 

• it is difficult to assess BGC points, or

• the noise contribution is significant, such as in measurements near an 
analyte’s detection limit 

Note 1 MSF is not suitable where there is complete overlap of analyte and 
interferent (In that case, use the Inter Element Correction (IEC). For all 
other types of spectral overlap, MSF is a powerful technique that can be 
used to improve detection limits and precision. 

Note 2 Even when there are no interferences, you can use MSF's ability to 
improve detection limits and precision. (Simply create a two-component 
model that is composed of just the blank spectra and the analyte spectra.) 
MSF is beneficial when:
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• For a two-component model, MSF may save you time because:

• MSF can automatically correct for the background so there is no 
need to select BGC points.

• MSF uses all of the information about the peak so there is no need 
to select peak wavelength.

Perform Steps to Use MSF
An overview of how to perform Multicomponent Spectral Fitting is shown below, 
along with information about how the software uses input data to calculate analyte 
concentration: 

Note 3 MSF may be used along with internal standardization to further improve 
precision, which may be especially important for measuring analytes in a 
complex matrix.
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Step 1.  Set Up Method

When you choose to perform MSF for an analyte, it is assumed that you have 
already acquired some knowledge of your samples:

• You have determined that there is a need for MSF (i.e., usually because of 
spectral interference and that no other interference-free wavelength is 
available).

• You have qualitative information about the sample (i.e., you have identified 
the analyte and the major interferent). If the interferent has minimal overlap 
then you can use masking (and in that case, it is unnecessary to know the 
identity of the interferent). Refer to the Masking topic earlier in this chapter for 
more information.

• You know what instrumental conditions are needed to run your application.

Next, you need to set up a method to collect spectra of individual solutions that will 
be used to model the spectral profile of each of the components (blank, analyte, and 
interferent(s)).

Note For multiple analytes you will have to make assignments for each analyte.

Tip 1 All solutions can be analyzed as samples. Make sure to identify every 
spectrum with a unique sample ID.
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Set up and save a Method that specifies the following parameters:

• Algorithm set to Peak Ht. or Peak Area 

• Multiple replicates to reduce noise 

• Spectral profiling (yes or no).Set this to match your analysis. (Spectral 
profiling is not required; however, in some instances, it may improve results, 
although it will take longer to process.)

Tip 2 Theoretically, it is “unnecessary” to prepare quantitative solutions for the 
model, since the underlying assumption is that the spectral profile is 
independent of the concentration, and you will not be entering 
concentration values into the method. However, in practice, if you wish to 
optimize the ability of the model to predict unknown concentration of the 
analyte, then you should still consider the following suggestions when 
preparing solutions for the model:

Concentration of the analyte solution should be 100 times its detection 
limit at that wavelength.

Concentration of the interferent solution should be the maximum 
concentration of interferent that will be present in the analysis.

Note At this point, do not specify MSF in the Method when you are first 
collecting the spectra for the model.

Tip Optionally, you may decrease the maximum read time to compensate for 
the increased time that is required for spectral profiling.
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Step 2.  Collect Model Spectra

Use the Automated Analysis Control Window or the Manual Analysis Control 
Window to perform an analysis. 

Make sure to...

• Save the sample and standard spectra to the same data set as the spectra used 
for the MSF model.

• Before you collect spectra, make sure that the Save Data and Print Log boxes 
are selected. in the analysis window.

• Set up the Sample Information file as required for your samples.

Step 3.  Assign Spectral Profiles

Once you have collected the model spectra, then you will create the model 
incorporating each spectral profile (for blank, analyte, and interferent(s)).

Display the spectra in the Examine MSF Window

1. In the Examine MSF window, choose a data set by selecting Data Set from the 
Data menu and following the Data Selection Wizard.

2. The spectra appear in the Examine MSF window and now you can build a 
Model.

Note For multiple analytes you can use the MSF menu to make global 
assignments.

Tip Save spectra to the same data set so that any spectra used to create the 
MSF model can be displayed at the same time in the MSF window (this is 
a requirement for creation of the MSF model since you can select only one 
data set per MSF session).
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Build the MSF Model

For specific steps on using the MSF menu to build the model, see Using the MSF 
Menu earlier in this chapter.

Save the Model of the Spectral Profile

In the File menu, click on Save  MSF Model and specify a name. Note that this 
MSF file name will appear as a selection in the MSF Table drop down list in the 
Method.

To repeat current assignments for new data, first open the new data set in the 
MSF window. Then, in the File menu, click on Open  MSF Model and 
select the MSF file that has the assignments you want to use. The Sample IDs 
must be the same.

Create .MSF File

Once you have assigned each spectrum as

(a) Analyte 

(b) Blank

(i) Interferent(s)

You must save this information as a .msf file.

While still in the MSF Window: In the File menu, click on Save  MSF Model 
to enter a file name (that must have a .msf extension). This file name is 
automatically added to the MSF Table drop-down list in the Method Editor 
(Process page, Spectral Corrections tab).

Note Once you have created and saved an MSF file, you can automatically 
repeat the assignments for the blank (b), analyte (a), and interferent (i) on 
a new data set as long as the Sample IDs are the same for both files.
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A summary of Steps 3 through 6 as they relate to how MSF functions in 
WinLab32:

In Step 3: Assign Spectral Profiles, first, you will assign the model spectra as 
blank (b), analyte (a), and interferent (i). Next, when you save the .msf file, the 
software will create the .msf file that contains the profile information.

In Step 4: Modify Method, you will select the .msf file that is appropriate for that 
method.

In Step 5: Perform an Analysis, the software will input both the modeled spectra 
(from Step 3:) and the spectra collected for analysis (blanks, standards, and 
samples) to create a Matrix equation that will output unknown analyte 
concentration.

In Step 6: Evaluate Results, you can view the MSF-corrected results that were 
output from the Matrix Model. The Results Display window lists the analytical 
results and indicates that the sample was processed by MSF (as applicable, the .msf 
file name will be listed for each analyte in the sample). The Spectra Display 
window shows both the uncorrected data and the MSF-corrected analyte data. 
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Step 4.  Modify Method

The purpose of modifying the method is to collect the spectra for analysis by 
applying MSF processing and selecting the .msf file that was created from the MSF 
window (i.e., saved as the profile model for that element/wavelength).

In the Method make sure to select:

• Process page, Peak Processing tab, MSF as the Peak Algorithm for the 
appropriate element/wavelength 

• Process page, Spectral Corrections tab, MSF, then from the MSF Table drop 
down list select the .msf file name.

• Options page, Results Display/Printed Log Options, check all appropriate 
boxes so that you will have all the information required to evaluate the 
analytical results.

• Options page, check all boxes so that you can perform data reprocessing and 
view spectra in the Examine MSF window, as needed.

Note You must use the same spectrometer Options (Resolution, Profiling) for 
data collection of the model spectra as for the standards and samples.

Note BGC points and Pts/Peak are irrelevant to the MSF processing mode and 
so the system deselects (shades a light gray) those parameters in the 
Method that are inappropriate, and therefore unavailable when MSF 
processing is selected.
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Step 5.  Perform an Analysis

Collect spectra of the:

• blank

• standards

• unknown samples

Tip SAVE SPECTRA TO THE SAME DATA SET so that any spectra used 
to create the MSF model can be displayed in the Examine MSF window 
along with the spectra collected for the analysis.
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Step 6.  Evaluate Results

The Results Display window lists the analytical results and, in this case, (if you 
selected to display the Expanded Method header) indicates that the sample was 
processed by MSF (as applicable, the .msf file name will be listed for each analyte 
in the sample). The Spectra Display window shows both the uncorrected data and 
the MSF-corrected analyte data. 

With Multicomponent Spectral Fitting, you can expect the detection limit will be 
improved by, at least a factor of 2 (sometimes as large as 5) compared to peak 
height processing. (For further details refer to Spectrochimca Acta Vol.48B. No. 
10 pp. 1265-1273, 1993.)

Validate the Model

A common approach to testing the validity of the MSF model is to analyze a 
solution containing a known amount of the interferent at the analyte wavelength. 
The resulting concentration should be zero. The zero amount verifies that the MSF 
model is applying the appropriate correction to your results.

Note Before you analyze an unknown sample with a new model, you should first 
validate the model by analyzing several samples (These samples should 
actually be standards with a known quantity of analyte). In this way you 
will be able to assess whether the model will be valid for the actual 
samples.
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The Matrix Model for MSF

Matrix Notation is used to express the model. (For further details refer to: (1) U.S. 
patent 5,308,982; Ivaldi et al. (2) N. Draper and H. Smith, Applied Regression 
Analysis, Wiley New York (1981))

Y = X β + E

Y is the (nx1) vector of the unknown sample spectrum The model of the unknown 
spectrum is treated as a vector and the analyte concentration is determined for 
each unknown sample.

X is an (nxp) matrix of the model components (analyte, interferent(s), blank). See 
more about X below.

β is a (px1) vector of parameters (coefficients) See more about β below.

E  is an (nx1) vector of errors (residuals). See more about E below.

(n = number of wavelength positions, p= number of components)
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About X

As input from the .msf file, the modeled spectral profiles (for blank, analyte, and 
interferent(s)) are included in matrix X as vectors.

No background correction is needed because the blank is included as a component 
in the X matrix. This means that background correction is derived automatically 
from the regression.
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About β

β is the regression coefficient. The method of least squares is used to estimate β 
such that the calculation apportions the relative contribution of the corresponding 
model to the unknown spectrum. 

As illustrated below, this apportionment becomes a quantitative measure of the 
corresponding element that is present in the unknown sample spectrum.
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About E

E is the unexplained error that occurs when the model estimates concentration as a 
function of peak response (intensity and shape). The error term is often called the 
residual (i.e., Prediction from the calibration curve minus the Actual measured 
response). 

The calibration curve is constructed by applying a linear regression to the actual 
data. The regression minimizes the residuals to result in the “best” straight line 
through the data points for each standard.

When a calibration curve is generated there will always be some residual (error). 
A model can never perfectly match reality and this is why you must use regression 
equations rather than simply solving a series of simultaneous equations. 
Multivariate calibration is highly effective in minimizing random error in order to 
“reality.”

Note that the residual applies to the emission counts if the concentration is known. 
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About Univariate and Multivariate Calibration

Any ICP calibration will try to estimate (or model) the relationship between peak 
response and standard concentration. 

• In univariate calibration (e.g., using Peak Height processing) peak intensity is 
taken at one wavelength. 

• In multivariate calibration (such as used in MSF), matrix algebra is used to 
process peak intensity at many wavelengths. When many wavelengths are 
used, the peak response is not just the intensity but the shape of the peak and 
this shape becomes an inherent part of the information that is used to calculate 
the sample concentration. Also, as summarized below, using more of the 
information from the spectra means that the multivariate calibration models 
can yield more precise estimates of the unknown concentration and can 
improve detection limits.

Display of Univariate Versus Multivariate Calibration
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Diagnostics and System Monitor Windows

You can use various windows to monitor your instrument, perform diagnostics, 
and review system (error) messages.

Select the appropriate window, depending upon the task you wish to perform.

System Monitors

You use the system monitors to check the status of the following:

• Plasma Torch

• Spectrometer

• Autosampler

• Auto Shutdown/Startup

The system monitor displays both a status icon and a system message:

Use To do this

System Monitors Check the status of the major components of the 
system.

Instrument Diagnostics 
window

Review detailed status information and messages 
for the spectrometer, plasma generator, and 
autosampler. 
Re-establish communication between the system 
components.



435System Monitors

By double-clicking on the status icon for the Plasma, Spectrometer, or 
Autosampler, you can get further information about the system component in the 
Instrument Diagnostics window. By double-clicking on the status icon for Auto 
Shutdown/Startup, you open the Automatic Shutdown/Startup dialog. 

Plasma Status Icons 

The following icons are used for instrument models with a horizontally mounted 
torch.

For instrument models with a vertically mounted torch, the icons have a different 
orientation but the meaning is the same. 

Spectrometer Status Icons

Axial
Plasma Off

Axial  
Plasma On

Radial  
Plasma On

Radial
Plasma Off

Plasma 
Error

Shutter Closed Shutter Open Spectrometer 
Error
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Autosampler Status Icons

Auto Shutdown/Startup Status Icons

System Messages

The System Monitor windows display the most recent messages pertaining to the 
system component. 

Probe Down Probe Up  Error

Not  Enabled Automatic  
Shutdown  
Enabled

Automatic  
Startup Enabled
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Instrument Diagnostics Window

You use this window to review the value of parameters for the overall system and 
the spectrometer, plasma, and autosampler. This window is also used to reset 
communication between the system components.

To display this window

In the System menu, click on Diagnostics.

Instrument Diagnostics 

The Instrument Diagnostics window contains bottom tabs, and each tab provides 
access to information on each system component, including the status of the 
component and a log of messages. 

Click on the appropriate tab on the bottom of the window to select these pages:

• System Page 

• Spectrometer Page 

• Plasma Page 

• Autosampler Page 

Diagnostics: System Page

This page shows a graphic representation of the system, which includes:

• the instrument showing the two major components, the plasma generator and 
the spectrometer optics;

• the computer

• the autosampler; and

• connections between the system components representing communication 
through the GPIB (General Purpose Interface bus) interface.
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The System page indicates the operational status problem of the system 
components in the following ways:

For example, a red fault is shown in the screen below. If a fault is indicated, obtain 
more information by clicking on the tab for the system component and reading the 
Message History. For example, for the screen below, a fault is indicated for the 
spectrometer so you would click on the Spectrometer tab to get more information.

Status Icon Meaning

Fault A problem has occurred within this part 
of the system. Read the Message History 
by clicking on the appropriate tab in the 
Diagnostics window. This problem needs 
to be fixed before you can operate the 
instrument.

Marginal This status only pertains to the Optima 
2000, 2100, and 7000 and is displayed 
when the neon lamp is not functioning 
properly.

Standby This status pertains to the Optima 3100, 
3200, 3300, 4100, 4300, 5100, 5200, 
5300, 7100, 7200, and 7300 
spectrometers.  When this symbol is 
displayed the spectrometer is in standby 
mode, which means the argon purge and 
cooling water are shut off.

Standby mode is entered by the user via 
the System > Auto Shutdown/Start-
up… menu command.
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If there is a communication error through the GPIB interface, the connection lines 
are shown in red.

System Communication

The computer communicates with the instrument and accessories through the 
GPIB (General Purpose Interface Bus) interface. 

The System page of the Diagnostics window indicates the system communication 
status in the following ways:
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If there is a communication error through the GPIB interface, the connection lines 
on the System page of the Instrument Diagnostics window are shown in red. For 
example, this is indicated for communication between the computer and the plasma 
generator and spectrometer in the screen below. 

Communication 
Status

Color Meaning

Connecting Blue The system is establishing system 
communication between components.

Connected Green System communication has been 
successfully established.

Not Connected Red A communication problem has occurred. 
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Before starting the software, you should always check that the following system 
components are on:

• spectrometer

• RF generator 

• autosampler 

• printer 

In addition, check that the Emergency Plasma Off switch on the front panel is not 
pressed in.

If you turn on any of the devices under GPIB control after you start the software, 
a communication problem may occur. For example, if the autosampler has been 
disconnected, then reconnected; the autosampler power was off, then turned back 
on when the software was started; or if you have selected a different type of 
autosampler, use the Reconnect button on the Autosampler page of the 
Diagnostics window.

If a communication problem should occur, check the following:

1. Check that the power cable is connected and the power is on for the system 
component.

2. Check that the GPIB cables (also called “IEEE” cables) are connected.

3. If using an autosampler, check that the DIP Switch settings are correct. For 
more information, see the Hardware Guide for your spectrometer. 

4. Click on the tab for the component in the Instrument Diagnostics window. 
Click on the Reconnect button.

5. If a problem still exists, check the connector on the cable. If the pins are 
broken, order a replacement cable.

In some cases, after clicking on the Reconnect button, you may need to exit then 
restart WinLab32. In addition, it may also be necessary to turn off power to the 
component, wait a few seconds, then turn it back on.
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You may also need to use the Reconnect button when you have a problem related 
to the instrument status (cooling water, temperature, gas flows). Once you have 
fixed the status-related problem, it may be necessary to click on Reconnect to reset 
the communication.

Diagnostics: Spectrometer Page

This page displays status information and the Instrument Message History for the 
spectrometer. 

Status

This includes information on the spectrometer model, serial numbers, base module 
software and firmware versions, and the current status of the instrument. To view 
all of the information, use the scroll bar. To print the information, click on the Print 
button. 

Instrument Message History

This includes a log of all of the messages that have been displayed in the System 
Monitor for the spectrometer. The most recent message is listed first. All messages 
listed here pertain to the spectrometer hardware. Messages marked with a question 
mark (?) indicate a “marginal” problem such as a temperature or voltage is too low 
or too high. Messages marked with an asterisk (*) indicate a “fatal” problem that 
would cause the spectrometer to shut down. Refer to Operating Status Problems 
later in this chapter for common status problems. For information on the different 
spectrometer error messages, refer to the Hardware Guide for your spectrometer. 

Configure IP

Click on this button to launch the Spectrometer IP Configure dialog. (This is not 
available when the Simulation mode is configured.)

Note This button only appears for Optima spectrometers connected via Ethernet 
(Optima 5X00 series).
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Initialize

This button appears only for Simultaneous ICP spectrometers and is used to start 
up the spectrometer when it is in standby mode. 

Firmware

Click on this button to install the firmware used when the current version of 
WinLab32 was developed.  

Reconnect

Click on this button to reset communication between the system components if a 
problem has occurred. For more information, see System Communication earlier in 
this chapter.

Print

Click on this button to print the instrument status information and the message 
history. This information is useful for PerkinElmer service engineers in 
troubleshooting a problem.

Enable Update

This checkbox updates the instrument status information and instrument message 
history. When you display this page, this checkbox is selected automatically.

Diagnostics: Plasma Page

This page displays status information and the Instrument Message History for the 
plasma generator. 

Note This button only appears for users who have administrator privileges for 
the local Windows Workstation.  You can check this under Start   
Programs  Administrative Tools  User Manager.  This button 
does not appear on Optima 3000 series instruments
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Status

This includes information on the generator model, base module software and 
firmware versions, and the current status of the plasma generator. To view all of 
the information, use the scroll bar. To print the information, click on the Print 
button. 

Instrument Message History

This includes a log of all of the messages that have been displayed in the System 
Monitor for the plasma. The most recent message is listed first. All messages listed 
here pertain to the plasma generator. Messages marked with a question mark (?) 
indicate a “marginal” problem such as a temperature or voltage is too low or too 
high. Messages marked with an asterisk (*) indicate a “fatal” problem causing the 
plasma generator to shut down. Refer to Operating Status Problems later in this 
chapter for common status problems. For information on the different plasma 
generator error messages, refer to the Hardware Guide for your spectrometer. 

Firmware

Click on this button to install the firmware used when the current version of 
WinLab32 was developed.  

Reconnect

Click on this button to reset communication between the system components if a 
problem has occurred. For more information, see System Communication earlier in 
this chapter.

Note This button only appears for users who have administrator privileges for 
the local Windows Workstation.  You can check this under Start   
Programs  Administrative Tools  User Manager. This button does 
not appear on Optima 3000 series instruments
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Print

Click on this button to print the status information and the message history. This 
information is useful for PerkinElmer service engineers in troubleshooting a 
problem.

Enable Update

This checkbox updates the instrument status information and instrument message 
history. When you display this page, this checkbox is selected automatically.

Diagnostics: Autosampler Page

This page displays status information and the Instrument Message History for the 
autosampler. 

Status

This includes information on the autosampler model, base module software and 
firmware versions, autosampler tray, and the current status of the autosampler. To 
view all of the information, use the scroll bar. To print the information, click on the 
Print button. 

Instrument Message History

This includes a log of all of the messages that have been displayed in the System 
Monitor for the plasma. The most recent message is listed first. All messages listed 
here pertain to the autosampler. Refer to Operating Status Problems later in this 
chapter for common status problems. 

Firmware

Click on this button to install the firmware used when the current version of 
WinLab32 was developed.  
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Reconnect

If the autosampler has been disconnected, then reconnected; the autosampler 
power was off, then turned back on when the software was started; or if you have 
selected a different type of autosampler, use the Reconnect button on the 
Autosampler page of the Diagnostics window. For more information, see System 
Communication earlier in this chapter.

Print

Click on this button to print the status information and the message history. This 
information is useful for PerkinElmer service engineers in troubleshooting a 
problem.

Enable Update

This checkbox updates the instrument status information and instrument message 
history. When you display this page, this checkbox is selected automatically.

Diagnostics: FIAS Page

This page shows important information about the flow-injection system that is 
useful for troubleshooting and service purposes.

Status

This information identifies your flow-injection system. You should have this 
information available when you discuss problems with your PerkinElmer service 
engineer.

Note This button only appears if you have an autosampler that uses 
downloadable firmware. Also, you must have administrator privileges for 
the local Windows Workstation.  You can check for such privileges under 
Start   Programs  Administrative Tools  User Manager.
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Instrument Message History

This is a list of all the messages sent to and received from the computer. This is 
very useful diagnostic information for the service engineer.

Reconnect

Use this button to reset the communication between the flow-injection system and 
the computer.

Print

Use this to print the information shown in this window. This page displays status 
information and the Instrument Message History for the FIAS. 

Diagnostics: Spectrometer Page - IP Configure

This dialog enables you to set the IP address configuration for your spectrometer.
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MAC Address

Enter the Media Access Control (MAC) Address that is specific to your Optima 
spectrometer and is a unique identifier. It is located on the spectrometer board, and 
on a sticker that is located on the back of your Optima instrument.

Get IP Configuration

Click the Get IP Configuration button to retrieve the IP configuration from the 
spectrometer. The Status area displays the status of selected action. 

Configuration Section

Network node configuration of the spectrometer.

IP Address

An identifier for a device on a TCP/IP network.  Enter the IP Address when Static 
IP configuration is selected.

Network Mask

Groups IP addresses together to form a sub net.  Enter the Network Mask when 
Static IP configuration is selected. 

Gateway

IP address of your network Gateway.  Enter the network address of your network 
gateway when Static IP configuration is selected.

Device Name

The name used to identify your Optima spectrometer rather than IP address, when 
DHCP is selected. Enter the Device Name to identify your Optima spectrometer 
when DHCP is selected.

Static IP

Click to select a fixed Internet Protocol address.
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DHCP

Click to select Dynamic Host Configuration Protocol (DHCP), a protocol for 
assigning a dynamic IP address on a network.

Set IP Configuration

Click this button to set the entered IP configuration into WinLab32 and optionally 
the spectrometer when the Spectrometer checkbox is checked.

Restore Defaults

Restores default values into all entry fields. 

Note: This button does not configure the spectrometer. Only the dialog fields are 
affected.

Close

Exits the dialog. No other action is taken.

Spectrometer

Check to configure your Optima spectrometer in addition to WinLab32.

WinLab32

This is always checked to select WinLab32 configuration.

Diagnostics: Spectrometer Page - Configuring IP

When you open this dialog, a default MAC address is entered into the MAC 
Address entry field. The first four fields are populated with the best known starting 
address for Optima spectrometers. The last two are populated with zeroes. The 
MAC address will be persisted by WinLab32, and will only require re-entry upon: 
Re-installation of WinLab32, or when connecting the PC to another Optima 
instrument.  Default values for all other dialog fields are entered into the dialog. 
Those fields are: IP Address, Network Mask, Gateway, Device Name, Static IP, 
and DHCP. Values for all these fields are persisted by WinLab32.
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The WinLab32 checkbox is always checked and always disabled. Its purpose is to 
indicate that WinLab32 is always configured whenever the 'Set IP Configuration' 
button is selected. The Spectrometer checkbox is unchecked when the dialog is 
opened.

1. Before proceeding enter the MAC address for the spectrometer the first time 
WinLab32 is installed. The MAC address is unique to the spectrometer and is 
located on the spectrometer board, and on a sticker that is located on the back of 
your Optima instrument.

2. Click Get IP Configuration once a valid MAC Address has been entered to 
retrieve the configuration currently set into the spectrometer. The configuration is 
displayed in controls within the Configuration group box. The status display 
informs you of the operation sequence and the outcome.

3. Messages are displayed describing operations performed.

Note:  The Status display is cleared upon entry of any value into any field.

4. Change or set a Static or Dynamic IP address

• Change or set a static IP address:  Click the Static IP radio button. Enter 
the IP Address, network mask, and gateway IP address into their respective 
entry fields, and click Set IP configuration. Monitor the Status display area 
for the "IP configuration set… Now retrieving IP configuration" message. 
Then monitor the Status display area for the "IP configuration retrieved" 
message. This completes the operation. Perform other actions or exit the 
dialog by selecting the Exit button.

• Set a dynamic IP address:  Click on the DHCP radio button. Enter a Device 
Name (See description below). The IP address, network mask, and 
gateway IP address will be assigned by a server configured on the network.  
Monitor the Status display area for the "IP configuration set… Now 
retrieving IP configuration" message. Then monitor the Status display area 
for the "IP configuration retrieved" message. This completes the operation. 
Perform other actions or exit the dialog by selecting the Exit button.

Note: Check the Spectrometer checkbox to configure your Optima spectrometer in 
addition to WinLab32. Only the Device Name is required to configure WinLab32.
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Device Name Allowable Settings

The Device Name will be used by ICP WinLab32 for connection to your Optima 
spectrometer when using DHCP. The DHCP server on your network assigns an IP 
address and will map the Device Name to that IP address when your application 
software (ICP WinLab32) connects to the spectrometer. The name is determined 
by you. Syntax rules for the name are: The name must be unique within your 
network. One (1) to twenty five (25) characters can be used. The characters can be 
either letters or numbers, and the first character must be a letter. Upper and lower 
case letters may be used, although no distinction is made between upper and lower 
case by a DHCP server when mapping a Device Name.

5. Recommended Setup for Optima 5X00:  Although the TCP/IP connection 
described in this document is flexible enough to support most LAN topologies, it 
is recommended that a direct, dedicated, static, single cable connection is used to 
connect the PC to the Optima spectrometer. The main driver for this decision is that 
performance can be affected by a DHCP server, and other LAN traffic. 

The Optima 5X00's PC can be connected to a LAN and/or Internet via a second 
network adapter. The IP configuration of this adapter, being separate from the 
spectrometer network, can be configured to the requirements of the customer's 
LAN and/or internet provider. A USB adapter is available for this purpose as 
PerkinElmer part number 0940-4826. 

The spectrometer network will have a class B Network mask "255.255.0.0" with 
the network portion of the IP set to "64.1".

Spectrometer Setup  

All Optima 5X00 Spectrometers will have the same IP configuration:

Static IP address "64.1.3.1", Network mask "255.255.0.0".  Gateway 

is not used and can be set to "0.0.0.0". Device name is not used and can be set to 
blank.

PC Setup  

All Optima 5X00 PC's will have the same IP configuration for the network card 
used for connection to the spectrometer:  Static IP address "64.1.3.2", Network 



452 Chapter 10 Diagnostics & System Monitors Windows

mask "255.255.0.0", Gateway is not used and can be set to "0.0.0.0", Device name 
is not used and can be set to blank. 

Operating Status Problems

The following table describes common problems associated with the system status. 
For more information about specific error messages or corrective actions, refer to 
the Hardware Guide for your spectrometer.

A red fault icon appears in the Instrument Diagnostics window. 

The system has been shut down due to a “fatal” error. Click on the tab for the 
system component and check the Instrument Message History for error messages 
that describe the cause(s). 

Check the operating status problems given below. Refer to the Hardware Guide for 
your spectrometer for a description of error messages. 

Cooling Water Status

Cooling water may not be flowing properly. 

Check that the cooling water is on. Check that the cooling water hoses are 
connected to the back of the instrument and that the hoses are not kinked. Check 
that the cooling water drain is not obstructed.

If using a chiller, check that it is filled and working properly. Check the chiller 
water temperature. Check if algae is building up in the cooling lines, causing a 
blockage. 

If using a cooling water supply, check the flow rate and pressure. Check the water 
filter and change the filter element if it is plugged.

After you fix the problem, you may need to reset the instrument in the Instrument 
Diagnostics window by clicking on Reconnect. If this does not work, exit and 
restart the WinLab32 software. 

Spectrometer Temperature Status
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The spectrometer temperature may not be within the required range.

Check the cooling water as described previously. Monitor the temperature in the 
Instrument Diagnostics window. The temperature affects instrument stability, so if 
you operate the system in marginal temperature status, your results may be 
affected. 

Interlock Status

The doors to the sample compartment may not be closed securely. Make sure that 
the doors are properly closed. Wait for error message to clear.

Interlocks for the argon or water flow may not be satisfied. Check the cooling water 
supply as described previously. Check the argon supply (see below).

Argon Status

The argon pressure (monitored for the detector purge) may not be in the required 
range. 

Check that the argon supply is on. Check the argon hose connections. Make sure 
that they are not obstructed. Check the pressure at the cylinder regulator. 

If this does not solve the problem, contact a PerkinElmer service engineer to check 
the argon pressure setting on the instrument.

After you fix the problem, you may need to reset the instrument in the Instrument 
Diagnostics window by clicking on Reconnect. If this does not work, exit and 
restart the WinLab32 software. 

Nitrogen Status

The pressure monitored for the spectrometer purge may not be in the required 
range. The purge gas may be nitrogen or argon.

Check that the purge gas supply (nitrogen or argon) is on. Check the gas hose 
connections. Make sure that they are not obstructed. Check the pressure at the 
cylinder regulator.
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After you fix the problem, you may need to reset the instrument in the Instrument 
Diagnostics window by clicking on Reconnect. If this does not work, exit and 
restart the WinLab32 software. 

The spectrometer is not ready.

The spectrometer may not have completed the initialization routine. In this case, 
the software will indicate how long the initialization will take.

All interlocks may not be satisfied. See the information on Interlock Status 
described previously. 

The GPIB cables (also called “IEEE” cables) may be disconnected or there may be 
a system communication problem. Check all GPIB cables. 

Double-check the cooling water, argon, and nitrogen supplies. 

Open and close the front door to the sample compartment to try resetting the door 
interlock. 

After you fix the problem, you may need to reset the instrument in the Instrument 
Diagnostics window by clicking on Reconnect. If this does not work, exit and 
restart the WinLab32 software. 
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Software Troubleshooting

This section includes general software maintenance and troubleshooting 
information.

Database Management Tips

On a regular basis, it is important to archive your results data sets on floppy disks, 
tape, or other storage medium for long term storage. After archiving data sets, you 
should then remove the data sets and pack the database (library). If you allow the 
database (library) to become too large, all database operations in WinLab32 such 
as performing an analysis or reprocessing data may take longer. It is also important 
to periodically archive your methods, although the method library fills up much 
more slowly than the results library. 

For instructions on archiving data sets and methods, see the WinLab32 Data 
Managers User’s Guide or online help.

Exiting the Software and Shutting Down the Computer

Before you turn off your computer, always close all applications and exit Windows 
properly to avoid damaging files, including the database. To exit Windows 
operating system, select the shut down option as described in your Windows 
documentation. A screen message informs you when you can safely turn off your 
computer. 
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Software Recovery Options

Occasionally, the keyboard or mouse may  “lock up” or a software error message 
that reads “General Protection Fault” may appear. If one of these situations occurs, 
refer to the software recovery options that follow.

If you get a “General Protection Fault” message, it is not usually necessary to 
exit Windows, however, you should exit and restart WinLab32.

If the software “locks up” do the following:

1. Hold down both the Ctrl and Alt keys and press Del. This will usually give you 
a Windows dialog that allows you to directly shut down the system. Click on 
Shut Down... in this dialog.

- or -

If the keyboard is locked and Ctrl-Alt-Del has no effect, try using the mouse 

to select Start Shut Down....

2. If the plasma was on, it is normal for it to remain on during shutdown. Restart 
WinLab32 to either resume work or extinguish the plasma. If you need to shut 
off the plasma, you can also press the red Emergency Plasma Off switch on the 
front of the instrument.

If you cannot shut down the computer properly as described above, as a last 
resort, do the following:

1. Press the Reset button on the computer.

- or -

Turn off the computer and wait 30 seconds (for the components to fully 
discharge), then restart the computer.

2. If the plasma was on, it is normal for it to remain on during shutdown. Restart 
WinLab32 to either resume work or extinguish the plasma. If you need to shut 
off the plasma, you can also press the red Emergency Plasma Off switch on the 
front of the instrument.
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Technical Support

Should you require assistance with a software- or hardware-related problem, 
contact your local PerkinElmer representative. In addition to a detailed description 
of the problem, the following files are helpful. 

• archived method (see Data Manager help file for instructions)

• archived results library (see Data Manager help file for instructions)

• message history (print out from Instrument Diagnostics window.)

Enable/Disable Service Log Files Dialog

This dialog enables you to provide a PerkinElmer service engineer with 
information about your instrument for diagnostics and troubleshooting. The service 
logs record software actions and intermediate results. Software actions concern the 
commands issued and the control of system devices. Intermediate results or 
calculations show, for example, how a concentration value was calculated or how 
data was acquired or normalized. 

To display this dialog

Hold down both the Ctrl and Shift keys and press L.

Note Service logs are not involved in routine procedures. They are for 
diagnostics and troubleshooting only. 

Note You cannot display this dialog while an analysis is in progress. 
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To enable or disable the service logs 

1. Hold down both the Ctrl and Shift keys and press L to display the Enable/
Disable Service Log Files dialog.

2. Select the service log files that you want to record.

The service logs will be recorded in the temporary files folder in the user 
directory, for example /pe/Default User/Temporary Files. The log files are 
named according to the selections in the dialog. For example, the Auto 
Sampler Controller Log file is named “AutoSamplerController.Log.”

Types of Service Logs

The following types of service logs are available:

Controller Logs: There are three Controller logs that record communication 
initiated by the Controllers to the three system devices: autosampler, plasma 
generator, and spectrometer. The Controllers send messages and pick up responses 
to and from the three device servers or “base modules.” The device server or “base 
module” for each of the three system devices is a separate application that controls 
its respective device.

Device Server Logs: There is a device server or “base module” for each of the 
three system devices: autosampler or FIAS, plasma generator, and spectrometer. 
The Device Server logs record the communication between the device server and 
its respective device. 

Note When you first enable a service log, the software erases any information 
that was previously in the log and begins recording new information. 
When you exit the software, the log files will remain unchanged. When 
you restart the software then begin recording new information, previous 
information in the log file will be erased. 
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Analysis Log: This log can record detailed information about the analytical results 
including pairs of data points; a break-down of analytes according to when they are 
processed in groups; wavelength calibration calculations; and spectral resolution 
values.

Result Storage Log: This log shows how results are sent to the results data set.

Stability Log: This log records a peak index value and actual peak wavelength 
indicating where the peak is located. 

Description of Available Log Files

Auto Sampler Controller Log
This log records communication between the controller and the device server (or 
“base module”) for the autosampler or FIAS. The letter “O” indicates OLE 
commands sent by the controller. The letter “B” indicates low level commands if 
the option for Low Level (All Controllers) is selected in the dialog. The time that 
each command is sent or received is given in milliseconds.

Plasma Generator Controller Log
This log records communication between the controller and the device server (or 
“base module”) for the plasma generator. The letter “O” indicates OLE commands 
sent by the controller. The letter “B” indicates low level commands if the option 
for Low Level (All Controllers) is selected in the dialog. The time that each 
command is sent or received is given in milliseconds.
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Spectrometer Controller Log
This log records communication between the controller and the device server (or 
“base module”) for the spectrometer. The letter “O” indicates OLE commands sent 
by the controller. The letter “B” indicates low level commands if the option for 
Low Level (All Controllers) is selected in the dialog. The time that each command 
is sent or received is given in milliseconds. Select Data Xfer Block to record a 
block of information for each replicate containing spectral data for each analyte. 
Errors shown indicate saturation codes.

Analysis Log
Select Detailed to record data points for intensity and wavelengths for each survey 
window. The detailed log also includes calibration coefficients and number of 
calibration standards. 

Select Process Groups to record how analytes are grouped according to 
processing parameters. Since instrument settings can vary by analyte, the 
instrument separates the analytes into groups that have the same settings. This log 
shows the number of processing groups, the analytes in each group, and a list of the 
parameters used. 

Select Wave Cal. To record the peak offset values generated during a wavelength 
calibration. This log shows the equation: Difference = Measured - Theoretical. It 
also lists the Result Vector and RMS (Root Mean Square) values. 

Select Spectral Resolution to display the resolution for each analyte peak. The 
resolution (in nanometers) is equal to the peak width at half of the peak height. 
Note: This value is only valid if the Peak Height algorithm is used.

Results Storage Log
This log records the analytical data sent to the results data set, including the result 
index, sample index, mean index, replicate number, corrected intensity, the number 
of data points in the spectral data. 
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Stability Log
For each replicate, this log records the sample name, analyte name, corrected peak 
intensity, peak index indicating where the peak was found in a series of data points, 
and actual peak position in nanometers. 

AsFIAS32 Log
This log records the communication between the device server and its respective 
device (autosampler or FIAS). Select Server to record OLE commands from the 
controller. Select Device to record commands from the device server. These 
commands are labeled “C” for a device server command or “A” for an answer from 
the device. Select Errors to display any error messages.

Generator32 Log
This log records the communication between the device server for the plasma 
generator and the firmware. Select Server to record OLE commands from the 
controller. Select Device to record commands from the device server. These 
commands are labeled “C” for a device server command or “A” for an answer from 
the device. Select Errors to display any error messages.

SimSpec32 Log or SeqSpec32 Log
This log records the communication between the device server for the spectrometer 
and the firmware. The SimSpec32 log applies to simultaneous ICP spectrometers. 
The SeqSpec32 log applies to scanning CCD ICP spectrometers. Select Server to 
record OLE commands from the controller. Select Device to record commands 
from the device server. These commands are labeled “C” for a device server 
command or “A” for an answer from the device. Select Errors to display any error 
messages.

SimSpec32 Log (Device Qualifiers)
For simultaneous ICP spectrometers, you can also select Device Qualifiers to be 
recorded in the SimSpec32 Log. To do this, you must select Device under the 
SimSpec32Log, then select the Device Qualifiers. 
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Select Auto Integration Groups to record information about the different analyte 
groups used in auto integration. Since auto integration times can vary by analyte, 
the instrument separates the analytes into groups that have the same integration 
times. This log shows the number of auto integration groups and the analytes in 
each group. Select Detailed to record the grouping algorithm in process and the 
maximum intensity within the integration window.

Select Fixed Integration Groups when Manual settings were selected in the 
method to record information about groups of analytes with fixed integration times.

Select Spectra Acquisition to record the data block sent back from the 
spectrometer to the base module. 

Select Normalization to record the treatment of each data point as it is converted 
to counts per second (cps). The normalization routine subtracts the signal bias 
(SB), applies the linearity constant, convert to cps, and subtracts the dark current 
(DC). 

Select Data Xfer Block to record a block of information for each replicate 
containing spectral data for each analyte. This data transfer block is the counterpart 
to the data transfer block for the Spectrometer Controller Log and is in an identical 
format. 

WinLab32 Message Dialogs

During WinLab32 operation, messages may appear to provide you with 
information to correct entries in the software and ensure that valid data is collected. 
These messages can be printed. 

WinLab32 General Messages dialog

When there is an inconsistency in input information, WinLab32 alerts you with a 
system message dialog. This identifies the concern and provides an appropriate 
action to enable you to make a correction, or it may present you with a choice of 
action.

WinLab32 messages can include the following message dialogs:
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• Check Method dialog
For more information see Check Method dialog in Chapter 11,  Menus and 
Toolbar.

• Analysis Checking and Error dialogs (discussed on the next page.)

Analysis Checking dialog

After you have entered the analysis information and begin the analysis, the 
software checks the entries to make sure everything is set up properly. 

A partial list of the checks performed is given below: 

• if used, recovery standards are defined

• results library specified is not too large to use

• sample information file entries are complete and consistent

Analysis Error (Warning) Messages dialog 

Depending on the error found, the software may display a software warning 
message. (In the Hardware Guide for your instrument, a warning means there is 
potential personal injury. The analysis error (warning) messages here alert you to 
possible collection of invalid data.)

A partial list of the checks that may result in a software warning message are: 

• reslope standards, QCs, recovery sets are specified correctly

• the method selected for reprocessing data is the same method used to collect 
the original data. 

• plasma is not turned on

• peristaltic pump is not turned on

• nebulizer gas is not turned on
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Progress Timer Dialog

During the operation of many processes throughout instrument operation, a 
Progress Timer dialog appears. This dialog reports the time remaining until the 
specified event occurs and gives you an opportunity to cancel, if desired. 

For example, this dialog appears when you have selected Immediately on OK in 
the Shutdown/Startup dialog and click on OK. It shows the amount of time until 

shutdown. 
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About the Toolbar and Menus
You use the toolbar for quick access to key windows and dialogs available in the 
software.

You use the menus to access the windows, commands and dialogs available in the 
software.
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Toolbar
The Toolbar is located below the menu bar in the application window. You can use 
the buttons on the toolbar as a shortcut to accessing key windows and dialogs in the 
software.

You can place the toolbar anywhere along the edge of the WinLab32 window with 
the toolbar buttons aligned either horizontally or vertically. Click on the 
background area surrounding the toolbar buttons and drag (hold down the mouse 
button and move the mouse) the toolbar to the location you wish.

To resize the toolbar, place the mouse cursor along any edge of the toolbar so that 
a double arrow appears. Then hold down the mouse button and resize the toolbar.

Toolbar Buttons

When you click on the Workspace (Wrkspc) button, the Open 
Workspace File Open dialog appears, which lists stored 
workspaces. To create a new workspace, see Workspaces in 
Chapter 1,  Introduction to WinLab32.

When you click on the Method Editor (MethEd) button, the 
Method Editor appears, which you use to enter analytical 
parameters.

Note If you do not see the toolbar: In the Options menu, click on General 
Preferences and then click on the Toolbar checkbox to select it.
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When you click on the Sample Information (SamInfo) button, the 
Sample Information Editor appears, which you use to enter 
information about your samples.

When you click on the Spectra button, the Spectra Display 
window appears, which you use to view spectra during analyses.

When you click on the Results button, the Results Display 
window appears, which you use to view analytical data during 
analyses.

When you click on the Calibration (Calib) button, the Calibration 
Display window appears, which you use to view the calibration 
curves. The calibration curves displayed are from the most recent 
analysis. You can clear the calibration curves or recall a stored 
calibration. For more information, see the Analysis Menu 
Commands later in this chapter. In addition, you can specify the 
calibration to be used in the method on the Calibration: Initial 
Calibration Options page.

When you click on the Examine button, the Examine Spectra 
window appears, which you use to examine the details of spectra 
one element at a time or use Multicomponent Spectral Fitting 
(MSF). Peak wavelength and background correction points may 
be fine-tuned here.

When you click on the Manual button, the Manual Analysis 
Control window appears, which you use to perform analyses 
with manual sampling. You can also use this window to control 
the autosampler manually during an analysis.
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When you click on the Auto button, the Automated Analysis 
Control window appears, which you use to perform automated 
analyses with an autosampler.

When you click on the Reprocessing (Reproc) button, the Data 
Reprocessing window appears, which you use to reprocess 
previously gathered data.

When you click on the Reprint button, the Reprint Data screen 
appears, which you use to specify which results data you want to 
reprint.  Reprinting data will create an exact copy of your original 
results data printout..

When you click on the Plasma button, the Plasma Control 
window appears, which you use to ignite and adjust the plasma 
conditions and peristaltic pump.

When you click on the Camer icon the Plasma Control window 
appears from where you can view the plasma.

When you click on the Method button, a dialog that you use to 
open a stored method appears. The name of the method that is 
currently open appears in the status display.

When you click on the Sample Info button, the Open Sample 
Information dialog appears, which you use to open a stored file. 
The sample information file that is currently open appears in the 
status display.
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File Menu Commands

File Menu Command Description

New Method... Use this command to create a new method. The 
Create New Method Dialog appears, where you can 
select a set of plasma conditions in a new method for 
different types of analyses, for example, organic or 
aqueous. Or, you can choose to use a copy of the 
active method or another stored method as a starting 
point.

New 
Sample Info. File...

Use this command to create a new sample informa-
tion file. The New Sample Information File dialog 
appears, in which you select the default design 
(default.sid) or a design you have created. The design 
(.sid) file is a template that contains the sample 
parameters that you want to use. To create a design 
file, see Using the Sample Information Editor in 
Chapter 4,  Sample Information Editor.

New 
MSF Model...

Use this command to create a new Multicomponent 
Spectral Fitting model. 

New 
IEC Model...

Use this command to create a new Interelement 
Correction model. The Interelement Correction (IEC) 
Model Builder appears showing the Set Up page.

Open Method... Use this command to select a stored method for edit-
ing or performing manual analyses. The Open 
Method dialog appears.

Open 
Sample Info File...

Use this command to select a stored sample informa-
tion file for editing or performing manual analyses. 
An Open dialog appears, where you can select a sam-
ple information file.
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File Menu Command Description

Open MSF Model... Use this command to open an existing Multicom-
ponent Spectral Fitting model. An Open dialog 
appears, where you can select an MSF model.

Open IEC Model... Use this command to open an existing Interele-
ment Correction model. An Open dialog appears, 
where you can select an IEC model.

Open Workspace... Use this command to open a workspace, which 
contains a layout of stored windows and entries. 
An Open dialog appears, where you can select a 
workspace.

Save Method Use this command to save changes to the active 
method. The first time you save a Method, the 
Save As Method dialog will appear prompting 
you for a name. Note: If, for any reason, a method 
is not ready to be saved, a check method dialog 
will appear.

Save Sample Info File Use this command to save changes to the active 
sample information file. The first time you save a 
sample information file, the Save As Sample 
Information File dialog will appear prompting 
you for a name.

Save MSF Model... Use this command to save changes to the active 
Multicomponent Spectral Fitting model.

Save IEC Model... Use this command to save changes to the active 
Interelement Correction model.

Save As Method... Use this command to save the active method with 
the latest changes in the methods database. The 
Save As Method dialog appears, where you can 
enter a name for the method.
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File Menu Command Description

Save As 
Sample Info File...

Use this command to save the active sample 
information file with the latest changes in a 
separate file. A Save As dialog appears, 
where you can enter a name for the sample 
information file.

Save As 
Sample Info Design...

Use this command to save the active sample 
information design with the latest changes in 
a separate file. A Save As dialog appears, 
where you can enter a name for the sample 
information design.

Save As MSF Model... Use this command to save the active Multi-
component Spectral Fitting model with the 
latest changes in a separate file. A Save As 
dialog appears, where you can enter a name 
for the MSF File.

Save As IEC Model... Use this command to save the active Interele-
ment Correction model with the latest 
changes in a separate file. A Save As dialog 
appears, where you can enter a name for the 
IEC File.

Save As Workspace... Use this command to save the active work-
space, which contains a layout of stored win-
dows and entries, with the latest changes in a 
separate file. A Save As dialog appears, 
where you can enter a name for the work-
space.
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Save As Text Use this command to save the contents of the 
Method Editor, a sample information file, 
Autosampler Loading List, or IEC Factors to 
an ASCII text file. You can then use a text 
editing application to view, modify or print 
the information.

Import from Results 
Library...

Use this command to open the method, MSF 
Model, or IEC model that was used to gener-
ate a data set. First, select the results data set, 
then select the method or model(s) you want 
to import. The method or model(s) will then 
be opened in the appropriate windows.

Message Use this command to print or save a message 
with your results. The Message dialog 
appears, where you enter the message.

Print Active Window Use this command to print the contents of the 
active window such as the Method Editor, the 
Calibration Display window, the Spectra Dis-
play window, the Examine Spectral/MSF 
window, a sample information file, or any 
text display window, such as the Results Dis-
play window or Autosampler Loading List. 
Click on the window of interest and then 
select this command. The Print dialog 
appears, where you can select the pages to 
print. Note: Printouts of spectra and calibra-
tion curves are always in the layout of 2 col-
umns and 3 rows. (See your Windows manual 
for further information on printing, if 
needed.)

File Menu Command Description
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Print 
Reset Page Numbers

When information in the Results window is 
printing, use this command to reset the page 
number of the next page to be printed to 1. 
This overrides the usual situation where the 
page numbers are consecutive when the 
Results window is printed.

Print Skip Line In the Results window, use this command to 
add a blank line after the end of the text. 
When the Results window is printed, it will 
contain the added space. 

Print New Page When information in the Results window is 
printing, use the command to force a page to 
print, even if the page is only half filled with 
information. Usually, a page does not print 
until it is completely filled. 

Print Setup... Use this command to set options for printing, 
such as printer name, paper size and orienta-
tion. (See your Windows manual for further 
information on printing, if needed.)

Active Window Preview Use this command to view the contents of the 
active window before printing.

File Menu Command Description
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Create New Method Dialog

This dialog gives you the option of selecting a set of recommended plasma 
conditions in a new method for different types of analyses, for example, organic or 
aqueous. It also gives you the option of selecting either the active method or 
another stored method as a starting point for creating a new method. 

To display this dialog

In the File menu, click on New  Method…

Utilities Use this command to view a submenu where 
you can start companion WinLab32 
applications. Use Data Manager to archive 
and maintain Method and Results Data Sets, 
create printed reports of data, and convert 
data for use with spreadsheet and database 
management programs. Use WinLab32 
Offline while the instrument is analyzing 
samples on-line to begin a new session of 
WinLab32. You can use WinLab32 Offline 
for entering information or reprocessing data. 
WinLab32 Offline does not allow you to 
control the instrument.

Exit Use this command to exit the WinLab32 
software application. This command prompts 
you to save data and to confirm that you want 
to exit, then it shuts down the plasma and the 
WinLab32 software.

File Menu Command Description
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To select plasma conditions in a new (default) method

1. Click on the Default option to start with a new “Untitled” method.

2. Select one of the following plasma conditions:

Aqueous (see conditions given below)
Organic (see conditions given below)
Add Conditions

- or -

Select Modify.

When you select Add Conditions or Modify you can set up conditions for a 
customized type of analysis. The Plasma Default Conditions Dialog appears. 
Enter a Plasma Conditions Name and select the appropriate settings for your 
analysis. 

The software will open the Method Editor with the settings you selected.
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Plasma Conditions for aqueous and organic analyses

To select the active method or a stored method to use as a starting point

When creating a new method, it may be useful to start with a copy of the active 
method or another stored method as a basis for creating the new method. By 
selecting Copy of active method or Copy of another method, a copy of the 
method is opened in the Method Editor called “Untitled.” Modify the settings as 
needed, then save it under a different name using Save As  Method in the File 
menu. 

Plasma Default Conditions Dialog

You use this dialog to select settings for plasma conditions, aerosol type, and 
nebulizer startup when creating a new method. Recommended settings are 
displayed for Aqueous and Organic analyses.

Parameter Aqueous Organic
Plasma Flow: 15 L/min 15 L/min

Auxiliary Flow: 0.5 L/min
(for Optima 3000 Family ICP
spectrometers)

0.2 L/min
(for other simultaneous ICP
spectrometers or for scanning CCD
ICP spectrometers)

1.0 L/min

Nebulizer Flow:
(for Low-Flow
GemCone or the
Concentric Glass
nebulizer)

0.80 L/min 0.50 L/min

RF power: 1300 watts 1300 watts

Sample Flow
Rate

1.50 mL/min 0.80 mL/min
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To display this dialog

In the File menu, click on New  Method and in the Plasma Default 
Conditions Dialog that appears, click on Modify...

Plasma Conditions Name
This shows the name of the set of plasma conditions that you selected in the Create 
New Method dialog. When defining a new set of conditions, enter a name here.

Post-ignition Plasma Conditions

Plasma Gas Flow (L/min)
This is the flow rate of the argon gas that is contained between the outer and 
intermediate injector tubes in the torch.

Auxiliary Gas Flow (L/min)
This is the flow rate of the auxiliary argon gas, which is contained between the 
intermediate and center injector tubes in the torch.

Nebulizer Gas Flow (L/min)
This is the flow rate of the nebulizer gas, which carries the sample aerosol into the 
plasma.

RF Power (Watts)
This is power in watts transmitted from the RF generator to the ICP. 

Sample Flow Rate (mL/min)
This is the flow rate of the solution pumped into the nebulizer by the peristaltic 
pump. Its range depends on the type of pump and pump tubing being used, but is 
typically 1 to 3.
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Aerosol Type
This shows the type of aerosol that will be used for the analysis.

Wet
Use when the sample aerosol is produced by nebulizing a solution using a 
pneumatic nebulizer, such as the cross-flow nebulizer or the GemCone 
nebulizer.

Dry
Use when the sample aerosol is desolvated, i.e., by an ultrasonic nebulizer or 
is produced directly from a solid sample, e.g. using laser sampling.

Nebulizer Start
These are two procedures that control the post-ignition nebulizer argon flow 
differently.

Instant turns the nebulizer argon flow on quickly after ignition. Use this for 
most cases.

Gradual turns the nebulizer argon flow on slowly after ignition. Use this for 
igniting while aspirating high solids sample matrices or when the first 
procedure does not work.

For more information, see Recommended Settings for Plasma Parameters in 
Chapter 6,  Hardware Control Windows.

New Sample Information File Dialog

You use this dialog to create a new sample information file based on a selected 
design.

To display this dialog

In the File menu, click on New Sample  Information File...

Using this dialog

Select a sample information design name from the Design List. This list includes a 
default design and any other designs that have been previously created and stored. 
A sample information design includes the exact parameters that you need to 
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describe your samples. For information on creating a sample information design, 
see Using the Sample Information Editor in Chapter 4,  Sample Information Editor.

Opening and Saving Methods and Selecting Results

This topic covers the Open Method, Save Method As and Select a Results Data Set 
dialogs. 

Check the database library location

The database library is where the methods or results are stored. The current library 
location is shown. If the stored methods or results data set does not appear, you may 
look for it in a different database library location. 

1. To change the library location, click on Browse...

2. In the Open dialog that appears, select the directory path and file name for the 
library.

Methods

To open a stored method (Open Method dialog)

Click on the name in the table, then click on OK.

-or-

Double-click on the name in the table.

To save a method (Save Method As dialog)

Type a name of up to 25 characters in the Name entry field, then click on OK.

Results Data Sets

To select a stored results data set (Select Results Data Set dialog)

Click on the name in the table, then click on OK.

-or-
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Double-click on the name in the table.

To create a new results data set

Type a name of up to 25 characters in the Name entry field, then click on OK.

To sort the method or data set list

Click on the appropriate option button to sort by Name or Date/Time.

Open Dialog

You use this dialog to select a stored file. This can be either a sample information 
file, a Multicomponent Spectral Fitting model, an Interelement Correction model, 
or a workspace file. 

To display this dialog

In the File menu, click on Open, then select either Sample Info File..., MSF 
Model..., IEC Model... or Workspace...

Using this dialog

The default folder where files are stored appears in the Look In box, and the 
extension for the file type you are opening automatically appears in the Files of 
Type entry field.

For example, if you are opening a sample information file, the default folder that 
appears contains existing sample information files. The .sif extension appears in 
the File of Type entry field.

Click on the name of the file you want to open, then click on Open.

Save As Dialog

Use this dialog to save the active file with the latest changes in a separate file. This 
can be either a sample information file, a sample information design file, a 
workspace file, an Interelement Correction model or a Multicomponent Spectral 
Fitting file. 
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To display this dialog

In the File menu, click on Save As then select the type of file you want to save.

To save the file

The default folder where files are stored appears in the Look In box.

1. Type a name in the File name entry field. 

The software automatically adds the appropriate extension.

2. Click on Save.

Import from Results Library Dialog

Use this dialog when you need to open the method, MSF Model, or IEC model that 
was used to generate a data set. For example, if you need to reprocess data, you 
would open the method that was used to generate the data set before starting 
reprocessing.

To display this dialog

In the File menu, click on Import from Results Library.

To import a method, MSF Model, or IEC Model 

1. In the File menu, click on Import from Results Library.

2. Select the results data set and click on OK. 

3. When the Import from Results Library dialog appears, select the method or 
model(s) you want to import and then at the bottom of the dialog, select the 
corresponding check boxes to describe your selection. Click on OK.

The method is opened in the appropriate windows. 

Note Windows allows you to use filenames longer than the 8-character names 
required by MS-DOS conventions.
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The MSF model is opened in memory so that the results may be reprocessed 
with this MSF model.  However, the MSF model is not available in the MSF/
Examine window, nor is it available for use with other methods.

The IEC model is opened in memory and will also appear in the IEC Model 
Builder window, if you have that window open.  If desired, this model can then 
be saved, so that a copy resides in the IEC directory.  The IEC model can then 
be used in other methods.

Message Dialog

Use this dialog to print a message regarding the analysis in your results. You can 
also save this message to the results library.

To display this dialog

In the File menu, click on Message…

Using this dialog

1. Type the message in the dialog. 

2. Check that you have the desired option(s) checked:

If you select Print Message, the message will appear in the Results window 
and be printed in the log. 

If you select Save Message, the message will be saved in the active results 
library.

Edit Menu Commands 

Edit Menu Command Description

Cut Use this command to remove selected text or 
values in a table and place in the Windows 
clipboard.
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Copy Use this command to copy selected text or val-
ues in a table and place in the Windows clip-
board.

Paste Use this command to insert text or values from 
the Windows clipboard into a table.

Clear Use this command to remove selected text or 
values in a table.

Find Next When the Results Window is open you can use 
this command to search the
Results Window.

Insert Rows Use this command to insert an empty row into 
a table of parameters such as those in the 
Method Editor or Sample Information Editor. 
Select a position in the line after the one you 
want to insert and then select the command. A 
line will be inserted before the line containing 
the cursor. All entries below the inserted line 
move down one position.

Delete Rows   Use this command to delete selected rows 
from a table. All entries below move up 
respectively one position.

Append Rows   Use this command to add rows to the end of 
the Sample Information table. In the Sample 
Information Parameters Dialog that appears, 
select the number of rows you want to append 
by using the spin box labeled Maximum 
number of samples. You can also modify the 
sample information parameters in this dialog.

Edit Menu Command Description
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Column Fill... Use this command to fill a selected column in 
the Method Editor or Sample Information Edi-
tor. When you click on this command, a dialog 
appears where you enter values to fill the 
selected column.

Check Method Use this command to check for any problems 
or inconsistencies in the method.

Sort by... 
Element Symbol

When the Method Editor Instrument page is 
open, use this command to sort the elements in 
the method alphabetically by the element sym-
bol.

Sort by... Wavelength When the Method Editor Instrument page is 
open, use this command to sort the elements in 
the method by the wavelength.

Sort by... Analyte Name When the Method Editor Instrument page is 
open, use this command to sort the elements in 
the method alphabetically by the element 
name.

Sort by... Function When the Method Editor Instrument page is 
open, use this command to sort the elements in 
the method by the function (as indicated by 
“analyte” or “internal standard”).

Parameter List.... Use this command to open the Sample Infor-
mation Parameters dialog, where you can add 
parameters to a sample information file. 
Parameters can be common to all samples or 
they can vary by sample.

Edit Menu Command Description
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Check Method

This message dialog lets you know the results of the Check Method command in 
the Edit menu. This command checks to make sure that the method is self-
consistent and, if any problems are found, the dialog displays information about 
what corrections are needed. When you save a method, the method will be checked 
automatically.

When a method is checked, the software examines the parameters to make sure that 
the information you have entered is fully complete. A partial list of the checks 
performed is given below:

• standard concentrations are entered

• the reslope standard concentrations are valid

• autosampler locations for calibration standards

• wavelengths are available

• survey and auto integration windows are properly defined
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• plasma conditions are valid

• internal standard assignments

• IEC selections

• MSF selections

• Quality Control samples (concentrations, schedule, failure actions)
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Tools Menu Commands

Tool Menu Command Description

Method Editor Use this command to view the Method Editor, 
where you enter analytical parameters.

Sample Information Editor Use this command to view the Sample Infor-
mation Editor, where you enter the location of 
the samples in the autosampler, sample IDs, 
sample weights and sample volumes.

Periodic Table Use this command to open the Method Peri-
odic Table, where you enter elements and 
wavelengths to create a new method or modify 
an existing method.

Wavelength Table Use this command to view the Wavelength 
Table window. You use this window to select 
wavelengths when creating or editing a method 
or identifying interferences viewed in the 
Examine Spectra window.

Results Use this command to view the Results Display 
window, which shows the measurements made 
on the current sample, the calculated concen-
tration values, and statistical information.

Calibration Use this command to view the Calibration Dis-
play window, which shows the active calibra-
tion curves.

Spectra Use this command to view the Spectra Display 
window, which shows spectra acquired during 
an analysis.
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Examine Spectra/MSF Use this command after data is acquired and 
saved to view the Examine Spectra window, 
where you can examine the spectra in detail, 
one element at a time. You can use this window 
to overlay spectra and to select peak wave-
length and background points. You also use 
this window for Multicomponent Spectral Fit-
ting (MSF) by creating models for analytes and 
interferents. You must save the data to perform 
these functions in this window.

Data Reprocessing Use this command to view the Data Reprocess-
ing window. You use this window to reprocess 
existing data.

IEC Model Builder Use this command to view the Interelement 
Correction Model Builder. You use this tool to 
create factors that correct for spectral interfer-
ences.

Manual Analysis Control Use this command to view the Manual Analy-
sis Control window. You use this window to 
perform analyses with manual sampling.

Automated Analysis
Control

Use this command to view the Automated 
Analysis Control window. You use this win-
dow to perform automated analyses with an 
autosampler.

Plasma Control Use this command to view the Plasma Control 
window. You use this window to ignite and 
adjust the plasma, control the peristaltic pump 
and check instrument status.

Spectrometer Control Use this command to view the Spectrometer 
Control window. You use this window to align 
the torch viewing position and select spectrom-
eter settings.

Tool Menu Command Description
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System Menu Commands

System Menu Command Description

Reset RF Emergency Off Use this command to reset the RF Emergency 
Off switch after it has been used to extinguish the 
plasma.

Calibrate Plasma Torch 
Gases…

Use this command only when a new torch has 
just been installed or if a message has been dis-
played indicating that there is a problem. Per-
forming this calibration at other times is 
unnecessary. The calibration procedure shuts off 
the plasma and takes approximately six minutes 
to complete.

Autosampler Loading 
List

Use this command to view information about the 
solution in each autosampler location. When you 
click on this command, the Autosampler Loading 
List appears.

Diagnostics Use this command to review the current status of 
parameters for the spectrometer, plasma and 
autosampler. When you click on this command, 
the Instrument Diagnostics window appears.

Plasma On/Off This command opens the Plasma Control win-
dow and turns on the plasma. If the plasma is 
already on, this command turns it off, but does 
not close the Plasma Control window.
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Automatic Shutdown/Startup Dialog

You use this dialog to select options for automatically starting up or shutting down 
the instrument.

Pump On/Off This command opens the Plasma Control win-
dow and turns on the pump. If the pump is 
already on, this command turns it off, but does 
not close the Plasma Control window.

Auto 
Shutdown/Startup...

Use this command to select options for automati-
cally shutting down or starting up the instrument. 
When you click on this command, the Automatic 
Shutdown/Startup dialog appears, where you 
make your selections.

System Menu Command Description
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To display this dialog

In the System menu, click on Auto Shutdown/Startup...

-or-

In the Automated Analysis Control window Set Up page, click on Set... next 
to Auto Shutdown.

Shutdown

To program an automatic shutdown, select Shutdown and select one of the 
following options:

At end of automated analysis
To schedule the automatic shutdown for the end of the next automated 
analysis, select this option. If you want the shutdown conditions you select to 
occur if the analysis is terminated by a hardware error or QC stop action, select 
Including terminations caused by error.

Immediately on OK
Select this option to schedule the automatic shutdown to occur immediately 
after you click on OK to close this dialog. A timer dialog appears and counts 
down the time to shutdown. It also allows you a brief opportunity to cancel the 
shutdown, if desired. 

Date/Time entry fields
To schedule the automatic shutdown for a specific date and time, enter the date, 
hour and minute when the shutdown is to occur. Base the time on a 24-hour 
clock. For example, 8:30 p.m. would be entered as 20:30.

Weekly Schedule
To schedule times during the days of the week for automatically shutting down 
the instrument, click on Set…

Note The WinLab32 software must be left on before the time when the 
automatic shut down is scheduled.
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Wash before shutdown
Select this box to specify the time in minutes that you want the wash to continue 
before the instrument automatically shuts down. You must be using an autosampler 
for this option. You can use single or multiple wash solutions:

Single for x minutes
Select this option if you have a single wash solution and enter the wash time. The 
location of the wash solution is selected in the method on the Sampler: 
Autosampler Wash page.

Multiple
Select this option if you have multiple wash solutions, for example, if you want to 
wash with nitric acid in autosampler location 2 for 10 minutes and then wash with 
deionized water in location 3 for 8 minutes. Click on Set... to enter the wash times 
and autosampler locations of the wash solutions.

Shutdown Options

Turn off Plasma and Pump
Select this box to turn off the plasma and pump upon shutdown.

Put Spectrometer into Standby
Select this box to put the spectrometer into a standby mode. This turns off the 
detector argon purge and cooling water.

Start-up

To program an automatic startup, select Start-up and select one of the 
following options:

Date/Time entry fields
Enter the exact date and time that the instrument is to begin operation. Base the 
time on a 24-hour clock. For example, 8:30 p.m. would be entered as 20:30.

Note If you do not schedule an automatic start-up, you can start the spectrometer 
manually from standby mode.  In the System menu, click on Diagnostics. 
When the Diagnostics window appears, click on the Spectrometer tab and 
then on the Initialize button. 
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Weekly Schedule
To schedule times during the days of the week for automatically starting up the 
instrument, click on Set…

Start-up Options
Use these options to select whether the plasma is to be ignited and the pump is to 
begin operating upon startup. You can also select whether to perform a high purge 
for the spectrometer upon startup. 

For more information, see Performing Analyses: Setting Up the Instrument in 
Chapter 2,  Performing Analyses, and Performing Analyses: Shutting Down the 
Instrument also in Chapter 2,  Performing Analyses.

Weekly Schedule Dialog

You use this dialog to schedule times during the days of the week for automatically 
starting or shutting down the instrument.

To display this dialog

In the Automatic Shutdown/Startup dialog, select Weekly Schedule and click 
on Set…

To set a weekly schedule

1. Select the day(s) of the week when you want to automatically shut down or 
start up the instrument.

2. Select the shutdown or start-up time(s).

Note The WinLab32 software must be left on before the time the automatic 
start-up is scheduled. 

Note The WinLab32 software must be left on before the time when the 
automatic shutdown or start-up is scheduled.
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For more information see Performing Analyses: Setting Up the Instrument in 
Chapter 2,  Performing Analyses, and Performing Analyses: Shutting Down the 
Instrument also in Chapter 2,  Performing Analyses.

Multiple Wash Settings Dialog 

Use this dialog if you want to use multiple wash solutions before the instrument 
automatically shuts down. For example, you can wash with a 5% or 10% nitric acid 
solution in autosampler location 2 for 10 minutes and then wash with deionized 
water in location 3 for 8 minutes. 

To display this dialog

1. In the System menu, click on Auto Shutdown/Startup...

2. Select Enable shutdown and Wash before shutdown.

3. Select the Multiple wash option, then click on Set…

Using this dialog

Enter the wash time and autosampler location for each wash solution.

Analysis Menu Commands

Analysis Menu Command Description

Enable/Disable Elements... Use this command to include or exclude an 
element from your method in an analysis. 
When you click on this command, the Enable/
Disable Elements dialog appears, where you 
can make your selections.
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Analytical Header Use this command to print the analytical 
header. This is particularly useful when you 
have reset a Manual Analysis. The analysis 
header will be displayed in the Results win-
dow and will also be printed provided that a 
printed log is selected. The analysis header 
includes the start time, name of analyst, sam-
ple information file name, results data set 
name, and results library name, and other gen-
eral information about the analysis.

Cancel Analysis... Use this command to cancel an analysis in 
progress in either the Manual Analysis Control 
or Automated Analysis Control windows. If 
you cancel an automated analysis, the Stop-
ping an Analytical Sequence dialog appears.

New Calibration Use this command to clear the existing cali-
brations from the Calibration Display window. 
You can generate a new calibration by analyz-
ing the calibration standards.

Recall Calibration... Use this command to recall a stored calibra-
tion from the results library. After you click on 
this command, select the results data set where 
the calibration is stored. If several sets of cali-
brations have been run, the most recent one 
will be recalled.

Analysis Menu Command Description
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Calibration Summary When you are performing a Manual Analysis, 
use this command to view a summary of the 
calibration data. When you click on this com-
mand, a calibration summary is added to the 
information in the Results Display Window. 
(In an Automated Analysis, the calibration 
summary appears automatically in the Results 
Display Window after the last standard is ana-
lyzed, provided that this option is selected on 
the Options page of the Method Editor.)

Clear Calibration Blank Use this command to clear the calibration 
blank concentrations from the analysis. If mul-
tiple calibration blanks have been analyzed, all 
calibration blank concentrations are cleared.

Clear Reagent Blank Use this command to clear the existing reagent 
blank concentrations from the analysis. If mul-
tiple reagent blanks have been analyzed, all 
reagent blank concentrations are cleared.

Clear Results Display Use this command to clear tabular analysis 
results from the Results Display window.

Clear Spectra Display Use this command to clear spectral and text 
information from the Spectra Display window.

Manual Analysis 
Analyze Next Blank

After you have set up the Manual Analysis 
Control window, use this command to analyze 
the next blank. This is the same as clicking on 
Analyze Blank in the Manual Analysis Con-
trol window.

Analysis Menu Command Description
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Analysis Menu Command Description

Manual Analysis 
Analyze Next Standard

After you have set up the Manual Analy-
sis Control window, use this command to 
analyze the next standard. This is the 
same as clicking on Analyze Standard in 
the Manual Analysis Control window.

Manual Analysis 
Analyze Sample

After you have set up the Manual Analy-
sis Control window, use this command to 
analyze a sample. This is the same as 
clicking on the Analyze Sample in the 
Manual Analysis Control window.

Automated Analysis 
Analyze All

After you have set up the Automated 
Analysis Control window to start analyz-
ing a sequence, use this command to 
begin analyzing the blanks, standards and 
samples. This is the same as clicking on 
Analyze All in the Automated Analysis 
Control window.

Automated Analysis 
Calibrate

After you have set up the Automated 
Analysis Control window to start analyz-
ing a sequence, use this command to 
begin analyzing the blanks and standards. 
This is the same as clicking on Calibrate 
in the Automated Analysis Control win-
dow.

Automated Analysis 
Analyze Samples

After you have set up the Automated 
Analysis Control window to start analyz-
ing a sequence, use this command to 
begin analyzing the samples. This is the 
same as clicking on Analyze Samples in 
the Automated Analysis Control window.



500 Chapter 11 Menus and Toolbar

Automated Analysis 
Reset Sequence...

Use this command after you have set up 
the Automated Analysis Control window, 
have interrupted the analysis and wish to 
reset the analysis to the beginning. Cali-
bration curves are cleared when the analy-
sis is restarted. This is the same as 
clicking on Reset Sequence in the Auto-
mated Analysis Control window.

Automated Analysis 
Priority Sample...

Use this command to add samples to the 
sample sequence while an automated 
analysis is in progress. When you click on 
this command, the Add Sample dialog 
appears in which you enter sample param-
eters and select when to analyze the sam-
ple. This command is the same as clicking 
on Priority… in the Automated Analysis 
Control window.

Automated Analysis 
Append Samples to Analysis 
List...

Use this command to append samples 
from your sample information file to the 
end of the run list while an automated 
analysis is in progress. In the Append 
Samples to Analysis List dialog that 
appears, enter the sample numbers from 
the sample information file (do not enter 
autosampler locations).

Autosampler 
A/S Probe Up/Down

Use this command to move the autosam-
pler probe up or down, depending on its 
current position.

Autosampler 
Go to Wash

Use this command to go to the autosam-
pler location of the wash solution. The 
location of the wash solution is selected in 
the method on the Sampler: Autosampler 
Wash page. 

Analysis Menu Command Description
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Autosampler 
Go to Location

Use this command to select the location 
where the autosampler probe will move. 
When you click on this command, the Go 
To Location dialog appears. 

Autosampler 
Load Autosampler Tray

Use this command to move the autosam-
pler probe up and then to the back left 
position. This is the same as clicking on 
Load Tray in the Automated Analysis 
Control window.

Analysis Menu Command Description
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Enable/Disable Elements Dialog

You use this dialog to include or exclude elements in the active method from an 
automated analysis, manual analysis or data reprocessing. This dialog applies only 
to single methods run from memory.

To display this dialog

In the Analysis menu, click on Enable/Disable Elements...

Using this dialog
1. Review the list of elements and decide which to include or exclude. These 

elements are taken from the active method.

To include an element in an analysis, click on the check box so that a check 
appears.

To exclude an element from an analysis sequence, click on the check box so 
that the check is cleared.

Note The Enabled parameter has a column fill dialog that can be accessed by 
double-clicking in the column header.
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2. Click on OK.

Recall Calibration Dialog 

You use this dialog to select stored calibration data for performing analyses. This 
is so that you do not have to calibrate each time you analyze samples.

To use this dialog 

Before opening this dialog, open a method that contains the elements and 
wavelengths that you want to use with the recalled calibration. Typically, this 
would be the method that you originally used to collect the calibration data. If 
you are not sure which method was used, select Import from Results 
Library… from the File menu, then select the results data set. If you want to 
use a different method, it must contain some (but not necessarily all) of the 
elements and wavelengths that were originally used when the calibration data 
was collected.

In the Analysis menu, click on Recall Calibration...

Check the library location

The database library is where the calibration data is stored, as part of a results data 
set. The current library location is shown.

1. To change the library location, click on Browse…

2. In the Open dialog that appears, select the directory path for the library.

To select stored calibration data 

In an analysis window, when the Save Data box next to During Analysis is 
selected, calibration data is automatically stored with results. When you display an 
analysis window and select a results data set, this box is selected automatically (an 
X appears).

Note Elements will remain disabled until re-enabled using this dialog or until a 
new method is loaded.
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To recall a particular set of calibration data, click on the name of the results 
data set where the results were stored when the calibration was performed, then 
click on OK.

The recalled calibration will be used for the next manual or automated analysis, 
which you can now start by clicking on Analyze Sample(s) in the Manual or 
Automated Analysis Control window.

Append Samples to Analysis List Dialog

Use this dialog to add samples to be analyzed at the end of an automated analysis.

To display this dialog

In the Analysis menu, click on Automated Analysis Append Samples to 
Analysis List while an automated analysis is in progress.

To append samples to the end of an automated analysis

1. Before using this dialog, you need to add new samples to the sample 
information file. 

Note In a situation where calibration was performed more than once for a results 
data set, the data for the last calibration performed are recalled.
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2. In the Analysis menu, click on Automated Analysis  Append Samples to 
Analysis List while the automated analysis is in progress. In the dialog, click 
on the entry field so the cursor appears. Type the sample numbers from the 
sample information file (for example 7,8,9 or 7-9). Use commas to separate the 
locations and ranges. 

The new samples are added to the end of the run list in the Automated Analysis 
Control window.
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Options Menu Commands

Options Menu Command Description

General Preferences... Use this command to set up the software 
with the desired toolbar icons and system 
monitors. See General Preferences Dialog: 
View Page later in this chapter for more 
information. In addition, use this command 
to select sounds to play at the end of certain 
tasks to signal completion or to signal the 
user’s attention. See General Preferences 
Dialog: Sounds Page later in this chapter 
for more information.

Automatic Export... Use this command if you want to automati-
cally export data contained in a results data 
set and write it into a file that can be read by 
many other programs, including spreadsheet 
and database management programs. The 
Automatic Export dialog appears. The 
export file contains ASCII data records.

Sample Information Editor… Use this command to select the exact 
parameters that you need to describe your 
samples, including sample description, 
preparation, and scheduling parameters, and 
add them to the Sample Information Editor. 
For more information, see the Sample 
Information Parameters Dialog in Chapter 
4,  Sample Information Editor.

Spectra Display... Use this command to change the number of 
panes and the colors that appear in the Spec-
tra Display window. You can also optimize 
colors for printing screens of this window in 
a 2-column by 3-row format. When you 
click on this command, the Spectra Display 
Options dialog appears.
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Calibration Display... Use this command to change the number of 
panes and the colors that appear in the 
Calibration Display window. You can also 
optimize colors for printing screens of this 
window in a 2-column by 3-row format. 
When you click on this command, the 
Calibration Display Options dialog appears.

Examine Spectra/MSF… Use this command to change the colors that 
appear in the Examine Spectra/MSF win-
dow. You can also optimize colors for print-
ing screen captures. When you click on this 
command, the Examine Spectra/MSF 
Display Options dialog appears.

Pump... Use this command to select options for the 
peristaltic pump. When you click on this 
command, the Configure Pump appears, 
where you make your selections.)

Autosampler... Use this command to view the autosampler 
model and select tray type that you are 
using. (To change the autosampler model, 
exit the software and click on Start  
Programs  PerkinElmer WinLab32  
Reconfigure.)

Options Menu Command Description
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General Preferences Dialog: Sounds Page

Users may elect to play sounds at various intervals or at the end of certain tasks to 
signal completion or to signal the user’s attention. Sounds are included in the 
software and are located in the same drive in which the application was installed. 
In order to use the Sounds Page, you must have a sound card installed in your 
computer.

To display this dialog

In the Options menu, click on General Preferences. Select the Sounds tab.

To select sounds

1. Select Play Sounds, which activates the dialog choices.

2. Select from the following choices: 

End of Analysis
This signals when an automated analysis is completed.

End of Wave Calibration
This signals when the wavelength calibration is completed.

End of Align View
This indicates the end of a torch view alignment. 

End of Detector Calibration
This indicates when the detector calibration is completed. 

QC Failure
If the Quality Control sample fails and the analysis is stopped, you can be 
alerted by a pre-selected sound.

QC Paused
If the Quality Control sample fails and you have selected to pause the system 
(using the Alarm & Pause failure action) you can be alerted by a pre-selected 
sound.

Note You may use any Windows sound files with a .wav document extension or 
any .wav sound files that you might have installed.
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Hardware Error
If a hardware error occurs such as the plasma gases are turned off, you can be 
alerted by a pre-selected sound.

Plasma Extinguished 
You will be alerted if the plasma is unexpectedly turned off (not a manual shut-
off).

Internal Standard Failure
If an Internal Standard Check fails, you can be alerted with a pre-selected 
sound.

Nebulizer Back Pressure
If the nebulizer back pressure is out of range, you can be alerted with a pre-
selected
sound.

3. Click on Browse… to modify the selection of a sound file.

Sounds are set to defaults and are interchangeable. For example, you may 
replace the End of Detector sound with that of the QC Failure. 

4. After you have checked the appropriate sounds and their related .wav files, 
click on Apply.

5. Click on OK to close the dialog.

General Preferences Dialog: View Page

You may select viewing preferences for your screen that serve as short-cuts for 
certain purposes. These viewing icons are a quick alternative for often-used 
functions. 

Viewing preferences that you may choose to appear on the screen include: 

Toolbar
This displays commonly used icons across the top of your screen.

Method/Sample Info Bar
This displays the buttons that allow you to quickly modify both methods and 
sample information.
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Status Bar
This displays the information line at the bottom of the screen.

System Monitors
The System Monitors allow you to monitor the status of the plasma, 
spectrometer, autosampler, and startup/shutdown activities. The four System 
Monitors are the Plasma Monitor, Spectrometer Monitor, Autosampler 
Monitor, and Startup/Shutdown Monitor.

Show Tool Tips
This displays tool tips, which appear when you place the mouse cursor on a 
WinLab32 feature such as a button, entry field, option, etc. When you do so, a 
one-line description, action, or other useful information relating to the feature 
selected appears. If you wish to turn off tool tips, click on this checkbox until 
the checkmark disappears. 

Lines of data to display
Select the maximum lines of data you want to display in the Results Window. 

To display this dialog

In the Options menu, click on General Preferences. Select the View tab.

To select viewing options

1. Click on the check box for each item you wish to view. 

2. After you have made your selections, click on Apply.

3. Click on OK to close the dialog.

Automatic Export Dialog

You use this dialog if you want the software to automatically export data contained 
in a results data set and write it into a file that can be read by many other third-party 
software packages, including spreadsheet and database management programs. 
The export file contains ASCII data records. 

To display this dialog

In the Options menu, click on Automatic Export... 
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-or-

On the Automated Analysis control window click on Set... next to Auto 
Export.

To automatically reformat data:

1. In the Export Design 1 entry field type the name of the design you created in 
the Data Manager or click on Browse... next to the entry field and when the 
dialog appears select the name of the design (*.xpt) and click on OK.

2. Repeat step 1 if an Export Design 2 was created in the WinLab32 Data 
Manager.

3. Click on OK. A checkmark appears in the Auto Export checkbox indicating 
that for each analysis you perform, data will be exported automatically. To stop 
exporting data in this manner, click in the checkbox to clear the checkmark.

Configure Pump Dialog

You use this dialog to select options for the peristaltic pump.

To display this dialog

In the Options menu click on Pump...

Using this dialog

Select the options that correspond to your instrument configuration.

Note You must first create the Export Design(s) in the Data Manager. An export 
design defines a subset of data items that you want to export from a data 
set. For more information, refer to Data Manager Help. When exporting 
data, you have the ability to select two of your designs as Export Design 1 
and Export Design 2. You may want to do this if you want different 
information to be exported or you want the data to be exported to two 
separate file locations. Remember, in each Export Design created you 
assign the directory path where you want your results stored.
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Pump Settings

Pump Tubing
Select the tubing type from the drop down list, for example:

black/black

orange/red

orange/blue, etc.

The pump tubing selected will determine the pump speed needed to achieve a given 
sample flow rate.

Pump Flush Rate 
Enter the default flush speed. This is the pump speed that will be used when you 
click on the Flush button in the Plasma Control window. A sample flush is 
normally used to deliver sample from the sample vessel to the nebulizer at a faster 
rate than the normal sample flow rate. This decreases the total amount of time it 
takes to analyze each sample.

Enable Tubing Saver
Select this checkbox to use the Tubing Saver feature, which extends the lifespan of 
the peristalic pump tubing by operating the pump at a slower speed than normal.  

Pump Type 
Optima
Select this option to specify the Optima pump.

Gilson Minipulse
This option appears only when the software is configured for the Optima 3000 
Family spectrometers. Select this option to specify the Gilson Minipulse pump.

Note This feature is not available for the Optima 3000 instruments. 
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Autosampler Configuration Dialog

You use this dialog to view the autosampler model and select the tray type that you 
are using.

To display this dialog

In the Options menu, click on Autosampler...

Using this dialog

Select the options that correspond to your autosampler configuration.

Autosampler Model

The autosampler model is set to its original configuration, which was set up 
when the software was installed.

You may not change the autosampler model in the Autosampler Configuration 
dialog. To change the model, you need to exit the software and run the 
Reconfigure utility.

To run the Reconfigure utility, click on Start  Programs  
PerkinElmer WinLab32  Reconfigure.

Autosampler Tray

Click on Browse to select a different autosampler tray.

Highlight the tray you are using and click on Open to select the tray. Different 
trays are available that will appear in this dialog depending upon the 
autosampler model you are using.

Turn peristaltic pump off while moving autosampler

Select this checkbox to turn off the pump while the autosampler probe arm 
moves horizontally between samples. 
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Autosampler Configuration Dialog AS-93

You use this dialog to view the autosampler model and select the tray type that you 
are using.

To display this dialog

1. In the  Options menu, click on Autosampler...

Using this dialog

Select the tray that corresponds to your autosampler configuration. 

Autosampler Model

The autosampler model is set to its original configuration, which was set up when 
the software was installed. 

To change the model, exit the software and run the Reconfigure utility. To run the 
Reconfigure utility, click on Start  Programs  PerkinElmer WinLab32  
Reconfigure.

Autosampler Tray

1. Click on Browse to select a different autosampler tray.

2. In the dialog that appears, the trays are listed that can be used with the current 
autosampler configuration. 

3. Click on the tray you are using and then click on Open. 

Rinse

The AS-93 autosamplers have a rinse location used to rinse the sample probe.  If 
you want to change the rinse solution continuously, select one of the options where 
the pump is switched on.  Use a higher pump speed to change the rinse solution 
more quickly. 
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Window Menu Commands
You use the Window menu to rearrange open windows or icons on the application 
window.

Window Menu Command Description

Cascade Use this command to resize and overlap open 
windows so that each title bar is visible.

Tile Horizontal Use this command to resize and arrange open 
windows horizontally across the screen.

Tile Vertical Use this command to resize and arrange open 
windows vertically down the screen.

Arrange Icons   Use this command to bring icons of minimized 
windows to the lower left-hand corner of the 
screen.

Close All Windows Use this command to close all of the open 
windows in the application.
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Help Menu Commands

Help Menu Command Description

Tip of the Day… Use this command to display tips about using 
the software when starting the software.

Active Window Help Use this command to display help information 
about the window that is currently active. 
Shortcut: F1.

Contents and Index Use this command to access a table of contents 
and the index for online Help.

How to Use Help Use this command to access information that 
explains how to use online Help.

About WinLab32... Use this command to view information about 
the software. In the dialog that appears, click on 
Details to view current version numbers for the 
main application, the base modules, and the 
firmware.



Calibration and
Calculations12

Chapter Table of Contents Page

Calibration ............................................................................. 518

Calculations ........................................................................... 533



518 Chapter 12 Calibration and Calculations

Calibration

Linear Calibration Algorithm

This calibration curve is established by assuming that the relationship between 
concentration (the X values) and intensity (the Y values) is linear and that the 
following equation describes this relationship:

Y = MX + B

where:

X = concentration

Y = intensity

M = slope of the calibration curve

B = y-axis intercept

Given 2 or more data points, the values for M and B are calculated using the 
following equations [1, 2].

n = number of standards (includes the blank)
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In this equation, the blank is subtracted from all solutions and included in the 
calculation of the calibration curve.
 

An example of this calculation is described below:
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The WinLab Report shows the following information for ZN 206.200:

Where:

Intensity is calculated as:  5227 * 5.780 + 0 = 30212.06 using the equation Y = MX 
+ B.

The intensity of the blank is then subtracted to get the Net Intensity which is 
calculated as:  30212.6 - 2.6 = 30209.46

Please note that the numbers derived from the calculation above may differ slightly 
from the intensity value displayed in the WinLab report, because WinLab 
calculates Intensity values using additional significant figures for the 
Concentration value; these additional significant figures are not displayed on the 
printed WinLab report.
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Linear Forced through Zero

A calibration curve defined using this equation is forced to go through zero 
intensity and zero concentration.

This calibration curve is established by assuming that the relationship between 
concentration (the X values) and intensity (the Y values) is linear and that the 
following equation describes this relationship:

Y = MX

where:

X = concentration

Y = intensity

M = slope of the calibration curve

The intercept is forced to be zero.

Given 2 or more data points, the values for M are calculated using the following 
equation.

n = number of standards (includes the blank)

In this equation, the blank is subtracted from all solutions and included in the 
calculation of the calibration curve.
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Linear Bracketing Calibration

The bracketing standards calibration option is applicable over a restricted 
concentration range. The calibration is performed with at least two calibration 
standards that bracket the concentration range of interest. 

This calibration curve is established by assuming that the relationship between 
concentration (the X values) and intensity (the Y values) is linear and that the 
following equation describes this relationship:

Y = MX + B

where:

X = concentration

Y = intensity

M = slope of the calibration curve

B = y-axis intercept

Given 2 or more data points, the values for M and B are calculated using the 
following equations [1, 2].

n = number of standards (includes the blank)
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The use of a blank is optional. If a blank is not used, a zero intensity is assumed. In 
this equation, the blank is subtracted from all solutions, but is not included in the 
calculation of the calibration curve.
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Non-Linear Calibration Algorithm

This calibration curve is established by assuming that the relationship between 
concentration (the X values) and intensity (the Y values) is a curvilinear one that 
can be described by the following polynomial equation:

X = concentration

Y = intensity

A = curvature 

B = slope 

C = y-axis intercept 

Given 3 or more data points, the values for A, B and C are calculated using the 
following equations [1, 2, 3].

n = number of standards (includes the blank)

In this equation, the blank is subtracted from all solutions and included in the 
calculation of the calibration curve.

Y = AX + BX + C2
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Where: 

a  =  
c
n

 -  
c
c0

0 1

0

a  = 
c
n

 - 
c
c1

1 3

0

a  =  
c
n

 -  
c
c2

2 4

0

a  =  
c
c

 -  
c
c3

1

0

3

1

a  =  
c
c

 -  
c
c4

3

0

5

1

a  =  c
c

 -  c
c5

4

0

6

1

c  =  (X )0 i
n

i = 1

∑

c  =  (X )1 i
2

n

i = 1

∑

c  =  (Y )2 i 
n

i = 1

∑

c  =  (X )3 i
3

n

i = 1

∑

c  =  (X Y )4 i i i
n

i = 1

∑

c  =  (X )5 i
4

n

i = 1

∑

c  =  (X Y )6 i
2

 i i
n

i = 1

∑



526 Chapter 12 Calibration and Calculations

Non-Linear Bracketing Algorithm

This calibration curve is established by assuming that the relationship between 
concentration (the X values) and intensity (the Y values) is a curvilinear one that 
can be described by the following polynomial equation:

X = concentration

Y = intensity

A = curvature 

B = slope 

C = y-axis intercept 

Given 3 or more data points, the values for A, B and C are calculated using the 
following equations [1, 2, 3].

n = number of standards (includes the blank)

In this equation, the blank is subtracted from all solutions and included in the 
calculation of the calibration curve.

Y = AX + BX + C2
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The use of a blank is optional. If a blank is not used, a zero intensity is assumed. In 
this equation, the blank is subtracted from all solutions, but is not included in the 
calculation of the calibration curve.
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Where: 
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Correlation Coefficient

Correlation coefficients are calculated in WinLab32 using three different formulas, 
based on the current calibration equation.

Linear Calculated Intercept / Linear Bracketing

where:

X = concentration

Y = intensity

n = number of standards+1

Based only on concentration (intensity) points, not the calculated curve.

Coefficient may be 1.0 even if points are not on the curve.

For Linear Calculated Intercept, the blank (0,0) point is included, which increases 
the number of standards (n) by 1.

Note The correlation coefficient is the same as Pearson’s “r” value. 
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Linear Zero Intercept

where:

X = concentration

Y = intensity

n = number of standards

Based only on concentration  (intensity) points, not the calculated curve

Coefficient may be 1.0 even if points are not on the curve

Nonlinear (Calculated Intercept / Zero Intercept / Bracketing)

where:

X = concentration (entered by user)
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Y = concentration (measured from calibration curve)

n = number of standards

Based on actual and measured concentrations (the delta between the user-entered 
value and the calculated curve).

Will work for linear or non-linear curves

Coefficient will be 1.0 only if all points are on the curve.

For Nonlinear Calculated Intercept, the blank (0,0) point is included, which 
increases the number of standards (n) by 1.

Method of Additions Sample Intercept

Use the analyte addition technique when the matrix causes an interference that 
varies from sample to sample.

The calibration curve is forced to go through the point defined by the sample with 
no addition added, and in the other the sample with no addition is treated as just 
another point by the least squares routine.

The equation used for the sample intercept option is:

C is the concentration added to an aliquot of sample and I is the difference between 
the intensity for the aliquot with added standard and the intensity measured for the 
sample. The final sample concentration is calculated by multiplying the slope (-K1) 
times the intensity of the sample.
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Method of Additions Calculated Intercept

A least squares technique is used to determine the K1 coefficient when two or more 
standards are used for calibration.  This calibration curve is not forced to go 
through the point defined by the unspiked sample and the intercept with the 
intensity axis is calculated.

The equation used for the calculated intercept option is:

The sample with no addition is treated as just another point by the least squares 
routine that determines the K1 and K2 coefficients.

Method of Additions Calibrate

The system uses method of additions, with the zero intercept equation option for 
the first sample then analyzes subsequent samples using the calibration curve 
generated for the first sample. This is appropriate when the matrix causes an 
interference that is the same for all the samples.

This calibration curve is forced to go through the point defined by the unspiked 
sample.
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Calculations

Standard Deviation and Precision

The equation used to calculate Standard Deviation (SD) is as follows:

where:

The equation used to calculate precision or the Relative Standard Deviation (RSD) 
is:

SD
c c 

n
i mean=
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−
∑ ( )2

1

c
c
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i

mean

  is each replicate measurement
   is the mean value
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RSD SD
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Reslope

The reslope feature of the software allows you to make small corrections to the 
calibration curve using a single calibration standard following small changes in 
instrumental conditions. You might also want to use a reslope standard with a 
matrix similar to your samples, for example Standard Reference Materials from the 
United States National Institute of Standards and Technology, to compensate for 
small matrix effects after you have performed the initial calibration with aqueous 
calibration standards. When a reslope recalibration is performed, the slope 
coefficient is adjusted to make the concentration calculated by the equation equal 
to the actual concentration of the reslope standard. A reslope standard near the 
middle of the calibration range will usually give the best results.

A single reslope standard, however, will not adequately compensate for major 
changes in instrument parameters. You should do a complete recalibration 
following parameter changes that are likely to alter the shape of the calibration 
curve, such as instrument drift, changes in plasma conditions, or large matrix 
differences.
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Internal Standardization

When performing a calibration in ICP, the sample intensity is expressed as a 
function of concentration:

[1]

When using internal standards, the sample intensity is divided by the intensity of 
the internal standard line as follows:

[2]

In addition, the WinLab32 software uses an internal standard initial intensity value 
(IS Initial value). The first time the internal standard intensity is measured, the 
value is remembered and added to equations 1 and 2 as follows:

[3]

By looking at the corrected analyte intensity value and comparing this with the raw 
value, you can see how much the intensity has drifted.

The internal standard initial intensity value (IS Initial value) is stored with the 
calibration curve. 

f ( )ISample C=

ISample

IInternal Standard

f ( )C=

IS Initial Value

ISample

IInternal Standard

I f ( )C=
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The following information gives more details about how the IS Initial value is 
handled in the WinLab32 software.

• The IS Initial value is determined during measurement of the first solution 
that contains the internal standard(s). If the calibration blanks contain 
internal standard, then the IS Initial Value is measured as part of the blank. 
If the internal standard(s) are not in the blank, then the IS Initial Value is 
measured in the first calibration standard.

• If the calibration curve is cleared, the IS Initial value is also cleared. This 
can occur under two circumstances: 

by selecting the New Calibration command from the Analysis menu, or

by loading a method that does not also load a stored calibration curve.

• The IS Initial value is stored with calibration curves and recalled when the 
calibration curve is recalled.

• The IS Init value is not reinitialized when any type of recalibration occurs.

• Results that have been internal standard corrected are marked with a 
footnote symbol. The † symbol is placed just after the analyte name.

• For data reprocessing the IS Initial value is cleared when the calibration 
curve is cleared exactly the same as for normal sample analyses. 
Generally, you should clear the calibration curve before reprocessing data; 
if existing calibration curves are not cleared, then any calibration 
operations, even if at the beginning of the samples to be reprocessed, 
would be treated as recalibrations and the IS Initial value would not be 
reinitialized. 



537Calculations

Weighted Linear Calibration

When working at low level concentrations it provides an alternative calibration 
scheme that weighs the low standards to a greater degree.

Determine the slope, intercept, and correlation coefficient for the equation:

where  x  is the measured net corrected intensity (blank subtracted). The weights 
are applied by multiplying the intensity by the weighting factor for each standard. 
In this calibration the weighting factor is the reciprocal of the square of the user 
entered concentration value for each standard.

Where:

x is the Concentration value of the standard

y is the measured intensity of the standard

n is the number of standards

i is the index for the standards

b0 is the intercept

b1 is the slope

C is the correlation coefficient
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Glossary
A
Analyte. The element whose concentration is determined in an analysis.

Array detector.  A silicon chip that is manufactured with a one or two-
dimensional array of photosensitive material on its surface. The photons that are 
absorbed by the units (pixels) of the array are converted to electrons which are 
collected and read out. Examples include Photodiode Arrays (PDAs), Charge-
coupled Devices (CCDs), Charge-injection devices (CIDs) and Segmented-array 
Charge-coupled Devices (SCDs). 

Aspiration. A high speed gas flow is directed across an open tube to draw solution 
into the nebulizer. 

Auxiliary flow.  The flow of argon gas that is contained between the intermediate 
and the injector tubes of the ICP torch. 
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B
Background correction.  Process of correcting the intensity recorded for a 
particular wavelength for intensity due to the ICP continuum background and other 
spectral interferences. This is normally done by choosing one or two points at one 
or both sides of the peak you want to correct. Points can be chosen manually. The 
software then measures the intensity at these points, interpolates an intensity at the 
peak wavelength, and then subtracts that intensity from the intensity recorded at the 
peak. 

BEC test.  Background Equivalent Concentration test. A test of instrument 
sensitivity. The concentration of a solution whose intensity is equivalent to the 
intensity of the background at the same wavelength is determined. The lower the 
concentration of this solution, the more sensitive the instrument for that element.

Blank (solution).  A solution that contains none (or rather, an undetectable 
amount) of the analyte you are interested in. Used for a zero point in calibration.
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C
Calibration curve.  The plot or equation showing intensity versus concentration 
for an analyte. Once this is established, the concentration of any solution 
containing this analyte within the concentration range of the calibration can be 
found.

Calibration equation.  Mathematical function used to convert a sample's 
measured emission intensity into a concentration reading. See also Curve Type.

CCD.  Charge-coupled Device. A two-dimensional array detector that uses a 
charge-coupled readout of the photoelectrons generated by light absorption. This 
type of detector is used in PerkinElmer scanning CCD ICP spectrometers. See also 
Array detector, SCD.

Correlation coefficient.  Indicates the quality of the fit between the calibration 
curve and the points it is fitting. A value of 1.000 indicates a perfect fit. 

Curve type.  Describes the calibration curve made using a particular calibration 
equation. Using different curve types for the same standard and blank 
measurements may give different analytical results.

CV test.  Coefficient of Variation test. See Relative Standard Deviation (RSD). 
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D
Default settings.  The instrument software contains standard settings which are the 
most generally used settings. There are default settings for aqueous and organic 
analyses that are available to use as a starting point when creating a new method.

Detection limit.  The lowest concentration of an analyte whose presence can be 
determined with a specified degree of certainty. Often defined as the concentration 
of an analyte that results in signal intensity that is three times (or twice) the 
standard deviation of the background intensity at the wavelength measured.

Detector.  A photosensitive device that absorbs photons and converts them into 
electrons with a certain efficiency. These photoelectrons can be measured to 
indicate the intensity of the incoming light, that is, the number of photons from the 
emission source. See also Array detector, CCD, and SCD.

Difference spectrum.  Spectrum that results from subtracting one spectrum from 
another.

E
Echelle grating.  Coarsely ruled diffraction grating used in multiple orders to 
achieve high spectral resolution.

Excitation characteristics.  The amount of energy required to promote an electron 
to a higher energy level in an atom or ion. This excited state is necessary for the 
atom or ion to emit light. Different elements have different excitation 
characteristics.

F
Firmware.  Programmable silicon chips that form an interface between the 
computer software and the instrument hardware that it controls. Firmware has a 
restricted set of commands but operates extremely fast, thus allowing the software 
to be simpler and speed up instrument response. 
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G
GPIB.  General-Purpose Interface Bus. A commonly used protocol (agreement) on 
how computers and electronic devices should communicate. The computer uses a 
GPIB card to allow it to communicate with the instrument firmware.

I
IEC.  See Interelement Correction.

IEEE-488.  Common interface protocol for communications between computers 
and other electrical devices.

Integration time.  The time for which the detector absorbs photons from the 
plasma before a signal is read out. The integration time multiplied by the number 
of reads specified equals the read time.

Interelement Correction (IEC).  A spectral interference correction technique in 
which emission contributions from interfering elements that emit at the analyte 
wavelength are subtracted from the apparent analyte emission after measuring the 
interfering element at another wavelength.

Intercept.  Where two lines meet. Commonly used in spectroscopy in calibration 
work, for example, the y-intercept, meaning the point where the calibration curve 
cuts the x= 0 axis of the calibration plot.

Interference.  Anything that causes the analyte signal in a sample to differ from 
the analyte signal in a calibration solution at the same concentration. See also 
Spectral interference.

Internal reference. IUPAC name for internal standard.

Internal standard.  A nonanalyte element, present in all standards, blanks, and 
samples, that is used to correct for physical or matrix interferences in an analysis.
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L
Linear fit.  Type of calibration curve where a straight line is drawn through the 
standard and blank emission/concentration values.

M
Matrix.  The components of the sample other than the elements of interest. The 
matrix can substantially change results obtained, through spectral interference or 
viscosity change.

Mercury lamp.  A lamp inside PerkinElmer simultaneous ICP spectrometers that 
emits light at a mercury wavelength. This is periodically used to return the 
instrument to the current wavelength calibration. 

Method.  Controls instrument settings and how the instrument acquires and 
processes data in an analysis.

MSF.  See Multicomponent Spectral Fitting.

Multicomponent Spectral Fitting (MSF).  A processing mode that distinguishes 
analyte spectra from interfering spectra by the use of stored mathematical models. 
It uses a multiple linear regression technique to fit the models created to unknown 
spectra during an analysis. Since only the peak shapes need to remain constant, 
typically, the models are independent of concentration, plasma conditions, and 
matrix effects. 

Sources of information on MSF include the following two articles:

Ivaldi, Juan C. et al., “Multivariate methods for interpretation of emission 
spectra from the inductively coupled plasma,” Spectrochimica Acta, Vol. 47 B, 
No. 12, pp. 1361-1371, 1992.

Ivaldi, Juan C. and Barnard, Thomas W., “Advantages of coupling multivariate 
data reduction techniques with simultaneous inductively coupled plasma 
optical emission spectra,” Spectrochimica Acta, Vol. 48 B, No. 10, 
pp. 1265-1273, 1993.
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N
Nebulizer Flow.  The flow of argon gas that enters the nebulizer and carries the 
sample in the form of an aerosol into the plasma.

Neon Correction. A neon reference spectrum is measured for use in wavelength 
correction on PerkinElmer scanning CCD ICP spectrometers.

O
Optimizing.  The process of determining the best conditions and settings for an 
analysis.

Outer Flow.  IUPAC term for plasma flow.

P
Peak algorithm.  The way in which the emission data from the spectrometer is 
converted into emission counts. This can be done in three ways: (1)  by searching 
for a peak and estimating its height (Peak height processing); (2)  by summing the 
output of several detector pixels (Peak area processing); or (3)  by treating the 
output mathematically and relating it to existing spectral models (Multicomponent 
Spectral Fit processing). 

Peak area processing.  A processing mode that sums the intensities recorded by 
specified pixels on a given subarray for an element.

Peak height processing.  A mode of processing emission data where the highest 
intensity points are searched for, and then an algorithm is applied to approximate 
the peak height. See also Area processing and Multicomponent Spectral Fitting.

Pixel.  Photosensitive unit of an array detector whose output can be read 
individually.

Polychromator.  A type of spectrometer that can detect and process data for two 
or more wavelengths at the same time.



546 Glossary

Pre-shot.  A quick “snapshot” of the plasma emission which is made by the 
spectrometer when Auto Integration is selected. This is used to determine optimum 
integration times.

Precision.  A measure of how reproducible a set of measurements is. Commonly 
used statistical measurements are standard deviation (SD) and relative standard 
deviation (RSD), also called coefficient of variation (CV).

R
Read time.  The amount of time per replicate for which the detector measures light 
from the plasma for the current sample. The total read time equals the integration 
time multiplied by the number of integrations specified.

Relative Standard Deviation (RSD). The standard deviation of a group of 
measurements divided by the mean of those measurements. A test used to measure 
relative precision for a group of measurements. Often expressed as a percent. Also 
known as Coefficient of Variation (CV) test.

Replicate.  A sample can have one or more replicates, meaning that there will be 
repetitive measurements taken.

Reslope. When there are small changes in instrumental conditions, the reslope 
feature of the software allows you to compensate by making small corrections to 
the calibration curve using a single calibration standard.

Resolution.  The measure of a spectrometer's ability to separate adjacent 
wavelengths. The High setting for resolution maximizes the resolving power on 
PerkinElmer simultaneous ICP spectrometers.

RF Power. The amount of energy per unit time transmitted from the RF generator 
to the ICP discharge. Measured in watts.
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S
Sample uptake rate. IUPAC term for sample flow rate.

Scanning CCD ICP Spectrometer.  A spectrometer that detects and processes 
data for one wavelength at a time.

Simultaneous ICP Spectrometer.  A spectrometer that detects and processes data 
for two or more wavelengths at the same time.

SCD.  Segmented-array Charge-coupled device Detector. A specialized type of 
array detector (developed for and used in PerkinElmer simultaneous ICP 
spectrometers) that has groups of photosensitive pixels, called subarrays, on the 
detector surface where important atomic emission lines appear. The SCD uses 
charge-coupled readout like a CCD, but the subarrays can be individually 
addressed. See also Array Detector, Detector, CCD. 

Slit Steps. The number of positions used by the spectrometer entrance slit during 
data collection for each replicate on simultaneous ICP spectrometers. The slit can 
be moved under software control. When the spectral profiling is set to off, the 
spectrometer uses one slit step (entrance slit position); when spectral profiling is 
on, the spectrometer uses four.

Shutter.  A mechanical device used to block the plasma emission from entering the 
spectrometer.

Spectral interference.  An interference caused by the emission from elements or 
compounds other than those of interest.

Spectral profiling.  On PerkinElmer simultaneous ICP spectrometers, the 
spectrometer entrance slit is adjusted by ¼ pixel steps during data collection, thus 
moving the slit image across the detector subarrays. This increases the data density 
across the spectral peaks and produces smoothed spectral displays. 

Split-pixel.  Reading a detector array so that information is taken from each half-
pixel rather than from each pixel.

Standard.  A solution with accurately known concentrations of the elements to be 
determined in an analysis. Two or more standards are used to make a calibration 
curve.
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Standard deviation.  A statistical definition of the variation in a group of similar 
measurements.

Structured background.  Spectral interference that is non-random, thereby 
altering analytical results for nearby analyte lines.

Subarray. On PerkinElmer simultaneous ICP spectrometers, this is a group of 
pixels on an SCD which are positioned to measure a small, specific wavelength 
range. 

T-Z
Weighted linear fit.  A curve type where the importance given to a calibration 
point in the fitting process (the weighting) is directly related to the concentration 
of the standard measured for that point.
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Calibration 219

Automated analyses 58
Creating new 148
Initial, for automated analyses 147
Manual analyses 62
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Manual analyses with Autosampler 66
Parameters 133
Recalling 63
Stored, selecting 503
Types of 58, 62, 66
Units editing 138
Using stored 147

Calibration (Calib) button
Toolbar 468

Calibration algorithms 518, 521, 522, 524, 
533

Calibration and Calculations 517
Calibration and Reagent Blank Usage Page

Method Editor 140
Calibration Blank 1-5 options 135
Calibration Blanks

Internal Standards in 129
Calibration command

Tools menu 489
Calibration curve correction 534

Reslope 534
Calibration curves

Printing 330
Calibration Display command

Options menu 507
Calibration Display Options dialog 330
Calibration Display window 327
Calibration Equation entry 143
Calibration equations 518, 521, 522, 524, 

533
Calibration Equations and Sample Units 

page
Method Editor 142

Calibration pages overview
Method Editor 133

Calibration Standard 1 - 30 options 135

Calibration Summary
Method Editor 310
Viewing 63

Calibration Summary command
Analysis menu 498

Calibration Summary Header 321
Calibration Units and Standard Conc page

Method Editor 138
Cancel Analysis command

Analysis menu 497
Cascade command

Window menu 515
Check Method command

Edit menu 486
Check Method dialog 487
Checking

Performance 39
System, daily 26

Checks page
Method Editor 152

Clear Calibration Blank command
Analysis menu 498

Clear command 196
Edit menu 485

Clear Reagent Blank command
Analysis menu 498

Clear Results Display command
Analysis menu 498

Clear Spectra Display command
Analysis menu 498

Close All Windows command
Window menu 515

Coefficient of Variation Test 40, 47
Color

Selecting for spectra display 302
column 110, 146
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Column Fill command 197
Edit menu 485

Column fill dialogs
Sample Information Editor 209, 210

Commands
Analysis menu 496
Edit menu 484
File menu 471
Help menu 516
Options menu 506
System menu 491
Toolbar 467
Tools menu 489
Window menu 515

Comments
About Samples 221

Communication 439
Computer

Starting up 30
Conc/Upper Limit/Lower Limit entries 164
Concentration Units entry 153
Concentrations for standards

Viewing 231
Configure Pump dialog 511
Configuring

Autosampler 30
Plasma viewing position 31
Pump 31

Contents and Index command
Help menu 516

Continuing
Automated analyses 60
Manual analyses 65
Manual analyses with Autosampler 68

Continuing an Analytical Sequence dialog 
248

Cooling water
Checking supply 27

Copy command
Edit menu 485

Copying
Methods 78, 86
Sample information files 188

Correlation Coefficient 529
Count as Sample entry 163
Countdown dialog 464
Create New Method dialog 476
Creating

Methods 78
Sample information files 188
Workspaces 20

Current Sample option 224
Cut command

Edit menu 484
CV Test 40, 47

D

Data
Exporting automatically 510
Saving 53

Data handling
Overview of windows for 17

Data Manager
Overview of windows 17
Starting 69

Data processing
Parameters 119

Data reprocessing
Including/excluding elements from 502

Data Reprocessing command
Tools menu 490
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Data Reprocessing window 250
Data Selection Wizard 380

Step 1. Select Results Data Set (Exam-
ine/MSF) 381

Data Selection wizard 381
Step 3. Select Analytes 383

Datasets
Selecting for Examine/MSF 381

Define Elements Symbol...page
Method Editor 95

Define Standard page
Method Editor 134, 137

Define Y-axis Options dialog 404
Delete button

Examine Spectra window 395
Delete Rows command 196

Edit menu 485
Deleting

Blanks and standards 137
Libraries 21
Methods 78
Rows 194
Sample information files 188

Design List for sample information files 
480

Detection limit test 40, 48
Detector Calibration 285
Detector calibration 291

Performing 291
Detector Calibration dialog 292
Diagnostics 437

Autosampler page 445
Plasma page 443
Spectrometer page 442
System page 438

Diagnostics command

System menu 491
Diagnostics window

Overview 434
Diluted to Volume Column Fill dialog 217
Diluted to Volume entry 201
Dilution 224
Dilution Factor 201
Disk storage

For results 260
Display options

Selecting for Examine Spectra/MSF 
406

Displaying
sample spectra 381

Displaying Spectra 302
Drains

Checking condition 29
Dry weight 220
Duplicate option 223

E

Edit menu commands 484
Editing

Sample information files 188, 193, 210
units.ini 139, 145

Element choice as internal standard 130
Element information field 104, 105, 110, 

120, 124, 140, 143
Elements 130, 132

Including/excluding from analyses 502
Selecting 80, 84

Emergency Plasma Off button
Using 34, 36

Enable Tubing Saver 512
Enable/Disable Elements command



Index 555

Analysis menu 496
Enable/Disable Elements dialog 502
Enable/Disable Service Log Files dialog 

457
Entry Dialog command 197
Entry fields

Clearing 193
User defined 209

Equations 518, 521, 522, 524, 526, 533
Error messages 487

In method 487
Software 462, 463

Examine button
Toolbar 468

Examine Spectra
Display Options dialog 406

Examine Spectra window
Overview 371
Using 374

Examine Spectra/MSF command
Options menu 507
Tools menu 490

Examine Spectra/MSF Window 370, 380
Keyboard shortcuts 378

Example
Setting the Peak wavelength 397

Exit command
File menu 476

Exiting
Software 70

Export data 510
Exporting

Spectra 384
Extended Search 278, 280
Extinguishing

Plasma 34, 36, 70

Extra Wash Concentration Limits dialog 
115

F

F’n information field 103, 105, 110, 120, 
124, 140, 142

Factors for IEC
Calculating 359
Entering manually 361
Summarize Factors page 363

Failure Actions for After-Calib QC’s 168
Method Editor 168

Failure Actions for At-End QC’s
Method Editor 173

Failure Actions for Periodic QC’s 170
Method Editor 168

FIAS Page, diagnostics 446
File menu commands 471
Files

Opening 482
Used in WinLab 32 21
Using NT Explorer 21

Filling a column
Sample Information Editor 214
Sample information Editor 210

Flow Charts 159
Flow Charts for QC 159
Flush Rate entry (Sample flush) 113
Flush speed

Pump 511, 512
Flush Time entry (Sample flush) 113
Function entry 97

G

Gas flows 109
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Changing 266
RF power and Viewing Distance entry 

111
General Preferences command

Options menu 506
General Preferences dialog

Sounds 508
View options 509

Global assignments
For MSF 416

Glossary 539
Go To Location dialog 250

H

Hardware control window
Overview 264

Heater control 268
Help menu commands 516
Hg Lamp

Manual Control 282
Hg Realign 284
Hide/Visible

Examine Spectra window 394
option 394

How to Use Help command
Help menu 516

How to Use the Examine MSF Window 
410

I

ID entry 134
Identifying samples 212
IDs 186, 211
IEC 358
IEC factors

Editing 350
User-entered 361

IEC for multiple wavelengths per element 
350

IEC Model Builder
Calculate Factors page 359, 360
Select Samples 367
Set Limits page 355
Set Up page 353
Summarize Factors page 363

IEC Model Builder command
Tools menu 490

IEC Model entry 125
IEC process

Overview 345
IEC standards

Analyzing new 350
Reanalyzing 350

IEC table 349
Creating 348
Modifying 350

IEC window 347
IEEE communication 441
Igniting

Plasma 32, 33, 36
Import from Results Library command

File menu 474
Import from Results Library dialog 483
Importing 483

EIC models 483
Methods 483
MSF models 483

Information display windows 299, 300
Overview of 14

Initial Calibration page
Method Editor 147



Index 557

Initial Sample Volume Column Fill dialog 
216

Initial Sample Volume entry 202
Initial Sample Weight entry 202
Initialize Optics 284
Insert Rows command 196

Edit menu 485
Instrument

Automatic shutdown 493
Checking the system 26
Parameters 95
Setting up 25, 29, 30, 31, 32, 33
Shutting down 70
Starting up 29

Instrument components
Status of 434

Instrument control
Overview of windows for 15, 16

Instrument Diagnostics window 434, 437
Instrument gases

Checking supply and setting pressure 
26

Integration Time entry 105
Interelement correction 343, 358

Multiple wavelengths per element 350
User-entered factors 361
When to use 343

Interelement correction factors
Editing 350

Interelement correction files
Opening 482
Save As dialog 482

Interelement Correction Model Builder
Calculate Factors page 359
Select Samples 367
Set Limits page 355

Set Up page 353
Summarize Factors page 363
window 347

Interelement correction process 345
Interelement correction standards 350
Interelement correction table 350

Creating 348
Interference correction 336

Types of 342
Interference Overview 336
Interferences 129

Corrected by internal standardization 
130

Interferents
Global assignments for MSF 416

Internal Standard Blank option 135
Internal Standard Options 129
Internal standardization 129, 130, 535
Internal Standards

Assinging 128
Reporting apparent concentrations 129, 

132
Internal Standards Concentrations dialog 

132
Introduction 8

WinLab 32 8
IP address 447
IS initial value 536

K

Keyboard shortcuts
Examine Spectra window 378

L

Label options
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Selecting for Examine Spectra/MSF 
406

Labels
Spectra 408

Libraries 21
Library Location 233

Methods 74
Linear Bracketing Calibration 522
Linear Calibration Algorithm 518
Linear Forced through Zero 521
Log files 457, 459

Disabling 458
Enabling 458

M

Main Instrument switch
Using 29

Manual analyses 62
Analyzing samples 64
Calibration 62
Restarting 65
Stopping 64

Manual analyses with Autosampler 65
Additional samples 69
Analyzing samples 67
Calibration 66
Restarting 68
Stopping 68

Manual analysis
View or change sample parameters 232

Manual Analysis command
Analysis menu 498

Manual Analysis Control command
Tools menu 490

Manual Analysis Control Window 227

Manual button
Toolbar 468

Mask button 413, 414, 415
Masking

Explanation and examples of 415
Using in MSF window 413

Matrix check dilution 224
Matrix check duplicate 223
Matrix Check Sample Entry dialog 222
Matrix Check Samples Entry 206
Max. Decimal Places entry 145
Max. Significant Figures entry 146
Maximum retries after QC failure 176
Mean Header and Information 317
Menus

Analysis 496
Edit 484
File 471
Help 516
Options 506
System 491
Tools 489
Window 515

Mercury Realign 284
Mercury realignment

Performing 290
Mercury Realignment dialog 290
Message command

File menu 474
Message dialog 484
Message Log

Save As dialog 482
Messages

Analysis 463
Printing 484
Saving 484
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Method
Active 74

Method button
Toolbar 469

Method Description entry 96
Method Editor

Calibration and Reagent Blank Usage 
Page 140

Calibration Pages 142, 147
Calibration pages 134, 138, 140
Calibration Pages overview 133
Calibration pages overview 133
Checks page 152
Failure Actions for After-Calib QC’s 

168
Failure Actions for At-End QC’s 173
FIAS Technique 101
Options page 177
Overview 74
Procedures 76
Process Pages 124, 128
Process pages overview 119
QC Pages 162
QC pages 163
Recovery Checks Page 73
Sampler pages 109
Sampler Pages Overview 108
Schedule for QC Analyses page 166
Settings pages 98
Spectral Corrections page 124
Spectral Peak Processing page 120
Spectrometer Pages 95
Spectrometer pages 112, 113
Spectrometer pages overview 95
Using 76

Method Editor (MethEd) button

Toolbar 467
Method Editor command

Tools menu 489
Method Editor Pop-Up Menus 90
Method Header 319
Method parameters

Updating 403
Methods

Checking 93, 487
Copying 78, 86
Creating 476, 478
Creating new 78
Deleting 78
Description 74
Including/excluding elements from 502
Modifying 87
Opening 86, 481
Overriding settings 268, 282
Printing 94
Saving 74, 79, 87, 93, 481
Selecting for analyses 50
Setting survey and auto integration 106
Using 76

Minimum Concentration Column Fill dia-
log 358

Modifying
Methods 87
Sample information files 191

MSF
Global assignments 416
Overview 418
Steps to perform 419

MSF and IEC
Which to use 343

MSF File
Viewing 417
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MSF Model entry 125
Multicomponent Spectral Fitting 419

Overview 418
When to use 343

Multicomponent spectral fitting files
Opening 482
Save As dialog 482

Multicomponent Spectral Fitting window
Masking 413, 414
using 412

Multiline Calibration 148
Multimethod 147
Multiple Wash Settings dialog 496
Multiple wavelengths per element 350

N

Name entry 97
Neb entry 111
Nebulizer end cap

Checking 38
Nebulizers

Recommended settings 271
New Calibration command

Analysis menu 497
New Command

File menu 471
New IEC Model command 471
New MSF Model command 471
New Sample Info File command 195
New Sample Information File Command 

471
New Sample Information File dialog 480
No MAsk button 413
Nominal Sample Weight entry 203
Non-Linear Bracketing Algorithm 526

Non-Linear Calibration Algorithm 524

O

Online assistance
Overview of in Software 18

Open command
File menu 471

Open dialog 482
Open Method command 471
Open Sample Info command 195
Opening

Files 482
Methods 50, 86
Results data sets 52
Sample information file 50
Sample information files 191
Workspaces 50, 482

Operating status problems 452
Optimizing performance 39
Options

In Control Window, setting for analyses 
52

Selecting for parameters 88
Specified for analyses 52

Options menu commands 506
Options page

Method Editor 177
Organics

Purging 32, 38
Overlap Correction entry 125
Override method 266, 280
Overview

Of software 9
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P

Packing
libraries 21

Panes
Calibration 327
Spectra display 301

Parameter input
Overview of windows for 11

Parameter List
Edit menu 486

Parameter List command 195
Parameters

Adding 208
Calibration 133
Data processing 119
Defining in sample information files 

187, 189
Editing 193
QCs 157
Required for samples 200
Sample information 197
Spectrometer 95

Paste command
Edit menu 485

Peak Algorithm entry 121
Peak wavelength 395

Example 397
Peaks 385

Exporting 384
Performance

Checks during set up 39
Optimizing and verifying 39

Performance checks
Method for 42
Setting up for 44

Performing Analyses
Overview 24

Periodic Table 79
Periodic Table button 97
Periodic Table command

Tools menu 489
Periodically entry 167
Peristaltic pump

Setting up 31
Tubing 32
Tubing, checking condition 28

Peristaltic pump flush
Setting 267, 268

Peristaltic Pump page
Method Editor 112

Plasma
Correcting problems 37
Correcting unsuccessful ignition 37
Extinguishing 34, 36, 70
Igniting 32, 33, 36
Preparing for igniting 32
Reigniting 36
Resetting system 34
Shutting off 36
Shutting off manually 34
Shutting off manually and auto 70
Stable 35
Unstable 36
Unstable, correcting 34

Plasma button
Toolbar 469

Plasma Conditions 109
Plasma conditions 476

Default settings 478
Selection of 477

Plasma Control command
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Tools menu 490
Plasma Control window 264, 265

Controls 266
Displays 266

Plasma Default Conditions Dialog 478
Plasma entry 111
Plasma On/Off command

System menu 491
Plasma page

Diagnostics 443
Method Editor 109

Plasma parameters
Recommended settings 270

Plasma switch 34, 266
Plasma View entry 112
Plasma viewing mode

Selecting 280
Plasma viewing position

Aligning 275
Configuring 31

Points per Peak entry 123
Pop-up menus 257

Data Reprocessing window 257
Sample Information Editor 195

Power entry 111
Precision Test 40, 47
Print command 196

File menu 474
Print Preview command 196
Print Setup command

File menu 475
Printing

Calibration curves 330
Methods 94
Results 323
Results during analyses 53

Sample information files 193
Spectra 303

Process pages overview
Method Editor 119

Profiling 121
Progress Timer dialog 464
Pump

Configuring 31
Setting up 31
Starting 31
Tubing 28

Pump command
Options menu 507

Pump configuration
Saving 511

Pump Flush Speed Entry 512
Pump On/Off command

System menu 492
Pump parameters 112
Pump Tubing Entry 512
Pump Type Entry 512
Purge Gas

Manual Control 280
Purge-gas Flow entry 98
Purging

Organics 32, 38

Q

QC Flow Charts 159
QC pages overview

Method Editor 157
QC Sample Concentrations and Limits 

page
Method Editor 163

QC Sample Definition page
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Method Editor 162
QC Sample ID entry 162, 164, 166, 168, 

174
QC’s

Scheduling 219
Quality control samples 219

Parameters 157

R

Read Delay entry 206
Read Time 100, 106

Setting 105
Reagent Blank 1-5 options 136
Recalibrate Before Column Fill dialog 218
Recalibration

Automated analyses 59
Manual analyses 63
Manual analyses with Autosampler 67

Recalibration Before entry 205
Recall Calibration command

Analysis menu 497
Recall Calibration dialog 503
Recalling a calibration 63
Recovery check samples

Analytes added to 152
Recovery sample 223
Recovery Set 1 to 6 entries 153
Recovery Set Number option 223
Reigniting

Plasma 36
Relative Standard Deviation (RSD) 40
Relative Standard Deviation Test 47
Remarks Entry dialog 199, 221
Renaming

Sample information files 188

Replicate Header and Information 315
Replicates entry 100
Reports

Generating 69
Reprocessing (Reproc) button

Toolbar 469
Reset Automated Analysis dialog 249
Reset button 60
Reset RF Emergency Off command

System menu 491
Resetting

Automated analysis 249
Reslope for calibration curve correction 

534
Reslope Standards option 136
Resolution

Setting 103
Resolution entry 99, 104
Restarting

Automated analyses 59
Manual analyses 65
Manual analyses with Autosampler 68

Results
Opening 481
Printing 323
Saving 481
Windows overview, interferences 14

Results button
Toolbar 468

Results command
Tools menu 489

Results Data Set Dialog 233
Results data sets

Storage space 260
Results Display options

Options page, Method Editor 177
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Results Display window 308
Save As dialog 482

Retires after QC failure
Setting maximum 176

Retries after QC failure 176
RF coil

Drying 32
RF Generator switch

Using 29
RF power

changing 267
RSD Test 40, 47
Run list

Appending samples to 505
Running samples

Overview 24

S

Safety
Checking the instrument 26

Sample description parameters 198
Sample Details Dialog 232
Sample Flow Rate entry 112
Sample Flush

Flush Rate entry 113
Flush Time entry 113

Sample Header 318
Sample ID Column Fill dialog 211
Sample ID entry 199
Sample Info File Column Fill dialog 240
Sample Information (SamInfo) button

Toolbar 468, 469
Sample information designs 191

Save As dialog 482
Sample information dialogs 198

Sample Information Editor
Customizing 187, 189
Overview 186

Sample Information Editor command
Options menu 506
Tools menu 489

Sample Information Editor Pop-Up Menus 
195

Sample Information Editor Pop-up Menus 
195

Sample information files
Adding parameters 208
Copying 188
Creating new 188
Deleting 188
Description 186
Editing 188
Existing designs for 480
Modifying stored files 191
Opening 191, 482
Printing 193
printing 193
Renaming 188
Save As dialog 482
Saving 192
Selecting for analyses 50

Sample Information parameters
Editing 193

Sample information parameters
Description 197

Sample Information Parameters dialog 207
Sample Introductory System

Checking condition 28
Purging Organics 38

Sample parameters
View or change 232
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Sample Prep Volume entry 203
Sample Preparation

An Example 205
Sample Preparation Parameters

Table 200
Sample reporting units 213
Sample units

Editing 145
Sample Units Column Fill dialog 213
Sample Units entry 144, 203
Sample volume 216, 217
Sample volume diluted to 218
Sample volume units 214
Sample weight 200, 202, 215, 220
Sample weight units 214
Sampler Pages Overview

Method Editor 108
Samples

Adding to analytical sequence 249
Appending to an analysis list 504
Comments on 221
Preparing 54, 201
Saturated 323
Selecting to analyze 240

Saturated samples 323
Saturation 323, 325

Outside of integration 326, 327
Saturation Codes 325
Save As command

File menu 472
Save As dialog 482
Save As Text command 196

File menu 474
Save command

File menu 472
Save Sample Info As command 196

Save Sample Info command 196
Save Sample Info Design As command 196
Saving

Data 53
data 260
Methods 79, 87, 93

Schedule for QC Analyses page
Method Editor 166

Scheduling
QC’s 219

Select Analytes
Data Selection wizard 383

Select Label Options dialog 406
Select Line Styles dialog 387
Select Results Data Set 381

Examine/MSF 380, 381
Select Samples

Data Selection wizard 381
Select Samples dialog for IEC 367
Select Scale & Offset dialog 390, 391
Set Element Resolution dialog 103
Set Limits for IEC 355
Set Manual Integration dialog 104
Set Peak Wavelength 395
Set Up page

Automated Analyis Control window 
235

Changing after analysis starts 60
Changing after automated analysis 

starts 235
Interelement Correction Model Builder 

353
Setting

Options in Control window, for analy-
ses 52

Setting up
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Instrument 29, 30, 31, 32, 33
Instrument gases 26
Peristaltic pump 31

Setting up pump
Tubing, setting up 32

Shortcuts 378, 380
Show Analytical Points 404
Shutter

Leaving open (warning) 56
Manual Control 281
Manual control 282

Shutting down
Instrument 70, 492

Shutting off
Plasma 34, 36, 70

Sodium bullet test 39, 41
Software 8

Exiting 70
Overview 9
Overview of for online assistance 18
Overview of windows for handling data 

17
Starting 30
windows for controlling analyses,Over-

view 13
Windows for correcting interferences 

14
Windows for displaying results 14
Windows for instrument control 15, 16
Windows for parameter input 11

Software troubleshooting 455
Solids Ratio Column Fill dialog 220
Solids ratio entry 202
Sort by command

Edit menu 486
Sounds

Configuring 508
Source Equilibration Delay entry 109
Spectra

Hiding in Examine window 394
MSF Spectra, masking selections of 

413, 415
Panes 303
Printing 303
printing 378
Selecting colors 302

Spectra button
Toolbar 468

Spectra command
Tools menu 489

Spectra Display command
Options menu 506

Spectra Display Options dialog 304, 306
Spectra display panes 301
Spectra Display window 301
Spectral Corrections page

Method Editor 124
Spectral interference correction 336
Spectral Peak Processing page

Method Editor 120
Spectral profiling 99, 121
Spectral Windows page 107

Method Editor 106
Spectrometer

Parameters 95
Standby 70

Spectrometer Control command
Tools menu 490

Spectrometer Control window 273
Manual settings 280
Overview 272
Table of controls 283
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Spectrometer Options
Settings page 98
Settings page, Method Editor 98

Spectrometer page
Diagnostics 442

Spectrometer pages
overview, Method Editor 95

Spike 223
Spike samples

Analytes added to 153
Standard concentrations

Analyte 138, 139
Standard Deviation and Precision 533
Standards

Viewing concentrations 231
Standby

Spectrometer 70
Starting

Automated analyses 60
Manual analyses 65
Manual analyses with Autosampler 68

Starting up
Computer 30
Instrument 29, 492, 493, 494

Status
Troubleshooting problems 452

Stopping
Automated analyses 59
Manual analyses 64
Manual analyses with Autosampler 68

Stopping an Analytical Sequence dialog 
247

Storage space
For results 260

Stored calibration
Selecting 503

Subarray calibration 398
Subtract Reagent Blank entry 141, 163
Summarize Factors page

IEC Model Builder 363
Survey

Setting in Method Editor 106
Symbol entry 96
System

Resetting 34
System communication 439
System menu commands 491
System monitor windows

Overview 434
System monitors 434
System page

Diagnostics 438

T

Table 79
Text display windows

Save As dialog 482
Tile Horizontal command

Window menu 515
Tile Vertical command

Window menu 515
Timer dialog 464
Times to retry QC entry 169, 174
Tip of the Day command

Help menu 516
Toolbar 467
Tools menu commands 489
Torch

Igniting 34
Torch Viewing Position

Aligning 275, 276
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Transient Read Delay 102
Transient Read Time 103
Troubleshooting

During set up 41
Operating status 452
Software 455
Unsuccessful ignition of plasma 36

Tubing
Pump 512
Pump, setting up 32

tubing saver 512

U

Units
No results displayed 204
Sample reporting 201, 213
Sample volume 214
Sample weight 214
Sample, editing 145
Specifying your own 204

Units entry
QC Sample Conc and Limits page 164

units.ini file 204
Universal Data Acquisition 73
Update Method Parameters dialog 403
Use Calibration Blank entry 141
User Defined entry 200
User Defined Entry Field dialog 209
User Entered IEC Factor dialog 361, 362
Utilities command

File menu 476

V

Values
Entering in methods 89

View Dist entry 111
View mode

Selecting 281
View options

General preferences 509
View Standard Concentrations Dialog 231
Viewing

Analytical sequence 57
Calibration Summary 63
MSF File 417
Spectra 302

Volume
Of sample 217, 218
Of samples 216

Volume Units Column Fill Dialog 214
Volume Units entry 203

W

Wash
Setting analyte concentrations for 115

Wash entry 114
Wash Frequency entry 114
Wash Location entry 114
Wash Rate entry 114
Wash solutions

Multiple 496
Wash Time

Increase based on concentration 114
Wash Time entry 114, 206
Wavelength

Adjusting 398
adjusting 400
Setting Peak 395, 397

Wavelength Calibration 283
Wavelength calibration
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Performing 285
Wavelength Calibration dialog 289
Wavelength entry 96
Wavelength Table 81
Wavelength Table button 98
Wavelength Table command

Tools menu 489
Wavelengths

measuring below 190nm 33
Recommended 80, 81
Selecting 80, 81

Weekly Schedule dialog 495
Weight

Of sample 215, 220
Weight Units Column Fill Dialog 214
Weight Units entry 202
Wet weight 220
When All Tries Fail entry 169, 174
Window functional categories 9
Window menu commands 515
Windows 353, 355, 359, 363

Analysis control overview 226
Automated Analysis Control overview 

234
Calibration display 327
Data Reprocessing 250, 251, 253
Hardware control overview 264
Information display 299, 300
Interelement correction 347
Manual Analysis Control 227
Method Editor overview 74
Overview for controlling analyses 13
Overview of for displaying results 14
Overview of for handling data 17
Overview of for instrument control 15, 

16

Overview of for online assistance 18
Overview of for parameter input 11
Overview of to correct interferences 14
Plasma Control 264
Required for analyses 50
Results Display 308, 312
Sample Information Editor 186
Spectra display 301
Spectrometer Control 272
System Monitor and Diagnostics 434

WinLab32
Important prerequisites 9
Introduction 7
Software features 8

Workspace (Wrkspc) button
Toolbar 467

Workspaces
Creating 20
Opening 482
Save As dialog 482
Selecting for analyses 50

Y

Y-axis
Defining in Examine Spectra/MSF 404
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